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NOTICE:
Warnings and Cautions appear at appropriate sections throughout this manual. Read these carefully:

�WARNING
Indicates a potentially hazardous situation, which, if not avoided, could result in death or serious injury.

�CAUTION
Indicates a potentially hazardous situation, which, if not avoided, may result in minor or moderate injury. 

It may also be used to alert against unsafe practices

CAUTION
Indicates a situation that may result in equipment damage or property damage.

The following format and symbol conventions appear at appropriate sections throughout this manual:

IMPORTANT
Alerts installer, servicer, or operator to potential actions that could cause the product or system to 

operate improperly but will not likely result in potential for damage.

This symbol precedes a procedure that consists of only a single step. 

Note:

A note may be used to make the reader aware of useful information, to clarify a point, or to describe 
options or alternatives.
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Chapter 1

Introduction

Welcome to the Tracer Summit System Programming guide. This guide 
provides a reference for setting up and configuring the Tracer Summit 
software to automate your building. Here you will find background infor-
mation and step-by-step procedures describing how to perform these 
activities.

What’s new 
• Trend Viewer—View trended data in graphical format (see “Using the 

Trend Viewer” on page 425).
• Simplified Overrides—Override system values from a graphic using 

an easy-to-use user interface (see “Overriding System Values” on 
page 171).

• Display override status from a graphic—Hand icon shows when an 
object has been manually overridden (see “Displaying Override Sta-
tus” on page 564).

• Category Alarms—Assign alarm categories (1-5) based on impor-
tance: categories can be assigned to alarms, workshifts, individuals, 
and more (see “To set up event classes:” on page 82).

• Alarm pop-up dialog boxes—Display alarm pop-up dialog boxes with 
alarm/event information for alarms (see “Configuring Category Alarm 
Buttons and Pop-up Dialog Boxes” on page 565).

Tracer Summit Optional Value-added 

Packages
Table 1 on page 2 lists optional features and the package with which they 
are bundled. You can purchase each package separately, but you must 
have Tracer Summit Version 13 or higher to start.
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Introduction
Table 1. Optional Value-added Packages 

Feature/Description
Tracer 

Summit

Tracer 
100/

Tracker 
Commun-

ication

Building 
Manage-

ment

Enterprise 
Manage-

ment

Critical 
Control 
System 
(CCS)

BCU operator display

• Select objects for display in standard 
screens

• Create custom screens, which display live 
information and a monochrome bitmap 
and links to other screens

• View alarms and acknowledge them
• Optional password protection

Add-on

Call center

Operators can schedule when to forward 
alarms from the workstation and the recipient.

X X

Copy site

Copy an existing site database, graphics, and 
reports as a new site.

X X X X X

Event log

Filter and sort events from the local event log 
of the Tracer Summit BCU. For more informa-
tion, see the Tracer Summit Daily Operations 
guide.

X X X X X

Tracer 100 and Tracker alarm support X X

Shared SQL event log X X

Global changes

Using global changes, modify items in one 
site and easily have those changes take effect 
at other sites within a group.

X

Select several similar objects in a site, modify 
them, and have those changes take effect for 
all the selected objects.

X X X X

Groups

Define individual sites as parts of a group. 
Assign levels of user access to the groups. 

X

Message forwarding

Forward alarms to a user-defined e-mail 
address. Users defined as on-call recipients 
can receive the e-mails on PCs or or on their 
cell phone/pagers.

X X X X X
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Tracer Summit Optional Value-added Packages
Multi-user database sharing

Handle large numbers of sites and share the 
database from a central server.
* Tracer Summit has been designed to work 
specifically with Microsoft SQL Server data-
bases.

X X

Navigation tree

Now has Windows Explorer features such as 
drag and drop, open, cut and paste, and find.

X X X X X

Task manager

• Schedule automatic scans and backups of 
sites

• Start immediate scan of single remote sites
• Download off-line global changes made to 

sites
• Automatically archive the event log as a 

Microsoft Excel file, as a text file, or as both

X X

Tracer 100 and Tracker (EMTK) Support and Tracer 100 or Tracker Configuration

• Connect to Tracer 100 and Tracker (EMTK) 
panels

• Communicate with Tracer 100 and Tracker 
panels using BMN-like terminal emulation

• Edit calculated binary/analog, and sched-
ules. Run equipment diagnostic summary 
reports

• Download schedules to Tracer 100 panels
• Override calculated binary/analog (point 

types 8 and 11)

X X

Trend Viewer X X X X X

View historical trends (Audit Trail data) 
using the Trend Viewer X X

Table 1. Optional Value-added Packages (Continued)

Feature/Description
Tracer 

Summit

Tracer 
100/

Tracker 
Commun-

ication

Building 
Manage-

ment

Enterprise 
Manage-

ment

Critical 
Control 
System 
(CCS)
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Introduction
Important Things to Know Before Using 

this Guide
The following list describes important prerequisite knowledge or skills 
that you should have available when programming Tracer Summit soft-
ware. This list is not exhaustive and serves to remind you of things that 
Trane installation engineers have learned from years of implementing 
Tracer Summit at client sites.

• Facilities—Know your facility. Know its needs and the different pro-
grammable inputs/outputs it uses, as well as the equipment that you 
will be controlling.

• Infrastructure—Understand what telecommunication and local 
area network/wide area network (LAN/WAN) that your facility has in 
place. What are its current needs and what are its future needs? Do 
you have a cell phone/pager service? What are your mail server 
requirements?

• Groups—The Enterprise Management Package allows you to create 
groups of sites. To group sites, have your sites organized and know 
where and how they fit together. Bring this information with you 
when you organize sites into Tracer Summit groups.

• Users and Security—If you are managing sites with various levels 
of users, know who they are and what requirements Tracer Summit 
can fulfill for them. You do not want to find yourself at a critical 
moment with users whose security levels are too low or too high.

• Knowledge of Various Trane Products—If you are connecting to 
Tracer 100 or Tracker panels or a BCU operator display, it is recom-
mended that you have the installation and set-up guides handy to 
consult.

• Interaction with Other Software—To use certain features in the 
Tracer 100/Tracker Communication and Enterprise Management 
packages, Tracer Summit makes use of other software platforms. 
These include various Microsoft operating systems, Microsoft SQL 
Server databases, and mail servers. Have the documentation for 
these other systems available.

• Naming Conventions—Spend some time thinking about how you 
want to name objects in your site. Then use those names appropri-
ately and consistently throughout the system.
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For More Information
For More Information
Use this guide in conjunction with the online Help system and the online 
library. Descriptions of all of the fields that you will see on Tracer Summit 
screens are in Tracer Summit Online Help. Press F1 on any screen to 
access online Help.

For information on how to maintain and operate Tracer Summit sites on 
a daily basis see the Tracer Summit Daily Operations guide. See the 
Daily Operations guide for more information on event logs.

Multi-use database sharing is also an advanced feature that is discussed 
in engineering bulletin BAS-PRB011-EN, Tracer Summit Best Practices.

Read the Release Notes. This is strongly recommended because this docu-
mentation has all the up-to-date information about Tracer Summit. Any 
new information about Tracer Summit programming not contained in 
this guide is in the release notes.

For a definition of important terms and acronyms used in this guide, see 
the “Glossary” on page 671.

To fully learn about the capabilities of Tracer Summit and how they can 
benefit you, consider enrolling in Tracer Summit training classes. For 
more information about these classes, see the course descriptions at http:/
/www.trane.com/commercial/training/trainbas.asp#fifteen.

Further References

Tracer 100 Series Panels

• Tracer 100 Series Installation Guide (EMTF-IN-6)
• Tracer 100 Series Operator’s Guide (EMTB-OG-15)
• Tracer 100 Series Programming Guide (EMTB-PG-11)
• Tracer 100 Version 15.1 Addendum to Tracer 100 Series Literature 

(EMTB-AD-4)
• T100 Version Conversion Programs (EMTB-IN-10)
• Tracer 100 Troubleshooting/Repair (EMTB-TSR-2A)
• Tracer 100i, 100L, and Chiller Plant Manager Troubleshooting/

Repair (EMTF-TSR-1)
• Tracer 100 Installation Guide (EMTB-IN-12)
• Tracer 100 Series Building Management System Unit-To-Unit Com-

munications (BAS-EB-12)
• Tracer 100 Series Software Versions (BAS-EB-25)
• Tracer 100 Series Custom Reports (BAS-EB-54)
• Tracer 100i, 100L, and Chiller Plant Manager Installation Guide 

(EMTF-IN-6)
BMTX-SVP01B-EN 5



Introduction
Tracker Panels

• Tracker Installation Guide (EMTK-IN-7)
• Tracker Operator’s Guide (EMTK-OG-8)

Tracer Summit

• Tracer Summit for Windows and Ethernet (BAS-EB-70)
• Commissioning Tracer Summit BACnet Projects (BAS-PRB002-EN)
• Tracer Summit Connections to LonTalk Devices (BAS-PRB003-EN)
• Tracer Summit BACnet/IP Network Installations (BAS-PRB004-EN)
• Building Control Unit Sizing for Tracer Summit Systems (BAS-

PRB005-EN)
• Tracer Summit Chiller Plant Control (BAS-EB-64)
• Tracer Summit Software Versions (BAS-PRB-006-EN)
• Tracer Summit Multisite Best Practices (BAS-PRB011-EN)
• Using Tracer Summit with a SQL Server Database (BAS-PRB012-

EN)
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Chapter 2

Programming Order Checklist

This chapter describes the recommended programming order. It also pro-
vides a checklist for setting up the Tracer Summit system.

Setting Up a PC Workstation 
(Refer to Tracer Summit Hardware and Software Installation guide.)

1. Install one of the following operating systems: Windows NT 4.0 (SP6 
or greater), Windows XP (SP1 or greater) or Windows 2000 (SP3 or 
greater). 

2. Install Tracer Summit using the CD.

3. Install the ARCNET or Ethernet related hardware and software.

4. Install a Trane-specified modem in the PC workstation if the PC 
workstation communicates remotely with a BCU.

5. Install any additional customer software.

6. Have the building owner set up TCP/IP support, if required.

Setting Up a Site 
1. Use the Site Creation/Connection Wizard to create, upload, or connect 

to a site. (See Chapter 6, “Configuring Tracer Summit BCU Sites” and 
Chapter 7, “Defining Tracer 100 or Tracker Sites.”)

2. Define units of measure. (See Chapter 6, “Configuring Tracer Summit 
BCU Sites.”)

3. Define devices (PC workstations, BCUs and non-Trane devices). (See 
Chapter 6, “Configuring Tracer Summit BCU Sites” and Chapter 7, 
“Defining Tracer 100 or Tracker Sites.”)  

4. Create UCM links and addresses.

5. Set up time and date and synchronize with connected devices.

6. Set up site control priorities as follows:

Note: 

Back up the Tracer Summit system periodically during this 
process.
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Programming Order Checklist
• BACnet defaults. (See Chapter 37, “Using BACnet for Non-Trane 
Devices.”)

• Tracer Summit defaults. (See Chapter 6, “Configuring Tracer 
Summit BCU Sites” and Chapter 7, “Defining Tracer 100 or 
Tracker Sites.”)

7. Set up site security access. (See Chapter 9, “Setting Up Security—
Tracer Summit System.”)

8. Route alarms and events. (See Chapter 6, “Configuring Tracer Sum-
mit BCU Sites.”)

9. Set up printers in the following order:

• Set up operating system printer
• Set up Tracer Summit printer (See Chapter 10, “Setting Up Print-

ers, Modems, Cell Phones, and Pagers.”)

10. Set up modems and cell phone/pagers (if used). (See Chapter 10, “Set-
ting Up Printers, Modems, Cell Phones, and Pagers.”)

11. Use binary and analog input/output objects to customize the system. 
(See Chapter 17, “Creating Input/Output Objects.”)

12. Configure the communication settings for the site. (See Chapter 6, 
“Configuring Tracer Summit BCU Sites.”)

Setting Up Tracer Summit Applications
1. Set up Chiller Plant Control, if applicable. (See Chapter 19, “Chiller 

Plant Control.”)

2. Set up Area Control for HVAC, lighting, and equipment: See Chapter 
20, “Area Control Application.”

3. Set up variable air volume (VAV) system, if applicable. (See Chapter 
22, “Comm3/Comm4 VAV Air Systems.” and Chapter 21, “Comm5 
VAV Air Systems”)

4. Set up Time of Day Scheduling:

• Events
• Exceptions
• Holidays

(See Chapter 24, “Time of Day Scheduling.”)

5. Write custom programs. (See Chapter 25, “Custom Programming 
Language.”)
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Setting Up Graphics
Setting Up Graphics
1. Create graphics. (See Chapter 30, “Using the Graphics Editor.”)

2. Set up the navigation tree. (See Chapter 26, “Using the Navigation 
Tree.”)

Setting Up Reports
1. Set up trends. (See Chapter 29, “Trending Data.”)

2. Set up calculations. (See Chapter 31, “Using the Calculations Editor.”)

3. Design reports. (See Chapter 32, “Designing Reports.”)

Setting Up Group Configuration
1. Use the Site (Creation/Connection) Wizard to create, upload, or con-

nect to a site. (See Chapter 6, “Configuring Tracer Summit BCU 
Sites.”)

2. Create groups. (See Chapter 13, “Creating Groups of Sites.”)

Setting Up Group Security
1. Create groups. (See Chapter 13, “Creating Groups of Sites.”)

2. Set up security for the groups. (See Chapter 9, “Setting Up Security—
Tracer Summit System.”)

Backing Up the System
1. Back up the Tracer Summit site database. (See the Tracer Summit 

Daily Operations guide.)

2. Back up reports. (See the Tracer Summit Daily Operations guide.)

3. Move files between PC workstations.
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Chapter 3

Online and Offline 

Programming

Information Flow in Tracer Summit
Tracer Summit uses an object-oriented distributed database to store and 
retrieve all system information. An up-to-date copy of the database is 
stored in each PC Workstation and appropriate data is stored in the 
BCUs that are communicating (or online). All programming (setup infor-
mation) is entered from a PC Workstation, stored in the PC Workstation 
database, and tagged to be downloaded to the BCUs. The information is 
then sent from the BCUs to additional workstations, if necessary.

If the PC Workstation is online (communicating with the BCU), the infor-
mation is downloaded immediately to the BCU. If the workstation is 
offline, the information is stored in the workstation’s database until it 
goes online with the BCU. Then, the newer information gets downloaded 
from the PC to BCU.

If you have the Tracer 100/Tracker Communications package installed, 
you can program Tracer or Tracker panels online and offline. The infor-
mation from these sites is uploaded to your workstation from a Tracer 
100 or Tracker site when you first connect to it. Any changes that you 
make online are immediately sent to the site. Offline changes download 
when you connect to the site.

If you have the Building Management installed, you can schedule offline 
changes using the Task Manager. You can choose to download immedi-
ately or to download in the future at a time that you specify.

You can also program changes and apply them globally to single sites. If 
you have the Enterprise Management package, you can program global 
changes for groups of sites. Then, using the Task Manager you can specify 
when these global changes are downloaded to the groups of sites.

 IMPORTANT
For the most efficient and trouble-free programming, use online pro-

gramming whenever possible.
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Online Programming
Online programming is recommended for several reasons:

• With online programming, the order in which programming occurs 
determines the settings in the system. For example, if one PC Work-
station programs a setpoint at 1:00 P.M., then another PC Worksta-
tion programs the same setpoint at 2:00 P.M., the programming that 
occurred at 2:00 P.M. automatically takes precedence and replaces 
the earlier programming in the first PC.

• Some configuration information and internal diagnostics reside in the 
BCUs. When the PC Workstation is online, all the information in the 
BCUs is available.

• Some configuration information and internal diagnostics reside in the 
unit controllers. When the PC is online, and the unit controllers are 
connected and communicating to the BCU(s), all the information is 
available.

• With online programming, you can immediately verify each step in 
the process.

Offline Programming on a New Site
In some situations, you may choose to use offline programming to set up 
the Tracer Summit system on a new site. For instance, when the BCUs at 
a site are not yet installed but the PC Workstations are configured, offline 
programming allows you to start setting up the system. Some program-
ming tasks that can be done offline include: 

• Configuring the site
• Creating input and output objects
• Creating schedules
• Creating areas
• Creating VAV air systems
• Setting up site security
• Setting up UCMs (see special issues with offline programming below)
• Creating graphics and reports

IMPORTANT
Offline programming changes must be performed on a single PC Work-

station. Choose a single workstation to serve as the master worksta-

tion and perform all offline programming on that workstation only. A 

master workstation prevents the loss of user program data. This may 

occur when changes that have been made by one user are overwritten 

by changes made by another user. The workstation keeps a copy of the 

programming in its database on its hard drive. When the BCUs are 

installed and online, the PC Workstation downloads this database to 

the BCUs. 
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Offline Programming on a New Site
You should test any setup functions performed with offline program-

ming after the BCUs and PC Workstations are online and the database 

has been downloaded.

When performing offline programming, note the following constraints 
and suggestions:

1. Using additional workstations for graphics setup. If time con-
straints require that two or more PC Workstations be used to set up 
the system, dedicate one workstation for site configuration and data-
base setup. Use the other workstations to create background graphics 
files and edit CPL routine text files. These items can be transferred 
easily between workstations with a floppy disk or other media. Set up 
one workstation completely before you connect other workstations to 
the Tracer Summit system.

2. Dynamic values show as “???”. When you create graphics on a PC 
Workstation that is not online, dynamic values do not show up on the 
graphic until the PC Workstation is online. In place of the value, “???” 
appears. 

3. Applications cannot be tested. You can set up application pro-
grams offline but you cannot test them. For example, custom pro-
gramming routines can be written and compiled offline, but you must 
test each routine when BCUs are online.

4. UCM-resident information cannot be accessed. Some informa-
tion, such as PCM setup information, is UCM-resident only and can 
only be accessed when the BCU is online. When setting up a UCM 
offline, the graphic that displays is the UCM default graphic or a 
user-specified custom graphic, rather than the graphic for the specific 
UCM that exists on the site. You must also select a unit type for the 
UCM in the Change Unit Type field in the Setup screen of the UCM 
editor. When you are programming online, the system automatically 
reads the UCM type and provides the type as a display only field. 
When you are programming offline, you must provide the UCM type. 
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Offline Programming of an Existing Site
Offline programming modification of an existing site is not recommended. 
If the BCUs are installed and communicating with the PC Workstations, 
use online programming if at all possible. Any changes to Site Configura-
tion of an existing site must be done online.

When you must modify an existing site offline, be sure that the following 
conditions exist:

• Make sure the latest copy of the database is loaded onto the offline 
computer. If the workstation or laptop has been online with the 
Tracer Summit system, it will contain the latest database. If the com-
puter hasn’t been online, you can copy the database to it using Tracer 
Summit’s Backup Site Database utility.

• If possible, prevent other PC Workstations from making edit changes 
to the system while the offline programming is in process. When 
offline programming is downloaded to the BCUs, it will overwrite any 
changes made from another workstation.
For example, if the same alarm limit in an analog input is pro-
grammed to 50°F by an operator online and then to 45°F by an opera-
tor offline, the newly downloaded offline setting (45°F) will take 
precedence and overwrite the online setting when the offline program 
is downloaded.

To program an existing site offline, follow the steps in the section “Pro-
gramming an Existing Site Offline” on page 14. 

After you have programmed the site, you need to either update or replace 
the existing site. Refer to “Updating an Existing Site with Offline Pro-
gramming Changes” on page 15 or “Replacing an Existing Site with a Site 
Programmed Offline” on page 16.

Programming an Existing Site Offline

1. Verify that the latest site database is installed on the offline worksta-
tion. If the database does not yet exist on the offline workstation, use 
one of the following methods to transfer the site to the offline work-
station:

• Upload the existing database from the BCUs to the offline work-
station. Be certain that all of the BCUs are communicating when 
uploading the site.

• Restore a recent backup of the site database as explained in 
Chapter 38, “Restoring into the Tracer Summit Workstation.”

Note:

If you have the Enterprise Management package, you can make 
programming changes to groups of sites. Offline programming 
is recommended to take full advantage of the application. For 
more information, see “Programming Offline with Global 
Changes” on page 18.
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Offline Programming of an Existing Site
2. Connect to the site and achieve database synchronization. You may 
observe database synchronization status by running the Tracer Sum-
mit System Status utility described in Chapter 5, “Utilities.” Be cer-
tain that all of the BCUs are communicating while observing 
database synchronization status.

3. Back up the local site database to a secure location. See the Tracer 
Summit Daily Operations guide for information on backing up a site.

4. Prevent the online local workstation from making any site program-
ming changes. This can be assured by assigning read-only applica-
tions security to all of the users at the site.

In addition, do not allow a site database restore operation while pro-
gramming offline.

5. Make programming changes offline. Objects may be created, edited, 
and deleted while offline.

6. When the programming changes are complete, back up the offline site 
database containing the programming changes to a diskette or 
another location that will be accessible by the local workstation. Also 
back up graphics (objects, HTML files, and images) and reports, if cre-
ated or modified offline.

If you have the Building Management or Enterprise Management 
package, you can back up groups of sites at scheduled times using the 
Task Manager.

7. Follow the steps in either “Updating an Existing Site with Offline 
Programming Changes” on page 15 or “Replacing an Existing Site 
with a Site Programmed Offline” on page 16.

Updating an Existing Site with Offline Programming 

Changes

1. Reconnect the offline workstation to the site and achieve database 
synchronization. You may observe database synchronization status by 
running the Tracer Summit System Status utility described in Chap-
ter 5, “Utilities.” Be certain that all of the BCUs are communicating 
while observing database synchronization status.

2. Restore graphics (objects, HTML files, and images) and reports, if cre-
ated or modified offline.

If you have the Building Management or Enterprise Management 
package, schedule the download in Task Manager to occur at a speci-
fied time or run an immediate scan.

3. Open the edited applications while online and verify that the pro-
gramming changes were properly downloaded to the site.

If you have the Building Management or Enterprise Management 
package, check the error log to verify that your programming changes 
downloaded correctly.
BMTX-SVP01B-EN 15



Online and Offline Programming
Replacing an Existing Site with a Site Programmed 

Offline

In some cases, it may be necessary to completely replace an existing site’s 
database. For example, if you are unsure if programming changes were 
made by an operator while the offline programming was being done, it is 
recommended that the database be replaced, rather than updated.

To replace an existing site with a site programmed offline:

1. Back up the local site database to a secure location from a primary, 
online workstation. See the Tracer Summit Daily Operations guide 
for information on backing up a site.

If you have the Building Management or Enterprise Management 
package, you can back up groups of sites immediately or at scheduled 
times using the Task Manager.

2. Disconnect the LAN cable from any secondary workstations on the 
site.

3. While online with all of the BCUs on the site from the primary online 
workstation, select Clear Database Ram and Reset from the BCU 
Reset/Restore utility on the Tools menu. Alternatively, you may clear 
the database manually at each BCU. (See Chapter 40, “Resetting a 
Device”, for information on clearing a BCU database.)

4. Immediately disconnect the LAN cable from the primary workstation. 
This will prevent the BCUs from obtaining the obsolete database 
from the workstation.

5. Perform a database restore operation on the primary local worksta-
tion, using the backup copy of the database containing the offline pro-
gramming changes. This backup was created in step 6 of the section 
“Programming an Existing Site Offline” on page 14. See Chapter 38, 
“Restoring into the Tracer Summit Workstation”, for information on 
restoring a site database.

6. Reconnect the LAN cable or modem on the primary local workstation. 
The BCUs will download the updated database. Allow the site to 
achieve database synchronization with all of the BCUs. You may 
observe database synchronization status by running the Tracer Sum-
mit System Status utility described in Chapter 5, “Utilities.” Be cer-
tain that all of the BCUs are communicating while observing 
database synchronization status.

If you have the Building Management or Enterprise Management 
package, schedule the download in Task Manager to occur at a speci-
fied time or run an immediate scan.

7. Restore graphics (objects, HTML files, and images) and reports, if cre-
ated or modified offline.

8. On secondary workstations you can either:

• Upload the new database from the BCU or
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Offline and Online Programming of Tracer 100 Sites
• Make a backup of the new database at the main workstation and 
restore it on the secondary workstation following steps 5 and 6 
above.

Repeat step 7 for the secondary workstation. Reconnect the LAN 
cable.

9. Open the edited applications while online and verify that the pro-
gramming changes were properly downloaded to the site.

If you have the Building Management or Enterprise Management 
package, check the error log to verify that your programming changes 
downloaded correctly.

Offline and Online Programming of 

Tracer 100 Sites
The information provided in the preceding sections applies to online and 
offline programming of Tracer 100 sites. Read those sections before con-
sidering the following paragraphs.

If you have the Tracer 100/Tracker Communications or Enterprise Man-
agement package installed, Tracer Summit allows you to program Tracer 
100 and Tracker sites online through terminal emulation. In terminal 
emulation you can program objects and modify them. All programming 
changes that you make online are immediately transmitted to the site.

To program offline you must first upload Tracer 100 objects to your work-
station database. This is because all Tracer 100 and Tracker objects are 
created at the panel. Objects are uploaded to your workstation when you 
first connect to a Tracer 100 site.

After a site’s objects are in your database, you can program some of the 
site’s objects offline using the Tracer Summit editors. For example, you 
can use Tracer Summit to change Tracer 100 schedules or override calcu-
lated binaries and analogs.

After you have programmed changes, the next time that you log on to the 
site the programming changes download automatically. If the panel has 
been changed locally, these changes are also uploaded to the database.
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Online and Offline Programming
Replacing an Existing Tracer 100 Site with a Site 

Programmed Offline

Replacing an existing Tracer 100 site is different from the procedure for 
BCUs described in “Replacing an Existing Site with a Site Programmed 
Offline” on page 16. Unlike BCUs, you cannot reset the RAM or memory 
of a Tracer 100 site from the Tracer Summit software. You must reset 
Tracer 100 at the panel itself.

To replace an existing Tracer 100 site with a site programmed 

offline:

◆ Perform the procedure described in “Restoring a Tracer 100 Panel” on 
page 668.

Programming Offline with Global 

Changes
If you have installed the Enterprise Management package, you can per-
form offline changes and apply those changes to multiple sites. Although 
it is generally not recommended that you edit sites when offline, the glo-
bal changes functions have been designed to minimize the risk of offline 
editing. Only certain objects and object properties are available for edit-
ing sites offline using global changes. For a list of these objects and more 
information on making changes to sites and applying them globally, see 
“Making Global Changes” on page 203.
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Chapter 4

Using Referencer Edit 

Controls

Referencer edit control fields (sometimes called referencers) are used 
throughout the Tracer Summit system to allow you to set the value of one 
property equal to the value of another property. They are commonly used 
for setpoints and other types of system information where you may need 
to make one value dependent on another value in the system. 

For example, you may want the chilled water setpoint of a chiller to use 
an analog output object that can be controlled from a graphic (see Chap-
ter 30, “Using the Graphics Editor”).

Referencer edit controls are identified by the mode button located on the 
left side of the field (see Figure 1).

Figure 1. Referencer Edit Control Field

Mode button

Note:

For more information on objects and properties, refer to Chap-
ter 5, “Utilities”.
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Using Referencer Edit Controls
Referencer Edit Control Modes
Referencer edit controls have up to three primary modes through which 
you can toggle by clicking on the mode button (see Figure 1 on page 19). 
The three modes are:

• Constant
• Referencer
• Not Used (if available)

Depending on which mode you choose and the current state of system 
communications, one of these values displays in the referencer edit con-
trol field:

• A constant numerical analog value or binary value (92, 10.5, On/Off, 
Open/Closed, etc.)

• The value of the referenced property
• ??? (referencer failed)
• Not Used (if available)

Referencer edit control modes are described in the following sections.

Constant Mode

This mode allows you to either:

• Input a constant numerical value to control the field for analog fields. 
(The decimal place does not display if an integer is expected.)

• Select a constant value from a pull-down list (On/Off, Enable/Disable) 
if it is a binary or a multi-state field (see Figure 2).

Figure 2. Constant Mode
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Referencer Mode

This mode allows you to reference another system property to control the 
field. Until you have selected a valid property in the referencer mode, the 
referencer edit control field is left blank. Once you have chosen a valid 
property, the property’s value displays in the referencer edit control field. 
You can get to the referencer mode by clicking the mode button until the 
referencer button (...) is available on the right side of the field (see 
Figure 3).

Figure 3. Referencer Mode

To reference a property:

1. Click the mode button in the referencer edit control field to toggle 
through the referencer edit modes until the referencer mode displays 
(see Figure 4).

Figure 4. Mode and Referencer Buttons

2. Click the referencer button. The Select Property Reference dialog box 
displays (see Figure 5).

Figure 5. Select Property Reference Dialog Box

Note:

Tracer Summit retains the selected property reference informa-
tion even when the mode is changed to a constant or to the Not 
Used mode, but the value of the property will come from the 
most recently selected mode. This affects your ability to delete 
the object that contains the referenced property.

Mode button Referencer button

Mode button
Referencer button
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3. Select the object type you would like to reference from the Type drop-
down list.

4. Select the object you would like to reference from the Name drop-
down list. The list contains only objects of the type you have chosen.

5. Select the property that will control the field from the Property list 
box. Only those properties belonging to the particular object you 
chose are available in this box. Depending on the type of field you are 
working with, the system automatically filters property types that 
are not appropriate. For example, if you are in a field that requires an 
analog entry, the dialog box displays with only analog properties to 
choose from. 

6. Click OK when you have made your selections. To exit without saving, 
click Cancel. 

Until you select a property reference, the referencer mode in the ref-
erencer edit control field is left blank. After you choose a valid prop-
erty, the property’s value displays in the referencer edit control field. 

If “???” displays in the referencer edit control field, the referencer has 
failed and the system cannot access the referenced property. 

When a Referencer Fails

If you choose the referencer mode and the system is unable to resolve the 
referenced property, “???” displays in the referencer edit control field. The 
UCM continues to use the last valid value it obtained (see Figure 6).

Figure 6. Failed Referenced Property

Referencers fail when Tracer Summit cannot get the referenced value 
back from the object where the property resides. This occurs when the 
communications between the PC workstation and BCU are down, or 
when you reference a property that is offline.

Not Used Mode

This option is available in a very limited number of fields in Tracer Sum-
mit. If this option is available and selected, Tracer Summit does not send 
a value to the UCM for this field. The UCM will derive the value from an 
algorithm, if appropriate (see Figure 7).

Figure 7. Not Used Mode
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For example, if Not Used is selected for the occupied cooling setpoint in a 
VAV UCM, the system calculates the setpoint by adding the differential 
to the occupied heating setpoint.
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Chapter 5

Utilities

This chapter includes the following sections:

• Viewing the Tracer Summit Electronic Library
• Viewing an object’s properties
• Viewing the system connection status

Viewing the Tracer Summit Electronic 

Library
Tracer Summit software includes an electronic library that contains the 
following reference information:

• Object and property definitions for all UCMs and applications
• Standard graphics for UCMs and applications
• Sample reports
• Sample Custom Programming Language (CPL) files

The electronic library is located on the Tracer Summit Software Installa-
tion CD.
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Utilities
To view the Tracer Summit electronic library:

1. Click the Windows Start button, select Programs, then select Tracer 
Summit. The list of Tracer Summit applications displays.

2. Select Library. The electronic library displays in Internet Explorer 
(see Figure 8).

Figure 8. Viewing the Electronic Library in Internet Explorer

3. Click a selection on the left to view reference information.
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Viewing an Object’s Properties
Viewing an Object’s Properties
Tracer Summit uses objects as the basic elements of the system. Objects 
include input and output points, UCMs, and applications. When you cre-
ate an object, you set up the object’s properties, or characteristic informa-
tion. For diagnostic purposes, you can view this property information 
through the Setup menu’s Objects and Properties command.

You can also view each object’s properties from its applicable editor (for 
example, to view the properties of an analog input, you can access the 
Analog Input editor). However, viewing the properties with the Objects 
and Properties command allows you to view and compare several objects 
at once.

To view an object’s properties:

1. From the Status menu, select Objects and Properties. The Object and 
Properties Selection dialog box displays (see Figure 9).

Figure 9. Object and Properties Selection Dialog Box

2. In the Site field, select the site name.

3. In the Type field, select the object type to be viewed. The Name field 
updates to include object names for the selected type.

4. In the Name field, select the object name.
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5. Select a property from the Properties list. To select multiple proper-
ties:

• For properties listed consecutively, click the first property that 
you want, then hold down the Shift key and click the last property 
that you want.

• For properties not listed consecutively, click the first property 
that you want, then hold down the Ctrl key and click on each 
additional property.

6. Click the Add button to add the selected properties to the Selected 
Properties list.

7. Repeat steps 3-6 for each object’s properties you want to view.

8. To remove any properties, select the properties in the Selected Prop-
erties list, then click the Remove button. You can also click the 
Remove All button to remove all properties from the list.

9. After you have selected the properties you want to view, click OK. The 
Tracer Summit window displays the value of each property you 
selected (see Figure 10).

Figure 10. Example Objects and Properties Display

10. To print the display, from the File menu, select Print. At the Print 
dialog box, click OK.

11. When you are finished viewing the properties, from the File menu, 
select Close Graphic.

Note:

If you have selected and added several properties and then you 
select a different object name (keeping the object type the 
same), those same properties are selected for the new object 
name. You can simply click the Add button to add them to the 
Selected Properties list. This can also be done for different 
object types and site names, allowing a broad variety of infor-
mation to be displayed at one time.

Note:

The objects and properties cannot be edited or saved from the 
display. To edit objects or properties, you must display the 
appropriate editor from the Tracer Summit Setup menu.
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Viewing System Status
You can view Tracer Summit’s system status to determine:

• The connection status of the PC workstation
• Whether the database of the PC workstation has been synchronized 

with (or is the same as) the databases of all BCUs connected to a site 
• How many alarms have not yet been acknowledged for a site

To view system status:

1. Make sure Tracer Summit is displayed on the screen. If it is mini-
mized, click the Tracer Summit button in the Windows task bar.

2. From the Windows task bar, double-click the Tracer Summit System 
Status icon (see Figure 11). The Tracer Summit System Status win-
dow displays (see Figure 12 on page 30).

Figure 11. Tracer Summit System Status Icon

Tracer Summit 
System Status Icon
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Utilities
Figure 12. Tracer Summit System Status Window

The status fields include the following:

• Site Name: Lists defined sites with a connection status.
• Connection Status: Indicates the connection status of the PC worksta-

tion to the site. Table 2 on page 31 describes the connection status 
options.

• Database Sync: Indicates whether the database for the PC worksta-
tion has been synchronized with (or is the same as) the databases of 
all BCUs connected to the site.

• Unacknowledged Alarms: Lists how many alarms requiring acknowl-
edgment have not yet been acknowledged in the event log. (For more 
information, refer to the Tracer Summit Daily Operations guide.)

IMPORTANT
Disconnecting without synchronizing the PC workstation and BCU 

databases may cause an incomplete database, resulting in improper 

system control.

Note:

The only sites that appear in the system status window are 
those sites that the workstation is communicating with or is 
attempting to communicate with.
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Viewing System Status
Table 2. System Connection Status

Connection 
Status

Description

Not Connected There is no connection or pending connection with a 
BCU. 

ARCNET The PC workstation has an active ARCNET connection 
to the site. 

Ethernet The PC workstation has an active Ethernet connection 
to the site. 

BACnet/IP The PC workstation has an active BACnet/IP connection 
to the site. 

EIA-232 The PC workstation has an active EIA-232 connection to 
the site.
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Chapter 6

Configuring Tracer Summit 

BCU Sites

A site defines boundaries for communication and control within the 
Tracer Summit system. A site consists of the BCUs and PC workstations 
assigned to the site, the UCMs attached to the BCUs, and other equip-
ment that communicates with the BCUs.

Tracer Summit supports multiple sites. If you have a single site on the 
system, it automatically becomes the default site and opens when you 
start Tracer Summit. If you have multiple sites,  you can define a default 
site to open at start up.

The Site Configuration editor allows you to:

• Select units of measure (upon initial site configuration only)
• Create, edit, and delete BCUs, PC workstations, and non-Trane BAC-

net devices
• Select a BCU version for downloading (to support existing Tracer 

Summit installations)
• Create UCMs and assign them to BCUs
• Define billing periods
• Define security class names for the site
• Set up event routing
• Set up control priorities
• Set time and date options
• Synchronize time and date for all devices
• Configure communication settings to define PC workstation connec-

tions to BCU
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Creating a Site
Tracer Summit’s Site Creation/Connection Wizard allows you to create 
and configure a site entirely from your PC workstation. You can also 
upload. restore, or copy an existing site with a LAN (BACnet/IP, Ether-
net, or ARCNET), modem, or direct connection.

As a part of the site creation process, the Site Creation Wizard automati-
cally takes you to the Site Configuration editor, where you finish configur-
ing your site.

This section covers:

• Creating a site
• Uploading a site
• Restoring a site
• Copying a site

Creating a New Site

1. From the Setup menu, select Site Configuration. The Select Site dia-
log box displays (see Figure 13).

Figure 13. Select Site Dialog Box
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Creating a Site
2. Click New. The Site Creation Wizard dialog box displays (see 
Figure 14). 

Figure 14. Site Creation Wizard Dialog Box

3. Click Create.

4. Enter a name in the Site Name field. Make the name as informative 
as possible. Use a maximum of eight characters.

5. Click Next to display the Site Connection Wizard dialog box (see 
Figure 15).

Figure 15. Site Connection Wizard Dialog Box

Note:

After you save this site configuration, the site name cannot be 
modified in the Site Configuration editor. Use the backup and 
restore functions, to restore the site under a new name (see 
Chapter 38, “Restoring into the Tracer Summit Workstation.”).
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Configuring Tracer Summit BCU Sites
6. Click the type of connection for your site. Only one network connec-
tion type can be defined.

7. Click Next. Depending on the type of connection you selected, a con-
figuration dialog box specific to that connection is displayed. 

Site Connection via dedicated Ethernet or ARCNET

1. From the Site Connection Wizard, select Ethernet or ARCNET as the 
site connection type.

2. Click Next to display the appropriate Ethernet or ARCNET Configu-
ration dialog box (see Figure 16).

Figure 16. Ethernet Configuration Dialog Box

3. Select the Ethernet or ARCNET card to be used for communicating 
with the site.

4. The Open On Startup check box is checked by default. Leave this box 
checked if you want the workstation to communicate to the site via 
Ethernet or ARCNET each time you start Tracer Summit.

5. Click Finish to display the Site Configuration editor.

When you create a new site you must designate units of measure for 
the site, and assign at least one BCU before you can save the new site 
(see “Creating, Editing, and Deleting Devices” on page 57 and “Creat-
ing, Editing, and Deleting PC Workstations” on page 66).

Note:

Tracer Summit menus are unavailable until you save the site 
or cancel the site.
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Creating a Site
Site Connection via BACnet/IP 

1. From the Site Connection Wizard, select BACnet/IP as the site con-
nection type.

2. Click Next to display the BACnet/IP Configuration dialog box (see 
Figure 17).

Figure 17. Site Connection Wizard Dialog Box

3. Click:

• Use Local Connection if your workstation is on an IP subnet that 
has a BCU.

• Use BBMD if your workstation is on a subnet that does not have a 
BCU.

4. Click Next:

• If you selected the Use Local Connection option, the Network 
Adapter Selection dialog box displays (see Figure 18 on page 38 
below).

• If you selected the Use BBMD option, the BBMD Configuration 
dialog box displays (see Figure 19 on page 39).

Note:

This dialog box helps Tracer Summit determine how to connect 
to the site. It allows you to connect to a BCU on a local subnet, 
or connect to a remote part of the facility, or connect to another 
building. The building owner’s information systems (IS) staff 
can tell you if the PC workstation and the BCU are on the same 
subnet.

BACnet broadcast management devices (BBMDs) are used to 
facilitate low level communications. On most sites the BCU 
serves as a BBMD. However, it is possible for other BACnet 
devices, such as, a BACnet IP router to fill this function.
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Network Adapter Selection Dialog Box

The Select Network Adapter field displays the available network adapt-
ers on the workstation that are bound to the TCP/IP protocol (see 
Figure 18). Use one of these adapters to communicate with the site.

Figure 18. Network Adapter Selection Dialog Box 
 

1. Select the network adapter. Note that the IP address shown is the 
address of this Workstation adapter.

2. Type the UDP port number in the Port field. This will typically be 
47808.

3. The Open On Startup check box is checked by default. Leave this box 
checked if you want the workstation to communicate to the site via 
BACnet/IP each time you start Tracer Summit.

4. Click Finish. The Site Configuration editor is displayed. 

When you create a new site you must designate units of measure for 
the site, and assign at least one BCU before you can save the new site 
(see“Creating, Editing, and Deleting Devices” on page 57 and “Creat-
ing, Editing, and Deleting PC Workstations” on page 66).

Note:

Tracer Summit menus are unavailable until you save the site 
or cancel the site.
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Creating a Site
The BBMD Configuration Dialog Box

The BBMD IP address is used to connect to a site (see Figure 19).

Figure 19. BBMD Configuration Dialog Box

1. Type the IP address of the BCU (or other BACnet device acting as a 
BBMD) in the BBMD Address field.

2. Type the UDP port number in the Port field. The other address is pro-
vided by the building owner’s IS staff.

3. The Open On Startup check box is checked by default. Leave this box 
checked if you want the workstation to communicate to the site via 
BACnet/IP each time you start Tracer Summit.

4. Click Finish the Site Configuration editor is displayed.

When you create a new site you must designate units of measure for 
the site, and assign at least one BCU before you can save the new site 
(see “Creating, Editing, and Deleting Devices” on page 57 and “Creat-
ing, Editing, and Deleting PC Workstations” on page 66).

Note:

Tracer Summit menus are unavailable until you save the site 
or cancel the site.
BMTX-SVP01B-EN 39



Configuring Tracer Summit BCU Sites
Site Connection by Modem or Hardwired

1. From the Site Connection Wizard, select Modem or Hardwired as the 
site connection type. Figure 20 shows the Modem option button 
selected.

Figure 20. Site Connection Wizard Dialog Box

2. Click finish. The Site Configuration editor displays.

Uploading a Site via a Dedicated ARCNET or Ethernet 

Connection

1. From the Setup menu, select Site Configuration. The Select Site dia-
log box displays (see Figure 21).

Figure 21. Select Site Dialog Box
40 BMTX-SVP01B-EN



Creating a Site
2. Click New. The Site Creation Wizard dialog box displays (see 
Figure 22).

Figure 22. Site Creation Wizard Dialog Box

3. Click Upload.

4. Click Next to display the Site Connection Wizard dialog box (see 
Figure 23).

Figure 23. Site Connection Wizard Dialog Box

5. Click ARCNET or Ethernet.

6. Click Next to display the ARCNET or Ethernet Configuration dialog 
box (see Figure 24 on page 42).
BMTX-SVP01B-EN 41



Configuring Tracer Summit BCU Sites
Figure 24. ARCNET Configuration Dialog Box

7. Select the ARCNET or Ethernet card to be used for communicating 
with the site.

8. The Open On Startup check box is checked by default. Leave this box 
checked if you want the workstation to communicate to the site via 
ARCNET or Ethernet each time you start Tracer Summit.

9. Click Finish.

10. Once connected, the system checks to see if your user name (the one 
you used to log onto the current site) is defined on the site to be 
uploaded:

• If your user name is not defined on the site to be uploaded, follow 
steps 11–14.

• If your user name is defined on the site to be uploaded, proceed to 
step 15.

11. If your user name is not defined on the site to be uploaded, the Logon 
to Upload Site dialog box displays (see Figure 25). You must log on so 
the system can verify you have the security access to upload the site.

Figure 25. Logon to Upload Site Dialog Box
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Creating a Site
12. In the User Name field, type your user name.

13. Press Tab to place the cursor in the Password field, then type your 
password.

14. Click OK. 

15. The Confirm Upload Site dialog box displays (see Figure 26). Click 
Yes to continue the upload.

Figure 26. Confirm Upload Site Dialog Box

The Upload Status dialog box displays with the current status of the con-
nection and the upload (see Figure 27).

Figure 27. Upload Status Dialog Box

When the upload is complete, you are returned to the Tracer Summit 
main window. The new site is now the active site.
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Uploading a Site via a BACnet/IP Connection

1. From the Setup menu, select Site Configuration. The Select Site dia-
log box displays (see Figure 28).

Figure 28. Select Site Dialog Box

2. Click New. The Site Creation Wizard dialog box displays (see 
Figure 29).

Figure 29. Site Creation Wizard Dialog Box

3. Click Upload.

4. Click Next to display the Site Connection Wizard dialog box (see 
Figure 30 on page 45).
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Figure 30. Site Connection Wizard Dialog Box

5. Click BACnet/IP.

6. Click Next to display the BACnet/IP Configuration dialog box (see 
Figure 31).

Figure 31. BACnet/IP Configuration Dialog Box

7. Click:

• Use Local Connection if your workstation is on an IP subnet that 
has a BCU.

• Click Use BBMD if your workstation is on a subnet that does not 
have a BCU.
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8. Click Next:

• If you selected the Use Local Connection option, the Network 
Adapter box displays (see Figure 32). 

• If you selected the Use BBMD option, the BBMD Configuration 
dialog box displays (see Figure 35 on page 48).

Network Adapter Selection Dialog Box

The Network Adapter field displays the available network adapters on 
the workstation bound to the TCP/IP protocol (see Figure 32). Use one of 
these adapters to communicate with the site.

Figure 32. Network Adapter Selection Dialog Box 

1. Select the network adapter.

2. Type the UDP port number in the Port field. This will typically be 
47808.

Note:

This dialog box helps Tracer Summit determine how to connect 
to the site. It allows you to connect to a BCU on a local subnet, 
or connect to a remote part of the facility, or connect to another 
building. The building owner’s information systems (IS) staff 
can tell you if the PC workstation and the BCU are on the same 
subnet.

BACnet broadcast management devices (BBMDs) are used to 
facilitate low level communications. On most sites the BCU 
serves as a BBMD. However, it is possible for other BACnet 
devices, such as, a BACnet IP router to fill this function.
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Creating a Site
3. The Open on Startup check box is checked by default. Leave this box 
checked if you want the workstation to communicate to the site via 
BACnet/IP each time you start Tracer Summit.

4. Click Finish.

5. The Confirm Upload Site dialog box displays (see Figure 33). Click 
Yes to continue the upload.

Figure 33. Confirm Upload Site Dialog Box

The Upload Status dialog box displays with the current status of the con-
nection and the upload (see Figure 34).

Figure 34. Upload Status Dialog Box

When the upload is complete, you are returned to the Tracer Summit 
main window. The new site is now the active site.

Note:

The system checks to see if your user name (the one you used to 
log onto the current site) is defined on the site you are trying to 
upload.
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The BBMD Configuration Dialog Box

The BBMD IP address is used to communicate with the site (see 
Figure 35).

Figure 35. BBMD Configuration Dialog Box

1. Type the IP address of the BCU (or other BACnet device acting as a 
BBMD) in the BBMD Address field.

2. Type the UDP port number in the Port field. The other address is pro-
vided by the building owner’s IS staff.

3. The Open on Startup check box is checked by default. Leave this box 
checked if you want the workstation to communicate to the site via 
BACnet/IP each time you start Tracer Summit.

4. Click Finish. Tracer Summit begins to upload the site (refer to steps 
four and five of the IP Address Configuration Dialog Box section). 
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Uploading a Site via Modem/Direct Connect

1. From the Setup menu, select Site Configuration. The Select Site dia-
log box displays (see Figure 36).

Figure 36. Select Site Dialog Box

2. Click New. The Site Creation Wizard dialog box displays (see 
Figure 37).

Figure 37. Site Creation Wizard Dialog Box

3. Click Upload.

4. Click Next to display the Site Connection Wizard dialog box (see 
Figure 38 on page 50).
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Figure 38. Site Connection Wizard Dialog Box

5. Click Modem, then click Finish:

• For a new system with no sites configured, you will need to add a 
PC workstation modem to Tracer Summit. Proceed to step 6.

• If your site already has a modem, proceed to step 8.
6. At the Modem Configuration dialog box, type the modem name in the 

Workstation Modem Name field (see Figure 39). 

7. In the Connect By field, click down arrow to select the modem type. 
Selecting the modem type should fill in the rest of the information, 
except for the modem name.

Figure 39. Modem Configuration
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8. Click OK. The Connection Manager dialog box displays (see 
Figure 40).

Figure 40. Connection Manager Dialog Box

9. In the Connect Using field, select a modem or port to use.

10. In the Phone Number field, select the telephone number for the 
remote connection.

11. If there is no phone number, add one in the Phone Book. Click the 
Phone Book button to display the Phone Book dialog box (see 
Figure 41 on page 52). 

Note:

If there is a modem that is being used for another site, click 
Current Connections. At the Current Connections dialog box, 
select the site currently using the modem/port and click Discon-
nect. When the site has disconnected, click OK to return to the 
Connection Manager.
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Figure 41. Phone Book Dialog Box

12. Click the Add Phone Number button to display the Add Phone Num-
bers dialog box (see Figure 42).

Figure 42. Add Phone Numbers

13. Enter a phone number in the Phone Number field and select the Use 
Dialing Prefix or Use Calling Card # check box as necessary. 

14. Click OK to close the Add Phone Numbers dialog box, then click OK 
to return to the Connection Manager dialog box.

15. In the Connection Manager dialog box, click OK. The system dials 
and connects to the site.

16. The Confirm Upload Site dialog box displays (see Figure 43 on 
page 53). 

17. Click Yes to continue the upload.

Note:

The system checks to see if your user name (the one you used to 
log onto the current site) is defined on the site you are trying to 
be upload.
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Figure 43. Confirm Upload Site Dialog Box

The Upload Status dialog box displays with the current status of the con-
nection and the upload (see Figure 44).

Figure 44. Upload Status Dialog Box

When the upload is complete, you are returned to the Tracer Summit 
main window. The new site is now the active site.

Restoring a Site from the Site Creation Wizard

Select the Restore button when you want to restore a site, instead of cre-
ating or uploading one (see Figure 45). This option is only available when 
the Tracer Summit database has no sites in it.

◆ From the Site Creation Wizard, click Restore, then click Finish. The 
Restore Location dialog box displays. (For instructions on how to 
restore a site, see Chapter 38, “Restoring into the Tracer Summit 
Workstation.”) 

Figure 45. Site Creation Wizard Dialog Box
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Copying a Site

Copy Site helps you create sites that are similar or identical to each other. 
If you have a large number of sites, Copy Site can eliminate much of the 
repetitive work that goes into configuring sites that have more similari-
ties than differences.

Copy Site is available with all Version 13 packages (Tracer 100/Tracker 
Communication, Building Management, and Enterprise Management).

Copy Site reproduces objects from an original BCU site and transfers 
them to a new site of the same type. Copy Site functions like the Restore 
function (see “Restoring a Site and CPL Files” on page 643), except that 
with Copy Site you can copy BCU graphic objects and report objects to a 
new site.

Copy Site does not copy workstation or global objects from the original 
site. This means that the new site will have the same information as the 
original from which it was copied but not the following items:

• Workstation modem objects
• Message forwarding objects
• Global graphics
• Sample values in calculation objects (samples are cleared in the new 

objects)
• Sample values in trend objects (samples are cleared in the new 

objects)
• CPL text files
• Report text files (*.rpt files)
• User-defined standard live reports

Copying a Tracer Summit BCU Site

1. From the Tools menu, select Copy Site. The Copy Site dialog box 
appears (see Figure 46 on page 55).

2. Type the name of the new site in the Name of New Site field.

The new site name must be unique, one that does not exist in the 
database.

3. Select BCU from the Site Type to Copy list.

4. Click Site to Copy. The list displays the name of all the BCU sites in 
the database.

5. Select whether or not to copy graphics and report files:

• If you want to copy graphics and reports from the original site, 
click OK. The default is to copy these objects, so Copy Graphics 
and Copy Reports are already selected.

• If you do not want to copy graphics and reports, click to clear the 
Copy Graphics and Copy Reports check boxes and click OK.
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Figure 46. Copy Site Dialog Box

Tracer Summit copies the information that you selected from the orig-
inal site. The new BCU site node appears in the navigation tree.

Selecting a Site to Configure
If your Tracer Summit system has a single site, it is the default site and 
will open when you start Tracer Summit. If you have multiple sites, you 
can select the site to open at log on. When you select Site Configuration 
from the Setup menu, the current site is highlighted in the Select Site 
dialog box. 

To select a site:

1. From the Setup menu, select Site Configuration. The Select Site dia-
log box displays (see Figure 47).

Figure 47. Select Site Dialog Box

2. Click the site you wish to edit.

3. Click OK to display the Site Configuration editor for the selected site 
(see “Configuring a Site” on page 56).
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Configuring a Site
To configure a new site on your PC workstation or to modify parameters 
of an existing site, follow the steps in this section.

Selecting Units of Measure

1. When creating a new site, the Units screen is automatically displayed 
after completing the Site Connection Wizard (see Figure 48).

Figure 48. Site Configuration Editor Units Screen

2. In the Setup Options field, select the units of measure for the site.

3. If you select Customize from I-P or Customize from SI, click the first 
item in the Physical Quantity list that you wish to customize. A choice 
of units for that item is displayed in the Units list.

4. Click the desired unit in the Units field.

5. Repeat steps 3 and 4 for each item in the Physical Quantity field you 
wish to customize.

6. Follow the instruction in the section “Creating, Editing, and Deleting 
Devices” to add a BCU and a PC workstation to the new site before 
you can save it.

Note:

When you create a new site, the Site Configuration editor opens 
with the Units screen active. You can select units of measure 
only when you are creating a new site. Once the site is saved, 
the Units screen becomes status only.
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Creating, Editing, and Deleting Devices
When creating a new site you must create at least one device before you 
can save the site. Once a device is created, you can edit or delete the 
device.

Creating a Device

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 49).

Figure 49. Site Configuration Editor Devices Screen

2. Click the Create Device button to display the Create New Device dia-
log box (see Figure 50 on page 58). 
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Figure 50. Create New Device Dialog Box

3. Type a name in the Device Name field. Make the name as informative 
as possible. Use a maximum of 32 characters.

4. Select a device number in the Device ID field.

▲IMPORTANT
Once you save the site configuration the Device ID field is fixed and you 

cannot change it. Additionally, once you save the site configuration you 

can not delete the Device in site configuration. Use the Delete Object 

function from the Tools menu.

5. Leave the network number at the default value of 1.

Note:

Tracer Summit provides a default device ID. The first BCU cre-
ated is ID 1. Each additional BCU is given the next available 
ID. To change the suggested ID, type a new ID number in the 
field.

Note:

The network number for the device is edited only when there 
are multiple networks on a site, typically on a BACnet job with 
non-Trane equipment. Contact Trane GCC Product Support for 
details.
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6. From the Panel Type list box, select a device type: Enhanced BCU 
(BMTX), Modular BCU (BMTW) or BCU (BMTS).

• For the BMTW, select capacity cards; 1 for standard and 2 for 
high.

• For the BMTX the communication links are fixed, for example, 
the comm5 link can only be set up as comm5 or Undefined (not 
used), it can not be changed to comm4 or comm3 (see Figure 51).

7. For the standard capacity BMTW, if you select Comm5 as a communi-
cation link, two Comm5 mode options become available: Install a new 
link and Add to or discover existing link.

• Select Install new link to enable the auto-install mode to commis-
sion Comm5 devices. In this mode, the BCU discovers Comm5 
devices. Select this option if you know that a service tool (Rover, 
for example) has not been used to bind devices (custom bindings) 
together. This option is faster than the Add to or discover existing 
link option.

• Select Add to or discover existing link for existing Comm5 or Lon-
Talk networks. Initial installation takes longer with this option. 
However, all existing (custom) bindings and link information are 
preserved.

Figure 51. BMTX Communication Links

IMPORTANT
Selecting the Install new link option for a network that has existing 

device bindings will result in removing those device bindings.

Adding device options: Modem, I/O Module, Operator 

Display, BCU Event log
BMTX-SVP01B-EN 59



Configuring Tracer Summit BCU Sites
Adding a BCU Modem 

1. If the device has a modem, click Add button in the Modem box to dis-
play the Create New Modem dialog box (see Figure 52 on page 60). 
For the BMTW or BMTS only, if the BCU will use an EIA-232 BACnet 
connection, you must add a BCU modem, which will later be config-
ured as hardwired. Note that for a BMTW or BMTS, the BCU may 
not have both a modem and an EIA-232 BACnet connection.

Figure 52. Create New Modem Dialog Box

2. Type a name in the Modem Name field. Make the name as informa-
tive as possible. Use a maximum of 32 characters.

3. To change the default security access for the modem, click Security 
Classes (see “Setting Security Access for Objects in a Site” on 
page 90). 

4. Click OK to close the Modem dialog box. 

Adding a BCU I/O Module object

◆ Refer to Chapter 18, “BCU Inputs and Outputs.”

Adding an Operator Display object

◆ Refer to Chapter 34, “The BCU Operator Display.”

Adding a BCU Event Log object

The BCU Event Log stores up to 5,000 events in the BCU. Add a BCU 
event log object to: 

• Dial up a BCU remotely to view alarms and events (refer to Tracer 
Summit Daily Operations guide, “Viewing the BCU Event Log”)

• View alarms and events at the BCU operator display.

To Add a BCU Event Log

1. Click the Add button in the BCU Event Log box. The BCU Event Log 
dialog box displays (see Figure 53 on page 61).

Note:

To view alarms and events at the operator display, you must 
save the BCU event log object to the same device as the opera-
tor display object. 
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Figure 53. BCU Event Log Dialog Box

2. Type a name in the event log name field. Make the name as informa-
tive as possible. Use a maximum of 32 characters.

3. To change the default security access for the BCU Event Log, click 
Security Classes (see “Setting Security Access for Objects in a Site” on 
page 90). 

4. Click OK to close the BCU Event Log dialog box and to return to the 
Create Devices dialog box.

5. From the Events Routing tab, set up event receiver routing for the 
newly created event log object. Alarms in the event log object show up 
in the newly created operator display (see “Setting Up Event Classes” 
on page 81).

Editing a BCU

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 54 on page 62).

Note:

The BCU Event Log object is not created until you click Save on 
the Devices screen.
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Figure 54. Site Configuration Editor Devices Screen

2. Click the name of the device you wish to edit in the Devices list.

3. Click Edit Device to display the Edit Device dialog box (see Figure 55 
on page 63).
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Figure 55. Edit Device Dialog Box

4. Modify the Device name, the network number, or the communication 
links, as desired. The Device ID cannot be changed at this point (after 
the device configuration has been saved).

5. If you select Comm5 as a communication link, two Comm5 mode 
options become available (standard capacity BMTW only): 

• Select Add to or discover existing link to have the BCU discover all 
Comm5 devices on the link, along with their custom bindings the next 
time RAM is cleared in the BCU. 

Note:

Once you add a UCM on a selected communication link on the 
BMTW, the link designation cannot be changed: You cannot 
modify the link when it is in use. To change the link type, you 
must first delete all UCMs on the link. On the BMTX BCU each 
of the links is predefined and can’t be changed except to set it 
“Undefined” (not used).

Note:

Select this option to preserve any custom bindings.
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• Select Install a new link to have the BCU discover all Comm5 devices 
on the link but to ignore their custom bindings the next time RAM is 
cleared in the BCU. 

IMPORTANT
Selecting the Install new link option for a network that has existing 

device bindings (custom bindings) will result in removing those device 

bindings.

6. In the Modem group, click the Add button to display the Create New 
Modem dialog box (see Figure 56).

7. If a modem was previously added to the device, the Add button 
becomes unavailable, and the Edit button is now available. Click the 
Edit button to display the Edit Modem dialog box. (See Figure 56.)

Figure 56. Create New Modem and Edit Modem Dialog Boxes

8. To modify the modem name, type a new name in the Modem Name 
field. 

9. Click OK to display the Edit Device dialog box.

10. To delete the modem, click Delete.

11. Add or Edit the BCU I/O Module, the Operator Display or the BCU 
Event Log by the same procedure described above for the Modem.

12. To modify the security classes for the Device, click Security Classes 
(see “Changing Security Access for Objects in a Site” on page 17).

13. Click OK to close the Edit Device dialog box and display the Devices 
screen.

Note:

• Select this option if you know that there are no custom 
bindings on the link, or if you wish to remove all of the cus-
tom bindings on the link.
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Deleting a Device

To delete a Device during Site Configuration:

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 57).

Figure 57. Site Configuration Editor Devices Screen

2. Click the name of the device in the Devices list that you wish to 
delete.

3. If the Device has not yet been saved and no UCMs have been created, 
the Delete button will be highlighted, Click Delete Device.

Note:

If the device has been saved in site configuration, you cannot 
delete the device from the Site Configuration editor (the Delete 
Device button is unavailable). Instead, use the Delete Object 
utility from the Tools menu to delete a Device (see Chapter 39, 
“Deleting Objects and Sites.”).

Note:

Once the device has been saved it can only be deleted using the 
Delete Object function from the Tools menu.
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Creating, Editing, and Deleting PC Workstations

Creating a PC Workstation

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 58).

Figure 58. Site Configuration Editor Devices Screen

2. Click Create Workstation to display the Create New Workstation dia-
log box (see Figure 59). 

Figure 59. Create New Workstation Dialog Box

3. Type a name in the Workstation Name field. 
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4. Select a device number in the Workstation Device ID field. Once you 
save the site configuration, the Workstation Device ID field becomes 
status only and you cannot change it.

5. To change the default security classes settings for the workstation, 
click Security Classes (see “Setting Security Access for Objects in a 
Site” on page 90).

6. Click OK to close the Create New Workstation dialog box and display 
the Devices screen. The name of the workstation you just created 
appears in the Workstations list.

Editing a PC Workstation

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 60).

Figure 60. Site Configuration Editor Devices Screen

Note:

Tracer Summit provides a default Workstation Device ID based 
on the number assigned during the software installation. Gen-
erally, the first workstation created is ID 80. Each additional 
workstation number is increased in increments of one. To 
change the default ID, enter a new ID number in the field.

Typical workstation addressing is as follows:

• 80 – 100 for on-site workstations
• 101 – 120 for remote workstations
• 121 – 140 Trane-reserved addressing
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2. Click the name of the workstation you wish to edit in the Worksta-
tions list.

3. Click Edit Workstation to display the Edit Workstation dialog box 
(see Figure 61).

Figure 61. Edit Workstation Dialog Box

4. Modify the workstation name, if desired.

5. To modify the security classes, click Security Classes (see “Setting 
Security Access for Objects in a Site” on page 90).

6. Click OK to close the Edit Workstation dialog box and display the 
Devices screen.

Deleting a PC Workstation

To Delete a PC Workstation during Site Configuration:

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 62 on page 69).

Note:

If the workstation has been saved in site configuration, you 
cannot delete the workstation from the Site Configuration edi-
tor (the Delete Workstation button is unavailable). Instead, use 
the Delete Object utility from the Tools menu to delete a Device 
(see Chapter 39, “Deleting Objects and Sites.”).
68 BMTX-SVP01B-EN



Creating, Editing, and Deleting Devices
Figure 62. Site Configuration Editor Devices Screen

2. Click the name of the workstation in the Workstations list that you 
want to delete.

3. Click the Delete Workstation button.

Creating, Editing, and Deleting Non-Trane BACnet 

Devices

Tracer Summit has the ability to communicate with non-Trane devices 
using standard BACnet protocols. When the non-Trane device is operat-
ing in a client application (providing data to Tracer Summit), you must 
create the device in the Site Configuration editor (see Chapter 37, “Using 
BACnet for Non-Trane Devices.”).
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Creating a Non-Trane BACnet Device

1. From the Site Configuration editor, click the Devices tab to display 
the Devices screen (see Figure 63).

Figure 63. Site Configuration Editor Devices Screen

2. Click Create Non-Trane BACnet Device to display the Create New 
Non-Trane BACnet Device dialog box (see Figure 64). 

Figure 64. Create New Non-Trane BACnet Device Dialog Box

3. Type the name and the device ID for the BACnet device.

Note:

The device ID is provided by the device manufacturer. Each 
device on a network must have a unique device ID. Contact the 
manufacturer for instructions, if necessary.
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4. Select the object type from the Object Types field. The default selec-
tion is All Types.

5. Click the Scan button to display a list of all the available objects in 
the non-Trane device. 

6. From the Available Objects list, select the objects that you want to 
view. Then, click the Add button to add the items to the Selected 
Objects list.

7. Click Okay to save the changes and return to the Devices tab.

8. Click the Communications tab and check the Disable Automatic 
Updates box (see Figure 65).

Figure 65. Disable Automatic Update

Editing a Non-Trane BACnet Device

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 66).

Figure 66. Site Configuration Editor Devices Screen

2. Click the name of the non-Trane BACnet device you wish to edit in 
the Non-Trane BACnet Devices box.

3. Click Edit Non-Trane BACnet Device to display the Edit Non-Trane 
BACnet Device dialog box (see Figure 67 on page 72).
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Figure 67. Edit Non-Trane BACnet Device Dialog Box

4. Modify the name and object type. Or, manually add new objects, if 
desired.

5. Click OK to close the Edit Non-Trane BACnet Device dialog box and 
display the Devices screen.

Deleting a Non-Trane BACnet Device

Note:

If the non-Trane BACnet device has been saved in site configu-
ration, you cannot delete the device from the Site Configuration 
editor (the Delete Non-Trane BACnet Device button is unavail-
able). Instead, use the Delete Object utility from the Tools 
menu to delete the device (see Chapter 39, “Deleting Objects 
and Sites.”).
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To delete a non-Trane BACnet device during Site Configuration:

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 68).

Figure 68. Site Configuration Editor Devices Screen

2. Click the name of the non-Trane BACnet device in the Non-Trane 
BACnet Devices list that you wish to delete.

3. Click the Delete Non-Trane BACnet Device button.
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Creating and Deleting UCMs

After you create a device, create the UCMs you wish to assign to the 
device. You can create multiple UCMs of a particular type simultaneously. 
To modify a UCM after you create it, use the UCM editor to change the 
settings.

Creating UCMs

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 69).

Figure 69. Site Configuration Editor Devices Screen

2. Click the name of the device in the Devices list to which you wish to 
assign UCMs.

3. Click Create UCM to display the Create UCMs dialog box for the 
selected device (see Figure 70 on page 75). 

Note:

The UCMs in Selected Device list can be sorted alphabetically 
by each column. To sort the list, click the column header.

Note:

Tracer Summit communication links and devices have a limit 
to the number of UCMs they can support. Tracer Summit 
checks the number of UCMs per link and per device and allows 
you to enter only the appropriate number of UCMs.
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Figure 70. Create UCMs Dialog Box

4. In the BCU Link field, click the type of communication link the UCMs 
will use.

5. Click the arrow to the right of the UCM Type field to select from a list 
of available UCM types for the particular communication link 
selected in the BCU Link field.

6. Type a name in the UCM Address Name field.

7. Click the arrow to the right of the Address field to select an address 
for the UCM from the list of available addresses. If you are creating 
multiple UCMs, the address you select will be the first address 

Note:

The BCU Link field displays the names of the links you defined 
in the BCU setup. To add a new communication link, see “Edit-
ing a BCU” on page 61.

Note:

If you are creating multiple UCMs, Tracer Summit will use the 
name you enter as the base name followed by numbers for the 
communication link and the address. For example if you enter 
Rooftop Unit as the name for three UCMs on Link 1, the system 
would name the units Rooftop Unit-01-033, Rooftop Unit-01-
034, and Rooftop Unit-01-035.
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assigned. The address for each additional UCM will increase in incre-
ments of one.

8. Enter the number of UCMs of the particular type that you wish to 
create in the Number to Create field.

9. To modify the security access to the UCMs, click Security Classes (see 
“Setting Security Access for Objects in a Site” on page 90).

10. Click Create to create the UCMs. The Create UCM dialog box closes 
and the Devices screen displays. The name of the new UCMs appear 
in the UCMs in Selected Device list.

Deleting a UCM

To delete a UCM during Site Configuration:

1. Click the Devices tab from the Site Configuration editor to display the 
Devices screen (see Figure 71 on page 76).

Figure 71. Site Configuration Editor Devices Screen

Note:

If you have created the UCM but have not saved it in site con-
figuration, clicking Delete UCM clears the UCM from the site.

If the UCM has been saved in the site, you cannot delete the 
UCM in the Site Configuration editor. Instead, use the Delete 
Object utility in the Tools menu to delete the UCM. (See Chap-
ter 39, “Deleting Objects and Sites.”)
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2. Click the name of the UCM in the UCMs in Selected Device list that 
you wish to delete.

3. Click the Delete UCM button.

Configuring Communication Settings

The Communications editor allows you to configure a site’s connection 
type after a site has been created. If the No Connection option was 
selected during site creation or an incorrect connection type was defined, 
use this editor to define the appropriate site connection type.

To Configure a Connection Type:

1. Click the Communications tab from the Site Configuration editor to 
display the Communications screen (see Figure 72). 

Figure 72. Communications Screen

2. Click the Configure button to display the Connection Wizard dialog 
box (see Figure 73).

Figure 73. Site Connection Wizard Dialog Box

3. To change connection type, follow the instructions for connecting to 
the following sites:

• “Site Connection via dedicated Ethernet or ARCNET” on page 36
• “Site Connection via BACnet/IP” on page 37
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• “Site Connection by Modem or Hardwired” on page 40

4. After you are finished defining the connection for the site, Tracer 
Summit returns you to the Communications screen, where current 
network settings are displayed in the Current Communications Set-
tings fields.

Selecting the BCU Version to Download

Tracer Summit stores several versions of BCU software code on the PC 
workstation. When a BCU is connected to a workstation and requests 
code, the workstation sends the code to the BCU based on the version 
selected in site configuration.

To select the BCU version:

1. Click the Setup tab from the Site Configuration editor to display the 
Setup screen (see Figure 74).

Figure 74. Site Configuration Editor Setup Screen

Note:

BMTX does not support ARCNET communications.
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2. Click the arrow to the right of the Enhanced BCU (BMTX) Version 
field or the Modular BCU (BMTW) Version field to select the version 
for downloading. 

Defining Billing Periods

Tracer Summit allows you to define billing period names and switches for 
calculation objects. For example, calculations for power consumption, 
water consumption, and gas consumption are tied to the utility company’s 
billing signal so that the Tracer Summit calculations are reset simulta-
neously as the utility company’s.

To define the billing period:

1. Click the Setup tab from the Site Configuration editor to display the 
Setup screen (see Figure 75).

Figure 75. Site Configuration Editor Setup Screen

2. Type the name for the first end of billing switch in the End of Billing 
1 name field.

Note:

On sites containing a mix of different model BCUs:

• BMTS BCUs must be at image 6.11
• BMTW BCUs (when mixed with BMTX BCUs) must be at 

Version 16.00 or higher.
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3. Select a referencer in the Switch field. For detailed information on 
referencing a property, see Chapter 4, “Using Referencer Edit Con-
trols.”

4. Repeat steps 2 and 3 for End of Billing 2 and End of Billing 3, if 
desired.

Defining Security Class Names

You define names for the security classes used throughout the site in the 
Site Configuration editor. The security classes allow you to control which 
operators have access on an object-by-object basis. Each user’s level of 
access is set in Site Security editor. See Chapter 9, “Setting Up Security—
Tracer Summit System.” 

To define security class names:

1. Click the Setup tab from the Site Configuration editor to display the 
Setup screen (see Figure 76).

Figure 76. Site Configuration Editor Setup Screen

2. Type the name for the first class in the Class 1 field.

3. Repeat the previous step for each class you wish to name. 
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Setting Up Event Classes

The Event Classes page lets you set up alarming options for each event 
class.

You can specify the following for each event class:

• Workstation beeps when an event is received.
• Operator acknowledges that an event message has been received.
• Forward an event to a different event class
• Attach expanded messages to specific event classes.
• Associate an event class with an alarm category.

Table 3 describes predefined event classes and shows recommended noti-
fications.

Table 3. Predefined Event Classes and Recommended Notifications

Event Class Event and Alarm Types
Audible 

Beep
Acknowledgment 

Required

System Print None No No

System Log Power Failure, Operator Log On/Off, UCM Diagnostic 
Alarm*, UCM Diagnostic Alarm Restore*

No No

System Alarm UCM Communication Failure*, UCM 
Communication Restore*

Yes No

System Critical 
Alarm

BCU Communication Failure, BCU Communication 
Restore, Watchdog Time-Out

Yes Yes

Comm5 NVM File Corrupted Yes Yes

BACnet Comm5 Database Mismatch Yes Yes

* If the alarm class is set to “No Notification” in the UCM editor.
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Example of User-Defined Event Classes

Figure 77 shows an example of user-defined event classes. Class 5 is 
named Pager Alarm, and Class 7 is named Event Alarm Class. When an 
event using the MOBILE ALARMS Class 6 is received, the system beeps 
and requires acknowledgment within 30 minutes or the alarm is re-
routed to the Pager Alarm class. The PC workstation receives all events.

Figure 77. Example of User-Defined Event Classes

To set up event classes:

1. Click the Event Classes tab from the Site Configuration editor to dis-
play the Event Classes screen (see Figure 77).

2. Click the Event Classes field to Select the field. 

3. Enter a label for the class in the Event Class field.

4. To make the receivers beep when an event of that class is received, 
click the Beep check box.

5. To require acknowledgment of event messages, click the Ack Reqd 
check box.

6. To set the delay before an event is forwarded if it is not acknowledged, 
change the value in the Delay Minutes field to increase or decrease 
the delay.

7. Click the Forward To Event field to display an arrow to the right of 
the field. (See Figure 77.)

8. Click the selection arrow to display a list of event classes.

9. Select an event class from the list to forward the event message to.

10. To assign an expanded message, click in the field to display an arrow 
to the right of the field.

11. Click the selection arrow to display a selection of expanded messages.

Note:

Labels for event classes one through four are pre-defined and 
cannot be altered.
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12. Select an expanded message for the event class.

13. To assign an alarm category, click in the field to display an arrow to 
the right of the field.

14. Click the selection arrow to display a list of category alarms.

15. Select a category for the event class.

16. Click Save.

Setting Up Event Receivers

From the Event Receiver screen, you can set up event routing for event 
classes (see Figure 78). Event messages are generated at the BCU and 
sent to every workstation, cell phone/pager, BCU event log, or Non-Trane 
BACnet device defined in the site. 

Figure 78. Event Receiver Screen

Note:

The analog input and binary input allow an expanded message 
to be associated with their event class. That setup takes prior-
ity over this setting.

Note:

You can assign categories (1–5) based on level of importance of 
the alarms, work shifts, individuals, or whatever you want (see 
Figure 77).
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Non-Trane BACnet Devices

When a non-Trane BACnet device is selected as the active event receiver, 
the Process ID column displays (see Figure 79). 

◆ Type the process ID for the BACnet device.

Figure 79. Process ID Column

Note:

The process ID that you enter here must agree with the process 
ID determined for the BACnet device.
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To set up event routing for event receivers:

1. Click the Event Receivers tab from the Site Configuration editor to 
display the Event Receiver screen.

2. Click the selection arrow to the right of the Event Receiver field to 
select an event receiver (see Figure 80). 

3. Click in an Event Class field to select the field. 

4. Click in the Receive Events field to display an arrow to the right of 
the field.

5. Click Always, True, or False for each class to select the conditions 
under which an event message is sent.

6. Click the arrow to the right of the Event Receiver Switch field to 
select True or False, or enter a referencer. 

7. Repeat for all event receivers.

8. Click Save.

Figure 80. Event Receiver Switch

Note:

Every workstation, cell phone/pager, and BCU local event log 
defined in the site appears in the Event Receiver list. 

Note:

For information about referencers, See Chapter 4, “Using Refer-
encer Edit Controls.”
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Setting Up Control Priorities

Control priorities identify the levels at which Tracer Summit applications 
control an object. Normally, control priorities are set to the Tracer Sum-
mit defaults. For information on setting up control priorities for non-
Trane BACnet devices, see Chapter 37, “Using BACnet for Non-Trane 
Devices.”

Setting the Time and Date for the Site

The time and date options in the Site Configuration editor allow you to:

• Set the workstation time
• Synchronize all devices on the site to the workstation time
• Synchronize all devices on the site to another device
• Automate daylight savings start and stop in the BCUs

Setting the Workstation Time and Zone

1. Click the Date/Time tab from the Site Configuration editor to display 
the Date/Time screen (see Figure 81).

Figure 81. Site Configuration Editor Date/Time Screen

2. Click Adjust Date/Time to display the Date/Time Properties dialog 
box (see Figure 82 on page 87). The Date & Time tab displays.
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Figure 82. Date/Time Properties Dialog Box

3. Click the arrow to the right of the month field to select the month.

4. Click the arrows to the right of the year field to select the year.

5. Click the date in the calendar.

6. To set the time, click the hour, minute, or second field and then click 
the arrows up or down to adjust the time.

7. To set the time zone, click the Time Zone tab to display the Time Zone 
screen (see Figure 83).

Figure 83. Time Zone Screen

8. Click the arrow to the right of the time zone field to select the correct 
time zone. 

9. To change the default setting, click the Automatically Adjust Clock 
for Daylight Saving Changes box.

10. Click OK to close the Date/Time Properties dialog box and display the 
Date/Time screen.
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Setting Site Daylight Savings/Standard Time

1. Click the Date/Time tab from the Site Configuration editor to display 
the Date/Time screen (see Figure 84).

Figure 84. Site Configuration Editor Date/Time Screen

2. Click the Configure button to display the Site Daylight Savings Time 
dialog box (see Figure 85).

Figure 85. Site Daylight Savings Time Dialog Box

3. If the Site Daylight Savings Time fields are unavailable, click the 
Enable Daylight Savings Time check box to enable the fields.

4. In the Daylight Savings Time Start fields, click the week of the month 
and the day of the week on which you want daylight savings time to 
start.

5. Click the arrow to the right of the Month field to select the month in 
which you want daylight savings time to start.

6. In the Standard Time Start fields, click the week of the month and 
the day of the week on which you want daylight savings time to end.
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7. Click the arrow to the right of the Month field to select the month in 
which you want daylight savings time to end.

Setting Device Time Synchronization

Tracer Summit automatically synchronizes the time on all devices from a 
master device at 2 a.m. each day. Typically, a BCU is chosen as the master 
device because a PC workstation may be turned off from time to time. You 
can also force synchronization of time to a PC workstation by using the 
Synchronize Now button at the Site Configuration editor’s Date/Time 
screen.

To set device time synchronization:

1. Click the Date/Time tab from the Site Configuration editor to display 
the Date/Time screen (see Figure 86).

Figure 86. Site Configuration Editor Date/Time Screen

2. To automatically align the time of all BCUs on the site with a particu-
lar device, click the Automatic Time Synchronization Enabled check 
box.

3. Click the arrow to the right of the Time Synchronization Device field 
to select a device to which you want to synchronize all other units. 
The current time on this device will be used for synchronization when 
you select Automatic Time Synchronization Enabled.

4. To synchronize devices immediately, click Synchronize Now to set all 
times on the BCUs on the site (if they are communicating) to the 
workstation time. A dialog box displays showing devices that have 
been synchronized (see Figure 87 on page 90).

Note:

Only the BCU selected as the time synchronization device 
should implement Daylight Savings Time adjustment.
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Figure 87. Synchronization Status Dialog Box.

Setting Security Access for Objects in a Site

The default security access for any object allows access for all classes. You 
can change the default security access settings for any object you create 
in a site. To change access, click the Security Classes button from the dia-
log box of the object for which you want to change access. For a complete 
discussion of security classes, see Chapter 9, “Setting Up Security—
Tracer Summit System.”

To change security class access to an object:

1. Click Security Classes from the dialog box for the object you wish to 
modify to display the Change Security Classes dialog box (see 
Figure 88).

Figure 88. Change Security Classes Dialog Box

Note:

Automatic time synchronization is conducted in the early morn-
ing each day. If you want to force synchronization immediately, 
click the Synchronize Now button. This process will not, how-
ever, set the time of other workstations on the site. You must 
set the time for the workstation individually. 
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2. Click the access check boxes to allow or deny access to the object. The 
security class names are defined in the Setup screen of Site Configu-
ration editor (see “Defining Security Class Names” on page 80).

3. Click OK to close the Security Classes dialog box and display the pre-
vious screen.

Deleting a Site
A site cannot be deleted from the Site Configuration editor. Use the 
Delete Object utility in the Tools menu to delete a site object. (See Chap-
ter 39, “Deleting Objects and Sites.”)
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Chapter 7

Comm5 Links

This chapter describes how to:

• Install a new Comm5 link on a Tracer Summit building control unit 
(BCU).  
For a BMTX BCU or a high capacity BMTW BCU, see page 94. For a 
standard capacity BMTW BCU, see page 100.

• Add a new UCM to an existing Comm5 link on a Tracer Summit BCU.  
For a BMTX BCU or a high capacity BMTW BCU, see page 107. For a 
standard capacity BMTW BCU, see page 109.

• Replace a UCM on an existing Comm5 link on a Tracer Summit BCU 
(see page 112).

• Upgrade Comm5 database storage in a high capacity BMTW BCU 
that has had its software image upgraded to Version 16 (see 
page 115).

• Replace an existing BCU (standard or high capacity BMTW) with a 
BMTX BCU (see page 118).

Differences Between BCUs Regarding 

Discovery and Database Storage
BMTX BCUs and high capacity BMTWs are different from a standard 
capacity BMTW BCU in terms of:

• Comm5 link discovery
• Comm5 database storage in non-volatile memory (Flash)

The BMTX BCU and the high capacity BMTW BCU do not automatically 
discover the Comm5 link. While setting up a site, a user will discover the 
Neuron ID and the bindings on a Comm5 network by using Site Configu-
ration. When Site Configuration is completed, the Comm5 database is 
saved into non-volatile memory (Flash). The BMTX BCU and high capac-
ity BMTW BCU use this Comm5 database after a power failure, reset, 
clear RAM, clear database, and clear code.

The standard capacity BMTW BCU discovers its Comm5 link automati-
cally on initial power-up of the BCU or after a clear RAM. The Comm5 
database is stored in volatile memory (RAM). If RAM is cleared, this 
database is recreated from the devices the BCU finds on the link. The 
Comm5 database is not stored in non-volatile memory.
BMTX-SVP01B-EN 93



Comm5 Links
Installing a New Comm5 Link (BMTX or 

High Capacity BMTW)
Before getting started, use the Rover service tool to verify that all devices 
on the Comm5 link have been configured and operation verified. Then 
remove the Rover service tool from the link and follow this procedure:

1. Select Setup from the Tracer Summit main menu, then Site Configu-
ration.

2. Select the Devices tab.

3. Highlight the BCU that you want to add devices to. Then, click the 
Edit Device button. The Edit Device dialog box displays (see 
Figure 89 on page 95).

If the BCU is a BMTX, proceed to step 5.

4. For a high capacity BMTW BCU, in the Communication Links group, 
choose a link and use the drop-down arrow to access the list of com-
munication links. Select the Comm5 link. (The BMTW BCU can have 
only one Comm5 link.) 

5. Click OK to close the dialog box and return to the Devices tab.

6. Click Save and create Comm5 UCMs as described in “Creating 
Comm5 UCMs Objects for BMTX or High Capacity BMTW” on 
page 95.

Note:

If this is a new site, choose the correct units, add your BCU and 
PC workstation, and then save your site (see “Creating, Edit-
ing, and Deleting Devices” on page 57). Then proceed to step 2.

Note:

After migrating from either a BMTS or BMTW to a BMTX, you 
must download the database to the BMTX before the PC Work-
station will allow you to do anything to either the Comm5 or 
UCMs.
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Figure 89. Edit Device Dialog Box

Creating Comm5 UCMs Objects for BMTX or High 

Capacity BMTW 

1. In Site Configuration, select the Devices tab.

2. Highlight the BCU that has the Comm5 link.

3. Click the Create UCM button. The Create UCMs dialog box displays 
(see Figure 90).

Figure 90. Create UCMs Dialog Box
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4. Select the option next to the Comm5 link (Link 4 in Figure 90).

5. From the UCM Type drop-down list, select the type of UCM you want 
to add.

6. Type a name in the UCM Address Name field.

7. In the Number to Create field, type the number of UCMs you want to 
create.

8. Click the Create button to create the UCMs and return to the Devices 
tab.

This step creates one UCM object for each of the Comm5 devices. The 
list of UCMs in the UCMs in Selected Device window shows all of the 
UCM objects (Figure 91). In this example, six SCC were created. Ulti-
mately, each UCM object will be connected to a Comm5 UCM through 
assigning a Neuron ID.

Figure 91. UCMs in Selected Device Window

Note:

If you are creating multiple UCMs, Tracer Summit software will use 
the name you enter as the base name and follow it with the communi-
cation link number and the device number. For example, if you use 
the default name “SCC” as the name for three UCMs on Link 4, the 
system would name the units SCC-1-4-1, SCC-1-4-2, and SCC-1-4-3. 

When doing assignments later, use the default base name if you plan 
to use the location label of the device (that was set up using Rover 
service tool) as the UCM object name.
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9. Click the Create UCM button to add other Comm5 UCMs. 

10. When you are finished, click Save to add these new objects to the 
Tracer Summit database.

Assigning Neuron IDs

Follow this procedure to discover Comm5 devices and bindings and to 
assign Neuron IDs to the UCM objects. Automatic discovery is initiated in 
standard capacity BMTWs (for more information, see “Differences 
Between BCUs Regarding Discovery and Database Storage” on page 93). 

1. In Site Configuration, click the Devices tab.

2. On the Devices tab, click the Assign Neuron ID button to open the 
Assign Neuron ID dialog box. 

When the Assign Neuron ID dialog box opens, all command buttons 
are unavailable while the PC workstation determines whether 
Comm5 activity is occurring in the BCU. When there is Comm5 activ-
ity, a progress bar displays in the Comm5 Status group in the upper 
right-hand corner of the dialog box. When all activity ends, the com-
mand buttons are available again.

3. Click the Discover Neuron IDs button. In this phase of discovery, the 
BCU discovers devices on the link and builds a list of Neuron IDs 
Unassigned to UCM Objects. 

4. Click the Discover Binding button, only if bindings exist on the site. 
(Since this phase of discovery can take time on a large link, it is more 
efficient to omit this step if bindings don’t exist.) 

In this phase of discovery, the BCU discovers bindings, verifies that 
all devices have unique network addresses, and determines that there 

Note:

BMTX and high capacity BMTW BCUs will preserve bindings 
only under the following conditions:

• Comm5 devices have not been installed on this BCU.
• All of the devices which have custom bindings were 

either wired together at the time the bindings were 
made, have always been wired together when communi-
cating with Rover since the bindings were made, and 
are now all wired to the BCU.

Note:

Before proceeding, look at the Comm5 Object and Neuron 
ID Summary on the right side of the dialog box to confirm 
that the BCU found devices (Figure 92).
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are no critical link errors. After discovery is complete, the Comm5 
Status field changes to the Normal mode and the dialog is activated.

Figure 92. Assign Neuron ID Dialog Box—After Discovery of Neuron IDs
 

5. To view the Discovery Details window to see if errors exist, click the 
Discovery Details button (Figure 93 on page 99). If errors exist, 
detailed information about them will appear in this window. If the 
errors are non-critical, such as Duplicate DSNs (domain, subnet, 
node) or incomplete bindings, the Fix button will be available.

6. To allow the BCU to resolve non-critical errors, click the Fix button 
(see Help for more detailed information about actions taken by the 
BCU). To manually resolve non-critical errors, click Help for sugges-
tions. 

If critical errors exist, contact technical support and provide them 
with the critical error message number to get help with resolving 
them. 

Note:

The Discover Bindings button is available only during initial 
installation. If devices are added later to the existing link, their 
bindings must be recreated using the Rover service tool, after 
they are installed on the BCU.

Note:

All errors must be resolved before installation to ensure 
that bindings are saved. 

If errors existed and were fixed, you will have to run the 
discoveries again. After viewing the Discovery Details win-
dow, proceed to the next step.
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Figure 93. Discovery Details Dialog Box—With Errors

7. Click Save to File to save the report to a file for future reference, or 
click Close to exit the Discover Details window and return to the 
Assign Neuron ID dialog box.

8. After all Neuron IDs are found and errors corrected, you can begin 
assigning Neuron IDs to UCM objects. From the UCM Type drop-
down list in the Assign Neuron ID dialog box, select the appropriate 
UCM type.

9. From the Unassigned UCM Object Name drop-down list, select an 
Unassigned UCM Object Name to give an unassigned Neuron ID to. 

10. If you do not want to use the Neuron ID location label as the UCM 
name, clear the Assign Location Label checkbox.

11. In the Neuron IDs Unassigned to UCM Objects list, select the Neuron 
ID that you want associated with the UCM object displayed in the 
Unassigned UCM Object Name field.

12. Click the Assign button to give the Neuron ID to the unassigned UCM 
object and move it to the Neuron ID Assigned to UCM Objects list.

13. Repeat the process for the other UCM objects.

14. Click OK to return to the Devices tab. Notice that the UCMs in 
Selected Device list now have Neuron IDs assigned to them.

Note:

If you are using the location label as the object name, use the 
default name that appears in the Unassigned UCM Object 
Name field. For example, Figure 92 on page 98 shows  
SCC-4-4-1 as the object name. 
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15. Click Save and close Site Configuration.

You can see communication established with your newly installed 
devices by looking at the UCM editors. (If power is lost to the BCU 
before communication is established, the devices will have to be rein-
stalled.)

Installing a New Comm5 Link (Standard 

Capacity BMTW)
Before getting started, use the Rover service tool to verify that all devices 
on the Comm5 link have been configured and operation verified. Then 
remove the Rover service tool from the link and follow this procedure:

1. Select Setup from the Tracer Summit main menu, then Site Configu-
ration.

2. Select the Devices tab. 

3. Highlight the BMTW that you want to add devices to. Then, click the 
Edit Device button. The Edit Device dialog box displays (see 
Figure 94).

Figure 94. Edit Device Dialog Box

Note:

Do not begin working on the link with the Rover service tool 
until you have verified that all devices are communicating with 
the BCU.

Note:

If this is a new installation, choose the correct units, add your 
BCU and PC workstation, and then save your site (see “Creat-
ing, Editing, and Deleting Devices” on page 57). Then proceed 
to step 2.
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4. In the Communication Links group, choose a link and use the drop-
down arrow to access the list of communication cards. Select the 
Comm5 card. (The BCU can have only one Comm5 card in any com-
munication link slot.)

5. Select a Comm5 Mode option:

• Install a new link—Select this option if you don’t have custom 
bindings or don’t care if they are destroyed.

• Add to or discover existing link—Select this option if you want to 
preserve custom binding.

6. Click OK to close the dialog box and return to the Devices tab.

7. Click Save and create Comm5 UCMs as described in Creating Comm5 
UCMs Objects below.

Creating Comm5 UCMs Objects 

1. In Site Configuration, select the Devices tab.

2. Highlight the BMTW BCU that has the Comm5 link.

3. Click the Create button. The Create UCMs dialog box displays (see 
Figure 95 on page 102).

4. Select the option next to the Comm5 link (Link 4 in Figure 95 on 
page 102).

5. From the UCM Type drop-down list, select the type of UCM you want 
to add.

Note:

The standard capacity BMTW BCU will preserve bindings only 
under the following conditions:

• Comm5 devices have not been installed on this BCU.
• The Comm5 Mode is set to Add to or Discover existing 

link.
• All of the devices which have custom bindings were 

either wired together at the time the bindings were 
made, have always been wired together when communi-
cating with Rover since the bindings were made, and 
are now all wired to the BCU.

• RAM is cleared prior to clicking the Discover button on 
the Assign Neuron ID dialog box, or pressing a service 
pin on one of the new devices. Existing custom bindings 
are only discovered on a RAM clear. Trane recommends 
clearing RAM immediately after configuring the BCU 
(see “Clearing RAM” on page 103). 
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Figure 95. Create UCMs Dialog Box

6. Type a name in the UCM Address Name field.

7. In the Number to Create field, type the number of UCMs you want to 
create.

8. Click the Create button to create the UCMs and return to the Devices 
tab.

This step creates one UCM object for each of the Comm5 devices. The 
list of UCMs in the UCMs in Selected Device window shows all of the 
UCM objects (see Figure 96 on page 103). In this example, six SCCs 
were created. Ultimately, each UCM object will be connected to a 
Comm5 UCM through assigning a Neuron ID.

Note:

If you are creating multiple UCMs, Tracer Summit software 
will use the name you enter as the base name and follow it with 
the communication link number and the device number. For 
example, if you use the default name “SCC” as the name for 
three UCMs on Link 4, the system would name the units SCC-
1-4-1, SCC-1-4-2, and SCC-1-4-3. 

When doing assignments later, use the default base name if you 
plan to use the location label of the device (that was set up 
using Rover service tool) as the UCM object name.
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Figure 96. UCMs in Selected Device Window

9. Click the Create UCM button to add other Comm5 UCMs. 

10. When you are finished, click Save to add these new objects to the 
Tracer Summit database.

11. Click Close to exit Site Configuration.

Clearing RAM

In order to initiate discovery by the BCU of the devices on the link and 
their bindings, you need to clear RAM. Bindings will be preserved only if:

• These are the first Comm5 devices installed on the BCU.
• The Comm5 Mode in the Edit Devices dialog box is set to Add to or 

discover existing link (see Figure 94).
• RAM is cleared after connecting the Comm5 link wire to the BCU.

To clear RAM:

1. From the main menu, select Tools.

2. Choose BCU Reset/Restore (see Figure 97 on page 104).

3. Choose the BCU with the Comm5 card.

4. Choose Clear Ram and Reset.

5. Click the Reset button.
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Figure 97. BCU Reset/Restore Dialog Box

Assigning Neuron IDs

After a clear RAM and reset, allow the BCU about 60 seconds to finish 
resetting. 

1. From the Setup menu, open Site Configuration and click the Devices 
tab.

2. On the Devices tab, click the Assign Neuron ID button to open the 
Assign Neuron ID dialog box. 

When the Assign Neuron ID dialog box opens, all command buttons 
are unavailable while the PC workstation performs discovery of 
Comm5 devices. When there is Comm5 activity, a progress bar dis-
plays in the Comm5 Status group in the upper right-hand corner of 
the dialog box.

As a result of clearing RAM, discovery is automatically initiated. 
There are two phases to discovery: 

• Phase 1: the BCU discovers devices on the link and builds a 
device list.

• Phase 2: the BCU discovers bindings and verifies Comm5 net-
work configuration. A phase 2 discovery only occurs after a clear 
RAM.

When all activity ends, the command buttons are available again, and 
devices that have been discovered appear in the Neuron IDs Unas-
signed to UCMs Objects window (see Figure 98 on page 105). If 
devices do not show up on the list, you can click Discover Neuron IDs 
to initiate a discovery.
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Figure 98. Assign Neuron ID Dialog Box—After Discovery 

3. To view the Discovery Details window to see if errors exist, click the 
Discovery Details button (Figure 99 on page 106). If errors exist, 
detailed information about them will appear in this window. If the 
errors are non-critical, such as Duplicate DSNs (domain, subnet, 
node) or incomplete bindings, the Fix button will be available.

4. To allow the BCU to resolve non-critical errors, click the Fix button 
(see Help for more detailed information about actions taken by the 
BCU). To manually resolve non-critical errors, click Help for sugges-
tions. 

If critical errors exist, contact technical support and provide them 
with the critical error message number to get help with resolving 
them. 

Note:

All errors must be resolved before installation to ensure 
that bindings are saved. 

If errors existed and were fixed, you will have to run the 
discoveries again. After viewing the Discovery Details win-
dow, proceed to the next step.
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Figure 99. Discovery Details Dialog Box—With Errors

5. Click Save to File to save the report to a file for future reference, or 
click Close to exit the Discover Details window and return to the 
Assign Neuron ID dialog box.

6. From the UCM Type drop-down list in the Assign Neuron ID dialog 
box, select the appropriate UCM type.

7. From the Unassigned UCM Object Name drop-down list, select an 
Unassigned UCM Object Name give an unassigned Neuron ID to.

8. If you do not want to use the Neuron ID location label as the UCM 
name, clear the Assign Location Label checkbox.

9. In the Neuron IDs Unassigned to UCM Objects list, select the Neuron 
ID that you want associated with the UCM object displayed in the 
Unassigned UCM Object Name field.

10. Click the Assign button to give the Neuron ID to the unassigned UCM 
object and move it to the Neuron ID Assigned to UCM Objects list.

11. Repeat the process for the other UCM objects.

12. Click OK to return to the Devices tab. Notice that the UCMs in 
Selected Device list now have Neuron IDs assigned to them.

13. Click Save and close Site Configuration.

You can see communication established with your newly installed 
devices by looking at the UCM editors. (If power is lost to the BCU 

Note:

If you are using the location label as the object name, use the 
default name that appears in the Unassigned UCM Object 
Name field. For example, Figure 98 on page 105 shows SCC-4-
4-1 as the object name. 
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before communication is established, the devices will have to be rein-
stalled.)

Adding a New UCM to an Existing 

Comm5 Link (BMTX or High Capacity 

BMTW)
To add a new UCM to an existing Comm5 link: 

1. Start your installation at the new UCM. Configure and verify opera-
tion of the new device in stand-alone mode, without the communica-
tion link connected, using the Rover service tool.

If this device was previously installed, push the service pin for 15 sec-
onds until the red service LED flashes.

2. Connect the UCM to the communication link on the BCU. Move ter-
mination resistors, if necessary.

3. At the PC workstation select Setup from the Tracer Summit main 
menu and open Site Configuration.

4. From the Devices tab, click the Create UCM button. Then follow the 
procedure for “Creating Comm5 UCMs Objects for BMTX or High 
Capacity BMTW” on page 95. If you created the UCMs during the ini-
tial installation, you can skip this step. 

5. On the Devices tab, click the Assign Neuron ID button to open the 
Assign Neuron ID dialog box.

When the Assign Neuron ID dialog box opens, all command buttons 
are unavailable while the PC workstation determines whether 
Comm5 activity is occurring in the BCU. When there is Comm5 activ-

Note:

Do not begin working on the link with the Rover service tool 
until you have verified that all devices are communicating with 
the BCU.

Note:

When you add a device to an existing link, you will not be able 
to preserve bindings between any of the new devices that are 
added. You will, however, be able to preserve existing bindings. 
If additional bindings are required, create them using the 
Rover service tool or Rover in Tracer Summit software, after 
the device has been added. Then remove the Rover service tool 
from the link and follow this procedure.

Note:

Unassigned UCMs show up in the UCMs list on the Devices 
tab with the default name and no Neuron ID assigned.
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ity, a progress bar displays in the Comm5 Status group in the upper 
right-hand corner of the dialog box. When all activity ends, the com-
mand buttons are available again.

6. Click the Discover Neuron IDs button. In this phase of discovery, the 
BCU discovers devices on the link and builds a list that appears in 
the Neuron IDs Unassigned to UCM Objects. Confirmation that the 
BCU found devices also appears in the Comm5 Object and Neuron ID 
Summary on the left side of the dialog box.

7. From the UCM Type drop-down list in the Assign Neuron ID dialog 
box, select the appropriate UCM type.

8. From the Unassigned UCM Object Name drop-down list, select an 
Unassigned UCM Object Name to give an unassigned Neuron ID to.

9. If you do not want to use the Neuron ID location label as the UCM 
object name, clear the Assign Location Label checkbox.

10. In the Neuron IDs Unassigned to UCM Objects list, select the Neuron 
ID that you want associated with the UCM object displayed in the 
Unassigned UCM Object Name field.

11. Click the Assign button to give the Neuron ID to the unassigned UCM 
object and move it to the Neuron ID Assigned to UCM Objects list (see 
Figure 100).

Figure 100. Assign Neuron ID Dialog Box—Adding a New Comm5 UCM 

to an Existing Link
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12. Repeat the process if there are more UCM objects to assign.

13. Click OK to return to the Devices tab. Notice that the UCM objects in 
Selected Device list now have Neuron IDs assigned to them.

14. Click Save and close Site Configuration. 

You can see communication established with your newly installed 
devices by looking at the UCM editors. (If power is lost to the BCU 
before communication is established, the devices will have to be rein-
stalled.)

Adding New UCMs to an Existing 

Comm5 Link (Standard Capacity 

BMTW)
To add a new UCM to an existing Comm5 link: 

1. Start your installation at the new Comm5 device. Configure and ver-
ify operation of the new device in stand-alone mode, without the com-
munication link connected, using the Rover service tool.

If this device was previously installed, push the service pin for 15 sec-
onds until the red service LED flashes.

2. Connect the UCM to the communication link on the BCU. Move ter-
mination resistors, if necessary.

3. When you have completed the installation of the new units on the 
link, push the service pin on all of the units. This broadcasts the Neu-
ron ID of the new devices on the link. The BCU will discover only the 
new devices on the link.

Note:

Do not begin working on the link with the Rover service tool 
until you have verified that all devices are communicating with 
the BCU.

Note:

When you add a device to an existing link, you will not be able 
to preserve bindings between any of the new devices that are 
added. You will, however, be able to preserve existing bindings. 
If additional bindings are required, create them using the 
Rover service tool or Rover in Tracer Summit software, after 
the device has been added. Then remove the Rover service tool 
from the link and follow this procedure.
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4. At the PC workstation select Setup from the Tracer Summit main 
menu and open Site Configuration.

5. From the Devices tab, click the Create UCM button. Then follow the 
procedure for “Creating Comm5 UCMs Objects” on page 101. If you 
created the UCMs during the initial installation, you can skip this 
step. 

6. On the Devices tab, click the Assign Neuron ID button to open the 
Assign Neuron ID dialog box. 

When the Assign Neuron ID dialog box opens, all command buttons 
are unavailable while the PC workstation performs discovery of 
Comm5 devices. When there is Comm5 activity, a progress bar dis-
plays in the Comm5 Status group in the upper right-hand corner of 
the dialog box.

After the BCU checks for Comm5 activity, it conducts a phase 1 dis-
covery. In phase 1, the BCU discovers devices on the link and builds a 
device list. You will not see a phase 2 discovery because you are not 
preserving any bindings.

Once discovery is complete the command buttons become available 
again and new devices will show up on the Neuron IDs Unassigned to 
UCM Objects list. If devices do not show up on the list, you can click 
Discover Neuron IDs to initiate a discovery.

7. From the UCM Type drop-down list in the Assign Neuron ID dialog 
box, select the appropriate UCM type.

8. From the Unassigned UCM Object Name drop-down list, select an 
Unassigned UCM Object Name to give an unassigned Neuron ID to.

9. If you do not want to use the Neuron ID location label as the UCM 
object name, clear the Assign Location Label checkbox.

10. In the Neuron IDs Unassigned to UCM Objects field, select the Neu-
ron ID that you want associated with the UCM displayed in the Unas-
signed UCM Object Name field.

11. Click the Assign button to give the Neuron ID to the unassigned UCM 
object and move it to the Neuron ID Assigned to UCM Objects list 
(Figure 101 on page 111).

Note:

Unassigned UCMs show up in the UCMs list on the Devices 
tab with the default name and no Neuron ID assigned.
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Figure 101. Assign Neuron ID Dialog Box—Adding a New Comm5 UCM 

to an Existing Link

12. Repeat the process if there are more UCM objects to assign.

13. Click OK to return to the Devices tab. Notice that the UCMs in 
Selected Device list now have Neuron IDs assigned to them.

14. Click Save and close Site Configuration. 

You can see communication established with your newly installed 
devices by looking at the UCM editors. (If power is lost to the BCU 
before communication is established, the devices will have to be rein-
stalled.)

Note:

Do not begin working on the link with the Rover service tool 
until you have verified that all devices are communicating with 
the BCU.
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Replacing a Comm5 UCM
The most obvious reason to replace a UCM is because of circuit board fail-
ure. But boards are also commonly replaced as a troubleshooting tech-
nique, to determine if the problem is with the controller. 

Begin the process at the Tracer Summit PC workstation. First you need 
to remove the UCM that is being replaced from the assignments list in 
the BCU. This tells the BCU not to look for this UCM on its Comm5 link.

To replace a Comm5 UCM:

1. Select Setup from the Tracer Summit main menu, open Site Configu-
ration and click the Devices tab.

2. On the Devices tab, click the Assign Neuron ID button. The Assign 
Neuron ID dialog box displays (see Figure 102).

Figure 102. Assign Neuron ID Dialog Box Showing Assigned UCMs

Note:

When you add a device to an existing link, you will not be able 
to preserve bindings between any of the new devices that are 
added. You will, however, be able to preserve existing bindings. 
If additional bindings are required, create them using the 
Rover service tool or Rover in Tracer Summit software, after 
the device has been added.
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3. From the Neuron IDs Assigned to UCM objects list, choose the UCM 
that is to be replaced.

4. Click the Unassign button. The UCM appears in the unassigned list 
(see Figure 103).

Figure 103. Assign Neuron ID Dialog Box Showing the UCM to be 

Replaced in the Unassigned List

5. Click OK. Tracer Summit returns to the Devices tab. 

On the Devices tab, the UCM object shows all zeros for the associated 
Neuron ID.

6. Save and close Site Configuration.

7. After the yellow communication LED stops flashing, disconnect the 
comm link from the UCM. Also, remove any other wiring. 

8. Replace board, rewire inputs and outputs, and connect power. Do not 
connect your communication wires yet.

9. Connect with Rover and configure the UCM.

10. Remove Rover from the UCM.

• If the UCM has been on another link, you will need to unconfigure 
its network configurations, go to step 11.

• If this is a new UCM from the factory, go to step 12.
11. Hold the service pin down for at least 15 seconds. The red service 

LED flashes, signaling the UCM is unconfigured.

12. Reconnect the communication link to the UCM.

13. Return to the PC workstation to complete the replacement.
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14. Re-open Site Configuration, Devices tab, and the Assign Neuron ID 
window.

15. Click the Discover Neuron IDs button. Discovery of Neuron IDs is ini-
tiated.

16. From the UCM Type drop-down list, select the UCM type. The unas-
signed UCM displays in the Unassigned UCMs field.

17. In the Neuron IDs Unassigned to UCM Objects list, select the new 
Neuron ID.

18. Click the Assign button to assign the Neuron ID to the unassigned 
UCM.

19. Click OK. Tracer Summit returns to the Devices tab.

20. In the UCMs in Selected Device window, verify that new Neuron ID is 
in the list.

21. Click Save and close Site Configuration.

You can see communication established with your newly installed 
devices by looking at the UCM editors. (If power is lost to the BCU 
before communication is established, the devices will have to be rein-
stalled.)

Note:

Do not begin working on the link with the Rover service tool 
until you have verified that all devices are communicating with 
the BCU.
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Upgrading Comm5 Database Storage 

for a High Capacity BMTW BCU that 

has had its Software Image Upgraded 

to Version 16
A high capacity BMTW BCU must have its software image upgraded to 
version 16 in order to store its Comm5 database in non-volatile (Flash) 
memory rather than volatile memory (RAM). 

You must create and save the Comm5 database to the non-volatile mem-
ory in your Version 16 BCU before you can add new devices to the existing 
link. Perform the upgrade first to keep Neuron ID assignments. Then 
install the new devices as instructed in “Adding a New UCM to an Exist-
ing Comm5 Link (BMTX or High Capacity BMTW)” on page 107. 

If the software image has been upgraded, you will be prompted to redis-
cover the Comm5 network Neuron IDs and bindings when you log on the 
PC Workstation (see Figure 104). 

Figure 104. Prompt to Rediscover the Comm5 Network after Upgrading 

BCU Software Image

1. From the Setup menu, open Site Configuration and click the Devices 
tab.

2. On the Devices tab, click the Assign Neuron ID button to open the 
Assign Neuron ID dialog box. 

Note:

This upgrade procedure does not apply to a standard capacity 
BMTW BCU, because it can store its Comm5 database only in 
RAM.
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When the Assign Neuron ID dialog box opens, all command buttons 
are unavailable while the PC workstation determines whether 
Comm5 activity is occurring in the BCU. When there is Comm5 activ-
ity, a progress bar displays in the Comm5 Status group in the upper 
right-hand corner of the dialog box. When all activity ends, the com-
mand buttons are available again.

Figure 105. Assign Neuron ID Dialog Box—Before Discovery of Devices

3. Click the Discover Neuron IDs button. In this phase of discovery, the 
BCU discovers devices on the link and builds a list of Neuron IDs 
Unassigned to UCM Objects. Confirmation that the BCU found 
devices also appears in the Comm5 Object and Neuron ID Summary 
on the left side of the dialog box (Figure 98 on page 105).

4. Click the Discover Bindings button, even if you have no bindings on 
the site. In this phase of discovery, the BCU will find old BCU bind-
ings, and re-establish assignments to Neuron IDs found on the link. 

Note:

Figure 105 shows the Neuron IDs Assigned to UCM Objects list 
populated. The location label column is blank because the BCU 
has not discovered the actual devices on the link yet and cannot 
associate the correct location label with the Neuron ID and 
UCM object name. After the discovery of Neuron IDs and bind-
ings is initiated, the appropriate Neuron ID location labels will 
appear.

Note that no 
location labels 
are assigned.

Step 3
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Notice that the location labels now appear in the Neuron IDs 
Assigned to UCM Objects list (see Figure 106).

Figure 106. Assign Neuron ID Dialog Box—After Discovery of Devices

The Discovery Details window will automatically appear after discov-
ery is complete (see Figure 107). To view the window again after clos-
ing it, click the Discovery Details button.

If errors exist, detailed information about them will appear in the 
Discovery Details window.

Figure 107. Discovery Details Dialog Box—Without Errors

Step 4

Note that location 
labels are now 
assigned

Step 7
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5. Click Save to File to save the report to a file for future reference, or 
click Close to exit the Discover Details window and return to the 
Assign Neuron ID dialog box.

IMPORTANT
If errors exist and you click either the Cancel or the Discover Neuron 

IDs button, the Comm5 database will be reset and all Neuron ID 

assignments and custom bindings will be lost. If you want to con-

tinue with the upgrade, you will have to reassign all Neuron IDs and 

recreate custom bindings. If you want help resolving this error, do 

not click either button. Contact technical support and provide them 

with the error message. 

6. If errors do not exist, click OK to install the devices on the BCU.

7. Click Save and close Site Configuration.

You can see communication established with your newly installed 
devices by looking at the UCM editors. (If power is lost to the BCU 
before communication is established, the devices will have to be rein-
stalled.)

Replacing an Existing BCU (Standard or 

High Capacity BMTW) with a BMTX 

BCU
For cases in which a BMTS or BMTW are replaced by a BMTX, you must 
create a Comm5 database in the BMTX. To do this, use the procedure 
given for “Upgrading Comm5 Database Storage for a High Capacity 
BMTW BCU that has had its Software Image Upgraded to Version 16” on 
page 115.

Note:

Do not begin working on the link with the Rover service tool 
until you have verified that all devices are communicating with 
the BCU.
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Chapter 8

Defining Tracer 100 or Tracker 

Sites

Tracer Summit communicates with Tracer 100 or Tracker panels and 
allows you to create sites with these legacy products. When you install 
the Tracer 100/Tracker Communication package, you can:

• Define phone modem or hardwired connection parameters for Tracker 
and Tracer 100 panels

• Define single- and multiple-panel Tracer 100 sites
• Type site names up to 32 characters long
• Treat a Tracer 100 and Tracker panel like a site device rather than as 

a site

You can communicate with Tracer 100 panels, whether they are config-
ured as unit-to-unit or not. For more information about unit-to-unit com-
munications, see Section 8 of the Tracer 100 Installation guide (EMTB-
IN-12).

Note:

Tracer Summit will connect to Tracer 100 sites Version 14.4 or 
higher and with Tracker sites Version 5.0 or higher. If you have 
Tracer 100 or Tracker sites that predate these versions, 
upgrade them with current software. Then you can communi-
cate with them using Tracer Summit Version 13 or higher.
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Creating Tracer 100 or Tracker Sites
Use the following procedure to create a Tracer 100 or Tracker site and to 
define how the Tracer Summit workstation connects to the remote unit.

To create Tracer 100 or Tracker sites:

1. From the Setup menu, select Site Configuration. The Select Site dia-
log box appears (see Figure 112 on page 124).

2. Click New. The Site Creation Wizard dialog box displays (see 
Figure 108).

3. Select a site type:

• For Tracer 100 sites, select the Tracer 100 Series button
• For Tracker sites, select the Tracker button

4. Type a name for the site in the Site Name field. 

Figure 108. Site Creation Wizard

5. Click Next. The Site Connection Wizard screen appears (see Figure 
109 on page 121).

Note:

If the database is empty, the Restore button appears as an 
option in the Select Action group. For more information on 
restoring remote sites, see “Restoring a Site from the Site Cre-
ation Wizard” on page 53.
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6. Click the Modem or Hardwired button for the connection type.

The Tracer Summit workstation must use a serial connection to com-
municate with a Tracer 100 or Tracker site. You can make a serial 
connection in two ways: hardwired or modem.

• Hardwired connections are made using a 25-foot (or less) EIA-232 
cable that connects the workstation to the Tracer 100 or Tracker 
panel.

• Modem connections are made using modems and an analog phone 
line. Hardwired and modem connections to Tracer 100 and 
Tracker panels use the BMN protocol.

To communicate with Tracer 100 and Tracker panels, you must define 
a workstation modem object. If this object is not defined in the work-
station database, you must create one before you can connect to a 
Tracer 100 or Tracker site. For more information about creating 
workstation modem objects, see “Configuring a Workstation Modem 
for Tracer 100 or Tracker Sites” on page 156.

Figure 109. Site Connection Wizard

7. Click Finish. The Tracer 100 or Tracker Configuration editor appears 
(see Figure 113 on page 125).
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Copying a Tracer 100 or Tracker Site

If you have a large number of sites that are similar or identical to each 
other, Copy Site can eliminate much of the repetitive work involved in 
configuring sites with more similarities than differences. Copy Site repro-
duces objects from an original Tracer 100 or Tracker site and transfers 
them to a new site of the same type.

Copy Site is available with all add-on packages (Tracer 100/Tracker Com-
munication, Building Management, and Enterprise Management).

Copy Site does not copy workstation or global objects from the original 
site. This means that the new site will have the same information as the 
original from which it was copied but not the following items:

• Workstation modem objects
• Message forwarding objects
• Report text files (*.rpt files)
• Tracer 100 objects (calculated analog, calculated binary, normal 

schedules, exception schedules, and holidays)

Copying Tracer 100 or Tracker Sites

1. From the Tools menu, select Copy Site. The Copy Site dialog box 
appears (see Figure 110).

Figure 110. Copy Site Dialog Box

2. Type the name of the new site in the Name of New Site field.

The new site name must be unique, one that does not exist in the 
database.

3. Select Tracer 100 or Tracker from the Site Type to Copy list.

The Copy Graphics and Copy Reports check boxes are unavailable 
because these items do not apply to Tracer 100 or Tracker sites.

4. Click OK. The Copy Site: Rename Panels dialog box displays (see 
Figure 111 on page 123).

Note:

For Tracker sites, the New Panel Name list has one panel to 
rename. Tracer 100 sites can have up to eight panels to rename.
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5. Type new names for the panel(s) of the new site in the New Panel 
Name field.

Figure 111. Copy Site: Rename Panels Dialog Box

6. Click OK.

Tracer Summit copies the database from the original site to the new 
site. The navigation tree displays the new site node, as well as any 
macros associated with the original site.

Note:

New panel names must be unique. They cannot duplicate oth-
ers in the original site or be panel names that are in other 
Tracer 100 and Tracker sites.
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Selecting a Site to Configure
1. From the Setup menu, select Site Configuration. The Select Site dia-

log box appears (see Figure 112).

Figure 112. Select Site Dialog Box

2. Select the desired site you wish to edit.

3. Click OK to display the site configuration editor for the selected site 
(see Figure 113 on page 125).

Configuring Tracer 100 or Tracker Panels
After you complete configuring the Tracer 100 or Tracker panel using the 
Site Creation and Connection Wizards, use the Tracer 100 or Tracker Site 
Configuration editors to establish the identity of the Tracer 100 or 
Tracker site.

If your workstation will connect with the Tracer 100 or Tracker panel 
using a modem, you must define telephone numbers for the site, as well 
as configure a remote unit. If your workstation will connect with the 
panel using a hardwired connection, you only define the Tracer 100 or 
Tracker panel as a remote unit.

Entering Phone Numbers

Use the following procedure to enter the phone number that your work-
station will call to connect to the Tracer 100 or Tracker panel. You can 
also configure a phone number for Tracer 100 sites that call out to a work-
station to send alarms, for example.

To enter phone numbers:

1. When creating a new Tracer 100 or Tracker site, the Setup screen is 
automatically displayed after completing the Site Connection Wizard 
(see Figure 113 and Figure 116 on page 127).
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Figure 113. Site Configuration Editor for a Tracer 100 Series Site Screen

2. In the Master to Remote Phone Number field, type the telephone 
number of the site.

3. If required, select the Use Dialing Prefix or Use Calling Card Number 
check box.

When you select these check boxes, Tracer Summit uses the prefix or 
calling card number you entered when you set up the workstation 
modem (see “Setting Up the Phone Books” on page 163).

4. Tracer 100 sites only: If the Tracer 100 panel will dial out to the 
Tracer Summit workstation, type the Remote to Master Phone Num-
ber using no more than 24 characters.

The actual number dialed can consist of the numbers 0 through 9, the 
# symbol, the letters w, p, and t, a single quote (for a two-second 
pause), spaces, and hyphens.

Creating a Remote Unit for Tracer 100 Sites

Use the following procedure to configure a single Tracer 100 panel that 
does not have unit-to-unit communication capabilities. A Tracer 100 
panel that is not a unit-to-unit Tracer can have only one remote unit 
defined for it.

To create a Tracer 100 remote unit:

1. From the Tracer 100 Site Configuration editor, click the Devices tab 
(see Figure 114).

Note:

The workstation uploads the remote to master phone number 
from the Tracer 100 panel the first time that the Tracer 100 
panel is scanned, either as part of normal processing or by Task 
Manager (see Chapter 15, “Using the Task Manager”). Subse-
quent scans download the number to the panel.
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Figure 114. Devices Screen

2. Click the Create Remote Unit button. The Create New Device dialog 
box appears (see Figure 115 on page 126).

Figure 115. Create New Device Dialog Box

3. Type the name of the Tracer 100 panel. This is the same name as you 
would see in BMN’s Remote Unit Setup or in the file name of the 
panel backup.

4. Type the unit password, if any, that is required to access the Tracer 
100 panel.

The password you type must be the same as the one in the security 
menu of the Tracer 100 panel.

Note:

Since this is not a unit-to-unit, or COP, Tracer 100, leave the 
Unit-to-Unit checkbox cleared. “Creating a Tracer 100 COP” on 
page 128 explains how to create a unit-to-unit Tracer 100.
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5. Click OK. The Devices screen appears with the new device displayed 
in the Remote Units list.

6. Click Save to store the site in the database.

Configuring a Tracker Panel

When you configure a Tracker using the Tracker Site Configuration edi-
tor, there is no Devices tab. Instead, you identify Tracker panels on the 
Setup tab.

To identify a Tracker panel:

1. From the Tracker Site Configuration editor, click the Setup tab (see 
Figure 116).

Figure 116. Tracker Setup Screen

2. In the Remote Unit Name field, type the name for the Tracker panel.

3. Click Save to store the Tracker site definition in the database.

Note:

The Unit Type remains unknown until the Tracer 100 panel is 
scanned as part of normal processing or by the Task Manager 
(see Chapter 15, “Using the Task Manager”).
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Creating Tracer 100 Sites with Multiple 

Panels
To create a site with multiple panels, each panel must have a unit-to-unit 
communications logic board or card installed. In addition, you must 
define a Tracer 100 Communications Processor (COP) panel with a logic 
board address of 1. You cannot add a Tracer 100 panel to an existing site 
unless the site already has the Tracer 100 COP unit defined for it.

For more information about setting up unit-to-unit Tracer 100 panels, 
refer to the Tracer 100 Installation guide software version 15 (EMTB-IN-
12) and /or the Installation Guide for Tracer 100i, Tracer L, and Tracer 
Chiller Plant Manager (EMTF-IN-6).

In the following paragraphs, the Tracer 100 COP is simply referred to as 
the COP.

Creating a Tracer 100 COP

When you add several Tracer 100 panels to a single Tracer Summit site, 
unit 1 is the Tracer 100 COP. A COP is the lead panel in a unit-to-unit 
site configuration. Communications between panels that are controlled by 
the COP occur at 1200 baud.

To add a Tracer 100 COP panel:

1. Create a site (see “Creating Tracer 100 or Tracker Sites” on page 120) 
and repeat the procedure described in “Entering Phone Numbers” on 
page 124.

2. From the Tracer 100 Site Configuration editor, click the Devices tab.

3. Click the Create Remote Unit button. The Create New Device dialog 
box appears (see Figure 115 on page 126).

Note:

All Tracer 100 panels linked to the Tracer 100 COP must have 
the same software version.

Note:

Building Management Network (BMN) ends connections when 
it detects mismatched site configurations, but Tracer Summit 
does not. BMN displays messages such as: “A COP answered, 
but is not edited as one,” or “Remote edited as a COP, but no 
COP found.”

These messages do not appear in Tracer Summit. Therefore, if 
you do not define additional remote panels when you should, 
Tracer Summit will not allow you to connect to them in termi-
nal emulation, nor will Tracer Summit scan for them.
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4. In the Remote Unit Name field, type the name of the Tracer 100 
panel. This is the same name as you would see in BMN Remote Unit 
Setup or in the file name of the panel backup.

5. Click the Unit-to-Unit Tracer check box. The Unit Number field dis-
plays 1, which is the default number.

A COP must have a unit number of 1 in Tracer Summit, as well as on 
the logic board DIP switch block.

6. In the Remote Unit Password for System Access field, type the pass-
word of the unit.

The password you type must be the same as the one given in the secu-
rity menu of the panel.

7. Click OK. The Devices screen appears. The COP appears in the 
Remote Units group (see Figure 117 on page 130).

8. If you are adding remote units to the COP, perform the procedure in 
“Adding Tracer 100 Panels to a Multi-Panel Site” on page 130. Other-
wise, click Save.

Note:

The Unit Type remains unknown until the Tracer 100 panel is 
scanned as part of normal processing or by the Task Manager 
(see Chapter 15, “Using the Task Manager”).

Note:

When you click Save, the remote device is permanently saved in 
the database. This means that you cannot re-edit the unit num-
ber of the remote unit.
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Adding Tracer 100 Panels to a Multi-Panel Site

1. Repeat steps 2-4 in “Creating a Tracer 100 COP” on page 128.

2. In the Unit Number field, if the default value in the Unit Number 
field is not the address of the remote you are adding, select the correct 
value.

This is the unit number as it is set in the DIP switch block on the logic 
board. For each Tracer 100 panel that you add, the unit number incre-
ments by one. Since there can only be one Tracer 100 COP per site, 
any additional panels that you add must have unit numbers other 
than 1.

3. In the Remote Unit Password for System access field, type the pass-
word that is used to access the Tracer 100 panel.

The password you type must be the same as the one in the security 
menu of the panel.

4. Click OK. The Devices screen appears with the unit displayed in the 
Remote Units group (see Figure 117).

Figure 117. Devices Screen Remote Units Group

5. Click Save. The new remotes are saved to the database.

Note:

The Unit Type remains unknown until the Tracer 100 panel is 
scanned as part of normal processing or by the Task Manager 
(see Chapter 15, “Using the Task Manager”).

Note:

When you click Save, the remote devices are permanently saved 
in the database. This means that you cannot re-edit the unit 
numbers of the remote units.
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Modifying Tracer 100 or Tracker Sites
Use the following procedures to edit phone numbers in the remote, 
rename the remote, configure a remote with or without unit-to-unit com-
munications, edit the remote password, or delete a remote.

Changing the Master to Remote Phone Number

1. From the Tracer 100 or Tracker Site Configuration editor, click the 
Setup tab.

2. Change the number in the Phone Number field as required.

3. Click the Use Dialing Prefix/Use Calling Card Number check box(es) 
as necessary.

4. Click Save.

Changing the Remote to Master Phone Number (Tracer 

100 Sites Only)

◆ From the Tracer 100 Site Configuration editor on the Setup tab, 
select and type over the existing phone number and click Save.

Renaming a Tracer 100 Remote Unit

When you rename a panel, you must first rename it in Tracer Summit. 
Once you rename the panel, connect to it to have Tracer Summit change 
the name at the panel.

To rename a remote unit:

1. From the Tracer 100 Site Configuration editor, click the Devices tab.

2. Select the panel that you want to rename.

3. Click the Edit Remote Unit button. The Edit Device dialog box 
appears (see Figure 118).

Figure 118. Edit Device Dialog Box
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4. Rename the panel using up to 8 characters.

5. Click OK to save the change to the database.

6. Connect to the site.

Once you connect, Tracer Summit displays a dialog box informing you 
that the connected panel does not have the same name as the one in 
the workstation database. The dialog box also asks whether you want 
to rename the panel.

7. In the dialog box, click OK to rename the panel.

Making a Tracer 100 Panel Unit-to-Unit

In the Tracer Summit software, you make a Tracer 100 panel unit-to-unit 
when the panel has a logic board installed with unit-to-unit communica-
tion capability. In most cases, this situation will only occur when you have 
changed the logic board or installed a unit-to-unit communication card. 
For more information on setting up a panel to communicate as a unit-to-
unit device, see “Creating Tracer 100 Sites with Multiple Panels” on 
page 128.

To make a Tracer 100 panel unit-to-unit:

1. From the Tracer 100 Site Configuration editor, click the Devices tab. 
The remote unit already assigned to the site displays in the Remote 
Units group.

2. Select the panel and click the Edit Remote Unit button. The Edit 
Remote Unit dialog box appears.

3. Click the Unit-to-Unit Tracer check box.

4. Click OK. The Devices screen appears, with modified device displayed 
in the Remote Units list.

5. Click Save to store the site in the database.

Removing Unit-to-Unit Capability

Use the following procedure when the panel at the site does not have 
unit-to-unit capability. This occurs when you have a panel that does not 
have a logic board with unit-to-unit communication capability.

To remove unit to-unit capability:

1. From the Tracer 100 Site Configuration editor, click the Devices tab. 
The sole remote unit already assigned to the site displays in the 
Remote Units group.

2. Click the Edit Remote Unit button. The Edit Remote Unit dialog box 
appears.

3. Click the Unit-to-Unit Tracer check box to remove the check mark.

4. Click OK.
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Editing the Unit Number of a Remote Unit-to-Unit 

Tracer Panel

You can only edit the unit number of a remote unit before you save it to 
the database. If you have already saved the panel and you want to edit its 
unit number, use the Delete Object utility to delete the remote unit (see 
“Deleting Objects” on page 652). Once the remote unit is deleted, you can 
then add the remote unit again, giving the panel the unit number that is 
set on the logic board DIP switch block.

To edit the unit number of a remote unit:

1. From the Tracer 100 Site Configuration editor, click the Devices tab.

2. Click the Edit Remote Unit button. The Edit Remote Unit dialog box 
appears.

3. In the Unit Number field, select the new unit number of the remote.

4. Click Save.

Editing the Password of a Remote Unit

Use the following procedure if you have changed the password of a remote 
unit at the panel and to change the password in Tracer Summit, or if you 
entered the password incorrectly when you created the site.

To edit the password:

1. From the Tracer 100 Site Configuration editor, click the Devices tab.

2. Click the Edit Remote Unit button. The Edit Remote Unit dialog box 
appears.

3. Click Remote Unit Password for System Access and type the new 
password.

4. Click OK.

5. Click Save to store the edited password to the database.

Deleting a Tracer 100 Remote Unit

You can only delete a remote unit from within the Tracer 100 Site Config-
uration editor if you have not saved the remote unit in the database. If 
you have saved the remote unit in the database, then use the Delete 
Object utility to delete the remote unit (see “Deleting Objects” on 
page 652). 

Note:

A site must have at least one remote defined for it. If you start 
with only one remote, you cannot delete the remote without 
also deleting the site.
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Chapter 9

Setting Up Security—Tracer 

Summit System

The Tracer Summit system provides sophisticated security to protect 
against unauthorized access. The operator enters a user name and pass-
word to log on to the system. 

Your security supervisor assigns passwords and access levels for each 
operator. The security supervisor also controls which operators have 
access to functions, applications, and objects within the Tracer Summit 
system. For most elements of the system, the supervisor can assign three 
levels of access:

• No access (the operator cannot see the information)
• View only (information can be seen, but not changed)
• View and edit (information can be seen and changed)

You can define which classes have access to an object when you create it. 

Setting Up a Security Supervisor

Tracer Summit includes a pre-defined user (User Name: tracer; password: 
summit) that allows you to log on the system before you define a security 
supervisor. To set up security access for a security supervisor, follow the 
steps for setting up a new user (see “Setting Up a New User” on 
page 136). Be sure to select Security Supervisor in the User Info screen 
options to allow the security supervisor access to the Security editor. 

After you define security access for the security supervisor, delete the 
tracer user name to prevent unauthorized access. 

Note:

The Tracer Summit system allows you to delete the tracer user 
name only after a security supervisor has been created on the 
system and that supervisor has logged on.
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Setting Up a New User

You must set up a user profile for each operator who will use Tracer Sum-
mit.

The steps to set up an operator are:

1. Enter user information.

2. Assign functions the operator may perform.

3. Assign applications the operator may view only or view/edit.

4. Assign objects to which the operator has access.

5. Assign the security classes the operator may view only and view/edit.

Tracer Summit has four operator levels with predefined security access 
(see Table 4).

Table 4. Predefined Security Access for Operator Levels

When setting up a new user, you can choose from the predefined profiles, 
or you can create a custom profile. You can also copy the profile from a 
previously defined user.

Operator 
Level

Example Operators Security Access

Level 1 Occasional operators, 
such as security 
guards

• View graphics and expanded 
messages. 

• Acknowledge alarms.
• Make timed override request.

Level 2 Daily operators Same as level 1, plus: 

• View chiller plant control, chiller 
plant status, reports, schedules, 
and trends. 

• Edit chiller plant control status and 
schedules.

• Make timed override request.

Level 3 Advanced daily 
operators

Same as level 2, plus: 

• Create schedules.
• Edit chiller plant control, expanded 

messages, graphics, reports, and 
trends.

• Make timed override request.

Level 4 System supervisor Complete access to everything.

Note:

Based on the profile you select when you create a user, access 
may be pre-selected for some objects. If you are creating a cus-
tom profile, no access is pre-selected.
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Entering User Information

1. From the Setup menu, select Security. The Select Security dialog box 
displays (see Figure 119).

Figure 119. Select Security Dialog Box

2. Click New. The User Setup dialog box displays (see Figure 120).

Figure 120. User Setup Dialog Box

3. Enter a name of 1–8 alphanumeric characters in the User Name field.
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4. Select an option:

• If you wish to use a predefined operator level profile or customize 
a predefined operator level profile for security access, click the 
name in the Selected Profile box, then click OK to display the 
Security editor User Info screen (see Figure 122 on page 139). 
Proceed to step 9.

• If you wish to copy the operator level profile of an existing user, 
click Copy From to display the Copy From dialog box (see 
Figure 121). Proceed to step 5.

Figure 121. Copy From Dialog Box

5. Click the user name you wish to copy. 

6. Click OK to display the User Setup dialog box.

7. Click OK to display the Security editor User Info screen (see 
Figure 122 on page 139).
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Figure 122. Security Editor User Info Screen

8. At the Security editor User Info screen, enter a First name in the 
First Name field (1–28 characters) and a Last Name in the Last 
Name field (1–29 characters). Entries in the Middle field (0–4 charac-
ters) and Job Title field (0–30 characters) are optional.

9. Enter a password in the Password field. Use up to eight characters. 
The password displays as asterisks (*).

Note:

• When setting up multiple sites, an operator can be auto-
matically logged on to all sites. For this to work, you need to 
enter the same user name and password for all sites that 
the user needs access to.

• When creating the password for the first time, click the 
Show Password check box to verify the password entry. 
After checking for mistakes, deselect Show Password to 
convert the password back to asterisks (*).
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10. In the Options fields, click the following to select or deselect the 
option:

• Security Supervisor
• Match Upper & Lower Case
• Automatic Remote Connect
• Disconnect Remote Connection at Log Off
• Auto-Log Off

11. If you select Auto-Log Off, in the Minutes field type in the number of 
minutes of non-activity before the system logs off the user.

Assigning Access to Functions

Click the Functions tab from the Security editor to display the Functions 
screen (see Figure 123).

Figure 123. Security Editor Functions Screen

1. Click the checkbox in the Access column to grant or deny access for 
each function.

2. Click the check box in the View Only column or in the View/Edit col-
umn for each application to grant or deny access to that application.

3. To set up Simplified Overrides, check the following functions:

• Allow Min/Max edit Simplified Override
• Change Values from Graphics

Note:

We recommend you select Auto-Log Off. If a user leaves a PC 
Workstation unattended, Tracer Summit logs the user off auto-
matically after the number of minutes specified in the Minutes 
field.
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• User priority level 

4. In the Select Default Priority for Simplified Override Dialog drop-
down, select a user default priority level.

Assigning Access to Applications

1. Click the Applications tab from the Security editor to display the 
Applications screen (see Figure 124).

Figure 124. Security Editor Applications Screen

2. Click the check box in the View Only column or in the View/Edit col-
umn for each application to grant or deny access to that application.

Note:

For further details on setting up simplified overrides, see “Set-
ting Up the Simplified Override Dialog Box” on page 172.

Note:

The highest user priority level you select will determine the 
highest user level default override setting available. 

To set up the system to perform overrides from a graphic, see 
“Setting Up the Simplified Override Dialog Box” on page 172
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Assigning Access to Objects

1. Click the Objects tab from the Security editor to display the Objects 
screen (see Figure 125).

Figure 125. Security Editor Objects Screen

2. Click the check box in the Access column to grant or deny access for 
each object.

Assigning Access to Security Classes

1. Click the Classes tab from the Security editor to display the Classes 
screen (see Figure 126).

Figure 126. Security Editor Classes Screen

2. Click the check box in the Read Only column or in the Read/Write col-
umn for each class to grant or deny access to that class.
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Modifying a User Setup
1. From the Setup menu, select Security. The Select Security dialog box 

displays. 

2. Click the name of the user you wish to modify.

3. Click OK to display the Security editor.

4. Use the Security editor screens to select user options and to modify 
access to functions, applications, objects, and classes. 

Defining Access for Users Not Logged 

On
When no user is logged on the Tracer Summit system, the system oper-
ates on a predefined user profile called Nobody Logged On. The default 
settings for Nobody Logged On deny the operator access to all functions, 
applications, and objects. There may be instances where you want opera-
tors to have limited access to general information, such as a main floor 
plan or a graphic display screen, without logging on to a site. You can do 
so by modifying the Nobody Logged On user profile.

To modify the nobody logged on user profile:

1. From the Setup menu, select Security. The Select Security dialog box 
displays (see Figure 127). 

Figure 127. Seclect Security Dilaog Box

2. Click Nobody Logged On.

3. Click OK to display the Security editor. 

4. Use the Security editor screens to select user options and to modify 
access to functions, applications, objects, and classes. 

Note:

Do not remove or change the name of the Nobody Logged On 
user. The system requires this user name to operate properly.
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Setting Up Group Security
Use the following procedure to create a new group user. Group-level secu-
rity is only available on Tracer Summit Version 13 or higher workstations 
with the Enterprise Management package installed.

Group security appears in the Setup menu when you log on to the work-
station with level 2 security access. When you perform a new installation 
in Version 13 or higher, or during an upgrade from previous versions, the 
only active username with level 2 access is username: Tracer, password: 
Summit. This is the Tracer Summit user.

To create a new group user:

1. Set up groups using the Group Configuration editor.

2. From the Setup Menu, select Group Security. The Select Group Secu-
rity dialog box appears (see Figure 128).

Figure 128. Select Group Security Dilaog Box

3. Click New. The Group User Setup dialog box appears (see Figure 129 
on page 145).

Note:

If you removed the Tracer Summit user from site security, you 
have to temporarily re-create this user to log on to a site and 
access group security. After you create a new level 2 security 
user, you can then delete the Tracer Summit user.
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Figure 129. Group Setup Dialog Box

4. Type the name of the new user.

5. Select the security level for the user.

6. Click OK. The Group Security editor displays (see Figure 130 on 
page 146). Edit the User Name and Security Level of the user if 
needed.

7. Type the password for the user in the Password field.

8. Click the options that apply to the new user.

Click Match Upper & Lower Cases if you want the Tracer Summit 
software to allow upper and lower case characters for the password. 
Otherwise, the software accepts all passwords that you type as 
though they were lower case.

Click the Auto – Logoff check box to activate the Minutes field. Type 
in the number of minutes of system inactivity after which the Tracer 
Summit software will automatically logoff the user.

9. In the Available Group(s) list, select the groups that the user can 
access.

10. Click Add to add the group(s) to the Assigned Group(s) list.

11. Click Save to store the new user to the database.

Note:

As a default, the Tracer Summit software masks the password 
from onlookers and all characters in the field display as aster-
isks. Click the Show Password check box to display the pass-
word without asterisks.
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Figure 130. Group Security Editor Screen
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Setting Up Security for the Operator 

Display
Use the following procedure to set up operator display passwords. This 
group is only displayed if the BCU is a BMTW. Entering data in this 
group is optional. Use it only to enable security at the operator display.

To set up security for the operator display:

1. Log on to the site that has a BCU operator display.

2. From the Setup menu, select Site Security. The Tracer Summit Secu-
rity editor displays with the User Info tab opened (see Figure 131).

Figure 131. Site Security Editor Screen

3. In the Tracer Summit Security group, set up the security profile of 
the user.

For more information on setting up user security.

4. In the Password field, type a password.

The password must be numeric only (4-8 digits). The password can be 
the same as or different from the Tracer Summit password. Each 
digit of the password displays as an asterisk (*).

To display the password, click the Show Password checkbox. The 
password displays in the form you entered it, showing numbers 
rather than asterisks.

5. Select the Allow Edit Access options that apply.
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• Click Alarms to enable acknowledgement and deletion of alarms. 
If the field is not selected, you can view alarms at the operator 
display but cannot acknowledge or delete them.

• Click Schedule to allow the modification of existing schedules. If 
the field is not selected, you can view schedules at the operator 
display but cannot modify them.

• Click Set Points to allow modification of setpoints. If the field is 
not selected, you can view setpoints at the operator display but 
cannot modify them.

• Click Overrides to allow overrides. If the field is not selected, you 
can view properties that can be overridden (manual controls) but 
you cannot modify them.

• Click Setup to allow setup activities at the operator display. If the 
field is not selected, you can view the Operator Display settings 
but cannot modify them.

• Click Timed Override to allow timed overrides of areas. If the 
field is not selected, you can view the timed override status of an 
area but cannot modify it.

6. Click Save.

Deleting a User
You cannot delete a user from the Security editor. To delete a user, use the 
Delete Object utility in the Tools menu..

Note:

Some of the setup activities are always available.

Note:

Deleting a user from group security does not delete the user 
from site security. This applies to site and group security.
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Setting Up Printers, Modems, 

Cell Phones, and Pagers

Tracer Summit software supports the following features:

• Printing of graphics, reports, Custom Programming Language (CPL) 
programs, the event log, and individual alarms and events as they 
occur

• Communications between a BCU modem and a PC Workstation 
modem

• Communications between a BCU modem, cell phone/pager
This chapter describes the steps in setting up each of these options.
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Setting Up Printers
In Tracer Summit, you can print graphics, reports and CPL programs, as 
well as the event log and alarms and events as they occur. For graphics, 
reports, CPL programs, and the entire event log, you can select the File 
menu’s Print item to print the displayed information. These items use 
page printing, which prints a page at a time to a printer. For page print-
ing, you can use any standard printer (such as a laser or inkjet printer). 
You set up and use the printer just as you do from any Windows program.

Event and alarm printing is handled differently. Tracer Summit prints 
alarms and events to a selected events printer one line at a time as they 
occur. A tractor-feed (or line-feed) printer works best as the events printer 
so that you can view the events as they are generated and printed.  If you 
select a page printer, you do not see the events until a complete page is 
printed. Typically, the events printer is connected directly to the PC 
Workstation (on the LPT1: port). However, the printer can also be con-
nected through a network.

To print the entire event log, you can use any printer. The events printer 
is only for printing alarms and events one at a time as they occur.

Whether you are setting up the events printer or any other printers, you 
need to first add the printer in the Windows operating system.

Adding a Printer in Windows

Before you can select a printer in Tracer Summit, you need to add the 
printer to the Windows operating system using the Add Printer applica-
tion.

To access the Add Printer application:

1. From the Windows desktop, double click on the My Computer icon, 
then double click on the Printers icon.

2. At the Printers window, double click on Add Printer. The Add Printer 
Wizard displays and will guide you through the installation of a 
printer.

Setting Up and Selecting the Events Printer

After you have added a printer to the Windows operating system, you can 
select that printer as your events printer. To set up the events printer, you 
access the System Options editor (from the Tools menu, select Options). 
For detailed information on setting up the events printer, refer to Chapter 
33, “Setting System Options”.

Selecting Other Printers

For printing graphics, reports, CPL programs, and the entire event log, 
you can use a printer you added to the Windows operating system. With 
the graphic, report, CPL program, or event log displayed, on the File 
menu select Print. At the Print Setup dialog box, select the printer.
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Setting Up Modems
Tracer Summit software supports modem communications between a 
BCU and a remote PC Workstation. Once the BCU and PC Workstation 
modems are installed, you can set up and configure both modems in 
Tracer Summit using the Workstation or BCU Modem editor.

In the Tracer 100/Tracker Communications package, Tracer Summit sup-
ports modem communication between Tracer 100 or Tracker (EMTK) 
panels and a remote PC Workstation.

You add BCU modems during site configuration (see “Adding a BCU 
Modem” on page 60). Once a BCU modem is configured, you can then 
modify the modem through the modem editor.

You add and configure workstation modems for BCU sites and for Tracer 
100 or Tracker (EMTK) sites through the modem editor.

Accessing the Workstation Modem Editor

1. From the Setup menu, select Communications, then select Worksta-
tion Modem. The Select Workstation Modem dialog box displays (see 
Figure 132).

Figure 132. Select Workstation Modem Dialog Box

2. Select a modem and click OK. The Workstation Modem editor dis-
plays (see Figure 133 on page 152).
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Figure 133. Workstation Modem Editor

Adding a Workstation Modem in Windows

Before you can create a modem object in Tracer Summit, you need to add 
a modem to the Windows operating system. The Windows Modems appli-
cation program is found in the Windows Control Panel. 

To access the Modems application program:

1. From the Windows desktop, double click the My Computer icon, then 
double click the Control Panel icon. The Control Panel displays (see 
Figure 134).

2. Double click the Modems icon. For further instructions on adding a 
modem, refer to the Windows operating system manual.

Figure 134. Windows Modems Icon
 

Modems
Icon
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Creating a New Workstation Modem 

A workstation modem is a modem that is installed in your PC. In Tracer 
Summit, you must configure your modem to communicate with BCU sites 
and Tracer 100 or Tracker sites (if you have the Tracer 100/Tracker Com-
munication package installed).

The modem editor will only allow you to create workstation modems for 
the type of Tracer Summit package that you have on your workstation. 
The Tracer Summit standard software allows you to add workstation 
modems for BCU sites. When you have the Tracer 100/Tracker Communi-
cation or Enterprise Management package, you can create workstation 
modems for Tracer 100 or Tracker sites.

To create a Tracer Summit local workstation modem, you perform 

these tasks:

1. Add a modem to the Windows operating system (see “Adding a Work-
station Modem in Windows” on page 152).

2. Configure and set up a workstation modem using the Modem editor. 
You need to:

• Open and name a new modem object (as described in this section)
• Choose which modem in Windows that your workstation will use 

(see “Setting Up a Workstation Modem” on page 157)
• Define how the modem will be used (see Table 5 on page 159)
• If you have the option to do so, determine whether you will use 

the workstation modem to communicate to Tracer 100 or Tracker 
sites

• Add phone numbers to the Phone Book (see “Setting Up the 
Phone Books” on page 163)

• Verify the defaults for the comm port and the configuration 
strings

• Save the modem object
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To create a workstation modem object:

1. From the Setup menu, select Communications, then select Worksta-
tion Modem. The Select Workstation Modem dialog box displays (see 
Figure 135).

Figure 135. Select Workstation Modem Dialog Box

2. Click New. The New Modem Name dialog box displays (see 
Figure 136). 

Figure 136. New Modem Dialog Box

3. Enter a name in the Modem Name field. Use a maximum of 32 char-
acters. You must enter a name before you can save the new worksta-
tion modem object. (You can modify the name from the Setup screen 
of the Modem editor.)

4. Click OK. The Workstation Modem editor displays (see Figure 137 on 
page 155).
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Figure 137. Workstation Modem Editor Status Screen

5. Proceed with configuring and setting up the new workstation modem 
(see “Configuring a Workstation Modem for BCU Sites” on page 155 
and “Setting Up a Workstation Modem” on page 157).

Configuring a Workstation Modem for BCU Sites

The following screen gives you a way to view and append the maximum 
speed of the comm port for the workstation modem, as well as the stan-
dard configuration strings that the Windows operating system provides 
for the modem.

To configure a workstation modem for BCU sites:

1. From the Workstation Modem editor, click the Configuration (BCU 
Sites) tab to display the Configuration (BCU Sites) screen (see 
Figure 138 on page 156).

Note:

The comm port in the BMTS BCU has a fixed speed of 9600 
baud. The BMTW BCU has an adjustable speed up to 38400 
baud. So, depending on what type of BCU you are calling, as 
well as the quality of the phone line, you might be able to use 
the higher baud rate.
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Figure 138. Workstation Modem Configuration (BCU Sites) Screen

2. Select the baud rate from the Workstation Comm Port Maximum 
Speed list.

Configuring a Workstation Modem for Tracer 100  
or Tracker Sites

If your Tracer Summit workstation includes the Tracer 100/Tracker Com-
munication or Enterprise Management package, the Configuration (T100/
Tracker Sites) screen appears when you access the workstation modem 
editor. The Configuration (T100/Tracker Sites) screen lets you enable or 
disable the modem for use with these Tracer 100 or Tracker sites.

To configure a workstation modem:

1. From the Workstation Modem editor, click the Configuration (T100/
Tracker Sites) tab to display the Configuration (T100/Tracker Sites) 
screen (see Figure 139 on page 157).

2. Select the Use this modem for T100/Tracker Sites check box.

Note:

The Configuration Strings fields display default modem com-
mand strings. However, you can edit the fields to accommodate 
specific modem requirements. For information about changing 
default settings, refer to the Tracer Summit online Help.
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Figure 139. Workstation Modem Configuration (T100/Tracker Sites) 

Screen

Setting Up a Workstation Modem

Use the following procedure to: 

• Rename the workstation modem
• Define what modem in Windows that the Tracer Summit workstation 

modem object should use
• Define comm port the modem is on
• Define whether the modem can accept incoming and/or outgoing calls

To set up the workstation modem:

1. From the Workstation Modem editor, click the Setup tab to display 
the Setup screen (see Figure 140 on page 158).

Note:

The Configuration Strings fields display default modem com-
mand strings. However, you can edit the fields to accommodate 
specific modem requirements. To connect to Tracer 100 or 
Tracker sites, it is very important to include commands to dis-
able error correction and data compression in the initialization 
string fields. For information about changing default settings, 
refer to the Tracer Summit online Help.
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Figure 140. Workstation Modem Editor Setup Screen

2. In the Workstation Modem Name field, modify the name of the 
modem if necessary.

3. From the Connect By list, select what modem in Windows the Tracer 
Summit workstation modem object should use.

4. In the Comm Port field, check the communication port default value 
for the workstation modem. If necessary, enter the new communica-
tion port number. 

5. From the Modem Usage list, select the option that best fits how the 
modem is to be used. For information on making your selection, see 
Table 5 on page 159.

Note:

• You will not be able to select a communications port that is 
being used by another workstation modem.

• If you edit this field for an existing workstation modem, 
Tracer Summit continues to use the previous value until 
you restart Tracer Summit.
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Table 5. How to Determine Modem Usage

Modem 
Usage

Use this 
Modem for 

T100/Tracker 
Sites

Result

Outgoing 
calls only

False

• Can dial BCU sites. 
• Cannot dial Tracer 100 or Tracker sites. 
• No incoming calls accepted. See note 1.

Outgoing 
calls only

True

• Can dial BCU sites, Tracer 100 sites, and 
Tracker sites. 

• No incoming calls accepted. See notes 1 
and 2.

Incoming 
calls only

False

• Can take incoming calls from BCU sites. 
• Cannot take incoming calls from Tracer 

100 or Tracker sites. 
• No outgoing calls allowed. See note 1.

Incoming 
calls only

True

• Can take incoming calls from BCU sites, 
Tracer 100 sites, and Tracker sites. 

• No outgoing calls allowed. See notes 1 
and 2.

Both incom-
ing and out-
going calls

False

• Can dial and take incoming calls from 
BCU sites. 

• Cannot dial or take incoming calls from 
Tracer 100 or Tracker sites. See note 1.

Both incom-
ing and out-
going calls

True
Can dial and take incoming calls from BCU 
sites, Tracer 100 sites, and Tracker sites. See 
notes 1 and 2.

(1) There is no setting to exclude BCU sites from using the modem as there 
is for Tracer 100 and Tracker sites (see the Use this Modem for T100/Tracker 
Sites check box discussed in “Configuring a Workstation Modem for Tracer 
100 or Tracker Sites” on page 156). However, to exclude incoming calls: pro-
gram your remote BCU sites to call a different phone number than the one 
your remote Tracer 100 and Tracker sites call.
(2) To communicate with Tracer 100 and Tracker panels, you must initialize 
the modem so that data compression and error control are disabled.
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Accessing the BCU Modem Editor

1. From the Setup menu, select Communications, then select BCU 
Modem. The Select BCU Modem dialog box displays (see Figure 141).

Figure 141. Select BCU Modem Dialog Box
 

2. Select a modem and click OK. The BCU Modem editor displays (see 
Figure 142). 

Figure 142. BCU Modem Editor
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Creating a New BCU Modem

Create a new BCU modem using Tracer Summit’s Site Configuration 
Utility (see “Adding a BCU Modem” on page 60). After creating the new 
modem, you can edit its configuration with the BCU Modem editor.

With the BCU Modem editor, you perform these tasks:

• Choose which model of modem you have installed in the BCU (see 
“Configuring a BCU Modem” on page 162) This does not apply to the 
BMTX BCU which has only one model of modem available.

• Set the number of dialing attempts (see “Setting Up a BCU Modem” 
on page 161) 

• For modems in BMTW and BMTX BCUs, set the BCU comm port 
maximum baud rate

• Verify the defaults for the configuration strings
• Add phone numbers to the Phone Book (see “Setting Up the Phone 

Books” on page 163)
• Define security access (see “Setting Security Access for a BCU 

Modem” on page 166)
• Save the modem object

Setting Up a BCU Modem

1. From the BCU Modem editor, click the Setup tab to display the Setup 
screen (see Figure 143).

Figure 143. BCU Editor Setup Screen

2. Select model of modem you have installed in the BCU from the Con-
nect By list. This does not apply to the BMTX because there is only 
one model of modem available.

3. In the Maximum Dialing Attempts field, enter the number of times 
the BCU will attempt to connect with a remote PC Workstation, cell 
phone/pager.

Note:

If the number of dialing attempts is greater than one, the BCU 
will wait five minutes before each attempt to dial the number 
again.
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Configuring a BCU Modem

1. From the BCU Modem editor, click the Configuration tab (see 
Figure 144).

Figure 144. BCU Modem Editor Configuration Screen

2. From the BMTW BCU Comm Port Maximum Speed list, select the 
baud rate that best matches the speed of the modem you have 
installed in the BCU.

The comm port in the BMTX and BMTW BCU has an adjustable 
speed setting. This is because modems are gaining in speed and phone 
lines are clearer, so the speeds at which a workstation or BCU modem 
can connect is increasing as well. To maximize the rate that data can 
be transferred between the BCU modem and the BCU, set the speed 
of the comm port to its maximum value.

Note:

For CE certification, special initialization strings must be used 
based on the international location. See online help for specific 
configuration information.

The Configuration Strings fields display default modem com-
mand strings. However, you can edit the fields to accommodate 
specific modem requirements.
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Setting Up the Phone Books

Use the Phone Book screen to enter and store phone numbers. The work-
station needs phone numbers in the workstation modem editor for remote 
sites. The BCU needs phone numbers in the BCU modem editor for rout-
ing alarms to remote workstations and cell phones/pagers.

The Phone Book screen allows you to:

• Edit existing phone numbers
• Add new phone numbers
• Remove phone numbers

Editing Existing Phone Numbers

1. From the BCU or Workstation Modem editor, click the phone book tab 
to display the Phone Book screen. Figure 145 shows the BCU Modem 
editor’s Phone Book screen (which is slightly different than the Work-
station Modem editor’s Phone Book screen).

Figure 145. BCU Modem Editor Phone Book Screen

2. In the Phone Number field, make changes as necessary to the phone 
number.

3. Make sure the Use Dialing Prefix and Use Calling Card # check boxes 
are set as desired.

Note:

For cell phone support, this phone number is the dial-up 
modem number for your short messaging service center 
(SMSC). This number comes from the cell phone provider.
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4. In the Dialing Prefix field, enter a dialing prefix to be used with all 
phone numbers defined in the phone book (if applicable).

5. In the Calling Card field, enter a long distance calling card number 
that can be used with the defined phone number.

Adding Phone Numbers

1. From the BCU or Workstation Modem editor, click the Phone Book 
tab to display the Phone Book screen.

2. Click the Add Phone Number button. The Add Phone Number dialog 
box displays (see Figure 146 and Figure 147: Workstation Modem Add 
Phone Numbers Dialog Box below).

Figure 146. BCU Modem Add Phone Number Dialog Box

Note:

When dialing out on the modem, the total combined character 
lengths of the dialing string cannot exceed the manufacturer’s 
recommended maximum length. The dialing string for worksta-
tions is comprised of the dialing command (ATDT), the dialing 
prefix, phone number, and calling card number. The dialing 
string for BCUs is the same as the workstations except that the 
BCU might also have a numeric message for digital (numeric) 
cell phones/pagers. The sequence in which the dial string is 
sent in the order listed above.

Note:

Depending on the calling card, a short pause or second dial tone 
may be required before dialing the calling card number. Use 
commas to define a pause (for example: ,,,821-163-2288-6576) 
Use a W to make the modem wait for a second dial tone (for 
example: W 825-163-2288-6576).
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Figure 147. Workstation Modem Add Phone Numbers Dialog Box

3. For BCU modems:

• In the Type field, select the object type the BCU needs to call.
• In the Name field, select the name of the object.

• In the Phone Number field, enter the phone number you want the 
BCU modem to dial when attempting to connect with the selected 
object type (workstation or cell phone/pager).

4. For Workstation modems, in the Phone Number field, enter the phone 
number you want the modem to dial.

5. If you defined a dialing prefix on the Phone Book screen, click the Use 
Dialing Prefix check box to have Tracer Summit send that dialing 
prefix.

6. If you defined a calling card on the Phone Book screen, click the Use 
Calling Card # check box to have Tracer Summit send that calling 
card number.

7. Click OK.

Removing Phone Numbers

1. From the BCU or Workstation Modem editor, click the Phone Book 
tab to display the Phone Book screen.

2. In the Phone Book field, click the left-most column of the number that 
you want to remove. 

3. Click the Remove Phone Number button.
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Setting Security Access for a BCU Modem

1. From the BCU Modem editor, click the Classes tab to display the 
Classes screen (see Figure 148).

Figure 148. BCU Modem Editor Classes Screen

2. Click Security Classes to display the Change Security Classes dialog 
box (see Figure 149).

Figure 149. Change Security Classes Dialog Box

3. Click on the Access field next to each class to grant or deny access. A 
check in the field grants access. No check denies access.

4. Click OK to display the Classes screen.
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Setting Up Cell Phone/Pagers
Tracer Summit software supports communication between a BCU and a 
cell phone/pager. The BCU (equipped with a modem) sends messages to 
the cell phone/pager using a paging service. Tracer Summit uses cell 
phone/paging to notify you of alarms in the system.

Accessing the Cell Phone/Pager Editor

1. From the Setup menu, select Communications, and then select Cell 
Phone/Pager. The Select Cell Phone/Pager dialog box displays (see 
Figure 150).

Figure 150. Select Cell Phone/Pager Dialog Box

2. Select a cell phone/pager and click OK. The Setup screen displays (see 
Figure 151).

Figure 151. Cell Phone/Pager Editor Setup Screen

Note:

See Chapter 6, “Configuring Tracer Summit BCU Sites”, for 
details on how to assign a cell phone/pager as an event receiver
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Creating a New Cell Phone/Pager Object

1. From the Setup menu, select Communications, then select Cell 
Phone/ Pager. The Select Cell Phone/Pager dialog box displays (see 
Figure 152).

Figure 152. Select Cell Phone/Pager Dialog Box

2. Click New. The New Cell Phone/Pager Name dialog box displays (see 
Figure 153).

Figure 153. New Cell Phone/Pager Name Dialog Box

3. Enter a name in the Cell Phone/Pager Name field. Use a maximum of 
32 characters. You must enter a name before you can save the new 
cell phone/pager object. (You can modify the name from the Setup 
screen of the Cell Phone/Pager editor.)
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4. Click OK. The Cell Phone/Pager editor displays (see Figure 154).

Figure 154. Cell Phone/Pager Editor

5. Set up the new cell phone/pager (see “Setting Up a Cell Phone/
Pager”).

Setting Up a Cell Phone/Pager

1. From the Cell Phone/Pager editor, display the Setup screen (see 
Figure 154).

2. In the Protocol field, select the type of cell phone/pager format the 
BCU will use to dial out alarms (either Alpha-Numeric ‘TAP” or Digi-
tal ‘Numeric Only’).

3. Make a selection:

• If the Alpha-Numeric ‘TAP’ button is selected, enter the telephone 
number of the cell phone/pager in the ID (PIN) field. 

• If the Digital ‘Numeric Only’ button is selected, enter a numeric 
code in the Message field. The code should be meaningful to the 
receiver.

Setting Security Access for a Cell Phone/Pager

1. From the Cell Phone/Pager editor, click the Classes tab to display the 
Classes screen (see Figure 155 on page 170).

Note:

If you select Alpha-Numeric ‘TAP, the paging service or the cell 
phone provider’s SMSC must support the TAP communications 
protocol.
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Figure 155. Cell Phone/Pager Editor Classes Screen

2. Click Security Classes to display the Change Security Classes dialog 
box (see Figure 156).

Figure 156. Change Security Classes Dialog Box

3. Click on the Access field next to each class to grant or deny access. A 
check in the field grants access. No check denies access.

4. Click OK to display the Classes screen.
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Chapter 11

Overriding System Values

You can override the system control of the present value property for an 
object by selecting the override control. When the override control is on a 
graphic, you can display status information as to the object’s override 
state, or if you have simplified overrides configured, you can click on the 
graphic and display the simplified override dialog box. This gives you 
information on what system applications are currently controlling the 
object (see Figure 161 on page 175 and Figure 162 on page 175). 

When a “hand” icon is displayed on an override button, it indicates that 
the present value of the object has been manually overridden. To set up 
this feature, see “Displaying Override Status” on page 564.

Figure 157. Manual Override Icon 

The Override button for UCMs is active if the BCU is up and communi-
cating with the UCM and your workstation, and if the UCM is not under 
local control. The Override button for an area object is active if the BCU 
that the area object is saved in is communicating to your workstation.

Note:

The text of the button that displays the Override dialog box is 
specific to your site. The button may, for example, be called 
Override, Control, or another name.
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Setting Up the Simplified Override 

Dialog Box
With the Simplified Override dialog box, the daily operator can change 
the present value of an object from a graphic. First, the simplified over-
ride must be set up before it is available for use in Tracer Summit.

To set up the simplified override dialog box: 

1. From the Site Security editor, click the Functions tab. 

2. In the Access column, click the checkbox for the following functions 
(see Figure 158): 

• Allow Min/Max edit in Simplified Override
• Change Values from Graphics
• User–Priority level 

3. In the Select Default Priority for Simplified Override Dialog drop-
down, select a user default priority level.

Figure 158. Functions tab

Note:

The highest user priority level you select will determine the 
highest user level default override setting available.
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4. Click the Objects tab (see Figure 159).

5. In the Access column, click the checkbox for the following:

• Analog Output
• Binary Output
• The appropriate UCMs

6. Click Save

Figure 159. Objects tab
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Accessing the Simplified Override 

Dialog Box
The Simplified Override dialog box can be only accessed through a 
graphic. You can access it by using either the Override Control button or a 
pop-up menu. With the Simplified Override dialog box you can override 
the present value of:

• Analog outputs
• Multi-state analog outputs
• Binary outputs
• UCMs and applications
• Non-Trane BACnet points

Using the Override Control button

1. In a graphic, click on the Override control button (see Figure 160). 
The Simplified Override dialog box displays (see Figure 161 on 
page 175).

Figure 160. Override control button

Note:

The Override control button only controls present value proper-
ties and does not have the capability to override an area appli-
cation’s lighting values. To override the lighting values, refer to 
“Overriding a Binary Output or a Lighting Value for an Area 
Application” on page 182.

Override control 
button
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Figure 161. Example of a Simplified Override Dialog Box

2. Click the More button to view information about priority arrays (see 
Figure 162). 

Figure 162. Expanded Simplified Override Dialog Box
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Using a Pop-up Menu

1. Right-click on a property in a graphic. A pop-up menu displays two 
override options (see Figure 163): 

• Override <object type> (this is the simplified override option)
• Override using Advance Dialog

2. Select the simplified override option to display the Simplified Over-
ride dialog box. 

Figure 163. Graphic Pop-up Menu

Note:

If you are not set up to use the Simplified Override dialog box, 
only the Advanced dialog box displays. See your Site Security 
Administrator for more information.

Simplified override option
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Using the Simplified Override Dialog 

Box
With the Simplified Override dialog box you can easily override the fol-
lowing: 

• Analog outputs
• Binary outputs
• Multi-state analog outputs
• UCMs
• Non-Trane BACnet points

Overriding an Analog Output

1. Open the Simplified Override dialog from a graphic or the from the 
override button. The Override dialog box displays (see Figure 164).

Figure 164. Analog Output Override Dialog Box 

Note:

When you first open the dialog, the Auto/Manual knob displays 
the control status of the object. Auto means the automation sys-
tem is in control. Manual means that a security user has over-
riden the object.

Note:

Click on the More control button at the bottom of the dialog box 
to display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.
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2. Click on Manual option on the Auto/Manual knob. This enables the 
slider bar and text field.

3. Click in the text field and type a new value. The green indicator in the 
slider bar moves to reflect the new value.

4. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

Changing the Min/Max Output Range 

1. Click on the Edit Min/Max button in the Analog Output Override dia-
log box. The Edit Min/Max dialog box displays (see Figure 165).

Figure 165. Edit Min/Max Dialog Box

2. Type values in the Max Value, Default Value, and Min Value fields.

3. Click OK. The dialog box closes.

To return control back to the BAS, see “Releasing Control Back to the Sys-
tem” on page 186.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.
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Overriding an Analog Output or Analog Value in a Non-

Trane BACnet Device

1. Open the Simplified Override dialog from a graphic or the from the 
override button. The Override dialog box displays (see Figure 166).

Figure 166. Non-Trane Analog Output Override Dialog Box

2. Click in the text field to type a new value.

3. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

Note:

Click the More control button at the bottom of the dialog box to 
display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.
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Overriding a Multi-State Analog Output

1. Open the Simplified Override dialog from a graphic or the from the 
override button. The Override dialog box displays (see Figure 167).

Figure 167. Analog Output (Multi-state) Override Dialog Box

2. Click on the Manual option in the Auto/Manual knob. This enables 
the multi-state slider bar and the Apply button. 

Note:

The analog output (AOP) object must be set up in the editor as 
a multistate object for this view. For more information see “Set-
ting Up Multi-State Values and Assigning Labels” on page 262.

Note:

Click on the More control button at the bottom of the dialog box 
to display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.
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3. Click and drag the indicator in the slider bar to the desired setting.

4. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the Sys-
tem” on page 186.

Overriding a Multi-State Output in a non-Trane BACnet 

Device

1. Open the Simplified Override dialog from a graphic or the from the 
override button. The Override dialog box displays (see Figure 168).

Figure 168. Non-Trane Analog Output (Multi-state) Override Dialog Box 

2. Verify that the Control knob is in the Change to position.

3. Click and drag the indicator in the slider bar to the desired setting.

Note:

Click on the More control button at the bottom of the dialog box 
to display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.
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4. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the Sys-
tem” on page 186.

Overriding a Binary Output or a Lighting Value for an 

Area Application

1. Open the Simplified Override dialog from a graphic or the from the 
override button. The override dialog box displays (see Figure 169).

Figure 169. Binary Output Override dialog box

2. Click on the Manual option in the Auto/Manual knob. 

Note:

Click on the More control button at the bottom of the dialog box 
to display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.
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3. Click the toggle switch to set it to the On state, or click the toggle 
switch to set it to the Off state. With either selection, the On label or 
the Off label will then appear in bold.

4. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the Sys-
tem” on page 186.

Overriding a Binary Output or Binary Value in a  
Non-Trane BACnet Device

1. Open the Simplified Override dialog from a graphic or the from the 
override button. The Override dialog box displays (see Figure 170).

Figure 170. Non-Trane binary Output Override Dialog Box

Note:

The toggle switch labels are defined in the Binary Output  
editor and can be assigned names other than On and Off.

Note:

Click on the More control button at the bottom of the dialog box 
to display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.
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2. Verify the control knob is in the Change to position.

3. Click the toggle switch to set it to the On state, or click the toggle 
switch to set it to the Off state. With either selection, the On or Off 
label will then appear in bold.

4. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the Sys-
tem” on page 186.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.

Note:

The toggle switch labels cannot be edited for non-Trane BACnet 
points. If you wish to edit the labels, create a binary output 
point that references the non-Trane BACnet point. Use the 
Binary Output editor to edit the labels.
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Overriding a UCM or Application

1. Open the Simplified Override dialog afrom a graphic or the from the 
override button. The override dialog box displays (see Figure 171).

Figure 171. UCM Override Dialog Box

2. Click the Manual on the Auto/Manual knob. 

3. Click and drag the indicator in the slider bar to the setting you want. 

4. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

Note:

If you are overriding an application object it must have a 
Present Value property. Area is an example of an application 
with a Present Value property.

Note:

Click on the More control button at the bottom of the dialog box 
to display the Priority Arrays box. To perform an override, your 
default control priority level must be higher than priority level 
listed in the box. If not, refer to “Using the Advanced Systems 
Override” on page 187.

Note:

An error message in red will display in the override details box 
warning you that your access level isn’t high enough to override 
the object. For more options, refer to “Using the Advanced Sys-
tems Override” on page 187.
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To return control back to the BAS, see “Releasing Control Back to the Sys-
tem” on page 186.

Releasing Control Back to the System

To return control back to the BAS after performing an override, do the fol-
lowing: 

Trane Objects

1. In the Simplified Override dialog box, click Auto in the  
Auto/Manual knob.

2. Click OK to close the dialog box, or click Apply to view the updated 
Present Value field and priority arrays.

Non-Trane BACnet devices

1. In the Simplified Override dialog box, click on the Release in the 
Release/Change to knob. 

2. Click OK to close the dialog box, or click Apply to view the updated 
Present Value field and priority arrays.

Note:

Clicking on Auto to release control back to the BAS also 
removes all user overrides from the priority array.

Note:

Clicking Release only releases control at the user’s default pri-
ority level.
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Using the Advanced Systems Override
You can perform overrides using the advanced Override dialog box  
(see Figure 172). However, Trane encourage’s you to define your default 
priority level in Site Security and then override from graphics by using 
the simplifed overrides dialog box (see Chapter 11, “Setting Up the Sim-
plified Override Dialog Box”).

• To override an analog or binary output using the advanced override 
dialog box, see Chapter 17, “Overriding an Analog or Binary Output.”

• To override an area using advanced override dialog box, see Chapter 
20, “Overriding an Area.”

• To override a UCM using advanced override dialog box, see Chapter 
12, “Setting the Overrides for a UCM.”

Figure 172. Advanced Override Dialog box
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Chapter 12

Using UCM Editors

Each unit control module (UCM) supported in the Tracer Summit system 
has an editor that allows you to create or to modify the UCM’s setup. You 
access the UCM editors through the Unit Controllers menu item of the 
Setup menu. 

You can use UCM editors to perform these tasks:

• Create, set up, and configure a UCM on the Tracer Summit system
• View the status of a UCM
• Troubleshoot a UCM

UCM editors share common layouts and functions. This chapter describes 
the typical editing tasks you can perform in UCM editors.

Accessing a UCM Editor
1. From the Setup menu, select Unit Controllers. The list of unit control-

lers displays.

2. Select the name of the unit controller that you want to edit. The 
Select dialog box displays, listing each UCM of the type you selected. 
Figure 173 shows a Select dialog box for a Voyager Rooftop.

Figure 173. Select Dialog Box

Note:

For detailed information about each UCM editor, refer to Tracer 
Summit online help (from any UCM editor, click the Help but-
ton or press the F1 key).
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3. Click on the name of the unit controller you wish to edit.

4. Click OK to display the UCM editor. Figure 174 shows the editor for a 
Voyager Rooftop. For all editors, the Status screen displays when the 
editor is first opened. You can view this screen to monitor the UCM’s 
status.

Figure 174. Voyager Rooftop Editor
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Creating a New UCM
To create a new UCM, you perform these tasks:

• If no UCMs of the appropriate type are defined yet, set up the new 
UCM type (as described in this section)

• Name and set the address of the new UCM (as described in this sec-
tion)

• Set up the UCM (see “Setting Up a UCM” on page 193)
• Configure the UCM, if appropriate (see “Configuring a UCM” on 

page 194)
• Set overrides for the UCM, if appropriate (see “Setting the Overrides 

for a UCM” on page 195)
• Route alarms and events and define security access (see “Routing 

Alarms and Events and Setting Security Access” on page 197)

The following steps show you how to create a new UCM using the Setup 
menu’s Unit Controllers option. You can also create a new UCM while 
configuring a site. For more information, see Chapter 6, “Configuring 
Tracer Summit BCU Sites.”

To create a new UCM:

1. From the Setup menu, select Unit Controllers. The list of defined 
UCM types displays.

2. Make a selection:

• If the appropriate UCM type is listed, select it. The Select dialog 
box displays. Then click New.

• If the appropriate UCM type is not listed, select New UCM Type. 
The Select New UCM Type dialog box displays, listing UCM types 
that have not yet been defined in the site (see Figure 175). Click 
the appropriate UCM type, then click OK.

Figure 175. Select New UCM Type Dialog Box

For both options, the New UCM Name/Address dialog box displays 
(see Figure 176 on page 192).
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Figure 176. New UCM Name/Address Dialog Box

3. In the UCM Name field, enter a unique name for the UCM. Make the 
name as informative as possible. Use a maximum of 32 characters.

You must enter a name before you can save the new UCM. You can 
modify the name at any time from the Setup screen of the UCM edi-
tor.

4. In the BCU field, select a BCU. Only BCUs with compatible links are 
listed.

5. In the Comm. Link field, select a communication link. Only compati-
ble links are listed.

6. In the Address field, select an address for this UCM. Only valid, 
unused addresses are listed.

7. Click OK. The UCM editor specific to the UCM type you have selected 
displays.

8. Set up the new UCM (see “Setting Up a UCM” on page 193).

Note:

You can not create a UCM in excess of the links capacity.
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Setting Up a UCM
The tasks for setting up a UCM vary depending upon the UCM type. In 
general, you can:

• Change the name of the UCM
• Control UCM setpoints
• Change the UCM link and address
• Select or change other setup information

You can make these changes from the UCM editor’s Setup screen. This 
screen contains the fields necessary for Tracer Summit to control the 
UCM. Depending on the type of UCM, there may be other dedicated 
Setup tabs for specific UCM functions. For detailed information on the 
fields of the Setup screen, click the Help button.

To set up a UCM:

1. From the UCM editor, click the Setup tab. Figure 177 shows an exam-
ple Setup screen. The fields vary depending upon the UCM type.

Figure 177. Example Setup Screen

2. Edit the setup information as necessary.

3. To change the UCM link or address, click the Change Address button. 
Make your changes and click OK.
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Configuring a UCM
Most UCM editors have a Configuration screen where you can set UCM 
configuration information. Because this information is stored locally in 
the UCM, you cannot edit the information on the Configuration screen 
when the UCM is offline. For detailed information on the fields of the 
Configuration screen, click the Help button.

To configure a UCM:

1. From the UCM editor, click the Configuration tab. Figure 178 shows 
an example Configuration screen. The fields vary depending upon the 
UCM type.

Figure 178. Example Configuration Screen

2. Edit the configuration information as necessary.
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Setting the Overrides for a UCM 
When you override a UCM from the Overrides tab of a UCM editor, you 
perform the override using the advanced Override dialog box. However, 
Trane encourages you to define your default priority level in Site Security 
and override from graphics by using the simplifed overrides dialog box 
(see “Setting Up the Simplified Override Dialog Box” on page 172). From 
the advanced override dialog box you can:

• Release control at the specific priority
• Change the present value at a specific priority

Overriding the Present Value of a UCM

1. From the UCM editor, click the Override tab. Figure 179 shows an 
example Overrides screen. All UCM editors have an Override button. 
The remaining fields vary depending upon the UCM type.

Figure 179. Example Overrides Screen

Note:

You will need access to change the priority level. Priority con-
trol ranges from 1 (highest) to 16 (lowest). The command with 
the highest priority controls the object. To take control off, you 
must select the Release Control option button. Then the next 
highest priority commands the object.
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2. Click the Override button. The Override dialog box displays with 
Change Value To selected (see Figure 180 on page 196).

Figure 180. Override Dialog Box

3. In the Change Value To list box, select the desired value. For a UCM, 
the available values are: Unoccupied, Optimal Stop, Occupied, Opti-
mal Start, Demand Limit, Duty Cycle, Priority Shutdown, Night 
Economize, and Night Heat/Cool.

4. Click the At Priority list box to select a priority.

5. Click Apply to perform the override. The Priority Array list updates.

6. Click OK to close the Override dialog box.

Releasing Control of a UCM

1. From the UCM editor, click the Override tab.

2. Click the Override button. The Override dialog box displays.

3. Click the Release Control button. The Change Value To button 
becomes inactive and the system selects the highest priority from the 
At Priority list box.

4. Click Apply to release control at the selected priority level. The Prior-
ity Array list updates, or click OK to apply the changes and close the 
dialog box.

Note:

If you need help with overrides, click the Tutorial button (see 
Figure 180 on page 196) to open the Tracer Summit Daily Oper-
ations Tutorial.
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Overriding Other Values in a UCM

1. From the UCM editor, click the Override tab.

2. Edit the override fields as necessary.

3. Click Apply to release control at the selected priority level. The Prior-
ity Array list updates, or click OK to apply the changes and close the 
dialog box.

Routing Alarms and Events and Setting 

Security Access
All UCM editors have a Classes screen where you can assign alarm and 
event routing and set security access for a UCM.

Defining Alarm and Event Routing

1. From the UCM editor, click the Classes tab. Figure 181 shows an 
example Classes screen.

Figure 181. Example Classes Screen

2. In the Control Class field, select a control class. The control class 
defines the event class that will receive an event message when the 
present value of the UCM changes.

3. In each diagnostic field in the Alarm Classes group, select an appro-
priate event class for routing alarms.
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Setting Security Access

1. From the UCM editor, click the Classes tab.

2. Click the Security Classes button. The Change Security Classes dia-
log box displays (see Figure 182).

Figure 182. Change Security Classes Dialog Box

3. Click on the Access field next to each class to grant or deny access to 
the security class. A check in the field grants access. If unchecked, 
permission to the security class is denied.

4. Click OK to close the Change Security Classes dialog box.

Deleting a UCM
You cannot delete a UCM from a UCM editor. Use the Delete Object func-
tion from the Tools menu to delete a UCM (see Chapter 39, “Deleting 
Objects and Sites”).
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Chapter 13

Creating Groups of Sites

Grouping sites allow you to quickly and easily service and monitor large 
numbers of sites. Creating groups is a feature that comes with the Enter-
prise Management package.

With grouping capabilities, you can group sites together and edit sched-
ules or change setpoints once for the group. This saves time because you 
do not have to make the same edit for each site. In addition, with Tracer 
Summit grouping functions, you can:

• Put a site in multiple groups.
• Perform global changes to the groups. These changes can affect all 

sites in the group.
• Use Task Manager to schedule a scan of groups of sites rather than 

scheduling individual site scans.
• Use message forwarding and call centers to organize message for-

warding by site groups rather than individual sites.

Note:

Group configuration does not appear as a selection on the Setup 
menu unless you have both site security and group security 
access. For more information about group security, see “Setting 
Up Group Security” on page 144.
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Creating a Group
Use Group Configuration to put sites into groups. You can also include 
groups of sites within groups.

To create a group:

1. From the Setup menu, select Group Configuration. The Select Group 
dialog box displays (see Figure 183).

Figure 183. Select Group Dialog Box

2. Click New. The Group Configuration dialog box displays (see 
Figure 184).

Figure 184. Group Configuration Dialog Box

3. In the Group name field, type the group name.

Note:

You must create sites before you can add or create groups (see 
“Creating a Site” on page 34).
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4. In the Available Site(s) list, select the desired sites.

5. Click Add to add the sites to the Current Member(s) list.

6. Click Save to save the new group to the database.

7. Click Close.

Modifying Groups
After you create a group, any changes that you make to this group are 
made to all of the site(s) or group(s) of sites in the group.

To modify groups:

1. From the Group Configuration dialog box:

• Click Add to add selected members to the Selected Site(s) list
• Click Remove to remove selected members from the Selected 

Site(s) list

2. Click Save to save the new group to the database.

3. Click Close.

Using Groups to Make Global Changes
Through a global change you can edit or modify the setup of many objects 
of the same type in one action. This means that you do not have to open 
the editor for every object to make a change. For more information about 
making global changes using groups, see “Applying Global Changes to 
Multiple Sites” on page 205.

Sample Scenarios

The following scenarios show how you might use groups to make global 
changes.

Scenario 1

As a building manager for a school district you have to override all of the 
schedules for 15 schools because of weather. To do this, you access the 
Time of Day application and click the Group Select button. You specify 
the “All Buildings” group and select all of the affected schedules. After 
you click OK, the global changes editor for time of day appears.

Note:

Groups of sites display in the Available site(s) list with a “(g)” 
prefix.
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In the editor, you remove all of the start events for the day and click the 
Save As Exception button. When the Download Scheduler dialog box 
appears, you download the changes to the sites immediately. The work-
station scans all of the sites in the database to download the schedule 
exceptions for that day.

Scenario 2

As a manager of several stores you need to change the cooling setpoint for 
the offices in all your stores. You select Area from the Setup menu, then 
click Group Select on the Select Area dialog box. You select the All Stores 
group and select all the office areas. After you click OK, the global 
changes editor for Area appears. On the Setup screen you change the 
occupied cooling setpoint and save your changes. In the Download Sched-
uler dialog box you schedule the changes to download that night at  
2:00 a.m. Later the next morning, the workstation begins a scan task at  
2:00 a.m., scanning all of the sites to download the area setpoint change.

Creating Scan Tasks for Groups
The Task Manager application scans groups that contain BCU sites, 
Tracer 100, or Tracker sites. For details about scanning groups with the 
Task Manager, see “Creating a Task for Groups of Sites” on page 226.

Creating Call Centers for Groups of 

Sites
Call centers allow you to e-mail and send cell phone pager messages for 
alarms and event occurrences to selected recipients. These recipients can 
receive these alarms for groups of sites that you specify in Message For-
warding. For information about sending alarm e-mails for groups of sites, 
see “Selecting a Site/Group from Which Alarms Are Sent” on page 245.

Deleting Groups
Use the Delete Objects utility to delete a group or groups. For more infor-
mation on using the utility, see “Deleting a Site” on page 658.
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Chapter 14

Making Global Changes

To make global changes, you select multiple objects of the same type and 
edit them simultaneously with the editor for that object type. For exam-
ple, you can select specific schedules in groups of sites and edit all the 
schedules in the schedule editor. 

Making changes to single sites is part of the Tracer Summit standard 
software. Making global changes to groups of sites is part of the Enter-
prise Management package.

Using the global change function editor of the object editor, you can 
quickly and simply change many objects in a single site or across numer-
ous sites that are part of groups. The following types of objects allow glo-
bal changes:

• Area
• Binary inputs/outputs
• Analog inputs/outputs
• Time of Day schedules (BCU and Tracer 100)
• Calculated binaries (type 08 points), see “Viewing and Modifying 

BCU Objects” on page 207
• Calculated analogs (type 11 points), see “Viewing and Modifying BCU 

Objects” on page 207
• Thermostat control modules
• Voyager rooftops
• VAV II/III/IV
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Applying Global Changes to a Single 

Site
Use the following procedure to make global changes (such as changing all 
binary outputs) in a single site.

To make global changes to a single site:

1. Log on to the desired site.

2. From the Setup menu, select an object. For example, from the Inputs/
Outputs submenu, select Binary Outputs. The Select Object dialog 
box displays (see Figure 185).

3. Select the objects you want to change at this site.

Figure 185. Select Object Dialog Box: Select Binary Output

4. Click OK. The editor of the object type you selected displays.

5. In the editor, change the desired properties of the object.

For example, from the Binary Output editor, click the Setup tab and 
change the On State Label from On to Enable.

6. Click Save. The editor saves the changes to the objects you selected in 
step 3. The Save Successful dialog box displays.

7. Click OK in the Save Successful to return to the editor.
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Applying Global Changes to Multiple 

Sites
To make global changes to groups of sites, you must have the proper secu-
rity access and groups must already exist (see “Creating a Group” on 
page 200).

To globally change multiple sites:

1. Log on to a site.

2. Select an object type to modify.

For example, from the Setup menu, select Unit Controllers, then 
select Voyager Rooftops. The Select Object dialog box displays.

3. Click the Group Select button. The group-level Select Object dialog 
box displays (see Figure 186).

Figure 186. Select Object for Global Edit Dialog Box

4. In the Available Groups field, select the desired group. The Available 
Objects list displays all the Voyager rooftops that are in the sites 
which are members of the specified group.

Note:

To sort the object list alphanumerically by object name, click 
the Object header.
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5. In the Available Objects in the Group list, select the desired object(s).

6. Click Add to add the object(s) to the Objects selected for editing list.

7. Click OK. The editor for the object type displays.

8. Click the Setup tab.

9. Change any available attribute of the object.

10. Click Save. The Global Changes - Schedule Download dialog box dis-
plays (see Figure 187).

Figure 187. Global Changes - Schedule a Download Dialog Box

11. Select a time to download the changes.

• Click the Download Immediately button to download the changes 
right away.

• Click the Download on button to schedule a date and time to 
download the changes.

12. Click OK. The changes will be sent to the database at the time you 
designated. The Save Successful dialog box displays.

13. Click OK on the Save Successful dialog box to return to the editor.

Note:

When you define a download time, it does not simply download 
the most recent changes. It also downloads any other changes 
that you made to the database.

Note:

To verify that the changes downloaded successfully, check the 
error log.
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Viewing and Modifying BCU Objects
You can upload, download, view, and modify BCU objects. You can glo-
bally change these objects across single sites or across multiple sites con-
taining BCU panels.

You can view these objects online or offline in the editors. You can modify 
them online or upload them to your workstation and then modify them 
through the appropriate editor.

Uploading and Downloading BCU Objects

When you are connected to a BCU site, Tracer Summit downloads any 
changes you make immediately to the BCU. When you change objects 
offline, Tracer Summit downloads the change to the BCU the next time 
that you connect to the site.

If you have installed the Building Management or Enterprise Manage-
ment package, you can schedule the Task Manager to connect to the site. 
See Chapter 15, “Using the Task Manager” for more information.

Accessing the Analog or Binary Editor

1. From the Setup menu, select Inputs/Outputs. Then, select either Ana-
log Output or Binary Output. Figure 188 on page 208 shows an exam-
ple of the Select Analog Object dialog box.

Note:

To change objects across multiple sites, you must have installed 
the Enterprise Management package.

Note:

Task Manager schedules scans, and during this process uploads 
and downloads the correct items.
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Figure 188. Select Analog Object Dialog Box

2. Select the desired object.

3. Click OK. The Analog Output/Binary Output object editor appears, 
with the object name displayed (see Figure 189).

Figure 189. Analog Output Object Editor
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Modifying the Present Value for Analog or Binary 

Objects

The following procedures describe how to override or release analog or 
binary output objects while performing:

• Offline single object overrides
• Offline or online global overrides within a single site
• Offline or online global overrides across multiple sites

Changing the present value of an Analog or Binary Object 

1. From the Setup menu, highlight Input/Output. Then select either the 
Analog Output or Binary Output editor. The dialog box for the object 
displays.

2. Select the object(s) that you want to override.

3. Click OK to display the editor.

4. Click the Overrides tab. The Overrides screen displays (see 
Figure 190).

Figure 190. Overrides Screen

5. Click the Override button. The Override Object dialog box appears 
(see Figure 191 on page 210).

Note:

When performing a global change across multiple sites you can 
override an object at the priority level selected in the At Prior-
ity drop-down list, even if your site level security does not allow 
access to priority level.
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Figure 191. Override Object Dialog Box

6. Click the Change Value to option.

7. For analog output objects, type the desired value in the field. For 
binary output objects, select one of the states listed in the drop-down 
list.

8. To apply the change, select one of the priority levels in the At Priority 
drop-down list. Priority 1 is the highest, priority 16 is the lowest. 

9. Click OK to make the change and close the dialog box.

• If you make the change while connected to the site, the change is 
immediately sent to the panel.

• If you make the change offline, you must connect to the BCU 
panel for the modification to take effect.

Dialog displayed for analog 
outputs

Dialog displayed for 
binary outputs

Note:

The analog or binary output objects may not control to your 
modification if the object is being controlled at a higher priority 
than the one you select.
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Releasing the present value of an Analog or Binary Object

1. From the Setup menu, highlight Input/Output. Then select Analog or 
Binary Output. The dialog box for the object displays.

2. Select the object(s) that you want to release.

3. Click OK to display the editor.

4. Click the Overrides tab. The Overrides screen displays (see Figure 
190 on page 209).

5. Click the Override button. The Override Object dialog box displays 
(see Figure 191).

6. Click the Release Control option. The requested value field (no label) 
is disabled.

7. Select the priority level in the At Priority drop-down box to be 
released. The object will not longer control to the value applied to this 
priority level. Priority 1 is the highest, priority 16 is the lowest.

8. Click OK.

Globally Changing Analog or Binary Output Objects

Modifying the present value of a analog/binary output is the most impor-
tant feature of these editors. There are two likely types of global changes 
that you might make using analog/binary output objects:

• Change the multiple analog/binary output points (turn the lights on 
in all areas, for example) within a single site or across multiple sites.

• Change an analog/binary output object that is in each of several iden-
tical or very closely matched sites and all programmed in the same 
manner. You can change a calculated analog/binary point that is in 
each site using the global change functions.

To globally change objects:

◆ Follow the procedure in “Applying Global Changes to a Single Site” on 
page 204 or “Applying Global Changes to Multiple Sites” on page 205.

Note:

If you make the change offline, you must connect to the BCU 
panel for the modification to take effect.
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Viewing and Modifying Calculated 

Analog and Binary Objects
You can upload, download, view, and modify calculated analog and binary 
objects if you have installed the Tracer 100/Tracker Communication pack-
age. You can globally change these objects across single sites or across 
multiple sites containing Tracer 100 panels.

You can view these objects online or offline in the editors with the termi-
nal emulation screen (see the section on terminal emulation in the Daily 
Operations guide). You can modify them online or upload them to your 
workstation and then modify them through the appropriate editor.

Calculated binary and analog objects are only used by Tracer 100 series 
panels. Calculated binaries (point type 08) and calculated analogs (point 
type 11) are similar to binary and analog inputs/outputs, but they are not 
associated with hardware. See Tracer 100 Series Programming Guide 
(EMTB-PG-11) for more information about calculated binaries and ana-
logs.

Uploading and Downloading Calculated Binary/Analog 

Objects

To view calculated binary/analog objects with their editors, you must first 
upload them from the Tracer 100 panel. Uploading occurs as part of nor-
mal processing when you connect to a Tracer 100 site. 

When you are connected to a Tracer 100 panel, Tracer Summit downloads 
any changes you make immediately to the panel. When you change 
objects offline, Tracer Summit downloads the change to the panel the 
next time that you connect to the site.

If you have installed the Building Management or Enterprise Manage-
ment package, you can schedule the Task Manager to connect to the site. 
See Chapter 15, “Using the Task Manager” for more information.

Note:

To change objects across multiple sites, you must have installed 
the Enterprise Management package.

Note:

Task Manager schedules scans, and during this process uploads 
downloads the correct items.
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Accessing the Calculated Binary or Analog Editor

1. From the Setup menu, select Calculated Binary or Calculated Analog. 
The select object dialog box appears (see Figure 192).

Figure 192. Select Calculated Object Dialog Box

2. Select which object you want to check.

3. Click OK. The calculated object editor appears, with the object dis-
played (see Figure 193).

Figure 193. Calculated Object Editor
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Modifying Calculated Binary or Analog Objects

Use the following procedures to override or release calculated binary or 
analog objects. When you are connected to the Tracer 100, access the cal-
culated analog or binary object through terminal emulation or through 
the Tracer Summit editors. Any changes you make to the object are sent 
immediately to the Tracer 100 panel.

When you are offline, you can access calculated analog or binary object 
status only through the editors. Since Tracer Summit is not connected to 
the Tracer 100, the editor does not display the alarm condition of the 
point, but it does display the last-known values. To have your changes 
take effect, you must connect to the panel (see “Uploading and Download-
ing BCU Objects” on page 207).

Modifying the Calculated Binary or Analog Object through 

Terminal Emulation

1. Connect to the Tracer 100 site using the procedure for terminal emu-
lation described in the Daily Operations guide.

2. Modify the object.

If you want to use the terminal emulation menus to change the object, 
follow the procedures described in the Tracer 100 Series Operator’s 
Guide (EMTB-OG-15).

Overriding the Calculated Binary or Analog Object through the 

Editor

1. From the Setup menu, select Calculated Binary or Calculated Analog. 
The object dialog box appears.

2. Select the object that you want to override.

3. Click OK.

4. Click the Overrides tab. The Overrides screen displays (see 
Figure 194).

Figure 194. Overrides Screen

5. Click the Override button. The Override Object dialog box displays 
(see Figure 191 on page 210).
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Figure 195. Override Object Dialog Box

6. Click the Change Value to button.

7. Position the cursor in the field (the unlabeled field next to the Change 
Value to button. Type the desired value.

8. Click OK to make the change and close the dialog box or click Apply to 
make the change but keep the dialog box open.

• If you make the change while connected to the Tracer 100, the 
change is immediately sent to the panel.

• If you make the change offline, you must connect to the panel for 
the modification to take effect, (see “Uploading and Downloading 
BCU Objects” on page 207).

Releasing a Calculated Binary or Analog Object 

through the Editor

1. From the Setup menu, select Calculated Binary or Calculated Analog. 
The select object dialog box appears.

2. Select the object that you want to release.

3. Click OK.

4. Click the Overrides tab. The Overrides screen displays (see Figure 
190 on page 209).

5. Click the Override button. The Override Object dialog box appears 
(see Figure 191).

6. Click the Release Control button The requested value field (no label) 
is disabled.

7. Click OK or Apply.
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• If you make the change while connected to the Tracer 100, the 
change is immediately sent to the panel.

• If you make the change offline, you must connect to the panel for 
the modification to take effect, (see “Uploading and Downloading 
BCU Objects” on page 207).

Globally Changing Calculated Binary or Analog Objects

Modifying the present value of a calculated analog/binary is the most 
important feature of these editors. There are two likely types of global 
changes that you might make using calculated analog/binary objects:

• Change multiple calculated analog/binary points (turn the lights on 
in all areas, for example) within a single site or across multiple sites.

• Change a calculated object that is in each of several identical or very 
closely matched sites and all programmed in the same manner. You 
can change a calculated analog/binary point that is in each site using 
the global change functions.

To globally change calculated objects:

Follow the procedure in “Applying Global Changes to a Single Site” on 
page 204 or “Applying Global Changes to Multiple Sites” on page 205.
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Chapter 15

Using the Task Manager

Task Manager helps you automate tasks to reduce the time it takes to 
maintain a site or groups of sites. Task Manager lets you schedule BCU, 
Tracer 100, or Tracker site backups, archive the event log, or scan sites to 
occur whenever your workstation is on.

With Task Manager, you can change site information offline and schedule 
these changes to download to specific sites or groups at night, when tele-
phone rates are low. If you have a large number of sites that require 
extensive changes, you can schedule these for non-work hours, saving this 
time for other duties.

The Task Manager is part of the Building Management and Enterprise 
Management packages. These add-ons to Tracer Summit enable you to 
create tasks for hundreds or even thousands of separate sites from a cen-
tral location.

The Task Manager lets you:

• Download during a scan the offline global changes that you made to 
any of the site types

• Schedule automatic scans for BCU sites, as well as Tracer 100 and 
Tracker sites (if you have the Tracer 100/Tracker Communication 
package).

• Schedule site backups that you can use to restore sites at a later date
• Schedule regular archives of the workstation event log
• Edit existing tasks to modify schedules, actions, or site members
• Schedule one-time events or repeating tasks
• Initiate manual scans on the site you are connected to
• Log scan errors in Task Log. (For more information, see the sections 

on the event log in the Daily Operations guide)
• Perform operations on the workstation while scans and other tasks 

are being run
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Defining the Four Tasks
Task Manager can perform a task for a site at a time that you schedule or 
perform the task immediately. The four tasks that Task Manager can per-
form include:

• Archiving the event log
• Backing up sites
• Scanning sites
• Panel backups

Archiving the Event Log

With Task Manager you can schedule the automatic archiving of the 
event log as it exists for each site in your workstation database. The infor-
mation is stored as a Microsoft Excel-compatible file format. You can 
import this file into Microsoft Excel to view it.

With Task Manager you can also archive the event log as a text file, as 
well as specify where the archive is stored in the Tracer Summit backup 
folder.

Backing Up Sites

Task Manager performs immediate or scheduled backups of BCU and 
Tracer 100. This function makes a copy of the information from your 
workstation database for BCU or Tracer 100 sites. A BDB file is created 
for each of the selected sites.

The backup files can be saved to any location that you specify.

Scanning Sites

During a site scan, Tracer Summit connects to a site and downloads 
changes to the site and collects information from the site.

Task Manager can scan Tracer Summit BCU sites, as well as Tracer 100 
and Tracker sites (if you have the Tracer 100/Tracker Communication 
package).

During a site scan, Tracer Summit uploads or downloads site informa-
tion. For BCU sites, Task Manager uploads all object types. For Tracer 
100 or Tracker sites, Task Manager uploads schedules, alarms, holidays, 
and calculated binary/analog objects.

During a site scan, Task Manager also determines whether you have 
made offline changes to the site. If you have changed a site’s information 
at the workstation, Task Manager downloads this information to the 

Note:

The Tracer Summit site scan is similar to the scan function of 
Building Management Network (BMN) software. Task Man-
ager, however, does not perform the reporting functions during 
scans that BMN software does.
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panel first. If you have not made offline changes, Task Manager uploads 
the panel information.

Panel Backups

During a panel backup, Tracer Summit connects to Tracer 100 sites and 
creates a backup file of the panel’s database. If a Tracer 100 site has mul-
tiple panels linked to it, Tracer Summit creates separate .SAV files for 
each panel.

This backup creates a .SAV file, which you can use to restore the panel 
(see “Restoring a Tracer 100 Panel” on page 668). You cannot, however, 
use this file to restore the panel information to your workstation data-
base. You can only use .BDB files to restore site information to the work-
station database.

Note:

If you want to back up individual panels of a site, use the 
Backup a Remote selection from the Setup menu. For more 
information, see “Creating .SAV files for Tracer 100 Panels” on 
page 412.
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Accessing the Task Manager Schedule 

Screen
◆ From the Setup Menu, select Task Manager. The Task Manager 

Schedule screen appears (see Figure 196).

Figure 196. Task Manager Schedule Screen
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Run Immediate Scan on a Single Site
Run an immediate scan on a single connected site when you need to 
upload or download site information right away. For example, a facility 
manager for a school building may need to run an immediate scan to 
download a schedule for a change due to weather. You might also run an 
immediate scan to back up a site before performing global changes.

If you have installed the Building Management or Enterprise Manage-
ment package, you can run immediate scans on BCU sites. You can scan 
Tracer 100 or Tracker sites if you have installed the Tracer 100/Tracker 
Communication package and either Building Management or Enterprise 
Management.

To run an immediate scan on a single site:

1. From the Task Manager Schedule screen, click the Run Immediate 
button. The Select Task dialog box displays (see Figure 197).

Figure 197. Select Task Dialog Box

2. Select the desired task:

• Select Archive Event Log to create a backup of the workstation’s 
alarms and events as they exist in the database

• Select Site Backup to create a .BDB file for the site
• Select Site Scan to upload information from the site or download 

changes made to the site offline in Tracer Summit
• Select Tracer 100 panel backup to create a .SAV file for a Tracer 

100 site and all of its linked panels
3. Click OK to run the task. The word “Scan” appears in a blue box in 

the lower right-hand corner of the screen.

When the task ends, the scan indicator on the status bar disappears.

Note:

For more information about running an immediate scan on 
groups of sites after making global changes, see “Applying Glo-
bal Changes to Multiple Sites” on page 205.
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To access the Scan Status dialog box, double-click the blue box on the 
status bar. The Scan Progress dialog box appears.

Creating a Task for a Single Site
Use the following procedure to schedule a task for a single site. Tasks you 
can schedule include archiving the workstation event log, backing up 
sites of panels, and scanning Tracer 100, Tracker, or BCU sites (see 
“Defining the Four Tasks” on page 218).

With the Task Schedule Wizard, you can specify the start time and date of 
these tasks. You can schedule a task as a once-only task, or schedule it to 
occur on a daily, weekly, monthly, or other specified time interval.

To create a task for a single site:

1. From the Task Manager Schedule, click the New Task button. The 
Welcome dialog box of the Task Schedule Wizard (1 of 4) appears.

2. Click Next. The Recurring Type screen (2 of 4) of the Task Schedule 
Wizard displays.

3. Select the interval at which the task should occur:

• Click the Once button if the task will occur just once
• Click the Daily button if the task will occur every day, beginning 

with the start date
• Click the Weekly button, if the task will occur at weekly intervals
• Click the Monthly button if the task will occur at specific times in 

a month
• Click Specified Time Interval if the task must occur intermit-

tently
4. Click Next. Screen 3 of 4 of the Task Schedule Wizard appears (see 

Figure 198 on page 223).

5. On Screen 3 of 4, select the appropriate data:

• On the once screen, select the start time and schedule start
• On the daily screen, select the start time, how often to perform 

the task, and the effective period
• On the weekly schedule, select the start time, the days of the 

week, how often, and the effective period
• On the monthly schedule, select the start time, the days of the 

month, how often, and the effective period

Note:

To verify that the changes downloaded successfully, check the 
error log.
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• On the time interval screen, select the start time, time interval, 
and effective period

Figure 198. Task Schedule Wizard: Weekly (3 of 4)

6. Click Next. The Task Schedule Wizard Summary screen (4 of 4) 
appears. Confirm that the task schedule is correct.

7. Click Finish. The Task Setup dialog box displays (see Figure 199 on 
page 224). Summary information from the Task Schedule Wizard 
appears in the Schedule field and the cursor is blinking in the 
Description field.

Note:

“Every 1 weeks” means every week. “Every 2 weeks” means 
every other week, and so on.
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Figure 199. Single Site User Task Setup Dialog Box

8. In the Description field, type a task description. 

The description that you type appears in the Task Manager Schedule 
field after you save the task.

9. Select the type of task you want to perform:

• Click the Workstation Tasks button to perform a workstation 
task.

• Click the Site Tasks button if you want to perform a site task.

10. Select the specific task you want to perform:

• Click the Archive Event Log check box to archive the event log. To 
save the archive as a text file, perform the procedure in “Saving 
the Event Log Archive File” on page 228.

• Click the Tracer 100 panel backup check box if you want to create 
a .SAV file for a Tracer 100 site. If you want to save the file in a 
specific location, perform the procedure in “Specifying Where to 
Save a Backup File” on page 229.

• Click the Site Backup check box if you want to create a .BDB file 
for a site. If you want to save the file in a specific location, perform 
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the procedure in “Specifying Where to Save a Backup File” on 
page 229.

• Click the Site Scan check box if you want to scan the site to 
upload data from the site or download changes you have made 
offline.

• If you desire, click both the Site Backup and Site Scan check 
boxes. Note, however, that if you have made offline changes to the 
site, these will download first. Beyond this, there is no order in 
which the task runs. If you require, for example, that the site be 
scanned first and then backed up, schedule these items as sepa-
rate tasks in the order you want them to run.

11. If you are backing up a site or scanning a site, in the Available Site(s) 
list, select the site that you want create the task for.

12. Click Add to add the site to the Selected Site(s) list.

13. Click OK. The Task Setup dialog box closes and the Task Manager 
Schedule displays.

14. Click Save. The new task is saved to the workstation database and 
displays in the Task Manager Schedule (see Figure 200).

The task runs at the time you schedule.

Figure 200. Task Manager Schedule Screen with a Task

Note:

The task does not appear in the Task Manager Schedule until 
you click Save. To verify that the changes downloaded success-
fully, check the error log.
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Creating a Task for Groups of Sites
Task Manager makes maintaining groups of sites easier, more effective, 
and more efficient. You can back up groups of sites and scan them to 
upload information or download changes that you made to them offline. 
You can also create .SAV files for an entire site or groups of sites, includ-
ing all the panels linked to them.

With the Task Schedule Wizard, you specify the start time and date of the 
task. You can schedule a task as a once-only task, or schedule it to occur 
on a daily, weekly, monthly, or other specified time interval.

To create a scan task for groups of sites:

1. Repeat steps 1 through 10 in “Creating a Task for a Single Site” on 
page 222.

2. In the Available Site(s) list, select the sites and/or groups that you are 
creating the task for.

3. Click Add to add the sites and/or groups to the Selected Site(s) list.

4. Click OK. The Task Setup dialog box closes and the Task Manager 
Schedule displays.

5. Click Save. The new task is saved to the workstation database and 
displays in the Task Manager Schedule.

At the scheduled time, the task runs.

Note:

See Chapter 14, “Making Global Changes” for procedures for 
global changes and scheduling them to be downloaded to groups 
of sites.

Note:

When you assign a group to a scheduled task, all sites that are 
members of the group when the task runs are included in the 
task. Use the Group Configuration dialog box to add or remove 
sites from the group after you have created the task (see “Creat-
ing a Group” on page 200). In this way, sites that are added to a 
group after you schedule the group for a task are included when 
the task runs.

Note:

The task does not appear in the task manager schedule until 
you click Save. To verify that the changes downloaded success-
fully, check the error log.
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Modifying Tasks
Use the following procedures to modify Tracer Summit tasks created with 
Task Manager.

Editing a Task

1. From the Task Manager Schedule, double-click the task you want to 
edit in the Task Manager Schedule. The Task Setup dialog box dis-
plays the description, schedule, task actions and site assignments for 
the edited task.

2. From this screen, you can perform the following:

• Change the description for the task
• Click Edit Schedule to modify the timing of the task
• Select different tasks and/or task options
• Add and/or remove sites from the scheduled task

3. After you edit the task, click OK to display the Task Manager Sched-
ule.

4. Click Save. The edited task is saved to the workstation database and 
displays in the Task Manager Schedule.

Deleting a Task

1. From the Task Manager Schedule, click the task you want to delete in 
the Task Manager Schedule view. The selected task is highlighted.

2. Press the Delete key.

3. Click Save. The task you selected and all further occurrences of it are 
removed from the system.
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Saving the Event Log Archive File 
Use the following procedure to save the event log archive as a text (.TXT) 
file or Microsoft Excel file.

To save the eventlog archive file in a specific format:

1. After selecting the archive event log option, click in the Archive 
Eventlog cell. A button with three dots (ellipsis) displays (see 
Figure 201).

Figure 201. Archive Event Log Button with Three Dots

2. Click the button with three dots. The Archive Options dialog box 
appears (see Figure 202).

Figure 202. Archive Options Dialog Box

3. Select the file format to save the file in:

• Click the Excel Format button to save the archive as a Microsoft 
Excel file

• Click the Text Format button to save the archive as a text file
4. In the Path field, specify the folder on your hard drive where you 

want to save the file.

Click the Browse button to select a path using the Microsoft Browse 
for Folder dialog box.

5. Click OK to save your selection. The Archive Options dialog box dis-
appears and the Task Manager Schedule becomes available again.

6. Continue programming the task.
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Specifying Where to Save a Backup File
Use the following procedure to select where the site backup is saved.

To save the site backup file in a specific folder:

1. After selecting the Site Backup or Tracer 100 panel backup option, 
click in the cell. A button with three dots (ellipsis) displays (see 
Figure 203).

Figure 203. Site Backup Button with Three Dots

2. Click the button with three dots. The Site Backup Options dialog box 
appears.

Figure 204. Site Backup Options Dialog Box

3. In the Path field, specify the folder on your hard drive where you 
want to save the file.

Click the Browse button to select a path using the Microsoft Browse 
for Folder dialog box.

4. Click OK to save your changes.

5. Continue programming the task.

Note:

When changing Panel Backup options, the Site Backup Options 
dialog box appears (see Figure 204).

Note:

The default save location for backup files is the  
\Tracer Summit\Backup directory.
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Chapter 16

Message Forwarding and  
Call Centers

Message forwarding enables a Tracer Summit workstation to forward 
alarms at scheduled times to a group of e-mail addresses or to individu-
als. Recipients who are on-call can receive the e-mails on their PCs or on 
e-mail enabled pagers and cell phones.

The basic features of message forwarding are set up in System Options 
(see “Setting Up the Events Printer, Message Forwarding, and Event Log 
Settings” on page 569). More advanced features are set up in the Message 
Forwarding editor. These advanced features are only available in the 
Building Management and Enterprise Management packages. This chap-
ter only discusses these advanced features

.

Note:

Tracer 100 and Tracker sites are available when you have the 
Tracer 100/Tracker Communications package installed, as well 
as either the Building Management or Enterprise Management 
packages.

Note:

Once set up, message forwarding and call centers work in the 
background. Message forwarding will send out alarm messages 
even when you are not logged onto a site, but, Tracer Summit 
must be running, and your PC must be logged in to your com-
pany’s mail server or your PC modem line must not be busy.
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What is a Call Center
A call center is a group of e-mail recipients. To better visualize how a call 
center works, think of a call center as a control room with Tracer Summit 
workstations, an operator, and one or more BAS recipients who are on- or 
off-site.

When working with call centers and message forwarding, remember the 
following:

• Message forwarding works with valid e-mail programs that support 
Messaging Application Programming Interface (MAPI) profiles. For 
example, a valid e-mail program is Microsoft Outlook but not 
Microsoft Outlook Express.

• The Tracer Summit workstation program communicates with a mail 
server. This server can be a LAN server or a modem-based, dial-in 
Internet service provider (ISP) server. If the mail server is a dial-up 
service, the Tracer Summit workstation dials up, sends the e-mail, 
and then closes the connection.

Background Considerations
Important issues you should remember when setting up message for-
warding and call centers for Tracer Summit BCU, Tracer 100, and 
Tracker sites are the setup processes for message forwarding and call cen-
ters, as well as preliminary setup issues.

Previewing the Message Forwarding Setup Process

There are two main stages to setting up the forwarding of alarms by 
means of e-mail. Figure 205 on page 234 provides an overview of the mes-
sage-forwarding setup process.

• Set up e-mail services—This is the responsibility of your informa-
tion services (IS) department. The IS person sets up a mailbox on a 
mail server used by the Tracer Summit software. The mailbox resides 
on the server.
Every valid user of the Tracer Summit message forwarding applica-
tion must have access to this mailbox. Also, the IS person must set up 
client-side access to this mailbox e-mail account profile in the Tracer 
Summit workstation.

A user profile is a group of settings that define how a mailbox is set 
up for a particular user. For example, a profile may include access to a 
mailbox on Microsoft Exchange Server and specify that the Outlook 
Address Book appear in the Address Book dialog box. A profile can 
contain any number of information services. 

Generally, you only need one user profile. If you sometimes need to 
work with a different set of information services, it may be helpful to 
create an additional profile to use those services. If more than one 
person uses the same computer, each person should have a separate 
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profile to keep personal items secure. Tracer Summit uses the profile 
to send alarms to the mail server.

• Set up e-mail message forwarding—This includes setting up the 
call center and recipient in the Tracer Summit software. While the 
facility is unattended, you can send cell phone pager alarms that orig-
inate from sites as e-mails to on-call recipients.
• The call center forwarding schedule displays the times when the 

call center forwards alarms to various recipients by means of 
their e-mail addresses. A typical schedule for alarm forwarding is 
between 5 p.m. to 8 a.m., Monday to Friday, and all day on week-
ends and holidays.

• The recipient on-call schedule is the time when an on-call recipi-
ent receives the e-mails. In a typical work situation, recipients 
are on-call on a rotating basis. When setting up a call center, 
make sure that the unattended hours of the facilities are covered.

• In Figure 205 on page 234, the Select Sites/Groups and Event 
Classes/Priorities boxes represent steps in which you specify 
which sites or groups and what alarms need to be forwarded. 
Besides sites and groups, you can schedule alarms for BCU event 
classes and alarm priorities for Tracer 100 or Tracker panels.

IMPORTANT
Your workstation must be set up as an event receiver in BCU sites, with 

a telephone number defined in Tracer 100 and Tracker sites, and other 

requirements for alarms must be satisfied, as described in Chapter 6, 

“Configuring Tracer Summit BCU Sites.”
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Figure 205. Setting Up Message Forwarding Flowchart

Preliminary Issues to Consider before Creating a Call 

Center

Before creating message-forwarding call centers, review the following 
information:

• Each call center has its own forwarding schedule. Therefore, you 
must create multiple call centers when the same recipient needs to 
receive alarms from specific event classes or priorities on different 
schedules.

• When you route e-mails to a pager service, the length of the message 
might be truncated to meet the specifications of the cell phone pager. 
The Tracer Summit software sends the message in such a way that 
the most important information is carried in the first part of the mes-
sage. How the message is truncated depends on the pager company 
and its policies.
For example, the following message: “TRANEBAS: 12/31/01 
11:59AM, 1234567890, Ack Reqd, UCM Diagnostic, Ipak-1” 

Set Up 
E-mail 

Services

Set up mailbox on server
Set up e-mail account profile on client 
(Tracer Summit workstation)

Set Up 
Schedules

Select Sites/ 
Groups

Select Alarm 
Priorities

Setup 
Complete

Set up call center’s recipient schedule
Set up recipient on-call schedule
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might be truncated to: “TRANEBAS: 12/31/01 11:59AM, 
1234567890.”

• Message forwarding information is stored only in the workstation 
where you create it. This information never goes to the BCU or to 
other workstations on the site. Therefore, configure each workstation 
with its own alarm forwarding schedules.

• Some mail servers require that you be logged in to the client worksta-
tion operating system to communicate with the server. If your mail 
server requires this, then you must meet this requirement before and 
after setting up the message forwarding application.

To access message forwarding and call center features, your security set-
tings must include the following:

• You have security access to the System Options editor to select an e-
mail profile.

• In client and server side e-mail services you have an e-mail profile set 
up. This profile is related to the address that appears in the From 
field in your e-mails.

• You have security access to the Message Forwarding editor (see 
“Assigning Access to Applications” on page 141).

Call Centers and Groups

You cannot create or edit groups from within the Message Forwarding 
editor. If you need to forward alarms from groups, then you must have the 
Enterprise Management package installed and defined groups along with 
their site members in Group Configuration. For more information about 
group configuration, see Chapter 13, “Creating Groups of Sites”.
BMTX-SVP01B-EN 235



Message Forwarding and Call Centers
Accessing the Message Forwarding 

Editor
1. From the Setup menu, select Message Forwarding. The Select Call 

Center dialog box displays (see Figure 206).

Figure 206. Select Call Center Dialog Box

2. Select the desired call center.

3. Click OK. The Message Forwarding editor displays (see Figure 207).

Figure 207. Message Forwarding Editor Screen Recipient Schedule 

Screen
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Setting Up Call Centers and Message 

Forwarding

If you have the Building Management or Enterprise Management pack-
age installed, you can set up call centers and advanced message forward-
ing for selected users, as well as to schedule when e-mails are sent and 
the types of alarms for which e-mails are sent.

To create a call center you:

• Add recipients and schedule when they should receive e-mails on the 
Recipient Schedule screen

• Schedule the on-call hours of the facility on the Forward Schedule 
screen

• Define the sites and/or groups for which the e-mails should be sent on 
the Sites screen

• Define the alarm classes for which you want e-mails sent to recipients 
on the Event Classes screen

Registering E-Mail Profiles

When you first access message forwarding, you must register your user 
profile. A user profile is a group of settings that define how the mail 
server is set up for a particular user. For example, a profile may include 
access to a mailbox on Microsoft Exchange Server and specify that the 
Outlook Address Book appears in the Address Book dialog box.

To register e-mail profiles:

1. From the Setup menu, select Message Forwarding. The Select Profile 
dialog box appears. One or more user profiles display in the Profile 
list box.

If the Tracer Summit software does not detect an already existing 
user profile, an error dialog box appears. If a profile is loaded but no 
profile is registered, the software prompts you to select a profile.

2. Select a profile.

3. Click OK. The Select Call Center dialog box appears.
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Creating a Call Center

When you create a call center you add recipients who will receive alarm  
e-mails during on-call hours. On the Recipient Schedule screen you spec-
ify the days and dates when each recipient should receive e-mails from 
Tracer Summit.

To create a call center:

1. From the Setup menu, select Message Forwarding. The Select Call 
Center dialog box displays.

2. Click New.

3. Type the call center name in the Select Call Center dialog box.

4. Click OK. The Message Forwarding editor launches. The name of the 
call center displays at the top of the screen.

5. To add recipient(s), click the Recipient Schedule tab. The Recipient 
Schedule screen appears (see Figure 208).

6. Click Add. The address book of the e-mail program, such as an Out-
look Address Book, displays.

7. Select one or more e-mail addresses to which to send alarms.

8. Click OK. The names of the recipients display in the list on the Recip-
ient Schedule screen (see Figure 208).

Figure 208. Recipient Schedule Screen

Note:

To save a call center you must first add recipients and schedule 
when they should receive e-mails.
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Scheduling When Recipients Receive E-mails

Next, schedule when recipients receive e-mails. Each recipient can have a 
different schedule when they are on-call.

To schedule when recipients receive e-mails:

1. From the Message Forwarding editor, click the Recipient Schedule 
tab.

2. Select the name of a recipient in the list.

3. Click the Schedule button. The Recipient Schedule dialog box dis-
plays (see Figure 209).

4. Select the schedule start date, how often the e-mail should be sent 
(once or daily), and how often the schedule should occur (weekly, daily 
or monthly). 

For example, in Figure 209 the recipient schedule is set up to: specify 
May 27, 2003 as the Start Date; indicate the day of the week the e-
mail is sent; repeat every two weeks.

Figure 209. Recipient Schedule 

5. Click OK to save the schedule. The recipient’s name, e-mail address, 
start date, and schedule display in the recipients Schedule screen.

6. Click Save to store the recipients and their e-mail schedules to the 
database.
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Testing E-mail Forwarding

Use this procedure to verify that Tracer Summit can send an e-mail to the 
recipients selected in the list of the current call center.

To send the e-mail, the Tracer Summit software:

• Uses the profile that is registered with Tracer Summit
• Uses the mailbox that is set up on the mail server. IS sets up the pro-

file to access this mailbox

To test e-mail forwarding:

1. From the Message Forwarding editor, click the Recipient Schedule 
tab.

2. Select the recipient(s) that you want to receive the test e-mail.

3. Click the Test Email button. The Tracer Summit software sends the 
test e-mail.

The e-mail contains the following message: “This is a test of the Test 
Email button.”

4. Verify with the recipients that they received an e-mail message from 
Tracer Summit.

Checking the Schedule of Existing Recipients

Use this procedure to check the e-mail forwarding schedules of recipients. 
You can also use it to make sure that a date for receiving e-mails is cov-
ered by one or more recipients.

To check the schedule for existing recipients:

1. From the Message Forwarding editor, click the Recipient Schedule 
tab.

2. Select one or more recipients in the grid whose message forwarding 
schedules you want to check.

3. Click the Check Schedule arrow next to the Check Schedule button 
and select the date you want from the calendar (see Figure 210).

Figure 210. Check Schedule Calendar

4. Click the Check Schedule button. A dialog box displays indicating if 
the selected recipient receives e-mail on the date you specified in step 
3.
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5. Click OK.

Creating a Message Forwarding Schedule

You can regard the Forward Schedule as representing the times when a 
facility is open and not open. When the facility is not open, you want to 
forward alarm messages to on-call recipients.

On the Forward Schedule screen, specify the operating hours of the call 
center. Define the start time when e-mails should be sent and the end 
time.

For example, a normal work day is from 8 a.m. to 5 p.m. These are the 
times when people are on-site. After-hours is from 5 p.m. to 8 a.m. During 
after-hours, the individuals designated to receive e-mails on the Recipient 
Schedule screen will receive any alarm messages generated.

To schedule when e-mails are sent:

1. From the Message Forwarding Editor, click the Forward Schedule tab.

2. In the schedule, click the cell that corresponds to the time and day 
you want the e-mail forwarding schedule to start. Select Set Start 
from the pop-up menu.

3. Click in the cell when you want the schedule to end and select Set 
End (see Figure 211 on page 242).

The cell set as Set Start is bright green and is labeled Start. The cell 
set as Set End is red and is labeled End. The cells in between these 
two cells are blue.
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Figure 211. Forward Schedule Screen

4. Repeat steps 2 and 3 to complete the schedule for any remaining 
weekdays and weekends.

5. Click Save.

Setting a Holiday Schedule

Setting up a holiday schedule is a two-step process. First, add holiday 
dates to the Selected Dates list box. Then, go into each call center and 
check the Send e-mail checkbox (see Figure 212 on page 243).

To add holidays:

1. Click the Edit button to display the Select Dates dialog box.

2. Select the holiday date from the calendar.

3. Click the Add Date button to add the date to Selected Dates list.

4. Click Save to save the holiday date to the list.

5. Click Okay to return to the editor. 

Note:

It doesn’t matter which call center you are in when you add 
dates to the list, the date will become a holiday for all call cen-
ters. However, each call center can decide whether to observe 
the holiday dates or not, depending on whether the Send e-mail 
checkbox is checked or unchecked.
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Figure 212. Holiday Calendar

To remove holidays

1. Click the Edit button to display the Select Dates dialog box.

2. From the Selected Dates list, select the holiday you want to remove.

3. Click the Remove Date button to delete the date.

4. Click Save to save your changes.

5. Click Okay to return to the editor.

To send e-mail on holidays:

◆ To have e-mail automatically sent on holidays, check the send e-mail 
check box (See Figure 212). 

To disable sending e-mail on holidays:

◆ Clear the send e-mail checkbox. The holiday schedule is disabled.

Send e-mail checkbox

Note:

The holiday date is removed from all call centers.

Note:

If you check this box, the call center will send e-mail on all holi-
days displayed in the list box. If you leave this box unchecked, 
no e-mail will be sent on any of the holidays.

Note:

Disabling the holidays only applies to the currently open call 
center. To disable holidays for other call centers, open each one 
individually and repeat step 1 above.
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Forwarding Alarms at All Times

You can have e-mails for alarm events sent at all hours of the day. This 
may prove useful when you need to override the call center schedule. 

To forward alarms at all times:

1. From the Message Forwarding editor, click the Forward Schedule tab.

2. Click the Forward At All Times check box (see Figure 213).

Figure 213. Forward at All Times Check Box

When alarms are forwarded at all times:

• Any previously specified forwarding schedule is overridden and  
e-mails are sent 24 hours a day, seven days a week.

• The schedule grid is unavailable.
• The Call Center Holiday list box is unavailable.
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Selecting a Site/Group from Which Alarms Are Sent

If you have the Tracer 100/Tracker Communication, Building Manage-
ment, or Enterprise Management package installed, after you define 
recipients and set up schedules, you need to select the sites or groups 
from which e-mails for alarms will be sent. You can only select alarms for 
groups of sites when you have installed the Enterprise Management 
package (see Chapter 13, “Creating Groups of Sites”).

To select sites or groups that forward messages:

1. From the Message Forwarding editor, click the Sites tab (see 
Figure 214).

2. Select the site in the Available list that you want to add to the 
Selected list.

These are the sites for which alarm messages will be sent as e-mails 
to recipients.

• For consecutive groups or sites, click on the first group or site, 
then hold down the Shift key and click on the next one.

• Otherwise, click on the first group or site, then hold down the Ctrl 
key and click on each additional one.

3. Click Add.

Figure 214. Message Forwarding – Sites Screen

4. Click Save.
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Selecting Alarm Event Classes

Use this procedure to select the alarm event classes for which you want  
e-mails sent to recipients.

To select alarm event classes:

1. From the Message Forwarding Editor, click the Event Classes tab (see 
Figure 215).

2. Click the alarm class check boxes for which you want Tracer Summit 
to send an e-mail to recipients.

IMPORTANT
The event class names in the Event Classes screen do not update to 

match the event class names that you might have entered in site con-

figuration (see “Example of User-Defined Event Classes” on page 82).

3. If you have Tracer sites selected, click the Tracer Priority alarms.

4. If you have Tracker sites selected, click the Tracker Priority alarms.

Figure 215. Event Classes Screen
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Modifying Call Centers
Use the following procedures to modify call centers and their schedules.

Deleting a Call Center

1. From the Setup menu, select Message Forwarding. The Select Call 
Center dialog box displays.

2. Select a call center. The Message Forwarding editor displays.

3. From the File menu, select Delete Call Center. The Select Call Center 
dialog box displays.

4. Select the call center you want to delete.

5. Click OK. The call center is deleted from the database.

6. Click Save.

7. Click Save.

Registering with a Different E-mail Profile

◆ For more information on how to register a different e-mail profile, see 
“Selecting an E-mail Profile for Message Forwarding” on page 579.

Note:

If you try to delete a call center that is currently open, a warn-
ing message displays. It explains that the editor will shut down 
if you delete the call center.
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Chapter 17

Creating Input/Output 

Objects

Input objects are used to generate alarms. Output objects are used to con-
trol devices and maintain calculated values for CPL routines. There are 
four types of input/output (I/O) objects:

• Analog input
• Binary input 
• Analog output 
• Binary output 

The Tracer Summit system can simultaneously monitor hundreds of ana-
log and binary inputs and outputs from every part of a facility.

Note:

Properties of objects can be viewed and controlled directly from 
a graphic or other application without the use of an I/O object. 
I/O objects are value for:

• Alarming
• Tracking changes in the Event Log
• Sharing data with other BACnet devices.
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Creating an Analog Input
An analog input is a value such as a room temperature or an airflow pres-
sure generated by a sensor or device on the Tracer Summit system.

Naming an Input and Defining the Referencer

1. From the Setup menu, select Inputs/Outputs. The list of inputs and 
outputs displays.

2. Select Analog Input. The Select Analog Input dialog box displays (see 
Figure 216).

Figure 216. Select Analog Input Dialog Box

3. Click New. The New Analog Input Name dialog box displays (see 
Figure 217).

Figure 217. New Analog Input Name Dialog Box

4. Enter a name for the input. Make the name as informative as possi-
ble. Use a maximum of 32 characters.

5. Click OK. The Analog Input editor displays (see Figure 218 on page 
251).
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Figure 218. Analog Input Editor

6. Click the Setup tab to display the Setup screen (see Figure 219).

Figure 219. Analog Input Editor Setup Screen

7. Select a property reference for the input. For detailed information on 
referencing a property, see Chapter 4, “Using Referencer Edit Con-
trols.”

8. Enter values for these Scaling fields:

• Multiplier
• Offset

9. Select a unit designator from the Units list.

10. Continue using the editor to set up alarming (see the section “Setting 
Up Alarming” below) and to route alarms and to set security classes 
(see the section “Routing an Alarm or Warning and Selecting an 
Alarm Message” on page 253).
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Setting Up Alarming

You can set up four types of alarm scenarios for an analog input:

• Off Alarm Limits. The analog input causes an alarm based on the Off 
Alarm Limits you enter. This is the default setting.

• On Alarm Limits. The analog input causes an alarm based on the On 
Alarm Limits you enter.

• Referencer control of On or Off Alarm Limits. A referencer controls 
the use of on or off limits.

• Disabled for no alarming.

The present value of an analog input is either inside or outside a range of 
normal values that you define. If the present value is outside the range of 
normal values, the analog input is either in a warning or alarm state. To 
direct the system to ignore a warning or alarm state, disable the alarm.

The alarming limit setup can be based on a binary property status. For 
example, you may want to allow a static pressure sensor input to alarm 
only when the associated fan is running. In this case, you would set up 
the fan status as the referencer for on/off alarm limits and set limits for 
on and off conditions appropriately.

To prevent nuisance alarms on start up of equipment, use the On Delay 
for Referencer field to set up a delay time before issuing an alarm on a 
change in status from off to on.

To set up an alarm:

1. Click the Alarming tab from the Analog Input editor to display the 
Alarming screen (see Figure 220).

Figure 220. Analog Input Editor Alarming Screen

2. Click Enable Alarming to make the rest of the fields on the screen 
available for editing.
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3. Select On or Off from the On or Off Alarm Limits list, or select a prop-
erty reference (for detailed information on referencing a property, see 
Chapter 4, “Using Referencer Edit Controls”).

4. If you selected On or Off Alarm Limits:

On Alarm Limits: Enter High Alarm, Low Alarm, High Warning, 
Low Warning values in the On Alarm Limits Setup fields.

Off Alarm Limits: Enter High Alarm and Low Alarm values in the 
Off Alarm Limits Setup fields.

5. If you referenced a property, enter values in these fields:

• High Alarm and Low Alarm (off limits)
• High Alarm and Low Alarm, High Warning and Low Warning (on 

limits)
• On Delay for Referencer

6. Enter a Return to Normal Deadband value.

7. Enter a Minimum Time in Alarm Before Notification value.

8. Select a CPL Program to run from the program list (optional).

Routing an Alarm or Warning and Selecting an Alarm 

Message

To select where alarms and warnings are routed, set the entry/exit classes 
using the Classes screen. You can also select an expanded message to dis-
play when an input enters an alarm state. (For information on expanded 
messages, see Chapter 30, “Using the Graphics Editor.”)

To route an alarm or warning and select an alarm message:

1. Click the Classes tab from the Analog Input editor to display the 
Classes screen (see Figure 221 on page 254).

The fields available on the classes screen depend upon your selection 
in the On or Off Alarm Limits field on the Alarming screen. If you use 
a referencer to determine the input state, both the Off Alarm Limits 
and the On Alarm Limits fields are available.

Note:

A CPL routine is called by an entry into alarm and a return out 
of alarm.
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Figure 221. Analog Input Editor Classes Screen

2. Select an entry routing class for each type of alarm or warning.

3. Select an expanded message for each type of alarm or warning 
(optional). (See Chapter 30, “Using the Graphics Editor”, for details 
on creating expanded messages.)

4. Select an exit routing class for each type of alarm or warning.

5. Click the Security Classes button if you want to limit access to this 
object using security classes. (See “Setting Security Classes” on 
page 274.)

Note:

The expanded message assigned in the Analog Input editor has 
priority over the expanded message assigned on the Event 
Classes tab in the Site Configuration editor. If the Entry Mes-
sage field for the Analog Input or Binary Input is set to None 
then the Expanded Message field in Site Configuration will be 
used.
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Creating a Binary Input
Binary inputs are two-state inputs, such as on/off or alarm/normal. The 
inputs are generated by momentary switches or standard (maintained) 
switching devices.

Naming an Input and Defining the Reference

1. From the Setup menu, select Inputs/Outputs. The list of inputs and 
outputs displays.

2. Select Binary Input. The Select Binary Input dialog box displays (see 
Figure 222).

Figure 222. Select Binary Input Dialog Box

3. Click New. The New Binary Input Name dialog box displays (see 
Figure 223).

Figure 223. New Binary Input Name Dialog Box

4. Enter a name for the input. Make the name as informative as possi-
ble. Use a maximum of 32 characters. 

5. Click OK to display the Binary Input editor (see Figure 224 on page 
256).
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Figure 224. Binary Input Editor

6. Click the Setup tab to display the Setup screen (see Figure 225).

Figure 225. Binary Input Editor Setup Screen

7. Select a property reference for the input. For detailed information on 
referencing a property, see Chapter 4, “Using Referencer Edit Con-
trols”.

8. Enter text in the On State Label field. Use up to eight characters.

9. Enter text in the Off State Label field (close contact = On). Use up to 
eight characters.

10. Click on Normal or Reversed to select the polarity for the input (close 
contact = Off).

11. Continue using the editor to set up alarming (see the section “Setting 
Up Alarming” below), to route alarms and warnings, and to set secu-
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rity classes, if desired (see the section “Routing an Alarm or Warning 
and Selecting an Alarm Message” on page 253).

Setting Up Alarming

You can set up three types of alarm scenarios for a binary input:

• Alarming always enabled
• Enable/disable via referencer
• Feedback referencing

Binary inputs have two states. They can either be active (on) or inactive 
(off). You define which of these states is the alarm state. You can also 
choose to disable the alarm state. If you only want to process alarms 
under certain conditions, select a binary referencer to determine whether 
alarms are enabled or disabled.

If you want alarm processing to occur and the normal state of the binary 
input can change dynamically (sometimes active is normal, sometimes 
inactive is normal), specify a feedback reference to determine if the 
binary input is in alarm. A feedback reference is a binary property in the 
system that mirrors the state of the referenced property of the binary 
input. If the present value of the binary input and the current value of the 
feedback reference do not match, the binary input is in alarm.

For example, choose the binary output command for fan start/stop as a 
feedback referencer for the fan status. If the two states do not match, an 
alarm is generated.

To set up an alarm:

1. Click the Alarming tab from the Binary Input editor to display the 
Alarming screen (see Figure 226).

Figure 226. Binary Input Editor Alarming Screen
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2. Click Enable Alarming to make the rest of the fields on the screen 
available for editing.

3. Select Alarming Always Enabled, Enable/Disable Follows Referencer, 
or Feedback Referencing.

• If you selected Alarming Always Enabled, select On or Off in the 
Input Alarm State.

• If you selected Enable/Disable Follows Referencer or Feedback 
Referencing, select a property reference. For detailed information 
on referencing a property, see Chapter 4, “Using Referencer Edit 
Controls”.

• If you selected Enable/Disable Follows Referencer, enter the num-
ber of minutes to delay in the Delay for Enable/Disable Refer-
encer field.

4. Enter a Minimum Time in Alarm Before Notification value.

5. Select a CPL Program to run from the program list (optional).

Routing an Alarm or Warning and Selecting an Alarm 

Message

To select where alarms and warnings are routed, set the entry/exit rout-
ing classes using the Classes screen in the Binary Input editor. You can 
also select an expanded message to display when an input enters an 
alarm state.

To route an alarm or warning:

1. Click the Classes tab from the Binary Input editor to display the 
Classes screen (see Figure 227).

Figure 227. Binary Input Editor Classes Screen

Note:

A CPL routine runs whenever the state changes. The routing 
must determine the state in order to provide the necessary con-
trol.
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2. Select a routing class in the Entry Class field.

3. Select an expanded message in the Entry Message field (optional). 
(See Chapter 30, “Using the Graphics Editor”, for details on creating 
expanded messages.)

4. Select a routing class in the Exit Class field.

5. Click the Security Classes button if you want to limit access to this 
object using security classes. (See “Setting Security Classes” on 
page 274.)

Creating an Analog Output
Analog outputs control devices on the Tracer Summit system, such as a 
damper actuator or a water valve. The most common use of analog out-
puts is to provide setpoints for control of end devices. For example you can 
send the same setpoint to all air handling units (AHUs) using a global 
reference of the analog output object value.

Analog output values are generated either by application programs or are 
entered manually.

Naming the Output and Defining the Reference

1. From the Setup menu, select Inputs/Outputs. The list of inputs and 
outputs displays.

2. Select Analog Output. The Select Analog Output dialog box displays 
(see Figure 228 on page 260).

Note:

The expanded message assigned in the Binary Input editor has 
priority over the expanded message assigned on the Event 
Classes tab in the Site Configuration editor. If the Entry Mes-
sage field for the Analog Input or Binary Input is set to None 
then the Expanded Message field in Site Configuration will be 
used.
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Figure 228. Select Analog Output Dialog Box

3. Click New. The New Analog Output Name dialog box displays (see 
Figure 229).

Figure 229. New Analog Output Name Dialog Box

4. Enter a name for the output. Make the name as informative as possi-
ble. Use a maximum of 32 characters.

5. Click OK to display the Analog Output editor (see Figure 230).

Figure 230. Analog Output Editor
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6. Click the Setup tab to display the Setup screen (see Figure 231).

Figure 231. Analog Output Editor Setup Screen

7. Select a property reference for the output (using a referencer is 
optional). For detailed information on referencing a property, see 
Chapter 4, “Using Referencer Edit Controls.”

8. Enter values for these Scaling fields:

• Multiplier
• Offset

9. Enter values for these Output Range fields (the Minimum and Maxi-
mum values are interactive):

• Minimum
• Maximum

10. Select a unit designator from the Units list.

11. Click Save. If you use a referencer, the analog output is automatically 
saved to the BCU where the referencer resides. If not, the Save dialog 
box displays. Click the name of a BCU to save the output to. 

After saving the analog output, you can save global references (see 
“Setting Up Global References for Analog or Binary Outputs” on 
page 268).

12. Continue using the editor to enter overrides, to enter a control class, 
or to set security classes, if desired (see the section “Entering a Con-
trol Class” on page 263).
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Setting Up Multi-State Values and Assigning Labels

Use the multi-state screen to define labels for the present values of a 
multi-state object. The labels provide a textual description of the state of 
the object on the simplified overrides screen (see Figure 232).

Figure 232. Simplified Overrides Screen—Textual descriptions (labels)

To define labels for the present values of multi-state objects:

1. Click the Multi-State Analog Output check box. The Setup Mult-State 
tab appears  
(see Figure 233).

Figure 233. Setup Multi-State Tab

2. Click the Setup Multi-State tab to display the screen (see Figure 234 
on page 263).

Multi-state labels 
for the state of 
the present value

Multi-State tab

Multi-State Analog 
Output check box
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Figure 234. Setup Multi-State Screen

3. In the Label fields, type a description of the state of the object based 
on its present value (for example, Label 1 = Off).

4. In the corresponding value fields, type the present value for that state 
(for example, Value 1 = 0.00).

5. Click Save to save your changes.

Entering a Control Class

To specify where change of state control notification is routed, set the con-
trol class in the Classes screen of the Analog Output editor.

To enter a new control class:

1. Click the Classes tab from the Analog Output editor to display the 
Classes screen (see Figure 235 on page 264).

Note:

All of the fields do not have to be used. However, Label 1 must 
be used before Label 2, Label 2 must be used before Label 3. 
Unused blank fields should have blank label fields and 0.00 in 
the value fields.
BMTX-SVP01B-EN 263



Creating Input/Output Objects
Figure 235. Analog Output Editor Classes Screen

2. Select a routing class in the Control Class field.

3. To set security access for this object and define class access, click the 
Security Classes button. (See “Setting Security Classes” on page 274.)
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Creating a Binary Output
Tracer Summit uses binary outputs to turn devices on and off or to send a 
calculated binary output. Typically, a binary output is used as an inter-
lock on enable/disable. Follow the steps in this section to control UCM 
outputs or to maintain calculated output values within the system.

Naming the Output and Defining the Reference

1. From the Setup menu, select Inputs/Outputs. The list of inputs and 
outputs displays.

2. Select Binary Output. The Select Binary Output dialog box displays 
(see Figure 236).

Figure 236. Select Binary Output Dialog Box

3. Click New to display the New Binary Output Name dialog box (see 
Figure 237).

Figure 237. New Binary Output Name Dialog Box

4. Enter a name for the output. Make the name as informative as possi-
ble. Use a maximum of 32 characters. 

5. Click OK to display the Binary Output editor (see Figure 238 on page 
266).
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Figure 238. Binary Output Editor

6. Click the Setup tab to display the Setup screen (see Figure 239).

Figure 239. Binary Output Editor Setup Screen

7. Select a property reference for the output (optional). For detailed 
information on referencing a property, see Chapter 4, “Using Refer-
encer Edit Controls”.

8. Enter text in the On State Label field. Use up to eight characters.

9. Enter text in the Off State Label field. Use up to eight characters.

10. Select On or Off in the Default Value field.

11. Click Normal or Reversed to select the polarity for the output.

12. Enter number of minutes in these On/Off Time fields to avoid exces-
sive cycling of equipment:
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• Minimum On Time
• Minimum Off Time

13. Click Save. If you used a referencer, the binary output is automati-
cally saved to the BCU where the referencer resides. If not, the Save 
dialog box displays. Click on the name of a BCU to save the output to.

After saving the binary output, you can save global references (see 
“Setting Up Global References for Analog or Binary Outputs” on 
page 268).

14. Continue using the editor to enter overrides, to enter a control class, 
or to set security classes, if desired (see the section “Entering a Con-
trol Class” on page 267).

Entering a Control Class

To specify where change of state control notification is routed, set the con-
trol class in the Classes screen of the Binary Output editor.

To enter a new control class:

1. Click the Classes tab from the Binary Output editor to display the 
Classes screen (see Figure 240).

Figure 240. Binary Output Editor Classes Screen

2. Select a routing class in the Control Class field.

3. To set security access for this object and define class access, click the 
Security Classes button. (See “Setting Security Classes” on page 274.)
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Setting Up Global References for 

Analog or Binary Outputs
Use global references to assign an analog or binary output to multiple 
objects on the system at one time. For example, you can send the same 
occupied setpoint to all air handlers in the system or enable/disable the 
economizer for the units.

To set up global references:

1. Click the Setup tab from the Analog or Binary Output editor to dis-
play the Setup screen (see Figure 241).

Figure 241. Analog Output Editor Setup Screen

2. Click Global References to display the Global Referencers dialog box 
(see Figure 242 on page 269).

Note:

The Global Referencers button is not available until the analog 
or binary output has been saved (click the Save button).
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Figure 242. Global Referencers Dialog Box

3. In the Object Type field, select the type of object. Select only one 
object type.

4. In the Property field, select the property you want this object to con-
trol.

5. In the Available Names field, select the name(s) of specific object(s).

6. Click Save Selections. The Global References dialog box closes and 
the Setup screen displays. 

Note:

Once a global reference has been set up it can not be deleted 
from this editor. In order to delete the reference you must go the 
the editor for each object that has been referenced to this point.
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Modifying an Input/Output
You can modify any parameter of an input or output at any time.

To modify an input/output:

1. From the Setup menu, select Inputs/Outputs. The list of inputs and 
outputs displays.

2. Select the type of input or output you wish to modify. The Select Input 
dialog box (specific to the item you chose) displays.

3. Click the name of the input or output you want to modify.

4. Click OK. The editor for the selected input or output displays.

5. Click the appropriate tab at the top of the editor to display the screen 
that you want to modify.

Note:

Be careful when changing the name of an input or output. A 
name change will affect any CPL routine that uses the input or 
output. (See Chapter 25, “Custom Programming Language”.)
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Overriding an Analog or Binary Output
When you override analog and binary values from the Overrides tab of a 
UCM editor, you perform the override using the advanced Override dialog 
box. However, Trane encourages you to define your default priority level 
in Site Security and override from graphics by using the simplifed over-
rides dialog box (see “Setting Up the Simplified Override Dialog Box” on 
page 172).

From the advanced override dialog box you can:

• Release control at the specific priority
• Change the present value at a specific priority

Note:

You will need access to change the priority level. Priority con-
trol ranges from 1 (highest) to 16 (lowest). The command with 
the highest priority controls the object. To take control off, you 
must select the Release Control option button. Then the next 
highest priority commands the object.
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Releasing Control to Another Object

1. Click the Overrides tab from the Analog or Binary Output editor (see 
Figure 243).

Figure 243. Binary Output Editor Overrides Screen

2. Click the Override button to display the advanced Overrides dialog 
box (see Figure 244).

Figure 244. Override Dialog Box

3. Click the Release Control option button.

4. In the At Priority field, select the priority level that you want to 
release control to. 

Note:

Control priorities identify the levels at which Tracer Summit 
applications control an object. Normally, control priorities are 
set to the Tracer Summit defaults. For information on setting 
up control priorities for non-Trane BACnet devices, see Chapter 
37, “Using BACnet for Non-Trane Devices.”
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5. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

Changing the Present Value

1. Click the Overrides tab from the Analog or Binary Output editor 

2. Click the Override button to display the Overrides dialog box (see 
Figure 245).

Figure 245. Override Dialog Box

3. Click the Change Value To option button.

4. For an analog output, enter a new value in the Change Value To field. 
For a binary output, select a new value from the list provided.

5. In the At Priority field, select the priority level that you want to give 
control to.

6. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

Note:

The Priority Array list shows all the applications and priorities 
that are currently commanding the object. The Priority Array 
and the Present Value fields show what the object is controlled 
to, when it was controlled last, and what application or user is 
controlling it.
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Setting Security Classes
Tracer Summit has 20 security classes you can set up to segment a site, 
based on whatever parameters you want. For example, a class might 
define a building, a floor, a chiller plant, inside, or outside. The class des-
ignations are used to group objects for security control. (See Chapter 9, 
“Setting Up Security—Tracer Summit System”). The Security Classes 
button on the Classes screen in the input/output editors allows you to con-
trol which classes have access to the input or output you are creating or 
modifying.

To set security classes:

1. Click the Classes tab from the input or output editor to display the 
Classes screen (see Figure 246).

Figure 246. Binary Output Editor Classes Screen

2. Click Security Classes to display the Change Security Classes dialog 
box (see Figure 247 on page 275).
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Figure 247. Security Classes Dialog Box

3. Click on the Access field next to each class to allow or deny access. A 
check in the field allows access. No check denies access.

4. Click OK to display the Classes screen.

Deleting an Input/Output
To delete an input or output, use the Delete Object utility in the Tools 
menu (see Chapter 39, “Deleting Objects and Sites”).
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Chapter 18

BCU Inputs and Outputs

This chapter describes input and output options available for the model 
BMTX and the model BMTW BCUs.

BMTX Binary Inputs
The BMTX BCU has two binary inputs hardwired onto the main board. 
You can use these inputs for: 

• Timed override inputs
• Failure inputs 
• Latching inputs
• Pulse meter inputs. 

These properties can be referenced from the Select Properties dialog box 
by selecting Type, Name, and Property (see Figure 248) .

Figure 248. Select Property dialog box

referenced property
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Each of the two binary inputs has four properties with different functions: 

• Binary Input [01] —Timed override (TOV). You can use this property 
as a TOV trigger for the TOV Application or a TOV CPL routine. This 
property is on if the Binary Input has been closed at any time in the 
last two minutes.

• Binary Input [02]—Fail. You can use this property to monitor status 
for alarms. This property is on if the Binary Input has not been closed 
at any time the last two minutes. 

• Binary Input [03]—Latch. This property will be on if the Binary Input 
has been closed any time in the last two minutes. You can monitor 
momentary inputs with this property.

• Binary Input [04]—Status. This property shows the current state of 
the Binary input point. The input must remain continuously on or off 
for at least two seconds before the property will change.

Pulse Meter Input

You can use the BMTX binary input for a pulse meter input. The inputs 
have analog properties even though they are binary inputs. These analog 
properties, typically used in calculation objects for Energy Management, 
can be referenced by choosing Type, Name, and Property (see Figure 249).

Figure 249. Referencing Analog Properties

Each input has four analog properties with different functions:

• Analog Input [01]—Rate. This is the rate of pulses per minute. The 
BCU calculates the rate by looking at the last ten pulses and averag-
ing the time between pulses for all the pulses that occurred within 
the last minute. Pulses older than one minute are ignored.

referenced property
278 BMTX-SVP01B-EN



BMTW I/O Module
• Analog Input [02]—Pulse count since last read. Note that each time 
you read this property from the Tracer Summit Workstation the BCU 
resets it to zero. 

• Analog Input [03]—Pulse Total. This is the number of pulses since the 
last power reset on the BMTX. This property has a maximum value of 
999,999,999, if it exceeds this number it reverts to 0.

• Analog Iput [04]—Not Used. This property has a value of 0.

BMTW I/O Module
The BMTW BCU uses the input/output (I/O) module which is an optional 
board on the BCU that facilitates connection of common points by adding 
five universal inputs (UIPs) and one binary output (BOP) to the BMTW 
BCU.

The I/O module’s inputs are referenced by analog input (AIP) and binary 
input (BIP) objects for alarm processing and limit checking. The one 
binary output can be used to control equipment or provide status infor-
mation, such as an alarm condition.

The I/O module is supported by a BCU I/O module object that you create 
in Tracer Summit. Each I/O module object has an editor that allows you 
to configure the UIP type to match the hardware jumper selection. Both 
hardware jumper selection and software configuration set the UIP type.

This section covers the following tasks:

• Creating a BCU I/O module object
• Configuring UIPs 
• Setting up alarm and security classes
• Creating analog and binary input/output objects

These tasks must be performed in order to create and set up the neces-
sary objects that will provide units, calculation, and alarming to the 
desired input.
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Creating the BCU I/O Module Object
The following steps show you how to create a BCU I/O module object from 
the Setup menu’s Site Configuration option. You can create a BCU I/O 
module object while configuring a site, or you can add it to a specified 
BCU.

1. From the Setup menu, select Site Configuration (see Chapter 6, “Con-
figuring Tracer Summit BCU Sites”). 

2. From the Site Configuration editor, click the Devices tab to display 
the Devices screen (see Figure 250):

Figure 250. Site Configuration Editor Devices Screen

• If the appropriate BCU is listed, select it. Then click the Edit 
Device button. The Edit Device dialog box displays (see 
Figure 251 on page 281). 

• If the appropriate BCU is not listed, click the Create Device but-
ton. The Create New Device dialog box displays (see “Configuring 
Tracer Summit BCU Sites” on page 33).

Note:

The BCU I/O module buttons are only selectable for standard 
and high capacity BCUs.
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Figure 251. Edit Device Dialog Box

3. Click the BCU I/O module Add button to display the Create New BCU 
I/O module dialog box (see Figure 252). 

Figure 252. Create New BCU I/O Module Dialog Box

4. In the Name field, enter a name for the BCU I/O module. Use a maxi-
mum of 32 characters. 

You must enter a name before you can save the new BCU I/O module 
object. You can modify the name at any time from the Edit BCU I/O 
module dialog box. You can access the dialog box from the BCU I/O 
module Edit button. Click OK to return to the main screen.

5. To define security access, click the Security Classes button to display 
the Security Classes dialog box (see “Setting Security Access for the 
BCU I/O Module” on page 286).

6. Click OK to return to the dialog box.
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7. Click OK to the Devices screen, then click Save.

Setting Up Universal Inputs 
After creating the BCU I/O module object in Site Configuration, set up 
the universal inputs (UIPs). The UIPs are set up in two places: on the 
BCU I/O module board on the BCU and in the Tracer Summit software. 
Both hardware jumper selection and software configuration selection set 
the UIP function type.

Accessing the BCU I/O Module Editor

1. From the Setup menu select Unit Controllers, then select BCU I/O 
Module. The BCU I/O module editor displays (see Figure 253).

Figure 253. BCU I/O Module Editor
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Setting Up the BCU I/O Module UIPs

1. From the BCU I/O Module editor, click the Setup tab to display the 
Setup tab screen (see Figure 254).

Figure 254. BCU I/O Module Editor Setup Screen

2. Configure the input Type fields (1-5) to match the BCU I/O module 
board UIP jumper settings. 

If the device is a pulse meter, enter the correction factor in the Pulse 
Multiplier field (see “Calculating the Pulse Multiplier” on page 284). 
This field is unavailable for other input types.

If the device is an analog type (voltage, current, or thermistor), the 
Disable Analog Failure check box is available:

• Check this box to disable the alarm within 2% of the range end 
points. 

• Leave this box unchecked to alarm on endpoint conditions.

3. See “Setting Up System Objects” on page 284 for creating and setting 
up system objects to reference the inputs.

Note:

After setup is complete, it is necessary to create and set up sys-
tem objects to reference the inputs, see “Setting Up System 
Objects” on page 284.

Note:

Verify input type settings with the BCU I/O module UIP jump-
ers.
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Calculating the Pulse Multiplier 

The pulse multiplier value is the desired consumption amount per contact 
closure. This value is a constant scaling factor that is applied to both the 
accumulator count and rate calculation. The multiplier is used only in 
constant consumption applications, such as, water and electricity. Under 
constant pressure and temperature conditions, a constant pulse multi-
plier value may be used for gas consumption. Refer to the manufacturer’s 
equipment specification for the proper value on consumption amount per 
pulse. The desired consumption amount is the consumption amount per 
pulse multiplied by a conversion factor (desire units/manufacturer’s 
equipment units).

Setting Up System Objects
After setting up the UIPs in the BCU I/O Module editor, create analog 
input (AIP) and binary input (BIP) objects that reference the BCU I/O 
module’s input object properties. The AIP and BIP objects read and 
manipulate raw data from the BCU I/O module, providing real values 
that are used in alarm processing and other applications (for example, 
CPL programming, graphics, reports, and calculations). 

Setting Up Analog Inputs 

Creating an analog input object is the only way to handle conversions, 
alarms, and CPL triggers for analog and pulse accumulator values. 

To create an analog input object, see “Creating Input/Output Objects” on 
page 249. Also refer to the steps below.

On the Analog Input editor Setup screen:

1. Select a property reference for the input.

2. Enter the multiplier and offset scaling values (for thermistor type 
inputs, use the default value).

3. Select the correct unit designator.

On the Analog Input editor Alarming screen:

◆ Set up alarm limits.

Setting Up Pulse Metered Inputs 

Setting up pulse metering inputs involve creating a Meter Totalization 
calculation object and alarm limits that reference the BCU I/O module’s 
pulse accumulator input.

Note:

The AIP and BIP objects must be saved in the same BCU as the 
BCU I/O module object.
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Creating a Calculation Object

In order to create a calculation object, you must first define the calcula-
tion type. Select Meter Totalization for the calculation type. 

To create a new calculation object, see Chapter 31, “Using the Calcula-
tions Editor.” Also, refer to the steps below.

On the Calculation editor Setup screen:

1. Set the Property Reference field to: BCU I/O module/Pulse Accumula-
tor, Since Last[x], where x is the input number for the UIP.

2. Set the Conversion Factor field to 1.

Alarming on Metered Inputs

Alarming on metered inputs is accomplished by creating an analog input 
object. (See Chapter 17, “Creating Input/Output Objects.”) Also, refer to 
the steps below.

On the Analog Input editor Setup screen:

1. Set the Property Reference field to: BCU I/O module/Pulse Accum-
rate[x], where x is the input number for the UIP.

2. Select the correct unit designator.

On the Analog Input Alarming tab:

◆ Set the On Delay For Referencer field to more than one minute.

Setting Up Binary Inputs 

Binary input objects are used for polarity, units, and alarming assign-
ment for UIPs. To create a binary input object, see Chapter 17, “Creating 
Input/Output Objects.” Also, refer to the steps below.

On the Binary Input editor Setup screen:

1. Set the Property Reference field to: BCU I/O module/Binary In[x] or 
Momentary Binary In[x], where x is the input number for the UIP.

2. Enter the Polarity.

3. Select the correct unit designator.

On the Binary Input editor Alarming tab:

◆ Set up the alarm limits.

Setting Up a Binary Output 

Creating a binary output object (BOP) is the only way to control the BCU 
I/O module’s binary output. To create a binary output object, see Chapter 
17, “Creating Input/Output Objects”. Also, refer to the steps below.

On the Binary Output editor screen:

1. Set the Property Reference field to: BCU I/O module/Binary Output.

2. Enter the Polarity.
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3. Select the correct unit designator.

Setting Security Access for the BCU I/O Module 

To specify where the BCU I/O module’s alarm messages are routed, set 
the Alarm Class in the Classes screen.

To enter a new alarm class:

1. Click the Classes tab from the BCU I/O module editor to display the 
Classes screen (see Figure 255).

2. Select an event class in the Alarm Class field.

Figure 255. BCU I/O Module Editor Classes Screen

3. To set security access for this object and define class access, click the 
Security Classes button to display the Change Security Classes dialog 
box (See Figure 256).

Figure 256. Change Security Classes Dialog Box
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4. Click on the Access field next to each class to grant or deny access. A 
check in the field grants access. No check denies access.

5. Click OK to display the Classes screen.
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Chapter 19

Chiller Plant Control

Chiller Plant Control is used to coordinate chillers and provide system 
chilled water control. The program performs four main functions:

• It controls leaving water temperature by adding chillers as the build-
ing cooling load increases. It also calculates the chilled water setpoint 
for each chiller. 

• It recovers from failures by starting the next chiller in the sequence 
immediately after a chiller is marked failed.

• It optimizes energy use by subtracting chillers when the cooling load 
does not require them to be enabled. It also matches chillers to the 
load.

• It equalizes runtime and wear on each chiller by using different rota-
tion schemes. It also provides a more reliable chiller plant by periodi-
cally exercising all of its components.

You can use the Chiller Plant editor or the Chiller Plant Control Status 
displays to perform these functions. For information on the Chiller Plant 
Control Status displays, refer to the Tracer Summit Daily Operations 
guide and the Tracer Summit Chiller Plant Control Application Program, 
BAS-APG004-EN.
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Accessing the Chiller Plant Editor
1. From the Setup menu, select Click Chiller Plant Control. The Select 

Chiller Plant dialog box displays (see Figure 257).

Figure 257. Select Chiller Plant Dialog Box

2. Select a chiller plant.

3. Click OK. The Chiller Plant editor displays (see Figure 258).

Figure 258. Chiller Plant Editor
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Creating a New Chiller Plant
To create a new chiller plant, you follow these steps:

• Create chiller objects in the Site Configuration editor (for more infor-
mation, refer to Chapter 6, “Configuring Tracer Summit BCU Sites”)

• Open and name a new chiller plant (as described in this section)
• Set up the chiller plant system (see “Setting Up the Chiller Plant Sys-

tem” on page 292)
• Modify startup settings (see “Modifying Startup Settings” on 

page 293)
• Modify subtract settings (see “Modifying Subtract Settings” on 

page 294)
• Add and set up chiller objects (see “Adding Chiller Objects to the 

Chiller Plant” on page 295 and “Setting Up Individual Chiller 
Objects” on page 297)

• Set up the chiller UCM objects (see “Chiller UCM Setup” on page 298)
• Set up security for the chiller plant (see “Routing Alarms and Events 

and Setting Security Access” on page 298)

To create a new chiller plant:

1. From the Setup menu, select Chiller Plant Control. The Select Chiller 
Plant dialog box displays.

2. Click New. The New Chiller Plant Name dialog box displays (see 
Figure 259).

Figure 259. New Chiller Plant Name Dialog Box

3. Enter the name of the Chiller Plant. Make the name as informative 
as possible. Use a maximum of 32 characters. You must enter a name 
before you can save the new chiller plant. You can modify the name at 
any time from the System screen of the Chiller Plant editor.

4. Click OK. The Chiller Plant editor displays.

Note:

The settings described for the Chiller Plant editor screens are 
required entries. (For more information, refer to Tracer Summit 
online help.) Verify that default entries on all screens of the edi-
tor are correct for the chiller plant.
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Setting Up the Chiller Plant System
1. From the Chiller Plant editor, click the System tab (see Figure 260).

Figure 260. Chiller Plant Editor System Screen

2. Reference the system Enable binary output object (refer to Chapter 
17, “Creating Input/Output Objects”), or set the Chiller Plant Enable 
referencer to On for continuous Chiller Plant operation. 

3. Use the Supply Temperature referencer edit control to reference the 
property for the system chilled water supply temperature. 

4. Use the Return Temperature referencer edit control to reference the 
property for the system chilled water return temperature.
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Modifying Startup Settings
The Startup screen of the Chiller Plant editor allows you to enable Ambi-
ent Temperature Lockout.

To modify startup settings:

1. From the Chiller Plant editor, click the Startup tab (see Figure 261).

Figure 261. Chiller Plant Editor Startup Screen

2. Click Enable to select Ambient Temperature Lockout.

3. Use the Sensor referencer edit control to reference the property for 
the outside air temperature.
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Modifying Subtract Settings
1. From the Chiller Plant editor, click the Subtract tab (see Figure 262). 

The temperature-based subtract method is the default selection.

Figure 262. Chiller Plant Editor Subtract Screen—Temperature Method

2. Make a selection:

• To use the temperature-based subtract method, verify that the 
Design Delta Temperature is correct for the Chiller Plant (the 
system default is 10.0ºF).

• To use the flow-based subtract method, click Flow (see 
Figure 263). Then use the Bypass Pipe Flow referencer edit con-
trol to reference the property for the Bypass Pipe Flow.

Figure 263. Chiller Plant Editor Subtract Screen—Flow Method
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Adding Chiller Objects to the Chiller 

Plant
1. From the Chiller Plant editor, click the Chillers tab (see Figure 264).

Figure 264. Chiller Plant Editor Chillers Screen

2. In the Chiller Type list box, select the type of chiller to be added.

3. In the Chiller Name list, select the chiller name to be added.

4. Click Add to add the chiller object to the Chiller Plant Control mem-
ber’s list. The Add Chiller dialog box displays (see Figure 265).

Figure 265. Add Chiller Dialog Box
BMTX-SVP01B-EN 295



Chiller Plant Control
5. In the Index field, select the array index used to display individual 
chillers. Use the default index number for the Chiller object.

6. In the Sequence Type field, select the chiller sequence type: Normal, 
Base, Peak, or Swing. 

Normal chillers rotate in a round-robin fashion (the last on is the first 
off). A base chiller is always the first chiller on and the last chiller off. 
A peak chiller is always the last chiller to run and the first chiller off. 
A swing chiller is the first on and then alternates after that (see Table 
6 on page 296 for an example of how a system having chillers of each 
type are stepped on and off). 

Table 6. Chiller Sequence Type

7. Click OK to save the entry and to return to the Chillers screen.

Note:

The PC Workstation validates these settings to eliminate dupli-
cate types for base, peak, or swing. One of each may be defined. 
After a base, peak or swing chiller has been chosen, it is 
removed from the drop-down list of member choices. There is no 
limit to the number of normal chillers allowed.

Step
Chiller 1 
(Base)

Chiller 3 
(Swing)

Chiller 4 
(#1)

Chiller 5 
(#2)

Chiller 2 
(Peak)

1 ON OFF OFF OFF OFF

2 ON ON OFF OFF OFF

3 ON OFF ON OFF OFF

4 ON ON ON OFF OFF

5 ON OFF ON ON OFF

6 ON ON ON ON OFF

7 ON ON ON ON ON
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Setting Up Individual Chiller Objects
1. From the Chiller Plant editor, click the Chillers tab (see Figure 266).

Figure 266. Chiller Plant Editor Chillers Screen

2. In the member’s list, click the Index number of the chiller you want to 
set up.

3. Click the Chiller Setup button to display the Chiller Setup dialog box 
(see Figure 267).

Figure 267. Chiller Setup Dialog Box
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4. If the temperature-based subtract method was selected on the Sub-
tract screen, highlight Chiller Design Capacity. If the Flow-based sub-
tract method was selected on the Subtract screen, highlight the 
Chiller Design Flow.

5. Type a valid value in the Value field.

6. Click OK to save the entry and return to the Chillers screen.

Chiller UCM Setup
After the Chiller Plant Control application is set up, go to the UCM editor 
for each of the chillers that were selected to be part of the chiller plant. 
(From the Setup menu, select Unit Controllers.) For more information on 
UCM editors, refer to Chapter 12, “Using UCM Editors”.

To set up a chiller UCM from the UCM editor:

1. Make sure the chilled water setpoint for each chiller references the 
chiller chilled water setpoint property in the Chiller Plant Control 
object. By editing the chilled water setpoint appropriately, you ensure 
that each chiller is getting its chilled water setpoint from the Chiller 
Plant Control object.

2. Make sure the current limit setpoint for each chiller references the 
chiller current limit setpoint property in the Chiller Plant Control 
object. By editing the current limit setpoint appropriately, you ensure 
that each chiller is getting its current limit setpoint from the Chiller 
Plant Control object.

3. Make sure the minimum On and Off time of each chiller is less than 
the control feed back delay time. Under certain circumstances, mini-
mum On and Off times longer than the control feedback delay time 
can cause the chiller to be needlessly marked as failed.

Routing Alarms and Events and Setting 

Security Access
At the Chiller Plant editor’s Classes screen, you can assign alarm and 
event routing and set security access for a chiller plant.

Defining Alarm and Event Routing

1. From the Chiller Plant editor, click the Classes tab (see Figure 268 on 
page 299).

Note: 

Be sure all chillers in this Chiller Plant use the same units for 
capacity (for example, tons, KWH, etc.), or flow (for example, 
gpm, l/s, etc.).
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Figure 268. Chiller Plant Editor Classes Screen

2. In the Event Class field, select an appropriate class for routing 
events.

3. In the Alarm Class field, select an appropriate class for routing 
alarms.

Setting Security Access

1. From the Chiller Plant editor, click the Classes tab.

2. Click the Security Classes button. The Change Security Classes dia-
log box displays (see Figure 269).

Figure 269. Change Security Classes Dialog Box
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3. Click on the Access field next to each class to grant or deny access to 
the security class. A check in the field grants access. If unchecked, 
permission to the security class is denied.

4. Click OK to close the Change Security Classes dialog box.

Deleting a Chiller Plant
To delete a chiller plant, use the Delete Objects utility from the Tools 
menu. For more information, see Chapter 39, “Deleting Objects and 
Sites”.
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Chapter 20

Area Control Application

Area control allows you to define the components and parameters of an 
area so that the same comfort level can be maintained throughout the 
defined space. An area may consist of a single office, a group of offices, a 
large open warehouse, a manufacturing space, or any grouping you wish 
to define.

Using Area Control
Use area control to perform these functions:

• Coordinate equipment operations, such as heating, cooling, ventila-
tion, and lighting within an area

• Integrate into time of day scheduling to allow for optimal start/stop, 
night economizing, and lighting events

• Facilitate night heating and cooling operations
• Give a common look and feel to all parts of a defined area, regardless 

of the equipment that serves it

Area control works in combination with the time of day scheduling, VAV 
air systems, custom programming language applications, and timed over-
ride to perform the following functions:

• Optimal Start/Stop: Area Control calculates optimal start/stop val-
ues that control the startup and shutdown times of heating and cool-
ing devices so they run only as long as necessary to meet the required 
temperature setpoints for the intended occupancy. You set the target 
start/stop times in Time of Day Scheduling. Area Control calculates 
the actual start/stop times required to meet the set targets. 

• Night Heat/Cool: Area Control monitors the temperature of an area 
when it is unoccupied and starts or stops heating or cooling to keep 
the space within a pre-defined temperature range.

• Night Economizing: Area Control works with Time of Day Schedul-
ing to initiate the Night Economizing operation. Night Economizing 
brings cool nighttime air inside the building to pre-cool the area 
before occupancy starts. Using cool outside air to help cool a building 
can reduce the load on the mechanical cooling equipment. Time of 
Day Scheduling provides the window of opportunity in which Area 
Control can use the night economizing mode. Area Control then deter-
mines if the outside air is cool enough to provide effective cooling.

• Ventilation Coordination: Area Control coordinates ventilation 
with heating and cooling functions during hours of occupancy.
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• Lighting Control: Area Control works with Time of Day Scheduling 
to control lighting on and lighting off times to minimize operating 
costs.

• Custom Programming Language: You can create Custom Pro-
gramming Language (CPL) routines that work with Area Control to 
control such system activities as Priority Shutdowns and Demand 
Limiting.

• Timed Override (TOV): Area control monitors the status of the On 
and Cancel thermostat buttons of Trane SCC, VAV, and Voyager 
equipment. Upon seeing a timed override request from a Trane zone 
temperature sensor, Tracer Summit PC Workstation, or BCU opera-
tor display the area will change from its current state to occupied. 

Area Mode/Member Modes

Table 7 on page 303 shows the standard operating behavior for binary 
output members and UCM members for each area control operating 
mode. For numeric entries (1, 2, 3, or 4), refer to the corresponding note.
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Table 7. Area Mode/Member Mode Chart

Binary Output Members UCM/CPL Members

Area Mode
Cool 
Only

Heat 
Only H/C Vent Light

Cool 
Only

Heat 
Only H/C Vent Light

Occupy
Heat Off 1 1 On 3 Occupy Occupy Occupy Occupy 3,5

Cool 1 Off 1 On 3

Unoccupy
Heat Off Off Off Off 3 Unoc-

cupy
Unoc-
cupy

Unoc-
cupy

Unoc-
cupy

3,5

Cool Off Off Off Off 3

*Night 
H/C

Heat Off On On Off 3 Unoc-
cupy

Night 
H/C

Night 
H/C

Unoc-
cupy

3,5

Cool On Off On Off 3 Night 
H/C

Unoc-
cupy

*Night Economize
2 Off 2 Off 3 4 Unoc-

cupy
4 Unoc-

cupy
3,5

Optimal 
Start

Heat Off 1 1 Off 3 Opti-
mal 

Opti-
mal 

Opti-
mal 

Opti-
mal 

3,5

Cool 1 Off 1 Off 3 Start Start Start Start

Optimal 
Stop

Heat Off Off Off On 3 Opti-
mal

Opti-
mal

Opti-
mal

Opti-
mal

3,5

Cool Off Off Off On 3 Stop Stop Stop Stop

Priority Shutdown

Off Off Off Off 3 Priority
Shut-
down

Priority
Shut-
down

Priority
Shut-
down

Priority
Shut-
down

3,5

Notes:

1 On if the occupied temperature control is disabled, otherwise follows the occupied temperature control logic.
2 On if checked for night economizing. 
3 Lighting members are controlled based on lighting control events in the Time of Day Scheduling application Binary output 

members will be on for lighting start events and off for lighting stop events. UCM/CPL lighting members will be occupied for 
lighting start events and unoccupied for lighting stop events.

4 Night economize if checked for night economizer. Night economize events must be scheduled in the Time of Day Scheduling 
application.

5 A timed override initiated by a UCM area member, the Area Editor Overrides tab, or the timed override toolbar button will over-
ride the present value of the area to occupied and the lighting value to On. The priority level will be Timed Override.

* Night Heat/Cool and Night Economizing are sub-modes of the area’s unoccupied present value. The area itself remains unoc-
cupied while its members are placed in these modes.
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Timed Override Control

Table 7 on page 303 does not show a timed override mode because timed 
override only affects the present value of the area. When timed override is 
in control, the present value shows “Occupied” at a priority level of timed 
override.

Accessing the Area Control Editor
1. From the Setup menu, select Area. The Select Area dialog box dis-

plays (see Figure 270).

Figure 270. Select Area Dialog Box

2. Select an existing area you wish to edit.

3. Click OK to display the Area Control editor (see Figure 271).

Figure 271: Area Control Editor
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Creating an Area
To create an area, you perform these tasks:

• Open and name the area (as described in this section)
• Assign members to the area (see “Assigning Members” on page 306)
• Define referencers for the indoor and outdoor air temperature sensor 

fields (see “Setting Air Temperature Sensors” on page 308)
• Define parameters for night economizing (see “Setting Up Timed 

Override” on page 310)
• Establish heating and cooling setpoints for the occupied and unoccu-

pied modes and occupied and unoccupied differentials (see “Setting 
Setpoints and Differentials” on page 309)

• Assign event classes (see “Assigning Event Classes” on page 312)
• Define security access (see “Setting Security Access for the Area” on 

page 313)
• If necessary, enable and set duration for timed override members (see 

“Setting Up Timed Override” on page 310). 

After you create an area, you should assign the Area object to a time of 
day schedule (see Chapter 24, “Time of Day Scheduling”). In the time of 
day schedule, you must include a night economizing value and a lighting 
value in addition to the present value if you intend to use those functions 
in area control. 

To create an area:

1. From the Setup menu, select Area. The Select Area dialog box dis-
plays (see Figure 272).

Figure 272. Select Area Dialog Box

2. Click New. The New Area Name dialog box displays (see Figure 273 
on page 306).
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Figure 273. New Area Name Dialog Box

3. Enter a name in the Area Name field. Make the name as informative 
as possible. Use a maximum of 32 characters. You must enter a name 
before you can save the new area. You can modify the name at any 
time from the Setup screen of the Area Control editor.

4. Click OK. The Area Control editor displays.

5. Click Save. The first time you save a new area, the Save Area dialog 
box displays (see Figure 274).

Figure 274. Save Area Dialog Box

6. Click the name of the BCU in which you want the area to reside.

7. Click OK.

Assigning Members
1. From the Area Control editor, click the Members tab (see Figure 275).

Figure 275. Area Control Editor Members Screen
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2. Select the member type from the Type list.

3. In the Name list, click on the member names that you want to add to 
the area.

4. Click Add. The Select Area Member Type dialog box displays (see 
Figure 276). The dialog box displays for each member you have 
selected. 

Figure 276. Select Area Member Type

5. Click on the arrow to select the member type from the list in the 
Member Type field. Member types include Heating, Cooling, Heating/
Cooling, Lighting, and Ventilation.

6. Click the Night Economize check box if you want to use this member 
for night economizing. The only member types that you can check for 
night economizing are Cooling Only and Heating/Cooling.

7. Click the Timed Override (TOV) initiator checkbox to allow timed 
override requests to be initiated from Trane SCC (except for very 
early versions of the ZN510/511), VAV and Voyager members. Timed 
override requests for these members can be generated from a Trane 
zone sensor, a Tracer Summit PC Workstation, or a BCU operator dis-
play.  

8. Click OK to add the member to the Area Members list (see Figure 277 
on page 308).

Note:

You can assign a member to only one area. If you try to add a 
member that is already assigned to another area, a message 
indicates that the member is currently assigned to another 
area. Do not assign a member to an area that also is an AHU or 
vent only member of a VAV Air System.

Note:

The Enable Timed Override checkbox on the Setup tab also has 
to be checked in order for the area to process requests and can-
cels from TOV members (see “Setting Up Timed Override” on 
page 310).
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Figure 277. Area Members List

Setting Air Temperature Sensors
1. From the Area Control editor, click the Setup tab (see Figure 278).

Figure 278. Area Control Editor Setup Screen

2. Enter a referencer in the Sensors Space Temperature field. Area Con-
trol uses the space temperature value, along with heating and cooling 
setpoints, to determine the heating/cooling mode (provided the Heat/
Cool Input field is set to Auto). For detailed information on using ref-
erences, see Chapter 4, “Using Referencer Edit Controls.”

3. Enter a referencer in the Sensors Outdoor Air Temperature field. 
Area Control uses the outdoor air temperature sensor for its Night 
Economizing and Optimal Start/Stop operations.

Note:

The Heat/Cool Input field should generally be set to Auto. For 
details, see Tracer Summit online help.
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Setting Setpoints and Differentials
Area Control uses occupied setpoints to:

• Calculate optimal Start/Stop rates for Time of Day Scheduling
• Determine whether the area should be in heating or cooling mode
• Maintain occupied temperature control (Binary Output heating or 

cooling members only)

Area Control uses unoccupied setpoints to:

• Maintain unoccupied heating/cooling control

The differential values prevent equipment from cycling on and off too 
quickly. Occupied differentials affect only Binary Output members that 
are actively using the areas occupied heating/cooling setpoints. Unoccu-
pied differentials affect both Binary Output and UCM members that are 
actively using the area’s unoccupied heating/cooling setpoints.

To set setpoints and differentials:

1. From the Area Control editor, click the Setup tab (see Figure 279).

Figure 279. Area Control Editor Setup Screen
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2. To change the default setpoint values, enter referencers or new con-
stants in the following fields:

• Unoccupied Cooling Setpoint
• Occupied Cooling Setpoint
• Occupied Heating Setpoint
• Unoccupied Heating Setpoint

3. To change the default differential values, enter new constants in the 
following fields:

• Occupied Differential
• Unoccupied Differential

Setting Up Timed Override
1. From the Area Control editor, click the Setup tab to display the Setup 

screen. (see Figure 280).

Figure 280: Area-Setup Screen

2. Make sure the Enable Timed Override checkbox is checked to enable 
timed override. The default setting for this checkbox is enabled.

3. In the Duration field, type the number of minutes you want timed 
override active after someone makes a timed override request. Timed 
override will remain active but not in control if:
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• Another application controls the Area to occupied, such as a 
schedule.

• Another application at a higher priority level controls the Area to 
any mode.

4. Use the Optional Request Source referencer to allow a timed override 
request from a binary property. (For an example of how to use this 
field, see the online help for the Area Editor–Setup tab.)

5. Click Save.

Setting Up Night Economizing
To set up night economizing use the Area Control and the Time of Day 
Scheduling (see Chapter 24, “Time of Day Scheduling”).

To enable or disable Night Economizing in Area Control:

1. From the Area Control editor, click the OSS - Night Econ. tab (see 
Figure 281).

Figure 281. OSS - Night Economizing Screen

Note:

You can edit this field when timed override is active, but the 
change will not take effect until the next timed override start 
request.

Note:

Area members in the member list on the Members tab must be 
set up for timed override in order for the area to process 
requests and cancels from TOV members (see, “Assigning Mem-
bers” on page 306).
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2. Use the Night Economizing Input field to enable or disable Night 
Economizing manually, or select a referencer that will control the 
enabling and disabling of Night Economizing. For detailed informa-
tion on referencing a property, see Chapter 4, “Using Referencer Edit 
Controls.”

3. Enter a value in the Minimum Indoor/Outdoor Temperature Differen-
tial field. For Night Economizing to occur, the actual temperature dif-
ferential between the indoor and outdoor temperatures must be 
greater than this number.

Assigning Event Classes
From the Classes screen, you can assign event classes for Control Class 
events and Timed Override Events (see Figure 282). An event class is an 
alarm category (system critical alarms, system log, no notification, etc.) 
that receives an event message. 

For control class events, Tracer Summit will generate messages to notify 
the daily operator when the present value of the area changes state (for 
example, changes from unoccupied to occupied).

For timed override events, Tracer Summit will generate messages to 
notify the daily operator when a timed override has been requested, can-
celled, or expired for the area.

Assigning an event class categorizes the type of event message that is 
routed to an event receiver (workstation, cell phone pager, BCU event log, 
etc.).

Note:

In the Site Configuration editor, you can choose which event 
receiver (workstation, cell phone pager, BCU event log, etc.) 
gets messages from an event class. For more information on 
choosing an event receiver, see “Setting Up Event Classes” on 
page 81.
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To assign an event class:

1. From the Area Control editor, click the Classes tab. 

Figure 282. Area Control Editor Classes Screen

2. Click the Control Class or Timed Override Class arrow to select an 
event class. 

3. Click Save.

Setting Security Access for the Area

1. From the Area Control editor, click the Classes tab (see Figure 282 on 
page 313).

2. Click Security Classes to display the Change Security Classes dialog 
box (see Figure 283).

Figure 283. Change Security Classes Dialog Box
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3. Click on the Access field next to each class to grant or deny access. A 
check in the field grants access. No check denies access.

4. Click OK to display the Classes screen.

Overriding an Area
When you override the present value and lighting value from the Over-
rides tab of a UCM editor, you perform the override using the advanced 
Override dialog box. However, we encourage you to define your default 
priority level in Site Security and override from graphics by using the 
simplifed overrides dialog box (see “Setting Up the Simplified Override 
Dialog Box” on page 172).

The Override function lets you manually override the present value and 
lighting value of an area. It also allows you to make a timed override 
request if timed override is enabled for the area.

Overriding the Present Value and Lighting Value

From the advanced override dialog box you can:

• Release control at the specific priority
• Change the present value at a specific priority

Note:

You will need access to change the priority level. Priority con-
trol ranges from 1 (highest) to 16 (lowest). The command with 
the highest priority controls the object. To take control off, you 
must select the Release Control option button. Then the next 
highest priority commands the object.
314 BMTX-SVP01B-EN



Overriding an Area
To access the Override dialog box:

1. From the Area Control editor, click the Overrides tab (see 
Figure 284).

Figure 284. Area Control Editor Overrides Screen

2. Click the Override button. The Override dialog box displays (see 
Figure 285).

Figure 285. Override Dialog Box

Releasing Control to Another Priority

1. From the Override dialog box, click the Release Control option.

2. In the At Priority field, select the priority level that you want to 
release control to. 

Note:

Control priorities identify the levels at which Tracer Summit 
applications control an object. Normally, control priorities are 
set to the Tracer Summit defaults. For information on setting 
up control priorities for non-Trane BACnet devices, see Chapter 
37, “Using BACnet for Non-Trane Devices.”
BMTX-SVP01B-EN 315



Area Control Application
3. Click the Apply button to apply the override and view the results, or 
click OK to apply the changes and close the dialog box.

Changing the Present Value

1. Click the Overrides tab from the Area Control editor. 

1. Click the Override button to display the advanced Overrides dialog 
box (see Figure 285 on page 315). 

2. Select the new present value from the drop-down list.

3. Select the priority level to which you wish to give control in the At 
Priority field.

4. Click Apply to perform the override.

5. Click OK to close the Overrides screen.

Making a Timed Override Request

After timed override is set up for an area, you can initiate or cancel a 
timed override request. (For setting up timed override for an area, see 
“Setting Up Timed Override” on page 310.) Timed override must be 
enabled in order for Area Control to process a request.

To start or cancel a timed override request:

1. From the Area Control editor, click the Overrides tab (see Figure 284 
on page 315).

2. Click the TOV button to display the Timed Override dialog box (see 
Figure 286)

Figure 286. Timed Override Dialog Box

Note:

The Priority Array list shows all the applications and priorities 
that are currently commanding the object. The Priority Array 
and the Present Value fields show what the object is controlled 
to, when it was controlled last, and what application or user is 
controlling it.
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3. In the Timed Override Request box, click the desired option.

4. Click OK to close the Timed Override screen and begin the request.

Deleting an Area
An area cannot be deleted from the Area Control editor. Use the Delete 
Object function from the Tools menu to delete an Area object (see Chapter 
39, “Deleting Objects and Sites”).

Note:

You can also get to this dialog box by clicking on the TOV but-
ton on the toolbar.
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Chapter 21

Comm5 VAV Air Systems

The Tracer Summit Comm5 VAV air system (VAS) coordinates a collec-
tion of variable-air-volume (VAV) boxes and an air-handling unit (AHU) 
to create a coherent air system. VAS Comm5 provides the following 
capabilities:

• Manages common space VAVs to prevent over-pressurization of the 
ductwork.

• Controls the AHU to provide air when any VAV member is in the 
occupied mode.

• Provides built-in ventilation and pressure optimization features.
• Provides air and water balancing features.
• Automates the commissioning and calibration of VAVs.
• Reports status information on a standard graphic, a standard report, 

and the VAS Comm5 editor.

VAS Comm5 supports the following controllers:

• Tracer VV550/551 VAV controllers (recommended) and other control-
lers that support the VAV object of the LonMark® Space Comfort Con-
troller (SCC) profile

• Tracer AH540/541 and MP580/581 controllers and other controllers 
that support the LonMark® Discharge Air Controller (DAC) profile

To create a VAV air system for Comm3 and Comm4 controllers, refer to 
Chapter 22, “Comm3/Comm4 VAV Air Systems.” 

Note:

The optimization features work only with Tracer VV550/551 
controllers. If you use other controllers, additional features of 
VAS Comm5 may not be available depending on how the con-
trollers implement the SCC profile.
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Accessing the VAS Comm5 Editor
1. From the Setup menu, select VAV Air Systems, then select VAS 

Comm5. The Select VAS Comm5 dialog box displays (see Figure 287).

Figure 287.  Select VAS Comm5 Dialog Box

2. Select an existing VAS object and click OK. The VAS Comm5 editor 
displays (see Figure 288).

Figure 288. VAS Comm5 Editor Status Screen
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Creating a Comm5 VAV Air System
To create a Comm5 VAV air system, follow these steps:

• Create the object (see “Creating a VAS Comm5 Object” on page 321)
• Assign VAS members (see “Assigning VAS Members” on page 322)
• Assign common space VAVs (see “Assigning Common Space VAVs” on 

page 324)
• Set up the VAV air system, including using duct pressure optimiza-

tion and ventilation optimization if necessary (see “Setting up a 
Comm5 VAV Air System” on page 326)

• Set up global references if necessary (see “Setting up Global Refer-
ences” on page 328)

• Change security classes if necessary (see “Setting Security Access” on 
page 329)

Creating a VAS Comm5 Object

1. From the Setup menu, select VAV Air Systems, then select VAS 
Comm5. The Select VAS Comm5 dialog box displays.

2. Click New. The New VAV Air Systems (VAS Comm5) Name dialog box 
displays (see Figure 289).

Figure 289. New VAV Air Systems (VAS Comm5) Name Dialog Box

3. Type a name in the VAV Air Systems (VAS Comm5) Name field. Make 
the name as informative as possible. Use a maximum of 32 charac-
ters. You can modify the name at any time from the Setup screen of 
the VAV Air System editor.

4. Click OK. The Status screen of the VAS Comm5 editor displays.

5. You will not be able to save the VAS until you add at least one VAV 
member (see “Assigning VAS Members” on page 322). After you have 
done so, click Save. The first time you save a new area, the Save VAV 
Air System dialog box displays (see Figure 290 on page 322).
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Figure 290. Save VAV Air Systems (VAS Comm5) Dialog Box

6. Select the name of the BCU in which you want the VAV Air System to 
reside.

7. Click OK.

Assigning VAS Members

You can assign two types of VAS members:

• One air-handler member per VAS, which can be a  
Tracer AH540/541, a Tracer MP580/581, or other DAC device

• VAV members, usually Tracer VV550/551 VAV controllers (although 
you can use other SCC devices, some features of VAS Comm5 work 
only with Tracer VV550/551 controllers) 

To assign members:

1. From the VAS Comm5 editor, click the Members tab (see Figure 291 
on page 323).

Note:

To delete a VAS object, use the Delete Objects utility from the 
Tools menu. Refer to Chapter 39, “Deleting Objects and Sites.”

Note:

VAS Comm5 supports two types of air-handler objects: Tracer 
MP580/581 objects and DAC objects. The air-handler controller 
must be configured as a DAC device.
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Figure 291. VAS Comm5 Editor Members Screen

2. To add VAV Members, click the Add Members button in the VAV 
Members area. The VAV Members dialog box displays (see 
Figure 292).

Figure 292. VAV Members Dialog Box
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3. Select the VAVs you want to add to the VAS. To add more than one 
VAV, hold down the Ctrl key and click each VAV you want to add.

All available Space Comfort Controllers (SCCs) display in the avail-
able VAVs list. Make sure that you select only SCCs configured as 
VAVs (VAS Comm5 does not check this for you).

4. Click the Add button. The VAVs you want to add display in the 
Selected VAVs list.

5. When you are done adding VAV Members, click OK. 

6. To add the AHU member, click the Add Member button in the AHU 
Member area. The AHU Member dialog box displays (see Figure 293).

Figure 293. AHU Member Dialog Box

7. In the Type list, select the type of air handler you want to add to the 
VAS.

8. In the Name list, select the air handler you want to add to the VAS.

9. Click OK.

Assigning Common Space VAVs

Common space VAVs act much like pressure relief valves—the VAS con-
trols common space VAVs to make sure that there is always someplace for 
the air to escape when the AHU is on. Make sure that you assign enough 
common space VAVs to avoid over-pressurizing the ducts. If you have 
other ways to relieve duct pressure, you may not need to use common 
space VAVs.

Typically, common space VAVs should serve common areas, such as lob-
bies, hallways, and restrooms. You can, however, designate any VAV as a 
common space VAV.

Follow these guidelines when assigning common space VAVs:

• Because common space VAVs act as pressure relief valves, do not set 
their minimum flow setpoints to zero. 

• A VAV cannot be a common space VAV if it is already a member of an 
Area object.
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• You cannot schedule common space VAVs because only the VAS can 
control them. Common space VAVs still provide space temperature 
control of the zone like any other VAV.

• If you decide to change a common space VAV back to a normal VAV, 
you will have to manually release the priority level 9 control that VAS 
has over the VAV. If you do not release the priority control, Area will 
not be able control the VAV because it controls at a lower priority 
level.

To assign common space VAVs:

1. In the VAV Members table on the Members screen, select the Com-
mon Space check boxes for the VAV members that you want to serve 
as common space VAVs (see Figure 294). 

2. Click Save to save your changes.

Figure 294. Assigning Common Space VAVs
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Setting up a Comm5 VAV Air System
Use the Setup screen to configure your Comm5 VAV air system. Click the 
Help button or press F1 to access the online Help, which contains detailed 
descriptions of each field.

To set up a Comm5 VAV air system:

1. From the VAS Comm5 editor, click the Setup tab (see Figure 295).

Figure 295. VAS Comm5 Editor Setup Screen

2. In the AHU Startup Delay field, type the number of minutes for the 
VAS to wait before starting the AHU. 

The AHU startup delay should be at least the amount of time it takes 
for the air valves in the common space VAVs to open to an acceptable 
position. The startup delay prevents the ductwork from over-
pressurizing.

3. In the Common Space VAV Shutdown Delay field, type the number of 
minutes for the VAS to wait before shutting down common space 
VAVs after the AHU enters the unoccupied mode. 

The shutdown delay should be at least the amount of time it takes the 
AHU to go from full speed to a complete stop. To prevent the duct-
work from over-pressurizing, VAS Comm5 prevents its common space 
VAVs from entering the unoccupied mode during the shutdown delay. 
Note that Tracer VV550/551 controllers have an automatic three-
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minute shutdown delay, which begins after the VAS shutdown delay 
is over.

4. In the VAV Calibration field, select Recalibrate if you want to initiate 
a recalibration of VAV members. You can also set up a referencer to a 
binary output to trigger recalibration (for example, you can reference 
a binary output and assign a schedule to the output). The BCU stag-
gers the calibration requests to prevent the ductwork from over-pres-
surizing.

Because Tracer VV550/551 calibrate automatically when they transi-
tion from occupied to unoccupied, use the VAV Calibration field only 
for VAVs that are continually occupied.

5. Select the Allow VAV Aux Heat at Night check box to allow VAV aux-
iliary heat at night. 

If you want to disable auxiliary heat at night to reduce energy usage, 
clear this check box. For this feature to work, you must also reference 
the Auxiliary Heat Control property of all VAV members to the VAS 
Aux Heat Control Request property (you can do this globally by click-
ing the Set VAV References button on the Members screen as 
described in “Setting up Global References” on page 328).

6. Select the Enable Duct Pressure Optimization check box if you want 
to use duct pressure optimization. Type new setpoints if necessary. In 
most cases, use the default settings for best performance. (Press F1 
for a description of each field.) 

The duct pressure optimization feature determines the optimal duct 
pressure based on VAV air-valve positions. This optimization reduces 
energy costs by ensuring that the AHU is working just hard enough 
to satisfy the most-open VAV air valve. Duct pressure optimization 
works only with Tracer VV550/551 controllers.

7. Select the Enable Ventilation Optimization check box if you want to 
use ventilation optimization. Type new setpoints or set up referencers 
if necessary. In most cases, use the default setpoints for best perfor-
mance. (Press F1 for a description of each field.)

The ventilation optimization feature manages the outdoor air intake 
system to meet ANSI/ASHRAE Standard 62-2001: Ventilation for 
Acceptable Indoor Air Quality. This standard specifies minimum ven-
tilation rates and indoor air quality to minimize the potential for 
adverse health effects for occupants. Ventilation optimization works 
only with Tracer VV550/551 controllers.

8. Click Save to save your changes.
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Setting up Global References
VAS Comm5 provides a way to set up references across the variable air 
system. After you create the global references, you cannot undo them in 
VAS Comm5. You can change the references only in the SCC editor for 
each device (or globally in the Analog Output object editor). 

To set up global references:

1. From the VAS Comm5 editor, click the Members tab.

2. Click the Set VAV References button. The VAV References dialog box 
displays (see Figure 296).

3. Select the global references you want to set up, then click OK. Some 
options are not available until you assign an AHU member. (Click the 
Help button or press F1 for a description of each option.)

Figure 296. VAV References Dialog Box
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Setting Security Access
Use the Classes screen to set security access for VAS Comm5.

To set security access:

1. From the VAS Comm5 editor, click the Classes tab.

2. Click the Security Classes button. The Change Security Classes dia-
log box displays (see Figure 297).

Figure 297. Change Security Classes Dialog Box

3. Select the Access check box next to each class to grant or deny access 
to the security class. A check in the field grants access. 

4. Click OK to close the Change Security Classes dialog box.

5. Click the Save button to save your changes.
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Balancing Air and Water Flow 
To assist with balancing air and water flow, use the system-wide over-
rides found on the Overrides tab (see Figure 298). 

From the Overrides screen, you can apply the following overrides to the 
air valves of all VAV members:

• Drive to minimum cooling flow setpoint
• Drive to maximum cooling flow setpoint
• Drive to a percentage of the maximum cooling flow setpoint

You can apply the following overrides to the water valves of all VAV mem-
bers:

• Drive open
• Drive closed 

Figure 298. VAS Comm5 Editor Overrides Screen

To perform an override:

1. Select the appropriate option.

2. Click the Apply button to perform a system-wide override.

Note:

Use the Rover Air and Water Balancing tool if you need addi-
tional balancing features.
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To Release an override:

◆ Click the Release Override Option to release the system-wide over-
ride.

Note:

If you do not release overrides from the VAS Comm5 editor, 
they will release automatically in each VAV controller after a 
certain period of time (by default, overrides to Tracer VV550/
551 controllers release automatically after 10 hours, though 
this time can be changed in Rover Comm5).
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Autocommissioning VAVs
Autocommissioning is a special operating sequence that validates the 
proper operation of all inputs and outputs of VAV members. Because air 
valves are closed during parts of the autocommissioning test, the BCU 
commissions the VAVs in several groups to avoid over-pressurization. The 
BCU divides common space VAVs evenly among the groups. 

To autocommission VAVs:

1. From the VAS Comm5 editor, click the Setup tab.

2. If duct pressure optimization is enabled, clear the Enable Duct Pres-
sure Optimization check box, then click Save.

3. Click the Overrides tab.

4. In the VAV Autocommissioning Sequence area, select Start, then click 
the Apply button.

5. Click OK to acknowledge the message that displays.

6. To check the progress of the autocommissioning sequence, open the 
VAS graphic by double-clicking the VAS icon in the navigation tree. 
While autocommissioning is in effect, the Mode: Active property of 
each VAV member will report Test (see Figure 299). Autocommission-
ing should take no more than 90 minutes, regardless of the size of 
your VAS.

Figure 299. VAV Graphic

7. After the autocommissioning sequence is done, re-enable duct pres-
sure optimization if you are using it in your VAS.

8. On the Status screen of the VAS Comm5 editor, click the Report but-
ton. The Select Standard Live Report dialog box displays.

9. Select VAS Comm5 Commissioning Report, then click OK. The VAV 
Commissioning Report displays.

10. Print or save the report as needed, then click Close.

Note:

Because the BCU staggers the VAVs being autocommissioned, 
starting another staggered sequence will interrupt the current 
sequence. For example, if a calibration sequence is initiated 
while autocommissioning is in progress, autocommissioning 
will stop and calibration will begin. Autocommissioning will not 
resume after the calibration sequence finishes.
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Comm3/Comm4 VAV Air 

Systems

The variable air volume air system (VAS), usually referred to as the VAV 
air system, is made up of variable air volume (VAV) boxes, the air-han-
dling equipment that supplies hot and cold air to those boxes, and ventila-
tion-only members. VAS works with Area Control and Time of Day 
Scheduling to manage the air handling unit and the associated VAV 
boxes.

Using the VAV air system, you can:

• Determine the heating or cooling control action of its VAV members
• Audit VAV member requests for Night Heat/Cool and Night Econo-

mize to verify that adequate demand exists before enabling the air 
handler

• Total the minimum cooling flow setpoints and present value votes of 
its VAV members to determine its own and the air handler’s present 
value 

• Control AHU startup and VAV shutdown delays during occupancy 
transitions

• Provide an offset control value for VAV I members

Depending on the member characteristics, you can use these options:

• Drive VAV boxes to maximum airflow position when the VAS heat/
cool mode is heating

• Provide VAV airflow overrides for all VAV members
• Specify supply air setpoints for air handler reference

These tasks are all accomplished through the VAV Air System editor, 
which is one of several editors in Tracer Summit that you use to set up, 
define, and modify elements in the system.

To create a VAV air system for Comm5 controllers, refer to Chapter 21, 
“Comm5 VAV Air Systems.”
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Accessing the VAV Air System Editor
1. From the Setup menu, select VAV Air System. The Select VAS dialog 

box displays (see Figure 300).

Figure 300.  Select VAS Dialog Box

2. Select an existing VAS object and click OK. The VAV Air System edi-
tor displays (see Figure 301).

Figure 301. VAV Air System Editor Status Screen
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Creating a VAV Air System Object 
To create a VAV Air System object, you follow these steps:

• Open and name the object (as described in this section)
• Assign VAS members (see “Assigning VAS Members” on page 336)
• Set up the VAV Air System (see “Setting Up a VAV Air System” on 

page 338)
• Modify setpoints (see “Modifying Setpoints” on page 341)
• Modify overrides, if necessary (see “Modifying Overrides” on 

page 342)
• Change control and security classes (see “Routing Alarms and Events 

and Setting Security Access” on page 343)

To create the VAV Air System object:

1. From the Setup menu, select VAV Air System. The Select VAS dialog 
box displays.

2. Click New. The New VAV Air System Name dialog box displays (see 
Figure 302).

Figure 302. New VAV Air System Name Dialog Box

3. Enter a name in the VAV Air System Name field. Make the name as 
informative as possible. Use a maximum of 32 characters. You must 
enter a name before you can save the new VAV Air System object. You 
can modify the name at any time from the Setup screen of the VAV 
Air System editor.

4. Click OK. The Status screen of the VAV Air System editor displays.

5. Click Save. The first time you save a new area, the Save VAV Air Sys-
tem dialog box displays (see Figure 303).

Figure 303. Save VAV Air System Dialog Box
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6. Select the name of the BCU in which you want the VAV Air System to 
reside.

7. Click OK.

Assigning VAS Members
Once the VAV Air System object is created, you must assign members. 
There are three different types of VAS members:

• Air handlers
• VAV boxes
• Ventilation-only devices

To assign members:

1. At the VAV Air System editor, click the Members tab to display the 
Members screen (see Figure 304).

Figure 304. VAV Air System Editor Members Screen

2. From the Category list box, select the category of the VAS members 
you would like to add. There are three options:

• Air handler
• VAV
• Vent only

3. In the Type list box, select the type of Air Handler, VAV, or Vent Only 
object from these options:

• Air handler: Binary Output, CPL Program, CSC, DAC, Intellipak, 
PCM, TCM, UPCM, Voyager, Voyager (Comm3), MP580/581
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Assigning VAS Members
• VAV: VAV I, VAV II/III/IV
• Vent only: Binary Output, CPL Program

The Name field now displays a list of all of the objects that are of the 
same object type selected in the Type list box.   

4. Select the name of the object you want to add. You can select as many 
members as you want.

5. Click Add to add the Selected members to the Current Members list 
box.

To change the Current Members list, click Remove or Remove All 
until the list displays only those members you want to add.

Resetting the Votes List for VAV Membership

The VAV Air System votes list keeps track of all its VAV members’ 
present values (for example, Occupied, Unoccupied, and Optimal Start) 
and minimum cooling flow setpoints. When VAVs are removed from the 
VAS membership list, the VAS retains votes from those VAVs that no 
longer belong to that VAS, until the votes list is reset. The Reset Votes 
button is used when VAV membership to the VAV Air System is altered.

To Reset the VAV Membership Votes List:

1. At the VAV Air System editor, click the Members tab to display the 
Members screen (see Figure 304 on page 336).

2. If VAV membership has changed (removed members), save the 
changes.

3. Click the Reset Votes button to remove votes no longer belonging to 
this VAS. 

Example:
The site called STARPORT has two VAV Air Systems in it (VAS#1 and 
VAS#2). Originally, each air system was set up with 20 VAV members 
each, which is a mistake. VAS#1 really has 18 VAVs connected to it while 
VAS#2 has 22 VAVs connected to it. To correct the situation, you must 
first remove the two extra VAVs from VAS#1. Then after saving the 
changes to VAS#1, you must click the Reset Votes button. The two extra 
VAVs are then added to VAS#2. Changes to VAS#2 are saved.

Note:

The BCU must be online in order for the reset to work. How-
ever, the Reset Votes button is always enabled.

Note:

It is not necessary to reset votes when VAVs are added to a 
VAS, only when VAVs are removed.
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Setting Up a VAV Air System
Once the VAV Air System object is created and members are assigned, 
you can set up the VAS to suit the individual needs of the system. You use 
the VAV Air System editor’s Setup screen to enter or modify setup infor-
mation.

To set up a VAV Air System:

1. From the VAV Air System editor, click the Setup tab (see Figure 305).

Figure 305. VAV Air System Editor Setup Screen

2. To modify the VAS name, enter a new name in the VAS Name field.

3. To modify the VAS minimum flow value, enter the minimum amount 
of air that the air handler members can deliver when the supply fan 
is on in the VAS Minimum Flow field. You can obtain this number 
from the air handler manufacturer.

4. To modify the heat/cool input, select one of these choices in the 
required Heat/Cool Input field:

• To allow the VAS to automatically determine its own heat/cool 
mode, select MWU Settings (morning warm up) from the list box. 
The heat/cool mode of the VAS will change between heating and 
cooling based on the values of the VAS morning warm up sensor, 
setpoint, and differential.

• If the air handler is a heating only or a cooling only machine, 
select either Heating or Cooling from the list box. Do not use a 
referencer.
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• Reference another heat/cool property in the Tracer Summit sys-
tem (perhaps the heat/cool mode of the Air Handler itself), using a 
referencer edit control. 

Although the Heat/Cool mode of the VAS can determine the heat/cool 
mode of its Air Handler members, it does not automatically do so. 
Typically, if the air handling unit is capable of making its own heat/
cool decision (as IntelliPak, Voyager, and CSC can), the air handling 
unit’s mode will determine the heat/cool mode of the VAS.

5. If you want the VAS to use the supply air temperature, in the Supply 
Air Temperature field enter a constant or assign a reference.

The Supply Air Temperature specifies the active temperature of the 
supply air feeding the VAV boxes of this system. Assigning a supply 
air temperature allows VAV II/III/IV members to make their own 
decision for heat/cool control action based on a comparison of supply 
air temperature and zone temperature.

If you select Not Used for the Supply Air Temperature field, the heat/
cool control action VAV II/III/IV members follow the heat/cool mode of 
the VAS.

6. To use the VAV Airflow Drive Max field, select the desired setting. 

• If you select Auto, the UCM uses its local control algorithms to 
decide when to implement the Drive max function. 

• If you use a referencer edit control, Auto displays in the entry 
field when the referencer is in the zero (0) state. In the zero state, 
the UCM can still locally decide to drive to maximum flow if it 
needs to. When the referencer is in the one (1) state, Drive Max 
appears in the entry field, and the Drive Max override is initiated 
from the Tracer Summit system.

• Some air handler units (such as IntelliPak, Voyager, and CSC) 
have properties that indicate when they are going into a constant 
volume heating mode, and thus require that all downstream VAV 
boxes open their air valves to maximum position. You must assign 
the property from the Air Handling Unit as the referencer. For the 
IntelliPak and Voyager, this property is called VAS Drive to Max. 

• If your air handler does not have a predefined property for heat-
ing mode, click the Overrides tab. On the Overrides screen, check 

Note:

Only VAV II/III/IV members can use the VAS supply air tem-
perature. VAV I members do not use the VAS supply air tem-
perature even if a sensor is assigned to the entry field. VAV I 
control action follows the heat/cool mode of the VAS.

Note:

During an Airflow Drive Max override, parallel fans, electric 
heat, and hot water heat are disabled for VAVs that have them. 

The VAV Airflow Drive Max field appears twice in the editor; 
once on the Setup screen and once on the Overrides screen.
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the box for Drive VAVs to Max Flow if VAS is Heating. Click Save 
and return to the Setup screen. 

7. To assign the morning warm up temperature, in the Temperature 
field select a referencer (which will typically be a zone temperature 
sensor in the system). Air handler members that are capable of a 
morning warm up cycle might want to reference the VAS Morning 
Warmup fields if they do not have their own. VAS does not automati-
cally determine the morning warm up settings for the air handling 
unit members, but provides reference information.

Occupied mode: If the temperature reported from the morning 
warm up sensor is less than or equal to the morning warm up setpoint 
minus the differential, the VAS heat/cool mode is heating. If it is 
greater than the morning warm up setpoint, the VAS heat/cool mode 
is cooling.

Unoccupied mode: If the temperature falls below this setpoint, the 
VAS heat/cool mode is heating. If it rises above it, the VAS heat/cool 
mode is cooling. The differential is ignored when the VAS is unoccu-
pied.

8. To assign the morning warm up setpoint, in the Setpoint field select a 
referencer (which will typically be a zone temperature setpoint in the 
system). If the VAS heat/cool input is left in MWU Settings, the morn-
ing warm up setpoint determines the cutoff point at which the VAS 
changes modes from heating to cooling or vice versa. (For a descrip-
tion of the occupied and unoccupied modes, see the previous step.)

9. To modify the morning warm up differential (the default is 2.0 
degrees), enter a number in the Differential field. The morning warm 
up differential value is the deadband used to keep VAS heat/cool 
mode from cycling too quickly between occupied heating and occupied 
cooling. You can set a 0.0°F to 10.0°F buffer that the temperature 
must surpass before switching modes. The differential is ignored 
when the VAS is unoccupied.

Note:

If you selected MWU Settings in the Heat/Cool input field, the 
system uses the Morning Warmup fields to determine its heat/
cool mode. (These fields have no other bearing on control.)
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Modifying Setpoints
The default values for the fields found on the VAV Air System editor’s Set-
points screen are what you would expect to find on most job sites. Occa-
sionally, however, you may need to change supply air setpoints, 
changeover delay times, changeover votes, and the VAV I control offset. 

To change setpoints:

1. From the Setup menu, select VAV Air System to display the Select 
VAS dialog box. The dialog box lists all existing VAS objects. 

2. From the list displayed in the Select VAS dialog box, select the one 
you want to modify.

3. Click OK to display the VAV Air System editor. The Status window 
becomes active and displays the settings and status of the object you 
selected. 

4. Click the Setpoints tab to display the Setpoints screen (see 
Figure 306).

Figure 306. VAV Air System Editor Setpoints Screen

5. Change the desired values in the Supply Air group, Changeover 
Delay Times group or the VAV I Control Offset field.

6. To change the values in the Changeover Votes group, refer to the sec-
tion “Modifying Changeover Vote Setpoints” on page 342.
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Modifying Changeover Vote Setpoints

The Present Value of the VAS is determined from the Present Value vot-
ing of the VAVs. A VAV box votes its Present Value to the VAS each time 
the VAV’s Present Value changes. The Minimum On and Minimum Off 
votes are the number of members required to vote for a change before the 
VAS considers the transition. You can redefine the number of VAV 
Present Value votes needed for Night Heat/Cool and Night Economize 
operations in these fields.

To change the value:

1. Click the text box of the value you want to change to Select the cur-
rent value.

2. Enter a new value for the number of votes.

3. Click Save.

Modifying Overrides
The Overrides screen of the VAV Air System editor contains the fields 
that override normal VAV box operation. To override the VAV terminal 
units’ flow control you can assign a binary reference to the appropriate 
flow override. You can also select the desired flow override from the list 
box.

You can override the VAV unit flow control either from the VAV object edi-
tor (individually) or from the VAS to which the VAV unit belongs. The 
VAV object editor source is the higher priority if there are overrides from 
both sources. 

To modify overrides: 

1. Click the Overrides tab in the VAS editor to display the Overrides 
screen (see Figure 307).

Figure 307. VAV Air System Editor Overrides Screen

2. Change the values in the desired fields by choosing a constant value, 
or reference another property in the system to control the field.
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3. To provide a VAV flow override to maximum if the VAS heat/cool 
mode is heating, click the check box next to the field Drive VAVs to 
Max Flow if VAS is Heating.

Routing Alarms and Events and Setting 

Security Access
At the VAV Air System editor’s Classes screen, you can assign alarm and 
event routing and set security access for the VAV Air System.

Defining Alarm and Event Routing

1. From the VAV Air System editor, click the Classes tab (see 
Figure 308).

Figure 308. VAV Air System Classes Screen

2. In the Control Class field, select a control class. The control class 
defines the event class that will receive an event message when the 
present value of the VAV Air System changes.
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Setting Security Access

1. From the VAV Air System editor, click the Classes tab.

2. Click the Security Classes button. The Change Security Classes dia-
log box displays (see Figure 309).

Figure 309. Change Security Classes Dialog Box

3. Click on the Access field next to each class to grant or deny access to 
the security class. A check in the field grants access. If unchecked, 
permission to the security class is denied.

4. Click OK to close the Change Security Classes dialog box.

Deleting a VAS Object
To delete a VAS object, use the Delete Objects utility from the Tools 
menu. Refer to Chapter 39, “Deleting Objects and Sites.”
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Chapter 23

Heat Pump Loop Control

The Heat Pump Loop Control (HPLC) application provides coordination 
between a water-source heat pump (WSHP) with Space Comfort Control-
ler (SCC) profile UCM and a Tracer loop controller. A Tracer loop control-
ler controls for example, pumps, cooling towers, and boilers for the WSHP 
water loop. The program performs two main functions:

• It enables or disables the compressors of WSHP members based on 
the operation of the water loop. For example, if there is no flow in the 
water loop, all WSHP compressors are disabled until flow is estab-
lished.

• It monitors the WSHP’s status and determines the proper water loop 
operation needed.

Each WSHP should be placed in an area and the area should be sched-
uled as desired. When a WSHP goes into the occupied mode, the HPLC 
application also goes occupied, and the Tracer loop controller is requested 
to operate the loop. When all units go into the unoccupied mode, the 
HPLC goes unoccupied, and the Tracer loop controller shuts down.

Note:

When in the unoccupied mode, the HPLC application monitors 
the need for heating or cooling (represented by the terminal 
load property) of all WSHP members in order to determine 
when to go into the Night Heat/Cool mode. Each WSHP mem-
ber votes its need-to-run based on a terminal load that is 
greater than 30% (a positive 30% for cooling and a negative 
30% for heating). When enough WSHP members vote a need-to-
run, the HPLC application transitions from the unoccupied 
mode to the Night Heat/Cool mode, enabling the Tracer loop 
controller to run.

All WSHP members vote continually to the HPLC concerning 
whether they have a need-to-run or not. The Need-to-Run 
Threshold located on the Setup screen determines how many 
WSHPs are needed to initiate Night Heat/Cool operation. In the 
Night Heat/Cool mode, the HPLC application commands the 
Tracer loop controller to run. In turn, the Tracer loop controller 
monitors system water flow and enables the WSHP compres-
sors to run, allowing the units to reach their unoccupied set-
points. The HPLC transitions back to the unoccupied mode 
when enough WSHP members fall within their unoccupied set-
points.
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Accessing the Heat Pump Loop Control 

Editor
1. From the Setup menu, select Heat Pump Loop Control. The Select 

Heat Pump Loop dialog box displays (see Figure 310).

Figure 310. Select Heat Pump Loop Dialog Box

2. Select a heat pump loop.

3. Click OK to display the Heat Pump Loop Control editor Status screen 
(see Figure 311).

Figure 311. Heat Pump Loop Control Status Screen
346 BMTX-SVP01B-EN
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From the Status screen you can view the following occupancy status of 
WSHP members:

• Tracer loop controller mode (as determined by the HPLC application)
• Current total heating and cooling loads for all WSHPs on this loop
• Compressor enable mode (as determined from the referencer on the 

Setup screen)
• Need-to-Run Votes 

Creating a New Heat Pump Loop Object

To create a new heat pump loop:

1. From the Setup menu, select Heat Pump Loop Control. The Select 
Heat Pump dialog box displays (see Figure 310 on page 346). 

2. Click New. The New Heat Pump Loop Name dialog box displays (see 
Figure 312).

Figure 312. New Heat Pump Loop Name Dialog Box

3. Type the name of the heat pump loop. Make the name as informative 
as possible. Use a maximum of 32 characters. You must enter a name 
before you can save the new heat pump loop. You can modify the 
name at any time from the Setup screen of the Heat Pump Loop edi-
tor.

4. Click OK. The Heat Pump Loop editor Setup screen displays (see Fig-
ure 313 on page 348).
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Setting Up the Heat Pump Loop Control 

Object
1. From the Heat Pump Loop Control editor, click the Setup tab (see 

Figure 313). 

Figure 313. Heat Pump Loop Control Setup Screen

2. In the Need-to-Run Threshold field, type the total number of need-to-
run votes needed from WSHP members before the HPLC transitions 
from the unoccupied mode into the Night Heat/Cool mode. The 
default number is 10 votes.

3. Set the Enable Startup field to a constant of Disable, or referenced to 
a binary output object that is controlled by a Time of Day Schedule 
(TOD) or CPL routine.

4. Check the Continuous Operation check box if you want the water loop 
to operate continuously. If this is checked, the Tracer loop controller is 
always in the occupied mode, regardless of individual WSHP sched-
ules or need-to-run.

Note:

The Enable Startup referencer field allows you to have the loop 
pre-heated or pre-cooled in advance of start up of the water 
source heat pumps.
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5. Assign a referencer to the WSHP Compressor field.

Assigning a Loop Controller Member 

1. In the HPLC Members Category field, select Loop Controller.

2. In the Type box, select the type of loop controller. This can be a Tracer 
loop controller, a PCM, UPCM, MP580 or MP581.

3. In the Name box, the available devices are shown. Highlight the 
name of the device you want to use as the loop controller.

4. Click the Add button to use this device as the loop controller.

5. To select an alternate loop controller follow steps 1–4, then click the 
Replace button.

Assigning a Water Source Heat Pump Member

1. In the HPLC Members Category field, highlight Water Source Heat 
Pump to select it. 

2. In the Name field highlight the unit you want to add.

3. Click the Add button to add the heat pump to the application.

Removing HPLC Members

1. From the Current Member List dialog box, highlight the HPLC mem-
ber that you want to remove.

2. Click the Remove button. To remove all members of the HPLC, click 
the Remove All button.

Note:

The WSHP referencer is used to monitor water loop operation 
and lock out compressor operation of the heat pumps when the 
loop is not operating properly. When a Tracer loop controller is 
used, the Compressor Control: Active property is automatically 
referenced. When a PCM or UPCM is used as the loop control-
ler, an appropriate referencer needs to be assigned. This could 
be a pump output, loop flow status, or a binary value that is set 
once all loop operation, including pumps, boilers and towers are 
proven.

Note:

Only SCCs can be assigned to this application.
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Setting Security Access
1. From the Heat Pump Loop editor, click the Classes tab to display the 

Classes screen (see Figure 314).

Figure 314. Heat Pump Loop Control Editor Classes Screen

2. Click the Security Classes button. The Change Security Classes dia-
log box displays (see Figure 315).

Figure 315. Change Security Classes Dialog Box

3. Click the Access field next to each class to grant or deny access to the 
security class. A check in the field grants access. If unchecked, per-
mission to the security class is denied.

4. Click OK to close the Change Security Class dialog box and display 
the Classes screen.
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Time of Day Scheduling

Time of day scheduling in Tracer Summit enables you to create and mod-
ify schedules that control HVAC equipment and lighting. It also gives you 
the flexibility to create time of day schedule reports from the scheduling 
screen (see “Creating Time of Day Schedule Reports” on page 366). 

Using the scheduling application, you can schedule equipment to start or 
stop at specific times during the day. You can use optimal start and stop 
times to turn equipment on as late as possible and turn it off as early as 
possible, while maintaining the desired comfort level in a defined zone or 
building.

You modify schedules using the Scheduling screen. A schedule is a set of 
defined events that applies to an effective period of time for one or more of 
the following:

• Areas
• UCMs
• Control points
• Set values

A schedule has a normal day defined for each day of the week. A normal 
day applies unless you create a holiday or an exception. Holidays take 
precedence over normal days, and exceptions take precedence over holi-
days and normal days.

You can define more than one set of events in a schedule for a site, and an 
object can be a member of more than one event in a schedule. However, an 
object cannot be active during two events simultaneously. For example, if 
a UCM is a member of one event that starts at 8 a.m. and stops at 5 p.m., 
it cannot be a member of another event that would require it to start at 
7 a.m. and stop at 4 p.m.

The Tracer 100/Tracker Communications package enables you to upload 
Tracer 100 schedules, edit them, and then download them to Tracer 100 
panels. For more information, see “Using Tracer 100 Schedules” on 
page 364.
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Accessing the Scheduling Screen
1. Click Schedule on the task bar. The Select TOD dialog box appears.

2. Select the schedule you want.

3. The Scheduling screen displays (see Figure 316).

Figure 316. Scheduling Screen

4. Select a month and year.

Tracer Summit displays the schedule for the selected name, month, 
and year.

Note:

If you need help with time of day scheduling, refer to the Daily 
Operations tutorial, Focus on Your System. (For information 
about using the tutorial, refer to the Tracer Summit Daily 
Operations guide.

Indicates Optimal 
Start/Occupied 
schedule

Indicates Night 
Economize

Indicates Lighting for 
BCU sites or Duty 
Cycle for T100 sites

Indicates Set Analog 
for BCU sites only

Occupied 
period

Optimal 
Start period
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Creating a New Daily Schedule
Refer to “Making Global Changes” on page 203 for information about how 
to modify a schedule that affects multiple schedules in the Time of Day 
Schedule application.

To create a new daily schedule:

1. Open the site to which you want the new schedule to apply.

2. Click Schedule on the task bar. The Select TOD dialog box appears.

3. Click New. The first Schedule Wizard dialog box displays (see 
Figure 317).

Figure 317. First Schedule Wizard Dialog Box

4. Type the name of the new schedule in the Schedule Name field.

5. Specify the Start Date using the up and down arrows. (The start date 
defaults to the selected date.)

6. Leave the No End Date check box selected if you do not want to spec-
ify an end date.

To specify an end date, uncheck the box to activate the End Date field. 
Then, use the up and down arrows to specify the end date.

Note:

The scheduling application can create new schedules for BCU 
sites only. You can create new schedules for Tracer 100 sites 
from the terminal emulation screen and from doing a system 
expansion on the Tracer 100 panel (see “Deleting a Tracer 100 
Schedule from the Workstation” on page 365). After this is 
done, scan the Tracer 100 panel for the new schedules. For 
more information about scanning Tracer 100 panels, see “Run 
Immediate Scan on a Single Site” on page 221.
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7. Click Next. The second Schedule Wizard dialog box displays (see 
Figure 318).

Figure 318. Second Schedule Wizard Dialog Box

8. Click the Member Types selection arrow to display the list of member 
types.

9. Select the desired member type to display in the Available Members 
list.

10. In the Available Members list, select the members to which you want 
the schedule to apply. 

11. Click Add to add the members to the Selected Members list. To add 
all available members to the Selected Members list, click Add All.

12. Click Next. The Schedule Wizard—Select Events Schedule Responds 
To dialog box displays (see Figure 319 on page 355).
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Figure 319. Schedule Wizard—Select Events Schedule Responds to 

Dialog Box

13. For each member in the Schedules column, define the schedule event 
types by selecting the check boxes under the desired column head-
ings. See Table 8 for an explanation of the direct relationship between 
schedule member types and event types.

Table 8. Scheduling Member Types

Note:

If a schedule contains a mixture of Normal and Optimal events 
(such as an Optimal Start and Normal Stop), the members 
must be set up as Normal and Optimal.

Schedule Member 
Type

Member Type Events

Normal Optimal
Night 

Economize
Lighting Set Analog

Area* Yes Yes Yes Yes No

Analog Output and 
Analog Value

No No No No Yes

Binary Output and 
Binary Value

Yes No No No** No

CPL Yes No No No No

UCMs Yes No No No No
Notes:
 *See Table 7 on page 303 for area mode/member mode behavior.
**To control a binary output (BOP) as a lighting member, the BOP must first be setup as a member of an area. This area is then 

added into TOD as a lighting event.
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14. Click Next. The Schedule Wizard—Set Default Event Times dialog 
box displays (see Figure 320).

Figure 320. Schedule Wizard—Set Default Event Times Dialog Box

15. For Normal, Optimal, and Lighting events, click the desired check 
boxes. Then, set the Start Event and Stop Event times, using the up 
and down arrows.

16. To schedule a start time and duration for the Night Economize event, 
click the Schedule Night Economize Events check box. Then, set the 
start time using the up and down arrows and enter the length of the 
event time in the Duration field.

17. To change the set analog start time, click the Set Analog Selected 
check box. Then, set the start time using the up and down arrows and 
enter the setpoint value in the Value field.
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18. Click Next. The final Schedule Wizard dialog box displays (see 
Figure 321).

Figure 321. Final Schedule Wizard Dialog Box

19. Click the check box for each day of the week on which you want the 
schedule to be effective. The Monday, Tuesday, Wednesday, Thursday, 
and Friday boxes are checked as defaults.

20. Click Finish. The Save New Schedule dialog box displays (see 
Figure 322).

Figure 322. Save New Schedule Dialog Box

21. Click the BCU Name selection arrow to display the list of available 
BCUs.

22. Select the BCU to which you want to save the schedule.

23. Click OK to display the Scheduling screen and the new schedule.
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Adding an Event to a Schedule
When adding events for a Tracer 100 schedule, consider the following:

Night Economize Events

Night economize, also known as purge cycle, events only apply to zone 
(point type 07) members in the schedule member list. The following 
conditions are required before the members of a zone economize:

• A night economize event is defined in the Time of Day Schedule 
application

• The zone is unoccupied
• The night enthalpy switch (if defined) is closed
• The inside space temperature is greater than the economizing 

setpoint
• The inside space temperature is greater than the night econo-

mizer delta temperature (if non-zero)
Duty Cycle Events

Duty cycle events establish when schedule members are allowed to 
duty cycle. This alone, however, will not duty-cycle the schedule mem-
bers. You must also define the duty cycle point for each member in the 
schedule while online with a Tracer 100 panel by means of a terminal 
emulation session. For zones in the schedule member list, the duty 
cycle event applies to the members of the zone, not to the zones them-
selves.

To add an event to a schedule:

1. Display the schedule you want to change.

2. On the clock grid, right-click the mouse once to display a submenu of 
events. The pop-up menu in Figure 323 appears for BCU sites. The 
pop-up menu in Figure 324 on page 359 appears for Tracer 100 sites.

Figure 323. List of Events for BCU Sites
358 BMTX-SVP01B-EN



Adding an Event to a Schedule
Figure 324. List of Events for Tracer 100 Sites

3. Select the event you want to add. Depending on the event you select, 
a dialog box appears for that event. For example, after you click one of 
the time bars, a Change Event Times dialog box similar to the one in 
Figure 325 appears. Depending on the event type that you choose to 
add, the fields that display in the dialog box vary.

Figure 325. Change Event Times Window

4. Click the Enable Start Event box.

5. In the Event Starts At field, select the time at which the event will 
start.

6. Click the Enable Stop Event box.

7. In the Event Ends At field, select the time when the event will end.

8. Click OK. The time bar for the new event displays in the clock grid.

Note:

Because Tracer 100 panels limit events, the Time of Day Sched-
ule application only lets you add up to six events each day in 
the schedule.
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Removing an Event from a Schedule
1. On the Scheduling screen, display the schedule you want to change.

2. On the time bar for the event you want to remove, click the right 
mouse button once to display a list of tasks (see Figure 326).

Figure 326. Displaying a List of Tasks

3. Select Delete Event. The event is deleted.

Changing a Schedule Name
You can only change names for BCU sites.

To change a BCU site name:

1. On the Scheduling screen, display the schedule you want to change.

2. From the Edit menu, select Schedule Name. The Change Schedule 
Name dialog box displays (see Figure 327).

Figure 327. Change Schedule Name Dialog Box

3. Enter the new schedule name in the New Name field.

4. Click OK.
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Adding a Member to a Schedule
You can only perform this function for BCU sites. You cannot use the 
scheduling application to add, remove, or insert member offsets in a 
schedule for Tracer 100 sites.

To add a member to a schedule:

1. On the Scheduling screen, display the schedule you want to change.

2. In the Schedule Members list box, right-click the mouse to display a 
pop-up menu (see Figure 328).

Figure 328. Pop-Up Menu

3. Select Add Members. The Add Members to Schedule dialog box dis-
plays (see Figure 329).

Figure 329. Add Members to Schedule Dialog Box

4. Click the Member Types selection arrow to display the list of member 
types.

5. Select the desired member type to display in the Available Members 
list.
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6. Select the member(s) you want to add to the schedule from the Avail-
able Members list.

7. Click Add to add the member(s) to the Selected Members list. To add 
all available members to the Members to Add list, click Add All.

8. Click OK.

Removing a Member from a Schedule
You can only perform this function for BCU sites. You cannot use the 
scheduling application to add, remove, or insert member offsets in a 
schedule for Tracer 100 sites.

To remove a member from a schedule:

1. On the Scheduling screen, display the schedule you want to change.

2. Select the member(s) from the Schedule Members list.

3. In the Schedule Members list box, right-click the mouse to display a 
pop-up menu (see Figure 328).

4. Select Remove Members. A dialog box displays warning you that you 
will permanently remove the member from the schedule.

5. Click Yes to remove the member from the schedule.

Setting or Modifying Offsets for 

Schedule Members
Offsets allow each member of a schedule to start before the defined occu-
pied start time and/or stop after the defined occupied stop time. Offsets 
are typically used to avoid having all equipment start at the same time.

You can only perform this function for BCU sites. You cannot use the 
scheduling application to add, remove, or insert member offsets in a 
schedule for Tracer 100 sites.

To set or modify offsets for schedule members:

1. On the Scheduling screen, display the schedule you want to change.

2. Select the member you want to offset in the Schedule Members list.

3. Right-click the mouse to display a pop-up menu (see Figure 328).

4. Select Set Member Offsets. The Set Member Offsets dialog box dis-
plays (see Figure 330 on page 363).
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Figure 330. Set Member Offsets Dialog Box

5. Set or modify the Start Advance time and Stop Delay time using the 
up and down arrows.

6. Click OK.

Changing a Schedule’s Effective Period
You can only use this function for BCU sites.

To change the effective period of a schedule:

1. On the Scheduling screen, display the schedule you want to change.

2. From the Edit menu, select Effective Period. The Effective Period dia-
log box displays (see Figure 331).

Figure 331. Effective Period Dialog Box

3. To change the Start Date, use the up and down arrows.

4. To change the end date, use the up and down arrows.

To specify no end date, click the No End Date check box.

5. Click OK.
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Save Events as a Normal Schedule to Weekdays, 

Weekends, and Holidays

Use this procedure to save modified schedules to specific days of the week 
(Sunday through Saturday) and/or save them as holidays. Before per-
forming the following steps, do the procedure described in one of the fol-
lowing:

• “Adding an Event to a Schedule” on page 358
• “Changing a Schedule’s Effective Period” on page 363
• “Removing an Event from a Schedule” on page 360

To save events as a normal schedule:

1. After you modify an event in the schedule, click Save.

2. The Save Normal Schedule dialog box appears.

3. Left-click the mouse on the days to which you want to save the sched-
ule. Options include:

• BCU Range—Sunday through Saturday
• Tracer 100 Range—Sunday through Saturday and all holiday 

dates
4. Click OK to save the changes for the selected days.

Using Tracer 100 Schedules
With the Tracer 100/Tracker Communications package you can access 
schedules for Tracer 100 panels online through the terminal emulation 
screen or use Tracer Summit’s Time of Day application to modify them.

The first time that you create a Tracer 100 site and connect to the panel, 
the Tracer Summit software scans the panel for existing schedules. The 
software uploads these schedules to your workstation. After the schedules 
are uploaded to your workstation, use the Time of Day application to 
modify Tracer 100 schedules online or offline as described in “Adding an 
Event to a Schedule” on page 358, and “Removing an Event from a Sched-
ule” on page 360.

If you modify Tracer 100 schedules offline in Tracer Summit, then the 
next time that you connect to the site, your changes are downloaded to 
the panel(s). When your workstation is connected to a Tracer 100 panel, 
any schedule changes go immediately to the panel.

If you have the Building Management or Enterprise Management pack-
age, use Task Manager to schedule when your off-line changes are down-
loaded to the Tracer 100 panel. For more information, see Chapter 15, 
“Using the Task Manager.”
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Accessing Tracer 100 Schedules

1. Log on and/or connect to the Tracer 100 site.

2. Click Schedule on the task bar. The Select TOD dialog box appears.

3. Select the desired schedule.

4. The Scheduling screen displays (see Figure 316 on page 352).

Globally Changing Tracer 100 Sites Schedules

◆ For Tracer 100 schedules, repeat the procedures in “Applying Global 
Changes to a Single Site” on page 204 and “Applying Global Changes 
to Multiple Sites” on page 205.

Deleting a Tracer 100 Schedule from the Workstation

You cannot remove a schedule from the Tracer 100 panel without clearing 
the panel’s memory, also known as doing a system expansion. You can 
remove the schedule from your workstation by deleting the schedule 
object (see “Deleting Objects” on page 652). However, because the Tracer 
100 panel always retains schedules in its memory, during the next scan 
the schedule that you deleted in the workstation will upload again from 
the panel.
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Creating Time of Day Schedule Reports
The schedule report provides information about time of day scheduling 
activities over a period of time. You select what information goes into the 
report (holidays, normal events, exceptions), the length of the reporting 
period (one day, one week, one month, etc.), and how the schedules are 
sorted in the report. You can create the report to include as many sched-
ules as you desire or just view the activities of one schedule over a report-
ing period. 

Figure 332 shows an example of a time of day schedule report containing 
information for multiple schedules. The report is sorted by start date and 
has a duration of one year. 

Figure 332. Time of Day Schedule Report

Note:

This report is also available in the standard site reports. For 
more information about standard site reports see “Designing 
Reports” on page 539.
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To create a time of day schedule report:

1. From the Scheduling screen click the Report button. The Choose Sort-
ing Criteria and Report Period dialog box displays (Figure 333).

2. Select the option that you want the schedules sorted by.

3. Select the length of the reporting period.

4. Click the Next button to display the Select Schedules dialog box (see 
Figure 334).

Figure 333. Sorting Criteria and Report Period Dialog Box

Figure 334. Select Schedules Dialog Box
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5. From the Available Schedules for Selected Period list, select the 
schedules that you want to include in your report.

6. Click the Add button to add those schedules to the Selected Schedules 
list.

7. Click the Finish button to create the time of day schedule report.

Adding event information to the report

Event information that you can add to the report is selected by default 
(see Figure 335). If you don’t want to include an event on the report, click 
on the checkbox to deselect it.

Figure 335. Scheduling information

Note:

To remove a schedule from the list click the Remove button.
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Chapter 25

Custom Programming 

Language

Tracer Summit’s Custom Programming Language (CPL) allows you to 
create custom programs to perform functions and calculations that can-
not be done by other applications in Tracer Summit.

The Tracer Summit PC Workstation is used to create CPL programs in 
the Tracer Summit CPL editor. The process of creating a CPL program 
begins with a CPL text file. The text file contains program logic state-
ments and comments. This chapter describes how to create, save, and 
compile a CPL text file. Once this process is complete, the CPL program is 
completed. This chapter also describes how the CPL program becomes an 
object that is sent to the system database and stored in a specific BCU. 

There are four basic steps used to successfully create and test a CPL pro-
gram object:

1. Create or Edit the CPL text file. CPL text files are created and 
edited using the CPL editor and saved to the PC Workstation data-
base.

2. Compile the CPL text file. The compiler checks for any syntax 
errors. After the syntax errors are corrected, you can compile the text 
file again. This process is repeated until it successfully compiles, at 
which point it is an executable CPL program.

3. Create the CPL Object in the Database. A successfully compiled 
CPL program is used either to create a new CPL object or replace an 
existing CPL object in the system database. During this step, a run 
frequency (if any) and the BCU where this program executes are 
assigned. The newly created CPL object is automatically sent to the 
BCU when the workstation is online.

4. Test the CPL Program. Once the CPL object is sent to the BCU, use 
the CPL editor to step through the program and test its logic.

Note:

For detailed information on specific CPL statements, functions, 
enumerations and so on, refer to Tracer Summit online help.

Tracer Summit includes a library of sample programs located 
in the folder C:\Program Files\Tracer Summit\cpl\library. 
You can also locate the sample programs in the Tracer Summit 
electronic library on the Tracer Summit CD (for more informa-
tion, see Chapter 5, “Utilities”).
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The process of creating a CPL program may require repeated editing if 
you have errors from the compile and/or test step. Once a step is repeated, 
you must repeat each successive step to complete the process of creating a 
successful CPL program. The steps to create a CPL program are 
explained in greater detail in the following sections.

Opening and Closing the CPL Editor
You can open the CPL editor with a blank file or with an existing CPL file 
displayed.

To open the CPL editor:

1. From the Setup menu, select Custom Programming. The Open dialog 
box displays.

2. Make a selection:

• To select a CPL file to work with, select the file’s location and 
name, then click Open.

• To display a blank text file, click Cancel.

The CPL editor displays.

To close the CPL editor:

◆ At the CPL editor main menu, click File. Then click Close CPL editor. 
The Tracer Summit main window displays.
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Creating or Editing a CPL Text File
The structure of a CPL text file is similar to a C or BASIC program file. 
You create this CPL text file using the Tracer Summit CPL editor because 
it contains features specific to CPL. You can also look in the library direc-
tory (C:\Program Files\Tracer Summit\cpl\library) for templates that 
you can adapt to suit your needs.

There are two ways to create a new CPL text file:

• Use a template (recommended). Follow the method in the section 
titled “Creating a CPL Text File From a Template” on page 371.

• Use a blank text window. Follow the method in the section titled “Cre-
ating a CPL Text File from a Blank Text Window” on page 374.

Creating a CPL Text File From a Template

The general steps required to edit a CPL text file in the CPL editor are as 
follows.

1. From the CPL editor File menu, select Open CPL Text File. The Open 
dialog box displays.

2. Open the Library directory (C:\Program Files\Tracer Sum-
mit\cpl\library). See Figure 336.

Figure 336. Open Dialog Box (Library Directory)

3. Select the desired CPL file. For a new routine, you can use the 
Header.cpl file, which has the recommended program structure.

4. Click Open to load the file into the CPL editor (see Figure 337 on page 
372). 
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Figure 337. Header File in the CPL Editor

5. Add the program name and text to the comment lines to define your 
program (see the section “Adding Comments” on page 374 for more 
details).

6. If applicable, use the predefined place in the Header.cpl file to define 
variables for the new program.

7. Using the Edit menu items for proper CPL syntax, insert the control 
statements and calculations that the program will use (see 
Figure 338 on page 373).
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Figure 338. CPL Editor Edit Menu

The Edit menu contains the following options:

• Add Statement (see “Adding Statements” on page 374)
• Add Function (see “Adding Functions” on page 375)
• Add Object (see “Assigning Objects and Properties” on page 376)
• Add Obj&Property (see “Adding an Object and Property Refer-

ence” on page 378)
• Add Enum Bool (see “Assigning Enumerations” on page 379)

8. Leave the word END on the last line of the program to let Tracer 
Summit know that the program is done.

9. From the CPL editor File menu, select Save CPL Text File As.

10. At the Save As dialog box, select the CPL\custom directory (do not 
save in the CPL\library directory). 

11. Type a new name for the program in the File Name field of the Save 
As dialog box. 

12. Click OK to save your CPL file to the PC Workstation. Save the file 
frequently during editing to avoid losing your work.

Note:

If special startup sequences are required after a power failure, 
naming a CPL program object “STARTUP_1”, “STARTUP_2”, 
etc., causes the program(s) to execute before all other applica-
tions execute after power is restored on the BCU.
BMTX-SVP01B-EN 373



Custom Programming Language
Creating a CPL Text File from a Blank Text Window

You can create a new CPL text file from a blank text window by inputting 
all the elements of a CPL program manually. However, it is recommended 
that you follow the method outlined in the section “Creating a CPL Text 
File From a Template” on page 371 to make the process of creating a new 
CPL text file easier. 

If you are going to create the CPL text file from a blank text window, you 
can review the CPL examples included with Tracer Summit for guidance 
on recommended format. The library of sample programs is located in the 
folder C:\Program Files\Tracer Summit\cpl\library or the Tracer Sum-
mit electronic library (for more information, see Chapter 5, “Utilities”).

You can display a blank text window for the creation of a new CPL text 
file in one of two ways:

• When you first enter the CPL editor (by selecting Setup, then Custom 
Programming, at the Tracer Summit main menu), click Cancel at the 
Open dialog box.

• At the CPL editor, from the File menu select New CPL Text File.

Once you have a blank text window in the CPL editor, create the program 
using the proper syntax end program structure. For more information, 
see “Creating a CPL Text File From a Template” on page 371.

Adding Comments

You must manually add comments to your CPL text file to explain the 
program steps. Comments will help you and others understand and debug 
the program later. There are two types of comments you can add:

• Comment lines beginning with /// use memory in the BCU. 

Type /// at the beginning of comment lines that you want to save to the 
BCU. These comments remain in the program after it is compiled and 
sent to the BCU. You see the comments when you open the CPL 
object.

• Comment lines beginning with // do not use BCU memory.

Type // at the beginning of comments lines that you want stored only 
in the CPL text file. This saves space in the BCU since these com-
ments are removed when the program is created as an object.

Adding Statements

1. Position the cursor in the CPL text file where you want to insert the 
statement.

2. From the Edit menu, select Add Statement. The Add Statement dia-
log box displays (see Figure 339 on page 375).
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Figure 339. Add Statement Dialog Box

3. Select the statement you want to insert in your file.

4. Click OK.

5. Use the proper syntax to complete the statement you have chosen.

Adding Functions

1. Put your cursor in the CPL text file where you want to insert the 
statement.

2. From the Edit menu, select Add Function. The Add Function dialog 
box displays (see Figure 340).

Figure 340. Add Function Dialog Box

3. Click on the function you want to add to your file.

4. Click OK.

5. Use the proper syntax to complete the function you have chosen.
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Assigning Objects and Properties

As a CPL programmer, you have access to a major subset of the objects 
defined in the BCU. You can directly enter an object name or property 
name. To avoid syntax errors use the CPL editor to reference objects and 
properties.

Adding an Object Reference

To assist you in specifying an object in your CPL program, the CPL editor 
has an object selection dialog box that you can access from the CPL editor.

To add an object reference:

1. Position the cursor in the CPL text file where you want to insert the 
statement.

2. From the Edit menu, select Add Object. The Select Object dialog box 
displays (see Figure 341).

Figure 341. Select Object Dialog Box

3. Select the object type and object name you want to insert.

4. Click OK to insert the object reference into your CPL text file.

Indirectly Referencing an Object

CPL provides an object pointer defined with a variable to reference an 
object indirectly. These variables are useful for being passed to proce-
dures that process an object. When not pointing to an object, object point-
ers have a null value.

Note:

The compiler will ignore spaces, tabs, and blank lines, but you 
must avoid carriage returns or word wrap (where the editor 
puts a dash mark to finish the word on the next line) when 
denoting an object name or property name in your file. The 
names of objects and properties used in the program must 
exactly match the names in the database. 
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You define variables to use as a user-defined shorthand name for an 
object. Once a variable has been defined, you can use it throughout the 
program to make the program more readable.

To indirectly reference an object:

1. Position the cursor in the Define Variables section of your CPL text 
file.

2. From the Edit menu, select Add Statement. The Add Statement dia-
log box displays (see Figure 342).

Figure 342. Add Statement—DEFOBJ

3. Select the DEFOBJ statement. 

4. Click OK to insert the DEFOBJ statement into the CPL text file.

Using the DEFOBJ statement adds two lines of code to the program: 
the statement DEFOBJ {object name} to the first line of the program 
and the object name at the cursor location.

5. In the CPL text file, type in a name for the variable defining the 
object pointer. For example:

DEFOBJ RTU1
RTU1 = {FINANCE DEPT TCM}

When defining an object, do not add a property reference to the vari-
able:

RTU1 = {FINANCE DEPT TCM}.{PRESENT VALUE}

Note:

Variable names are case sensitive. For example, the compiler 
sees the names OAT and oat as different variables.
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Indirectly Referencing an Object and Property

CPL provides an object and property pointer defined with a variable to 
reference an object and property indirectly. These variables are useful for 
being passed to procedures that process an object and property.

There are four types of variables available:

• DEFINT defines integers
• DEFLNG defines long integers
• DEFFLT defines single floating point values
• DEFDBL defines double floating point values

To indirectly reference an object and property:

1. Position the cursor in the Define Variables section of your CPL text 
file.

2. From the Edit menu, select Add Statement. The Add Statement dia-
log box displays.

3. Select the DEFINT, DEFLNG, DEFFLT, or DEFDBL statement and 
click OK. The statement is inserted.

4. In the CPL text file, type in a name for the variable defining the 
object and property pointer. For example:

DEFFLT ZONETEMP
ZONETEMP = {BCU#1 VAV-01-065}.{ZONE TEMPERATURE}

Adding an Object and Property Reference

To assist you in specifying an object and property in your CPL program, 
the CPL editor has an object and property selection dialog box that you 
can access from the CPL editor.

To add an object and property reference:

1. Position the cursor in the CPL text file where you want to insert the 
statement.

2. From the Edit menu, select Add Obj&Property. The Select Property 
Reference dialog box displays (see Figure 343).

Note:

Variable names are case sensitive. For example, the compiler 
sees the names OAT and oat as different variables.
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Figure 343. Select Property Reference Dialog Box

3. Select the object type, name, and property you want to insert.

4. Click OK to insert the property reference into your CPL text file.

Assigning Enumerations

Tracer Summit treats all binary and multi-state properties as integers. 
On is usually a 1 and Off is 0. These associations between words and inte-
gers are called enumerations. It is critical that the enumeration, once 
defined, appear the same throughout the entire program (identical spell-
ing and capitalization).

To assign enumerations:

1. From the Edit menu, select Add Enum Bool. The Select Property Ref-
erence dialog box displays.

2. Select the desired property from the list.

3. Click OK. The Enumeration/Boolean dialog box displays (see 
Figure 344). 

Figure 344. Add Enumeration Dialog Box
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4. Select the desired enumeration.

The enumeration is automatically defined as an integer with the 
proper syntax at the top of the CPL program. In this location, the 
resulting DEFINT statement is a global variable. It can be moved to 
another place in the program if desired.

5. Click OK.

Defining an Enumeration for Priority Shutdown

Say, for example, that you are writing a CPL program in which the 
Present Value of a PCM (attached to AHU1) is controlled to priority shut-
down. You want to define an enumeration for priority shutdown. To do 
this, you must perform the following steps (see “Example: Before Enu-
merated Booleans Program” on page 380 and “Example: After Enumer-
ated Booleans Program” on page 381 to see the effect of these steps).

To define an enumeration for priority shutdown:

1. Position the cursor at the location in the CPL program where the enu-
meration is to occur (for instance, at the location in the control state-
ment where the Present Value of the PCM is controlled).

2. From the Edit menu, select Add Enum Bool. The Select Property Ref-
erence dialog box displays.

3. Select the PCM object type, AHU1 object name, and PRESENT 
VALUE object property. Then click OK. The Enumeration/Boolean 
dialog box displays with the selectable enumerations listed.

4. Choose Priority Shutdown from the available list and click OK.

5. The program adds the words “Priority_Shutdown” where the cursor 
was positioned. 

The global variable is added to the top of the program where it auto-
matically defines Priority_Shutdown as an integer and sets it equal to 
6 (6 is the integer recognized internally by the system as 
Priority_Shutdown for the Present Value of the AHU1 PCM).

Example of Assigning Enumerated Booleans

The following two examples show the effect of assigning enumerated bool-
eans to a sample program.

Example: Before Enumerated Booleans Program

This is an example of a CPL text file before an enumeration is assigned.

Program AHU1_SHUTDOWN
// Written: December 15, 1992 by Ryan Smith
// Modifications:
// None
// Properties modified:
 // {AHU1 PCM}.{Present Value}
/// This program is executed by Binary Input AHU1 ALARM;
/// therefore, the frequency should be set at 0 seconds.
/// This program turns the AHU Off anytime the binary input
/// AHU1 ALARM is turned On.
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/// This CPL object uses the text file named AHU1SD.CPL
Defint 
On = 1, // Define enumerations 
Off = 0
If ({AHU1 ALARM}.{Present Value} = On) Then 
// If alarm switch is turned On 
Control ({AHU1 PCM}, {Present Value}, 6, 2, SET) 
// Turn the AHU Off
Else
// If alarm switch is turned Off 
Control ({AHU1 PCM}, {Present Value}, 6, 2, RELEASE) 
// Release the AHU to normal control 
End If
End 

Example: After Enumerated Booleans Program

This is the same CPL text file after the CPL editor assigns the enumera-
tion (the changes are in boldface type).

Defint Priority_Shutdown = 6

Program AHU1_SHUTDOWN
// Written: December 15, 1992 by Ryan Smith
// Modifications:
// None
//
// Properties modified:
//{AHU1 PCM}.{Present Value}
/// This program is executed by Binary Input AHU1 ALARM;
/// therefore, the frequency should be set at 0 seconds.
/// This program turns the AHU Off anytime the binary input
/// AHU1 ALARM is turned On.
/// This CPL object uses the text file named AHU1SD.CPL
Defint
On = 1, // Define enumerations
Off = 0
IF ({AHU1 ALARM}.{Present Value} = On) Then
// If alarm switch is turned On 
Control ({AHU1 PCM}, {Present Value}, Priority_Shutdown, 2, SET) 
// Turn the AHU Off 
Else
// If alarm switch is turned Off 
Control ({AHU1 PCM}, {Present Value}, Priority_Shutdown, 2, RELEASE) 
// Release the AHU to normal control 
End If
End 
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Using Arrays

Tracer Summit CPL allows arrays of objects and/or properties to be cre-
ated to reduce the number of CPL statements needed for a CPL program. 
Arrays also make it easier to edit a CPL program once it has been created 
by arranging objects and properties in a specific order. Arrays are typi-
cally used in CPL programs where repetitive calculations are performed 
(such as programs that use FOR...NEXT statements). 

The syntax for defining an array that points to objects and their proper-
ties is:

Defint BIP[6]
BIP[1]={object A}.{property}
BIP[2]={object B}.{property}
BIP[3]={object C}.{property}
BIP[4]={object D}.{property}
BIP[5]={object E}.{property}
BIP[6]={object F}.{property}

The syntax for defining an array that points to objects is:

Defobj BOP[6]
BOP[1]={object A}
BOP[2]={object B}
BOP[3]={object C}
BOP[4]={object D}
BOP[5]={object E}
BOP[6]={object F}

Example Array Program

The following example is a program that looks at the status of binary 
inputs (set up in an array), goes through this array, and matches a binary 
output to the binary input. The binary output might be directed to a TCM 
binary output that controls a lighting relay somewhere else in the facility.

PROGRAM Motion_Status_Lights
// Written 11/20/92, by Seymour Anderson
//
// Properties modified: (BOPs) 
// {Area1 Status Light}.{Present Value} 
// {Area2 Status Light}.{Present Value} 
// {Area3 Status Light}.{Present Value} 
// {Area4 Status Light}.{Present Value} 
// {Area5 Status Light}.{Present Value} 
// {Area6 Status Light}.{Present Value}
//
// Properties read: (BIPs) 
// {Area1 Motion}.{Present Value} 
// {Area2 Motion}.{Present Value} 
// {Area3 Motion}.{Present Value} 
// {Area4 Motion}.{Present Value} 
// {Area5 Motion}.{Present Value} 
// {Area6 Motion}.{Present Value}
/// This program monitors the status of several binary inputs
/// throughout the building and directly controls matching binary
/// outputs connected to the status light panel in the security station.
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/// This program is executed anytime a binary input changes state.
/// This CPL object uses the text file named AREASTAT.CPL

DEFINT
Off = 0, // Enumeration for Off
On = 1, // Enumeration for On 
NUMB = 6, // Define number of binary inputs and outputs
BIPS[NUMB], // Define array for binary inputs
i // Define index for FOR-NEXT statement

DEFOBJ
BOPS[NUMB]// Define array of binary outputs that will 
// match the binary inputs

// Define the array of binary inputs
BIPS[1] = {Area1 Motion}.{Present Value}
BIPS[2] = {Area2 Motion}.{Present Value}
BIPS[3] = {Area3 Motion}.{Present Value}
BIPS[4] = {Area4 Motion}.{Present Value}
BIPS[5] = {Area5 Motion}.{Present Value}
BIPS[6] = {Area6 Motion}.{Present Value}

// Define the array of binary outputs
BOPS[1] = {Area1 Status Light}
BOPS[2] = {Area2 Status Light}
BOPS[3] = {Area3 Status Light}
BOPS[4] = {Area4 Status Light}
BOPS[5] = {Area5 Status Light}
BOPS[6] = {Area6 Status Light}

For i =1 to NUMB step 1 
If (BIPS[i] = On) 
Then 
// Turn the light BOP ON
CONTROL(BOPS[i], {Present Value}, On, 5, SET)
Else 
// Turn the light BOP OFF
CONTROL(BOPS[i], {Present Value}, Off, 5, SET)

End If
Next
End 

Using Saved Values

Each CPL program has 16 properties called saved values. Saved values 
can store variables in memory between CPL executions, share CPL vari-
ables with other CPL programs or applications within the Tracer Summit 
system, or display on a graphic. 

Typically you use a saved value when you want to save a calculation from 
one execution to the next (such as a timer or counter). Saved values can 
be either local (defined within the current program) or referenced from 
another CPL program object. 

CPL variables are initialized to zero and are not saved between CPL exe-
cutions. Therefore, CPL variables must be assigned a value at the start of 
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the program or otherwise a new value must be calculated each time the 
CPL program runs. 

An analog or binary input can be set up to reference a CPL saved value 
and alarm if it exceeds the alarm limits (refer to Chapter 17, “Creating 
Input/Output Objects”, for more information on setting up analog inputs).

To read or write a local saved value in your program:

1. Position the cursor where you want the saved value to reside.

2. From the Edit menu, select Add Statement.

3. Select LOCAL.{SAVED VALUE}[ ]

4. Click OK to insert the following line into your program:

Local.{Saved Value}[ ]

5. Add a number within the square bracket to indicate the array num-
ber of the saved value (1-16).

To read or write a saved value from another CPL program:

1. Position the cursor where you want the saved value to reside.

2. From the Edit menu, select Add Obj&Property. The Select Property 
Reference dialog box displays.

3. Select the CPL program object from the Type list. 

4. Select the CPL program name from the Name list. 

5. Select the Saved Value [#] you want to reference from the property 
list (see Figure 345).

Figure 345. Select Property Reference Dialog Box—Saved Value
 

6. Click OK. The CPL editor will insert the statement. For example:

{Chiller_Control}.{Saved Value}[7]
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Saved Value Program Example

In the following example, a timing function is performed, based on a local 
saved value.

Program Exhaust_Fan1
// Written 3/22/97 by Eugene Jones
// Properties modified: 
// {Exhaust Fan1}.{Present Value} 
// Local.{Saved Value}[1]
// Properties read: 
//{Warehouse Temperature}.{Present Value} 
//{Warehouse Exhaust Fan Setpoint}.{Present Value}
/// This program controls the exhaust fan for the warehouse on 
/// anytime the space temperature exceeds setpoint for 10 minutes.
/// This program is executed every minute to keep timers in sync.
/// This CPL object uses the text file named EXHAUST1.CPL

Defint 
Off = 0,//Enumeration for Off 
On = 1,//Enumeration for On 
Timer_1
// If space temperature is 1 F above setpoint, start 10 minute timer
Timer_1 = Local.{Saved Value}[1]
If
({Warehouse Temperature}.{Present Value} > ({Warehouse Exhaust Fan Set-
point}.{Present Value} +1)) 
Then
Timer_1 = Timer_1 + 1 
Else
Timer_1 = 0 
End If
// Control the exhaust fan On or Off 
If (Timer_1 > 10) Then
Control({Exhaust Fan1}, {Present Value}, On, 5, SET) 
Else 
Control({Exhaust Fan1}, {Present Value}, Off, 5, SET) 
End If
// Store Timer value for the next execution
Local.{Saved Value}[1] = Timer_1
End
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Compiling a CPL Text File
Once the text file for the CPL program is created and saved as a CPL file, 
your next step is to compile the program. The CPL editor analyzes the 
currently loaded CPL text file for syntax errors and valid object and prop-
erty names. Compiling the text file also structures the information into a 
CPL object format so that it can be sent to the Tracer Summit database. 

To compile a CPL text file:

1. In the CPL editor, open the CPL text file you would like to compile.

2. From the Program menu, select Compile.

If there are syntax errors or errors in object or property names, the 
Compile Report dialog box identifies each error, the type of error and 
the line in the program where the compiler finds an error (see 
Figure 346).

Figure 346. Compiler Report

3. Double click on the line listed in the Compile Report dialog box to go 
to that line and fix the errors, or use the Go To Line command on the 
Edit menu.

Depending on how the text file was edited, the line given as the loca-
tion of the syntax error may actually be the line after the location 
where the error occurred. Therefore, look at the line indicated and the 
lines before it when looking for syntax errors. 

4. After you make your corrections, save the file.

5. Run the compile function again. Repeat this cycle (steps 2 - 4) until 
the Compile Report dialog box displays “Successful Compile,” indicat-
ing that there are no errors (see Figure 347 on page 387).
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Figure 347. Compiler Report—Successful Compile

6. After compiling successfully, click Close.

7. Save the CPL text file again. It is important to save the file after a 
successful compile.

Creating a CPL Object in the Database
In this section, you will see how to use a successfully compiled CPL text 
file to create a CPL object in the Tracer Summit database. The objective 
is to send the compiled CPL program to be stored as an object in the 
selected BCU. After the program is stored at the BCU, the BCU software 
schedules the CPL program to execute at a selected frequency and per-
forms the program logic during each execution.

During this step, you will be selecting:

• The CPL object name
• The security classes
• The CPL program execution frequency (if any)
• The BCU where the CPL object will be stored

You can either create a new CPL object in the database or overwrite an 
existing CPL object. To overwrite an existing CPL object see “Replacing 
an Existing CPL Object in the Database” on page 389.

Note:

In addition to errors, this dialog box also displays warnings. Pro-
grams can successfully compile when warnings are generated. 
They fail if errors are generated.
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Creating a New CPL Object in the Database

When you have successfully compiled CPL text files saved on the PC 
Workstation, the Create and Replace items on the Program menu are 
available to allow you to create a CPL object in the Tracer Summit data-
base.

To create a new CPL object in the database:

1. Once you have successfully compiled the CPL text file, from the Pro-
gram menu select Create CPL Object. The CPL Program Creation 
editor dialog box displays (see Figure 348).

Figure 348. CPL Program Creation Editor

The default name displays in the Program Name field. This is the 
name from the program statement of the CPL text file. Do not change 
the name.

2. From the BCU drop-down list, select the BCU where the CPL pro-
gram object will be stored. Store the CPL object in the same BCU that 
most of the objects and properties referenced in the CPL program 
reside.

3. Define the frequency with which the CPL program runs. To set this 
frequency click the up/down arrows on the right side of each box. It is 
recommended that CPL programs run no faster than once every 30 
seconds. Normally, programs run every minute, every hour, every day, 
or are event-driven, based on the functions performed in the CPL pro-
gram.

4. To assign security classes click Security Classes. (For more informa-
tion on assigning security classes, refer to Chapter 9, “Setting Up 
Security—Tracer Summit System.”)
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5. On the CPL Program Creation editor dialog box, click Create to create 
the CPL object and return to the CPL editor.

A Status dialog box displays stating whether sending the CPL object 
to the BCU was successful. If the PC Workstation is online with the 
BCU, a “Successful Operation Online” message displays. If the PC 
Workstation is offline, the CPL editor sends the CPL object to the PC 
Workstation database, and a “Successful Operation Offline” message 
displays. When the PC Workstation goes online, it sends the CPL 
object to the selected BCU.

Replacing an Existing CPL Object in the Database

When you have successfully compiled CPL files saved on the PC worksta-
tion, the Create and Replace items on the Program menu allow you to 
replace a CPL object in the Tracer Summit database.

To replace an existing CPL object in the database:

1. Once you have successfully compiled the CPL text file, from the Pro-
gram menu select Replace CPL Object. The Select CPL Program dia-
log box displays (see Figure 349).

Figure 349. Select CPL Program Dialog Box

2. Select the CPL program object to be replaced and click OK.

3. The CPL Program Replacement editor dialog displays (see Figure 350 
on page 390).
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Figure 350. CPL Program Replacement Editor

4. Define the frequency with which the CPL program runs. To set the 
frequency click the up/down arrows on the right side of each box. It is 
recommended that CPL programs run no faster than once every 30 
seconds. Normally, programs run every minute, every hour, every day, 
or are event-driven, based on the functions performed in the CPL pro-
gram.

5. To assign security classes, click Security Classes. (For more informa-
tion on assigning security classes, refer to Chapter 9, “Setting Up 
Security—Tracer Summit System”.)

6. At the CPL Program Replacement editor, click OK to replace the CPL 
object and return to the CPL editor.

A Status dialog box displays stating whether sending the CPL object 
to the BCU was successful. If the PC Workstation is online with the 
BCU, a “Successful Operation Online” message displays. If the PC 
Workstation is offline, the CPL editor sends the CPL object to the PC 
Workstation database and a “Successful Operation Offline” message 
displays. When the PC Workstation goes online, it sends the CPL 
object to the selected BCU.

Note:

• In the CPL Program Replacement editor dialog box, the BCU 
field is unavailable, because the program is being replaced at 
the BCU where the previous program object resides.

• The default name displays in the Program Name field which is 
the name of the CPL object. Do not change the name.
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Testing a CPL Program
Testing (debugging) allows you to step through a specific CPL program to 
view variables and properties, and to verify proper performance of the 
program. You can perform CPL testing only when the PC Workstation is 
online with the BCU containing the CPL object.

You will usually encounter two kinds of problems when testing a CPL pro-
gram:

• The program results in the wrong values for the program variables.
• The program halts because of a runtime error. Runtime errors are 

errors that do not appear when a program is compiled, but do appear 
when the program is executed.

Testing a CPL program will help you identify and resolve both types of 
problems.

To test a CPL program:

1. From the Test menu, select Start Debug. The Select CPL Program 
dialog box displays (see Figure 351).

Figure 351. Select CPL Program Menu

2. Select the program you want to test. Then click OK or double click the 
desired program.

The background color of the CPL editor changes to cyan when the edi-
tor is in the debug (or test) mode. The first line of the program will be 
highlighted, indicating that the test mode is ready to execute.

Note:

When a CPL program is in the debug mode, WAIT statements are 
executed. For longer WAIT statements, it is recommended that 
they temporarily be shortened or commented out (insert “//” or “///” 
in front of the statement and recompile) before testing the CPL 
program.
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3. Select Inhibit DB Writes on the Test menu to prevent the program 
outputs from being performed.

4. If necessary, use the Set Breakpoint function on the Test menu to 
manually enter a point in the program at which the program execu-
tion will stop. 

A break is useful at a point in the program just before a problem area, 
or for an area that you want to test more slowly by stepping through 
line-by-line.

For example, to test a program you can insert a break just before a 
problem area in the program. To begin the test, from the Test menu 
select Run. When the program stops at the set break point, use the 
Step function to execute the program line by line from that point. 

5. Use the Run or Step items on the Test menu to execute the program 
test. 

If you click Step, only one line of the program executes. If you select 
Run, the editor tries to execute the entire program until it hits a 
Break or the End statement, or until a runtime error occurs.

6. From the Test menu, select View Variable. The Variable Viewer dialog 
box displays (see Figure 352 on page 393).

Note:

• When a CPL program is in the debug mode, the programmer is 
manually running the CPL program. All outputs from the pro-
gram are performed unless the Inhibit DB Writes menu item 
is selected.

• Inhibit DB Writes will prevent the program from writing to 
the database, and prevent any control functions of the pro-
gram. The calculations contained in the program will be per-
formed as intended, but no outputs will be sent out.
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Figure 352. Variable Viewer Dialog Box

7. When you encounter a problem that involves editing the CPL pro-
gram, from the Test menu, select Stop Debug. If the program encoun-
ters a runtime error, see the section “CPL Error Codes” on page 394 
for explanations of the error codes and possible solutions.

8. Load the original CPL text file back into the CPL editor. You should 
not use the decompiled program used for the test to do your edits. The 
original CPL text file contains the all the extra comment lines that 
are not saved in the compiled program.

9. Edit the CPL text file to fix the problems encountered during the test.

10. Compile the program (see “Compiling a CPL Text File” on page 386). 

11. Replace the CPL object in the database (see “Replacing an Existing 
CPL Object in the Database” on page 389).

12. Test the new CPL program again. Repeat these steps for testing a 
CPL program until the program runs properly and gives the desired 
results.
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CPL Error Codes
Table 9 shows the error codes that are displayed when you encounter a 
problem during testing of a CPL program object. Use the Possible Cause 
and Possible Solution columns of the table to help you fix your CPL pro-
gram when one of these errors is encountered. If problems persist contact 
your local Trane representative. 

Table 9. CPL Error Codes 

Error Possible Cause Possible Solution

Error-30 Requested unit is down. The CPL object is trying to access a property in a BCU 
that is currently not available.

Error-39 An invalid index was provided for 
accessing an array element.

The array of Local.{Saved Value} properties in each CPL 
object has only 16 elements. Trying to access element 
17 or higher causes this error. For example, the follow-
ing compiles, but causes this error.

Num=21
For I=1 to Num step 1
Local.{Saved Value}[i]=VAV[i].{Zone Temperature}
Next

Error-103 The CPL program’s Get Property table 
entry call failed.

The property referred to in the CPL routine could not be 
found for that object.

Error-250 The CPL program has a bad symbol 
type.

Recompile and replace the CPL object.

Error-251 The CPL program has a bad expression 
stack.

A bad expression exists in the routine. A common error 
is to forget to add the property in a statement that is 
intended for testing the property. For example,

If ({Area 1} = 2) Then
rather than

If ({Area 1}.{Present Value}= 2) Then

Error-252 CPL program has a bad program stack. Adjust the Context Size property of the CPL object. The 
default context size is 624. Change the value from 624 to 
1248. If the error still occurs, change the value to 1872. If 
the routine then runs, change the value to 1560. Keep 
adjusting the value to find the proper context size.

Error-253 CPL program has an invalid symbol 
stack offset.

Recompile and replace the CPL object. 

Error-254 CPL program has a bad BCX_ITRP exe-
cution queue or the entry was not found.

Recompile and replace the CPL object. 

Error-255 The CPL program has an invalid/unsup-
ported token operation.

Recompile and replace the CPL object. 

Error-256 The CPL program has a general problem 
with a symbol.

Recompile and replace the CPL object.

Error-257 The CPL program has overflowed its P 
stack or E stack.

Adjust the Context Size property of the CPL object. The 
default context size is 624. Change the value from 624 to 
1248. If the error still occurs, change the value to 1872. If 
the routine then runs, change the value to 1560. Keep 
adjusting the value to find the proper context size.
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Error-258 CPL program has an array index that is 
out of bounds.

An array index is too big or too small. You may have 
defined the array to have three elements, and then tried 
to perform an operation on array element four. Also 
remember that 0 is not a valid array index.

Error-259 The CPL program has a bad assignment 
(usually unequal types).

Recompile and replace the CPL object.

Error-260 The CPL program has an unknown 
token.

Recompile and replace the CPL object. 

Error-261 The CPL program has a BCX_ITRP that 
had a problem looking up symbol (usu-
ally invalid type).

Recompile and replace the CPL object.

Error-262 The CPL program parameter and argu-
ment types do not match.

Recompile and replace the CPL object.

Error-263 The CPL program has underflowed its 
expression evaluation stack.

Recompile and replace the CPL object. 

Error-264 The CPL program has underflowed its 
program stack.

Recompile and replace the CPL object. 

Error-265 The CPL program (or BCX_ITRP) has 
problem with nested If statements.

Recompile and replace the CPL object.

Error-266 The CPL program has attempted to 
divide by zero.

Debug the routine to find where the divide by zero error 
is occurring. Determine whether a variable is not being 
initialized (variables are always 0 unless initialized to 
another value). Question whether the MIN/MAX opera-
tors or an IF-THEN statement can be used to prevent the 
variable in the denominator from going to 0.

Error-267 The CPL program has a bad storage 
address for symbol.

Recompile and replace the CPL object. 

Error-268 The CPL program is too small to be cor-
rect.

Recompile and replace the CPL object. 

Error-269 The CPL context is too small to be cor-
rect.

Recompile and replace the CPL object. 

Error-307 An invalid property size was given. Debug the routine to find where the property size error 
is occurring. A common error is controlling a binary out-
put to a value other than 0 or 1.

Table 9. CPL Error Codes (Continued)

Error Possible Cause Possible Solution
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Chapter 26

Using the Navigation Tree

The navigation tree is a convenient and intuitive way for users to find and 
display information in Tracer Summit. The navigation tree displays next 
to the Tracer Summit application window. Daily operators can see where 
they are in the system and where they can go. Daily operators can also 
use the navigation tree to connect with sites or gather information about 
their system.

The ability to connect to Tracer 100 and Tracker sites by double-clicking 
is available in the Tracer 100/Tracker Communication and Enterprise 
Management packages. Connecting to BCU sites by double-clicking a 
node on the navigation tree is available in Tracer Summit as a standard 
feature.

Each item on the tree is called a node. For a description of nodes and their 
functions, see “Different Types of Nodes” on page 399. Nodes appear auto-
matically as you build sites and add objects. To make your navigation tree 
logical and easy to use, arrange the tree to represent the way your organi-
zation is set up. For example, if sites are organized in geographical 
regions, arrange nodes based on this geographical layout.

Depending on security level, users can:

• Rearrange an existing navigation tree using drag and drop and cut 
and paste commands

• Connect to or disconnect from a site
• Add and remove nodes
• Change the graphic associated with a UCM, area, or site

Note:

Except for systems with shared databases, the navigation tree 
is unique to each workstation. You cannot change a navigation 
tree on one workstation and have these changes reflected auto-
matically on another workstation. To copy navigation tree 
changes from one workstation to another, back up the site data-
base of the workstation where you made the changes and 
restore it to the other workstation.
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The Navigation Tree
The navigation tree graphically depicts where in the system you are and 
where you can go. Think of the site node as a place where other sites or 
nodes exist. Nodes outside the site node belong to the system. Nodes 
inside the site node belong to the site (see Figure 353).

When a node has nodes inside it, a plus (+) symbol displays in front of the 
node. Click the + symbol to expand the node and to display the nodes 
inside it. After you expand a node, a minus (-) symbol displays in front of 
the node. Click the - symbol to collapse the node.

Figure 353. Sample View of the Navigation Tree with Various Nodes

System node

Group of sites node

Tracer 100 site node

Custom site graphic 

Area node

Panel node

Macro node

Tracker site node

Custom global 
graphic node

Tracer Summit BCU 
site node

UCM nodes
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Different Types of Nodes
The ten types of nodes found on the navigation tree appear in Table 10. 
For further information about nodes, see “Basic Considerations in Moving 
Nodes” on page 402.

Note:

In the following paragraphs, we refer to connecting to a site by 
double-clicking a site node on the navigation tree. Connecting 
to sites automatically when you double-click on them is set up 
in the System Options editor (see “Setting Connection Features 
of the Navigation Tree” on page 580). For more information, see 
“Connecting to a Site from the Tree” on page 401.

Table 10. Navigation Tree Nodes: Types, Icons, and Descriptions 

Node Type Icon Description/Action

System The Tracer Summit system node belongs to the system. All other nodes are 
inside the system node. The system node is the collection of all site nodes.

Tracer Summit 
BCU Site

A site node is any site in the system that belongs to the system. Site nodes 
display after you create, restore, or upload a site.
When you double-click on a site node, its linked graphic appears in the appli-
cation window. Double-click the site node again to connect to it or to program 
off-line. 
When you connect to a Tracer 100 or Tracker site, the terminal emulation 
screen appears. When the site is a multiple-panel Tracer 100 unit-to-unit site, 
the panel to which you connect is unit 1 (the COP).

Tracer 100 Site

Tracker Site

Panel A panel node appears for each remote unit that you create for legacy Tracer 
100 and Tracker sites. Double-click a panel node to connect to it or to program 
off-line.

Group of Sites;
also known as a 
Custom Global 

Graphic Without site 

nodes, 

appears as:

...

The group of sites node is a collection of sites. It is a custom global graphic 
node belonging to the system site. A group of sites node differs from a cus-
tom global graphic node in the following way. A group of sites node has at 
least one site node inside it. The custom global graphic node has no site 
nodes inside it. The group of sites node is not associated with groups.
When you double-click a group of sites node, its linked graphic displays in the 
application window.

Custom Site 
Graphic

… The custom site graphic node is found inside a site node. When you double-
click a custom site graphic node, its linked graphic displays in the application 
window. You can also double-click the node to connect to it or to program off-
line.

Area Node … An area node appears for each area defined in a BCU site. UCM and custom 
site graphic nodes are commonly found inside area nodes. Double-click an 
area node to see its linked graphic in the application window. If you are not 
connected already, the Tracer Summit software also connects you to the site 
to which the area node belongs.
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Using the Navigation Tree
Use the navigation tree to access nodes, sites, equipment, and macros.

Accessing the Tree

◆ From the View menu, select Navigation Tree.

• To expand the entire tree, double-click the system node.
• To collapse the tree, double-click the system node.

Using the Tree Menu and Pop-up Menus

The selections that are available from the Tree menu or pop-up menus 
depend on the type of node you have selected. Therefore, using the pop-up 
menu is a convenient way to access actions such as Cut, Paste, Add/Edit/
Change/Remove Graphics, Connect Site, Add Macro, and so on.

To access a pop-up menu:

◆ Right-click the mouse on a node in the navigation tree to display a 
pop-up menu specific to that type of node (see Figure 354).

Figure 354. Navigation Tree Pop-up Menu

UCM Node … A UCM node appears for each UCM defined in a BCU site. UCM nodes are 
grouped together, most often inside area or custom site graphic nodes. Dou-
ble-click a UCM node to see its linked graphic in the application window. If 
you are not connected already, the Tracer Summit software also connects you 
to the site to which the UCM belongs.

Macro … Macro nodes are found inside Tracer 100 and Tracker sites. When you are 
connected to a site and you double-click a macro node, it runs regardless of 
what site panel is active.

Table 10. Navigation Tree Nodes: Types, Icons, and Descriptions (Continued)

Node Type Icon Description/Action
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Accessing Sites and Equipment

◆ To access a node and its equipment, perform one of the following:

• Click the + symbol to expand a node to display nodes inside it.
• Click the - symbol to collapse a node when nodes inside it are dis-

played.
• Double-click a node to open it. This opens the site but does not 

necessarily connect to it. See “Connecting to a Site from the Tree” 
for more information on connecting to sites when you double-click 
their nodes.

Connecting to a Site from the Tree

When you use the navigation tree to connect to a site, you can only use 
the connection method you set up in site configuration in the Site Connec-
tion Wizard. For more information, see “Creating a New Site” on page 34.

You can configure the nodes on a workstation tree to automatically con-
nect to sites when you double-click site nodes or any node(s) inside them. 
For more information about this procedure, see “Changing Advanced Set-
tings” on page 575.

◆ To automatically connect to a site, double-click the site node or any 
node inside that site.

Disconnecting from a Site

◆ While connected to the site, from the Connect menu, select Discon-
nect. The site is disconnected from the workstation but stays open for 
offline programming.

Closing a Site

◆ With the site open, from the Connect menu select Close Site.

Note:

The advanced option for connecting automatically might not 
work due to workstation hardware limitations. For example, if 
your workstation does not have enough modems to communi-
cate simultaneously with every remote site, the system displays 
an error message.
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Refreshing the Navigation Tree

The navigation tree can display up to 32,768 nodes. Any node created 
afterwards does not display until you make room for it by closing other 
nodes or sites. When you try to add node 32,769, for example, the naviga-
tion will not display the new node until you collapse a site. Collapsing and 
expanding sites refreshes the tree.

Creating Nodes
There are several ways to create nodes. These include site configuration, 
site uploads, site restorations, the Area editor, the Keyboard Macro editor, 
restoring graphics, and the Graphics editor. Once you add nodes to the 
tree, you can further modify them by cutting and pasting or dragging and 
dropping them inside other nodes.

Basic Considerations in Moving Nodes

“Different Types of Nodes” on page 399 describes and explains the ten 
types of nodes. Note the difference between a system node and a site 
node. You can move site nodes but not the system node. Table 11 lists 
what nodes you can and cannot move.

Table 11. Moving Nodes

Note:

Use the Refresh command as a quick way to collapse all nodes 
in the tree.

You can move You cannot move

Custom graphic nodes System nodes inside site nodes

Area nodes System nodes inside any of the 
objects belonging to a site

UCM nodes Nodes that belong to a site outside of 
that site

Macro nodes Any node with nodes inside of lower-
level nodes

Site nodes Panel nodes (Tracer 100 or Tracker)

Macro nodes inside other macro 
nodes
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Cutting and Pasting Nodes

1. Click the node that you want to cut and paste.

• For consecutive nodes, click on the first node, then hold down the 
Shift key and click on the next node.

• Otherwise, click on the first node, then hold down the Ctrl key 
and click on each additional node.

2. From the Tree menu, select Cut.

3. Click the node in which you want to paste the cut node.

4. From the Tree menu, select Paste.

Dragging and Dropping Nodes

For an example of dragging and dropping nodes, see “Grouping Nodes” on 
page 404. You can also consult the procedure for dragging and dropping 
nodes explained in the Daily Operations guide.

Creating Nodes that Belong to the System

Some nodes are associated with the system and some nodes are associ-
ated with specific sites. Site nodes and custom global graphics, for exam-
ple, belong to the system. Panel and macro nodes belong to specific sites. 
All nodes are found inside the system icon. For more information, see 
“Different Types of Nodes” on page 399.

Consult the following procedures for creating nodes that belong to the 
system.

• You create site nodes during site configuration, uploads, and restora-
tions. For more information, see Chapter 6, “Configuring Tracer Sum-
mit BCU Sites” and Chapter 8, “Defining Tracer 100 or Tracker 
Sites.”

• To create custom global graphic nodes, access the Graphics editor. For 
more information, see “About Site and Global Graphics” on page 501.

• To restore custom global graphics, see “Restoring Global Graphics” on 
page 646.

Creating Nodes Inside Site Nodes

Consult the following procedures for creating nodes inside site nodes.

• To create custom site graphic nodes, use the Graphics editor. For more 
information, see “About Site and Global Graphics” on page 501.

• To restore custom site graphics, see “Restoring Site Graphics” on 
page 647.

• To create UCM nodes, use the UCM editor. For more information, see 
“Creating a New UCM” on page 191.

• To create area nodes, use the Area editor. For more information, see 
“Creating an Area” on page 305.

• If you want to create a node in a Tracer 100 or Tracker site, create a 
device (remote unit) or a macro in the Keyboard Macro editor. For 
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more information, see “Creating a Remote Unit for Tracer 100 Sites” 
on page 125 and “Creating a Keyboard Macro” on page 415.

Grouping Nodes

Group nodes to better organize your site. For example, create a custom 
site graphic titled UCMs and then group all UCMs under the graphic 
node.

To group nodes:

1. Click the first node and left-click the mouse.

2. Drag it onto the second node.

3. Release the left mouse button. The first node moves inside the second 
node.

Finding a Node

Use the following procedure to find a node. For example, if you want to 
find a specific piece of equipment but have forgotten which site it belongs 
to, use Find.

Tracer Summit does not search sites for which you do not have security 
access. If you use Find to locate a node that is inside a site to which you do 
not have access, then Tracer Summit will not find the node for you.

Any user, except Nobody Logged On, can find nodes outside the site level, 
regardless of their security level. Nodes that exist outside the site level 
include custom global graphic, group of sites, and site.

To find a node on the navigation tree:

1. From the Tree menu, select Find. The Find Item in Tree dialog box 
displays.

2. Type the name of the node that you are looking for in the Look for 
field. Use wildcards if you want. (See online Help for information on 
wildcard search commands.)

3. Click Find. The Tracer Summit software searches for the node and 
highlights it when found. Otherwise, a dialog box informs you that 
the node was not found.

4. Click Close.
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Modifying the Tree
The following procedures describe how to modify the navigation tree. 
These procedures include removing nodes, adding back nodes you 
removed, changing the graphic of a node, and modifying macro nodes.

Assigning Graphics to Nodes

You can assign the graphic for a Tracer Summit BCU site object, UCM 
object, or area object on the tree. You cannot, however, assign the graphic 
for a custom graphic object on the tree. This is because custom graphic 
nodes always represent themselves.

The only types of nodes that do not have a graphic associated with them 
are the system node, panels, and keyboard macros. You cannot assign 
graphics to these nodes.

To change the graphic assigned to a node:

1. Select the desired node to modify.

2. From the Tree menu, select Change Graphic. The Change Graphic 
dialog box appears (see Figure 355).

Figure 355. Change Graphic Dialog Box

3. Select the type of graphic that you want to use for the selected node:

• Click Standard for a list of available standard graphics.
• Click Site for a list of site-only graphics (graphics created just for 

the site where the selected node resides).
• Click Global to display a list of available global standard and cus-

tom graphics.
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4. From the Graphics list, select the graphic you want to assign to this 
node.

5. Click OK to link the node to the selected graphic.

Editing the Graphic of a Node

1. Double-click the desired node to modify.

2. From the Setup menu, select Graphics Editor. The Graphics editor 
displays.

3. To edit the graphic, follow the procedures described in “Editing 
Graphic Properties” on page 468.

Removing Node(s)

You can remove custom graphic, UCM, area, and macro objects from the 
navigation tree. You cannot remove the system node, site nodes, or Tracer 
100 and Tracker panel nodes. To remove these, use the Delete Object util-
ity. For more information, see “Deleting a Site” on page 658.

For example, if you remove a custom graphic node that has UCMs in it, 
the UCM nodes under the custom graphic node will also be removed.

If you try to remove a site node that has a macro inside it, the macro node 
cannot be removed. Therefore, it relocates inside a higher level site node 
or inside the system node.

To remove a node from the navigation tree:

1. Click the node(s) that you want to remove.

2. From the Tree menu, select Remove Graphic/Remove Macro.

If the selected node has nodes inside it, the Node Removal Confirma-
tion dialog box appears asking you whether you are sure you want to 
remove the node and all nodes under it.

3. Click OK on the Node Removal Confirmation dialog box. The nodes 
are removed from the tree.
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Adding Back a Removed Node

When you remove one or more nodes from the navigation tree, you can 
later add them back to the tree without recreating their objects, as long as 
the objects they reference have not been deleted from the system. The 
nodes are added back to a site node or the Tracer Summit system node 
(depending upon where they were located originally).

To add a previously removed node:

1. Click in the tree where you want to add back a removed node:

• For previously removed custom graphic nodes that belong to the 
system, click on any site or custom global graphic node.

• For previously removed custom graphic nodes that belong to spe-
cific site, click anywhere within that site.

2. From the Tree menu, select Add Graphic. The Add Graphics dialog 
box appears. The dialog box displays the nodes that were previously 
removed.

3. Select the node(s) you want to add back to the tree.

4. Click OK. The node appears back in the tree.

Editing a Tracer 100 Keyboard Macro from the 

Navigation Tree

◆ Select the desired macro to edit. From the Setup menu, select Key-
board Macro editor. The Select Keyboard Macro dialog box appears. 
For more information, see “Creating a Keyboard Macro” on page 415.

Note:

• A graphical node can only appear in the tree once. 
• Any macro node can be shared between many sites, so it 

might appear in several sites at a time.

Note:

Since the tree automatically sorts nodes alphanumerically, the 
node might not appear in the spot you wanted it. In that case, 
drag and drop or cut and paste it where it belongs.
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Chapter 27

Connecting to Tracer 100 and 

Tracker EMTK Panels 

Once you install the Tracer 100/Tracker Communication package, you 
can connect to Tracer 100 or Tracker EMTK panels in terminal emulation 
mode, create .SAV files for Tracer 100 panels, and create keyboard macros 
for T100 and Tracker terminal emulation sessions.
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Background Considerations for 

Connecting to Tracer 100 or Tracker 

EMTK Panels

Important issues to consider when you connect to a Tracer 100 or Tracker 
EMTK panel include port connections, the navigation tree, and altering 
panel memory.

IMPORTANT
Tracer Summit supports a connection to Tracer 100 panels at version 

14.4 or higher and Tracker EMTK panels at version 5.0 or higher. You can 

not connect to the new Tracker BMTK (Tracker III). 

Configuring Port Connections

Terminal emulation occurs only through connected sites. Tracer Summit 
workstations connect to a Tracer 100 or Tracker (EMTK) by means of 
direct connection or modem. In determining the means by which you com-
municate with a Tracer 100 or Tracker panel, the port that you connect to 
on the panel logic board is important.

You can directly connect to port 1 or port 2 of the Tracer 100 for terminal 
emulation. You can only connect by means of a modem to port 2. Remem-
ber the following when you configure Tracer 100 and Tracker panels:

• Port 1 of the Tracer 100 logic board does not support the BMN proto-
col. This port only handles terminal emulation

• The Tracer Summit workstation—like the BMN workstation—only 
supports connection through port 2. Port 2 can handle terminal emu-
lation and BMN protocol simultaneously.

• You can directly connect the Tracer Summit workstation to port 2 on 
the Tracer 100 panel or connect to port 2 through a modem

• Port 2 handles ASCII mode and BMN protocols simultaneously. Using 
both, however, might cause the terminal emulation menus to slow 
down and miss key strokes.

For more information about configuring the Tracer 100 or Tracker panel 
for direct or modem connection, see the Tracer 100 Series Programming 
guide (EMTB-PG-11), Tracer 100 Installation guide (EMTB-IN-12), or the 
Installation Guide for Tracer 100i, Tracer L, and Tracer Chiller Plant 
Manager (EMTF-IN-6).

Note:

If you have several Tracer 100 or Trackers connected to the 
Tracer Summit workstation, only one site can use the terminal 
emulator at a time.
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Tracer 100 and Tracker EMTK Sites on the Navigation 

Tree

You can configure the Tracer 100 or Tracker site nodes in the navigation 
tree to automatically connect to a Tracer 100 or Tracker site and open a 
terminal emulation session.

For more information about terminal emulation, see the Tracer 100 Daily 
Operations guide.

For more information about selecting this capability in system options, 
see “Setting Connection Features of the Navigation Tree” on page 580. 
For information about the navigation tree and how it connects to Tracer 
100 and Tracker panels, see “Connecting to a Site from the Tree” on 
page 401.

Altering Panel Memory

Terminal emulation is one of two methods to change settings in a Tracer 
100 or Tracker EMTK panel. Another method of changing the settings in 
a Tracer 100 panel is to restore a site (see “Restoring a Tracer 100 Site” 
on page 650).

Any memory alterations, such as system expansion, that you make while 
in terminal emulation mode do not show up in Tracer Summit until the 
panel is scanned as part of normal processing. If you have the Building 
Management or Enterprise Management package you can scan the site 
any time using the Task Manager (see “Run Immediate Scan on a Single 
Site” on page 221).

Note:

• Expanding and collapsing the tree by clicking the + and - 
symbols does not connect you to a site. 

• When you configure the navigation tree to open a site auto-
matically when you double-click on it, the automatic con-
nection applies to all sites or no sites.
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Creating .SAV files for Tracer 100 Panels
Use the following procedure to back up all the information in a Tracer 100 
panel and save it to a .SAV file. If a site has multiple panels, use this pro-
cedure to back up each panel. When you are disconnected from a site, 
Tracer Summit automatically connects to the panel and creates the file, 
and then disconnects (if you choose to let it).

With the Tracer 100/Tracker Communications package installed, you can 
back up individual Tracer 100 panels. If you want to back up entire 
Tracer 100 site with multiple unit-to-unit panels or groups of sites, pur-
chase the Building Management or Enterprise Management package. In 
these packages, the Task Manager application has an option that backs 
up all defined panels of a Tracer 100 site (see “Backing Up Sites” on 
page 218).

To create a SAV file:

1. From the Tools menu, select Backup. A submenu appears.

2. Select Remote. The Backup a Remote dialog box appears (see 
Figure 356).

Figure 356. Backup a Remote Dialog Box

3. From the Remote Unit to Backup list, select the panel to back up.

Click the Browse button to select the directory where you want to 
store the SAV file.

The name of the backup file will always be *.SAV, where * is the name 
of the remote unit as defined in Tracer 100 site configuration.

Note:

A SAV file differs from a .BDB file, which is created during 
daily operations. A .BDB file contains the information that has 
been scanned from the panel into the workstation database. 
The .BDB file information for Tracer 100 or Tracker sites only 
includes schedules, calculated binaries and analogs, and 
generic points. A .SAV file, on the other hand, contains all the 
information from the panel. The .SAV file is used to restore 
Tracer 100 panels (see “Restoring a Tracer 100 Panel” on 
page 668).
412 BMTX-SVP01B-EN



Creating Keyboard Macros
4. Click OK. If you are not already connected to the site, Tracer Summit 
connects to the panel and performs the backup. While the backup is 
in process (which may take up to 15 minutes), you cannot perform 
any other action in terminal emulation.

5. If Tracer Summit had to connect to the site, at the end of the backup, 
a dialog box appears that asks whether you want to go online with the 
panel. You must respond within two minutes or Tracer Summit dis-
connects.

Creating Keyboard Macros 
The Keyboard Macro editor provides access to one feature that is unique 
to Tracer 100 and Tracker sites. This is the keyboard macro, also known 
as the keystroke macro by many BMN users.

The keyboard macro sends a sequence of ASCII characters and control 
codes to the Tracer 100 or Tracker panel while in terminal emulation 
mode. This coded sequence is the same as those a user might type at the 
command line of the BMN interface.

Keyboard macros make navigation through a Tracer 100 or Tracker 
screen quick and efficient. In BMN, all the user has to do is run the 
macro, and the BMN interface finds and locates the menu/submenu/item 
that the user requires. Tracer Summit has taken these macros and auto-
mated them. Now with Tracer Summit, you can run these macros by dou-
ble-clicking them on the navigation tree or from a pop-up menu.

Macros, however, are not set up to take you between panels. Tracer Sum-
mit handles navigation between panels based on the setup in Site Config-
uration. It does not rely on the keyboard macros to do this.

Tracer Summit ships with a standard library of predefined keyboard mac-
ros. For detailed tables listing these macros and the names they display 
on the navigation tree, see “List of Predefined Keystroke Macros” on 
page 418.
BMTX-SVP01B-EN 413



Connecting to Tracer 100 and Tracker EMTK Panels
Accessing the Keyboard Macro Editor

1. Log on to a Tracer 100 or Tracker site.

2. From the Setup menu, select Keyboard Macro Editor. The Select Key-
board Macro dialog box appears (see Figure 357).

Figure 357. Select Keyboard Macro Dialog Box

3. Select a Macro and click OK.

4. The Keyboard Macro editor displays (see Figure 358).

Figure 358. Keyboard Macro Editor
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Creating a Keyboard Macro

Use the following procedure to add macros to a site or multiple sites.

To create a keyboard macro:

1. Log on to a Tracer 100 or Tracker site.

2. From the Setup menu, select Keyboard Macro Editor. The Select Key-
board Macro dialog box appears (see Figure 357 on page 414).

3. Click New. The New Keyboard Macro Name dialog appears.

4. Type a unique name for the new macro.

Make your macro name generic enough to remember across numer-
ous sites but specific enough to remember what function it performs.

5. Click OK. The Keyboard Macro editor appears (see Figure 358 on 
page 414).

6. Click the Macro Sequence field and type or edit the macro sequence 
that you want to run when the macro is chosen. The text entered in 
this field is the keystroke sequence that Tracer Summit sends to the 
panel.

7. In the Available Site(s) list, select the site(s) to which you want to 
apply the macro.

8. Click Add to add the site(s) to the Selected Site(s) list.

9. Click Save. The macro object is saved to the database of the worksta-
tion. The navigation tree is updated to include the macro node under 
the sites you specified.

Note:

The Tracer 100 or Tracker terminal emulator application does 
not validate keyboard macros that run during the session. The 
Tracer Summit software assumes that you have properly set up 
the macro to locate and find the correct location in the Tracer 
100 or Tracker menu structure.
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Selecting Predefined Macros

Tracer Summit has certain predefined keyboard macros that you can 
select without having to enter them manually. For lists of these pre-
defined macros, see “List of Predefined Keystroke Macros” on page 418.

To select predefined macros:

1. With the Keyboard Macro editor open, click the Browse button. The 
Macro Reference Table appears (see Figure 359).

2. Click the Panel Main Menu arrow and select a macro type (see 
Figure 359).

Figure 359. Macro Reference Table Dialog Box and Pull-down Menu

3. From Submenu Options, select the desired macro (see Figure 360).

Figure 360. Macro Reference Table Dialog Box with a Selected Macro
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4. Click OK. The Keyboard Macro editor appears (see Figure 358 on 
page 414). The name of the macro displays in the Macro Name field. 
The macro sequence displays in the Macro Sequence field.

5. In the Available Site(s) list, select the site(s) to which you want to 
apply the macro.

6. Click Add to add the site(s) to the Selected Site(s) list.

7. Click Save. The macro object is saved to the database of the worksta-
tion. The navigation tree is updated to include the macro node under 
the sites you specified.
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List of Predefined Keystroke Macros
The following tables list details for the following three types of predefined 
keyboard macros: miscellaneous, Tracer 100, and Tracker.

Miscellaneous Keyboard Macros

Table 12 lists keyboard macros that perform general functions on a termi-
nal emulation menu.

Table 12. Miscellaneous Macros

Tracer 100 Predefined Keyboard Macros

Table 13 through Table 20 list keyboard macros that navigate you to spe-
cific places in a specific terminal emulation screen of a site. 

The Node Name column contains the name of the keyboard macro as it 
appears in the navigation tree and the terminal emulation pop-up menu.

The Keystroke Sequence column displays the actual characters that 
make up the content of the macro; that is, the sequence of characters sent 
to the terminal emulation interface.

Table 13. Event Log Menu Macro

Function Keystroke Sequence

Acknowledge A

Help H

List L 

Menu M

Next N

Panel Main Menu 9M

Previous P

Node Name Keystroke Sequence

Event Log 9M1S
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Table 14. Building Status Menu Macros 

Node Name Keystroke Sequence

Building Status-main menu 9M2S

Binary Input Status 9M2S1S1S

Analog Input Status 9M2S1S2S

Meter Input Status 9M2S1S3S

Tracer Rooftop Analog Status 9M2S1S4S

Binary Output Status 9M2S1S5S

Tracer Rooftop Status 9M2S1S6S

Zone Status 9M2S1S7S

Calculated Binary Status 9M2S1S8S

TIM Equipment Status 9M2S1S9S

TIM Analog Status 9M2S1S10S

Calculated Analog Status 9M2S1S11S

Analog Output Status 9M2S1S12S

Global Binary Input Status 9M2S1S13S

Global Binary Output Status 9M2S1S14S

Global Analog Input Status 9M2S1S15S

Global Analog Output Status 9M2S1S16S

SCP Status 9M2S1S17S

UCM Analog Input Status 9M2S1S18S

UCM Binary Input Status 9M2S1S19S

VAV CU Group Output Status 9M2S1S20S

Global UCM Output Status 9M2S1S21S

AHU Output Status 9M2S1S22S

UCM Binary Output Status 9M2S1S23S

UCM Analog Output Status 9M2S1S24S

TCM Status 9M2S1S25S

CSC Output Status 9M2S1S26S

Scroll Chiller Output Status 9M2S1S27S

PCM Output Status 9M2S1S28S

VariTrac I CM Output Status 9M2S1S29S

Voyager Micro Rooftop Status 9M2S1S30S

Fan Coil CU Group Status 9M2S1S31S

Fan Coil CU Status 9M2S1S32S

VAV CU Status 9M2S1S33S

RTA-RTW Chiller Output Status 9M2S1S34S

WS Heat Pump Status 9M2S1S35S
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VAV CU II Group Output Status 9M2S1S36S

VAV CU II Status 9M2S1S37S

Generic Interface Node Status 9M2S1S38S

† Terminal Unit Controller Status 9M2S1S39S

‡ VariTrac II CCP Group Status 9M2S1S40S

‡ VariTrac II CCP Status 9M2S1S41S

† CenTraVac/RTHB UCP2 Status 9M2S1S42S

† Absorption UCP2 Chiller Status 9M2S1S43S

IntelliPak Rooftop Status 9M2S1S44S

UPCM Status 9M2S1S45S

‡ Voyager Commercial RTU Status 9M2S1S46S

(Referencing BAS-EB-25, Tracer 100 Series Software Versions)
† V14.4 added communication and control capabilities for the UCP2 
CenTraVac chiller (type 42), the UCP2 Absorption chiller (type 43), and 
the WS Heat Pump TUC (type 39).
‡ V15.0 added communication and control capabilities for the VariTrac 
II CCP (types 40 & 41) and Voyager Commercial 27.5 to 50-ton rooftop 
units (type 46).

Table 15. ICS Equipment Status Main Menu Macros 

Node Name Keystroke Sequence

ICS Equipment Status -main menu 9M3S

Unit Controller Status 9M3S1S

Tracer Rooftops 9M3S1S6S

TIM Equipment 9M3S1S9S

SCP 9M3S1S17S

Air Handler Outputs 9M3S1S22S

TCM Outputs 9M3S1S25S

CSC Outputs 9M3S1S26S

Scroll Chiller Outputs 9M3S1S27S

PCM Outputs 9M3S1S28S

VariTrac ICM Outputs 9M3S1S29S

Voyager Micro Rooftops 9M3S1S30S

Fan Coil Command Units 9M3S1S32S

VAV Command Units 9M3S1S33S

RTA-RTW Chiller Outputs 9M3S1S34S

WS Heat Pumps 9M3S1S35S

VAV Command Unit II 9M3S1S37S

Table 14. Building Status Menu Macros (Continued)

Node Name Keystroke Sequence
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List of Predefined Keystroke Macros
Terminal Unit Controllers 9M3S1S39S

VariTrac II CCP 9M3S1S41S

CenTraVac UCP2 Chillers 9M3S1S42S

Absorption UCP2 Chillers 9M3S1S43S

IntelliPak Rooftops 9M3S1S44S

UPCM 9M3S1S45S

Voyager Commercial Rooftops 9M3S1S46S

Chiller Sequencing Status 9M3S2S

Chiller System Status 9M3S2S1S

Chiller Unit A Status 9M3S2S2S   

Chiller Unit B Status 9M3S2S3S   

Chiller Unit C Status 9M3S2S4S   

Chiller Unit D Status 9M3S2S5S   

Chiller Unit E Status 9M3S2S6S   

Chiller Unit F Status 9M3S2S7S   

Table 16. Operator Logon/off Menu Macros

Node Name Keystroke Sequence

Operator Logon and Logoff 9M4S

Table 17. Report & Summaries Menu Macros 

Node Name Keystroke Sequence

Reports and Summaries -main menu 9M5SL 

Current Summary Report 9M5S1S1S+$

Monthly Summary Report 9M5S1S2S+$

33-Day Energy Report 9M5S1S2S+$

12-Month Energy Report 9M5S1S4S+$

12-Month Meter Report 9M5S1S5S+$

7-Day Override Time Report 9M5S1S6S+$

Monthly Override Time Report 9M5S1S7S+$

7-Day Temperature Report 9M5S1S8S+$

12-Month Degree Days Report 9M5S1S9S+$

SCP Chiller 12 Month Summaries 9M5S1S10SL

Trend Log Report 9M5S1S11SL

Totalizing Report 9M5S1S12S+$

Table 15. ICS Equipment Status Main Menu Macros (Continued)

Node Name Keystroke Sequence
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Connecting to Tracer 100 and Tracker EMTK Panels
RTA-RTW Chiller Report 9M5S1S13SL

Custom Reports – Monthly 9M5S1S14S1SL

Custom Reports – 12 Month 9M5S1S14S2SL

Table 18. Building Control Menu Macros

Node Name Keystroke Sequence

Building Control Menu 9M6S

Building Control On/Off 9M6S1S

Zone Setpoints 9M6S2S

Time of Day 9M6S3S

Duty Cycle 9M6S4S

Timed Override 9M6S5S

Demand Limiting 9M6S6S

Trend Log 9M6S7S

Air Balance 9M6S8S

Boolean Processing 9M6S9S

Run Time/Maintenance 9M6S10S

Expanded Message 9M6S11S

Process Control Language 9M6S12S

DDC 9M6S13S

Priority Control 9M6S14S

Totalizing 9M6S15S

Chiller Sequencing 9M6S16S

Custom Reports 9M6S17S

Table 19. Keyboard Timed Override Menu Macros

Node Name Keystroke Sequence

Keyboard Timed Override 9M7S

Table 17. Report & Summaries Menu Macros (Continued)

Node Name Keystroke Sequence
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List of Predefined Keystroke Macros
Table 20. System Setup Menu Macros

Tracker Predefined Keyboard Macros

Table 21 lists keyboard macros that only run on Tracker panels.

Table 21. Tracker Macros

Node Name Keystroke Sequence

Building Control On/Off 9M8S1S

Time and Dates 9M8S2S

Input/Output Data 9M8S3S

System Expansion 9M8S4S4S

System Configuration 9M8S5S

System Security 9M8S6S

ICS Equip Local Programming 9M8S7S

Status Display Definition 9M8S8S

Link A – ICS Equip Address 9M8S9S1S

Link B – ICS Equip Address 9M8S9S2S

Link C – ICS Equip Address 9M8S9S3S

Node Name Keystroke Sequence

Alarm Log 9M8S1S

Bldg Equip – Varitrac II CCP 9M8S2S

Bldg Equip – TCM 9M8S3S

Bldg Equip – Slave TCM 9M8S4S4S

Bldg Equip – Voyager Rooftop 9M8S5S

Demand Limiting Status (Stat16) 9M8S6S

Trend Log Status 9M8S7S

Current Day Energy Log (Stat16) 9M8S8S

35 Day Energy Log (Stat16) 9M8S9S1S

Operator Logon/Logoff 9M8S9S2S
BMTX-SVP01B-EN 423



Connecting to Tracer 100 and Tracker EMTK Panels
424 BMTX-SVP01B-EN



Chapter 28

Using the Trend Viewer

The Trend Viewer provides one of the easiest methods for viewing and 
graphing trended data. With a few clicks of the mouse button on a 
graphic, you can display trended data on a graph. The graph can also dis-
play icons for alarms and events to represent activity changes in the sys-
tem. This gives you a clear and easy-to-use picture of what is happening 
in your automation system and when those changes occurred. The activ-
ity of live, trended and untrended data is viewed in a Trend Viewer win-
dow. 

Whether you need to determine the temperatures in a room for a short 
period of time or watch an air handler’s output temperature over a long 
period of time, the Trend Viewer gives you the flexibility to view data in 
the way that best fits your needs. 

With the Trend Viewer you can:

• View live untrended data
• Plot overrides, alarms, and events related to the trended point
• Plot audit trail data
• View up to 10 properties
• Save trend data in graphical format or as a CVS file
• Print out data
• View multiple graphs at one time

This chapter covers the following topics:

• “Setting up the Trend Viewer” on page 426
• “Creating a Trend Viewer” on page 431
• “Opening a Trend Viewer” on page 434
• “Saving a New Trend Viewer” on page 438
• “Adding to a Trend Viewer” on page 439
• “Historical Trends in the Audit Trail Database” on page 447

Note:

To set up the Trend Viewer you must have security access 
rights. For further information, see your Site Security Adminis-
trator.
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Using the Trend Viewer
Setting up the Trend Viewer
1. From the Site Security editor select the Objects tab (see Figure 361).

2. In the Access column, click the Trend Viewer checkbox. 

3. Click Save.

Figure 361. Objects Tab

Trend Viewer 
checkbox
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Setting up the Trend Viewer
4. Click the Applications tab (see Figure 362).

5. Select the View Only or View/Edit checkbox for the Trend Viewer. 

6. Click Save. 

7. Click Close.

Figure 362. Applications Tab 

8. From the Menu bar select Setup, and then select Trends. The Select 
Trend dialog displays (see Figure 363).

Figure 363. Select Trend Dialog Box

9. Select a trend from the Name list.

Trend Viewer 
checkbox
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Using the Trend Viewer
10. Click OK. The Trend Editor displays (see Figure 364).

11. Click the Members tab.

12. Check the Harvest Data for this trend checkbox.

13. Check the Enable Historical Trending box (not shown in Figure 364; 
this only applies to Tracer Summit CCS and Enterprise users).

14. Click Save.

15. Click Close.

Figure 364. Members Tab 
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Setting up the Trend Viewer
16. From the menu bar click Tools, and then select Options. The Systems 
Options screen displays (see Figure 365).

Figure 365. Systems Options Screen–General tab

17. In the Harvested Trend area, click the arrow to display the drop-down 
list. Select a time frame.

18. Click Save. 

19. Click Close.

Notes:

• Harvested trends only affect the Trend Viewer database, 
not the Audit Trail database. 

• Data in harvested trends is scheduled to be deleted after a 
certain number of years.
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Using the Trend Viewer
Setting up Properties from Pop-up Menus in a Graphic

In order to display a pop-up window with the Open Trend Viewer option 
available as shown in Figure 366, a property within a graphic must meet 
the following conditions: 

The property must be trendable

And: 

The property must be one of five status points:

• Status text
• Analog in 5 color
• Binary text
• Animation
• Slider

Or one of three control point types:

• Setpoint control
• Binary checkbox control
• Selection list control

Figure 366. Displaying a Pop-up Window from a Graphic
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Creating a Trend Viewer
Creating a Trend Viewer
You can create a Trend Viewer from the following:

• The Setup menu
• A property in a graphic

Creating a Trend Viewer From the Setup Menu

1. From the Setup menu, select Trend Viewer. The Select Trend Viewer 
Object dialog box displays (see Figure 367).

Figure 367. Select Trend Viewer Object Dialog Box
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Using the Trend Viewer
2. Click New. The Trend Viewer Member Editor displays (See 
Figure 368).

Figure 368. Trend Viewer Member Editor

3. In the Type box, select an object type. Your selection determines 
which object name will display in the Name box. 

4. Select an object name from the Name box. Your selection determines 
which properties will display in the Property box. 

5. Select the properties from the Property box you want to add to the 
members list. Up to 10 members can reside in a Trend Viewer object.

6. Click Add to add the selected properties to the Current Members list 
box. (see Figure 369).

Figure 369. Adding members to the Trend Viewer Member Editor

Note:

Only properties that are already members of a harvested trend 
will appear in this list.
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Creating a Trend Viewer
7. Click OK. The Trend Viewer displays (see Figure 370). 

Figure 370. Trend Viewer

Creating a Trend Viewer from a Property in a Graphic

1. Right-click on a property in graphic.

2. From the pop-up menu, click Create Trend Viewer. 

3. A new Trend Viewer displays.

Note:

You must be online to create a Trend Viewer through a property 
in a graphic.
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Using the Trend Viewer
Opening a Trend Viewer
There are several ways you can open a Trend Viewer: 

• The Setup menu
• A graphic (pop-up windows)
• The toolbar

Opening a Trend Viewer from the Setup Menu

1. From the Setup menu, select Trend Viewer (see Figure 371). The 
Select Trend Viewer Object dialog box displays (see Figure 372).

Figure 371. Opening a Trend Viewer from The Setup Menu 

Figure 372. Select Trend Viewer Object dialog box

2. Select the trend object you want to display in the Trend Viewer.
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Opening a Trend Viewer
3. Click OK. The Trend Viewer displays (seeFigure 373).

Figure 373. Trend Viewer

Opening a Trend Viewer from a Graphic

1. Right-click on a property in a graphic to display the pop-up menu  
(see Figure 374). 

Figure 374. Pop-up Menu in a Graphic
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Using the Trend Viewer
2. From the pop-up menu, select Open Trend Viewer. The Select Trend 
Viewer dialog displays (see Figure 375).

Figure 375. Select Trend Viewer Dialog Box

3. From the drop-down list select a Trend Viewer. 

4. Click OK. The Trend Viewer displays (see Figure 373 on page 435).

Note:

The Select Trend Viewer dialog box will not display if the prop-
erty is a member of only one Trend Viewer object. In this case, 
the Trend Viewer will display immediately.
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Opening a Trend Viewer
Opening a Trend Viewer from the Toolbar

1. Click the Harvested Trend Viewer toolbar icon in the Tracer Summit 
task bar (see Figure 376). The Select Trend Viewer Object dialog box 
displays.

2. Click the trend viewer object you want to display.

3. Click OK. The Trend Viewer displays (see Figure 373 on page 435).

Figure 376. Tracer Summit Task Bar

Harvested Trend Viewer Icon
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Using the Trend Viewer
Saving a New Trend Viewer

1. After the new Trend Viewer displays, click Save. The New Trending 
Names dialog box displays (see Figure 377).

Figure 377. The New Trending Names Dialog Box

2. In the New Trend Viewer Name field you can type in a name for the 
Trend Viewer object, or keep the default name.

3. In the New Trend Name field, you can type in a name of the new 
trend object or you can keep the default name. 

4. In the Sampling Interval drop-down list, select how fast you want the 
trend object to collect samples. The default time is one minute.

5. Click OK. 
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Adding to a Trend Viewer
You can add a property to a Trend Viewer by clicking on a property in a 
graphic. 

1. Right-click on a property in a graphic. A pop-up menu displays.

2. From the pop-up menu, select Add to Trend Viewer. The Select Trend 
Viewer dialog displays, which lists all of the Trend Viewer objects 
that the property is not a member of (see Figure 378).

Figure 378. Select Trend Viewer Dialog Box

3. Select the Trend Viewer object you want to add the property to.

4. Click OK. The Trend Viewer displays (see Figure 373 on page 435). 

5. Click Close. The Save Changes dialog box displays. 

6. Click Yes.
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Using the Trend Viewer
Working with the Trend Viewer
The Trend Viewer plots trend data on a graph. When you are online, data 
is displayed in the live mode with the ability to show historical data. 
When you are offline, data is viewed in the historical mode only.

The Trend Viewer consists of three main components (see Figure 379):

• The “Trend Viewer Toolbar” on page 441
• The “Trend Viewer Chart” on page 442
• The “Trend Viewer Main Control Buttons” on page 445

Figure 379. Components of the Trend Viewer Window

Main control buttons

Toolbar

Chart
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Working with the Trend Viewer
Trend Viewer Toolbar

Table 22 describes the functions of the buttons on the Trend Viewer  
toolbar.

Table 22. Trend Viewer Toolbar Functions

Button1 Description

The scroll (axes) button lets you move the x or y-axis. 
Drag the pointing finger horizontally to move the x-axis 
and vertically to move the y-axis. 

The zoom (axes) button lets you compress or expand 
the display range of the x or y-axis. Drag the arrow hori-
zontally along the x-axis and vertically along the y-axis.

The zoom out all axes button lets you zoom out both 
the x and y-axes. Each time you click this button the axes 
zooms out two times its previous view.

The zoom in all axes button lets you zoom in both the x 
and y-axes. Each time you click this button the axes 
zooms in two times its previous view.

The select button lets you see details related to the 
icons and markers in the Trend Viewer chart. Move the 
pointer over the icon and click the pointing finger to see 
details.

The zoom box button lets you zoom in anywhere in the 
chart. Click this button and place the arrow at the point 
where you want to zoom in. Then, click and drag the 
arrow.

The tracer line button lets you display a vertical line in 
the chart to see the date, time stamp, and value for a 
point. Click on a point in the legend or click on a different 
plot in the chart to change which plot the vertical line is 
showing data for.

The save to file button lets you save the current view to 
a BMP, JPEG, or PNG formatted file. To save the data to a 
comma separated value file (CSV), select this format 
from the File menu.*

The print button lets you print the current graphical 
view to a printer.

* A CSV file is a basic industry format used for opening up a 
text file into any application (for example, Microsoft Excel).

1The selected button transforms into a pointing finger 
when you hover over an object in the Trend Viewer. 
When clicked on, the object reveals further details.
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Using the Trend Viewer
Trend Viewer Chart

A Trend Viewer chart consists of the legend, icons, data markers, and grid 
(see Figure 380).

Figure 380. Trend Viewer Chart

Legend

Gridlines Data marker
Icon
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Working with the Trend Viewer
Viewing the Legend

The legend represents members of a trend object. They are displayed in a 
Trend Viewer chart as data markers. 

1. Right-click on a member of the legend. The Settings dialog box dis-
plays (see Figure 381 on page 443). 

2. If desired, make changes using the checkboxes. 

3. Click OK. 

Changing the Legend Member Name

You can change the name of the legend member by using the Settings 
Dialog box.

1. In the Display Name field, delete the current legend member name 
(see Figure 381 on page 443). 

2. Type in a new legend member name. 

3. Click OK. 

Figure 381. The Settings Dialog Box

Note:

You can also hide or show the legend by selecting Hide/View 
Legend from the Edit menu.

Note:

The Display Name field is disabled when the audit trail is used 
on the system.

Tool Palette

Display Name field
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Using the Trend Viewer
Icons

Icons represent event log activity such as alarms, manual overrides, and 
events.

Click on the icon to display a dialog box that contains details about 
the event (see Figure 382).

Figure 382. Event Dialog Box (manual override example)

Changing Data Marker Settings

Data markers are visual representations of legend members within the 
trend object. Each data marker is displayed as a different color inside the 
chart. To change the color:

1. Right-click on a data marker. The Settings dialog box displays (see 
Figure 381 on page 443).

2. Click on the Tool Palette.

3. The Color Palette dialog box opens. Select a color.

4. Click OK. The data marker displays in the selected color. 

Grid

The grid is made up of gridlines that help you read the chart. You can 
choose to view or hide the grid.

1. Right-click in the chart’s background. A pop-up menu displays.

2. Click on Hide Grid to hide the gridlines, or click on View Grid to show 
the gridlines. 
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Working with the Trend Viewer
Trend Viewer Main Control Buttons

The Trend Viewer main control buttons allow you to control and adjust 
the chart. It puts the chart into live mode and allows you to select the 
date range, move the chart forward or backward, and save current and 
new trend objects. Table 23 describes the functions of the Trend Viewer 
main control buttons. 

Table 23. Functions of the Trend Viewer Main Control Buttons

Button Description

The back button moves the displayed data backward 
half the displayed date range. (The button is disabled if 
the view is in live mode).

The play button puts the chart into live mode and 
allows you to track the data as it enters the database 
source for existing members. For new members, the 
data is plotted every 30 seconds.

The pause mode button temporarily stops the chart 
from updating with new data. This button only displays 
after the play button has been depressed.

The forward button moves the displayed data forward 
half the displayed date range. (This button is disabled if 
the user is in live mode). 

The Select Range button displays the Date Range to 
Display dialog box (see Figure 383 on page 446). Use 
this dialog to select the date-range of data to load into 
the chart. 

The Close button exits the Trend Viewer and returns to 
the previous window. 

The Save button saves changes made in the Trend 
Viewer. If the point cannot be saved because communi-
cation to the device is down, reconnect and then try 
again. 

The Open Another button allows you to view another 
Trend Viewer object without closing the existing one. 

Click on the Help button for more information about the 
Trend Viewer. 
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Using the Trend Viewer
Selecting a Date Range 

The Date Range to Display dialog box displays when you click on the 
Select Range control button (see Figure 383).

The Available Range field shows the range of time that data is available 
for members of the Trend Viewer.

1. In the From field select a date and time from the drop-down lists.

2. In the To field select a date and time from the drop-down lists.

3. Click OK. The Trend Viewer displays the data from the selected data 
range. 

Figure 383. The Date Range to Display Dialog Box
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Historical Trends in the Audit Trail Database
Historical Trends in the Audit Trail 

Database
Historical trending is used to display data from the Audit Trail database 
in a Trend Viewer. It is enabled in the Trend editor by checking the 
Enable Historical Trending checkbox.

Viewing Historical Trends 

1. From the Status menu, Select the Audit Trail Trend Viewer. The 
Select Historical Trends dialog box displays (see Figure 384).

Figure 384. Select Historical Trends Dialog Box

Note:

Historical trending is only available if you are registered to use 
either the Tracer Summit CCS or Enterprise packages. For 
more information about historical trends, refer to the Tracer 
Summit CCS System Programming guide.

Note:

You must be online to use the Audit Trail.
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2. In the Database Source list, select a database:

• Audit Trail SQL Database—displays current data
• Archived Audit Trail SQL Database—displays historical data
• Previously Archived Audit Trail SQL Database—displays histori-

cal data.
3. In the Select Historical Trends list, select up to 10 historical trends.

4. In the Select Range drop-down list, specify a date and time range you 
want displayed in the Trend Viewer.

5. Click OK. The Trend Viewer displays.
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Chapter 29

Trending Data

A trend (or trend object) is a historical sampling of data stored from spe-
cific objects and properties taken at a specified sampling frequency.  
Trends can be stored in the BCU or as an option on the PC workstation. 
To upload trends from a BCU, you can run a standard or custom trend 
report (see Chapter 32, “Designing Reports”). These trends provide infor-
mation necessary to make decisions about building management issues, 
including utility costs, equipment efficiency, and tenant billings.

Use the Trend editor to define the data you want sampled and stored in 
the BCU. This trend information can then be compiled and presented in a 
trend report at a later time.

Each trend object contains a list of members. These members are the 
properties that the trend will sample. You set up and maintain the list of 
members using the Trend editor.

With Tracer Summit’s Trend editor, you can:

• Create a new trend object or edit an existing one
• Add or remove members for a trend object
• Determine the trend interval
• Determine how or when sampling will start and stop
• Delay sampling during startup to allow the system to stabilize before 

trending occurs
• Specify the number of samples you will allow the BCU to store in 

memory, and clear any accumulated samples
• Set up a trigger and notification class for a snapshot, as well as reset 

a snapshot after it has been taken
• Harvest trends for the Trend Viewer or Audit Trail databases
• Set up security classes for a trend object

Note:

Trends can be easily viewed and created in Tracer Summit by 
right-clicking on a graphic and creating a Trend Viewer object. 
The trends are then viewed in graphical format. (See Chapter 
28, “Using the Trend Viewer.”)
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Trending Data
Accessing the Trend Editor
1. From the Setup menu, select Trends. The Select Trend dialog box dis-

plays (see Figure 385).

Figure 385. Select Trend Dialog Box

2. Select the name of the trend you want to edit.

3. Click OK. The Trend editor displays (see Figure 386.)

Figure 386. Trend Editor
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Creating a New Trend
Creating a New Trend
To create a new trend, you complete these tasks:

• Set security access for the trend (see “Setting Security Access for a 
Trend” on page 458)

• Open and name the new trend object (as described in this section)
• Add members to the trend object (see “Setting the Members of a 

Trend” on page 453)
• Set up the trend, including determining when sampling will start and 

stop (see “Setting Up Trend Sampling” on page 454)
• Save the trend object (see “Saving a Trend Object to a BCU” on 

page 460)

To create a new trend:

1. From the Setup menu, select Trends. The Select Trend dialog box dis-
plays (see Figure 387).

Figure 387. Select Trend Dialog Box

2. Click New. The New Trend Name dialog box displays (see 
Figure 388).

Figure 388. New Trend Name Dialog Box

3. In the Trend Name field, enter the name you want to give this trend. 
The name can be up to 32 characters long.
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Trending Data
4. Click OK. The Status screen of the Trend editor displays (see 
Figure 389).

Figure 389. Trend Editor—New Trend

5. Complete the remaining trend information as described in the follow-
ing sections.
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Setting the Members of a Trend
Setting the Members of a Trend
Members are sampled properties that will be monitored by a trend object. 
The Members screen of the Trend editor allows you to add, delete and 
view members of the trend object.

To set the members of a trend:

1. From the Trend editor, click the Members tab (see Figure 390). 

Figure 390. Trend Editor Members Screen

2. In the Type list box, select the object type for the object whose prop-
erty you want this trend to sample. The Name list box automatically 
displays a list of object names for this object type.

3. In the Name list box, select the name of the object whose property you 
want this trend to sample. 

4. In the Type of Property list box, select the type of property you want 
this trend to sample. This list is filtered to show only properties of the 
type in the Property list box.

5. In the Property list box, select the property then click Add to add it to 
the Member List box.

6. Repeat steps 2–5 above to add other properties to the list of members, 
as necessary.
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Trending Data
7. To remove a member from the Member List, select the member in the 
Member List box, then click Remove to delete it from the list. Or, click 
Remove All to clear the entire list.

Setting Up Trend Sampling
When setting up a trend, you need to configure the sampling parameters 
and sampling interval of the trend object. You can set up trend sampling 
at the Trend editor’s Setup screen. At this screen you can also change the 
name of the trend.

To set up trend sampling:

1. From the Trend editor, click the Setup tab (see Figure 391). 

Figure 391. Trend Editor Setup Screen

2. If you want to change the trend’s name, in the Trend Name field, 
enter a new name for this trend.

3. In the Sampling Enable referencer edit control, select a method for 
determining whether sampling should occur. Select Enabled to turn 
on sampling manually. Select Disabled to turn off sampling manually. 

Note:

Trend objects may contain up to 64 members. Because of BCU 
memory limitations, however, the more members you include, 
the fewer samples you can take. If taking large numbers of 
samples is a priority for you, consider creating multiple Trend 
objects with limited membership to accomplish this. You can 
later combine the Trend objects in a single report for compari-
son. (See Table 24 on page 455 to understand the relationship 
between number of members and number of possible samples.)
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Setting Up Trend Sampling
Select Referencer if you want sampling to be activated or deactivated 
by the state of a referenced binary property.

4. If you selected Referencer in the Sampling Enable field, then the On 
Delay for Referencer field becomes active. Type the minimum number 
of minutes the binary property must be in On state before sampling 
occurs. You can enter a number between 0 and 60. This feature allows 
the system to stabilize before trending occurs.

5. In the Number of Samples field, select the number of samples you 
want the BCU to retain in its memory. This number is limited by the 
number of members you want the trend to sample. (See Table 24 to 
understand the relationship between the number of members in this 
trend and the number of samples it is possible to store.) 

Table 24. Limits on Numbers of Samples Stored in BCU Memory 

Number of Members Maximum Samples Stored

1 244

2 169

3 129

4 104

5 88

6 75

7 66

8 59

9 53

10 48

11 44

12 41

13 38

14 36

15 33

16 31

17 30

18 28

19 27

20 25

21 24

22 23

23 22

24 21

25–26 20

27 19

28–29 18
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6. In the Interval field, select the frequency with which you want the 
members to be sampled. You can choose 1 Minute, 5 Minutes, 15 Min-
utes, 1 Hour, 8 Hours, 1 Day, 7 Days, or Billing Period.

7. If you selected 8 Hours or 1 Day in the Interval field, the Collect Sam-
ple at Time field displays. Enter in this field the time of day you want 
sampling to begin.

8. If you selected 7 Days in the Interval field, the Collect Sample at 
Time field and the Collect Sample on Day field are displayed. Com-
plete these fields with the time of day you want sampling to begin, 
and the day of the week you want sampling to begin, respectively.

9. If you selected Billing Period in the Interval field, the following but-
tons are displayed:

• Use Last Day of Month, which directs the system to sample at 
11:59 p.m. on the last day of every month.

• Define Day of Month, which directs the system to sample at 11:59 
p.m. on the day of the month you specify in the related field.

• Use Billing Periods.

The last button is available only if you have set up billing periods in 
Site Configuration. You can select to sample at the end of any one of 
up to three billing periods, which you specify in the related field.

30–31 17

32–33 16

34–35 15

36–38 14

39–41 13

42–44 12

45–48 11

49–53 10

54–59 9

60–64 8

Table 24. Limits on Numbers of Samples Stored in BCU Memory 

Number of Members Maximum Samples Stored
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Harvesting Trend Objects for the Trend 

Viewer or the Audit Trail Databases
Use the Trend editor to set up a trend as a harvesting or historical trend 
object. These trends can be easily viewed in Tracer Summit by right-click-
ing on a graphic and creating a Trend Viewer object. The trends are then 
viewed in graphical format in the Trend Viewer. (See Chapter 28, “Using 
the Trend Viewer.”)

To set up harvesting and historical trends:

1. From the Trend editor, click the Members tab (see Figure 392). 

• For the Trend Viewer, check the Harvest Data for this trend dia-
log box.

• For Audit Trail databases, check the Enable Historical Trending 
box (not shown). This only applies to Tracer CCS and Enterprise 
users.

2. Click Save.

Figure 392. Trend Editor Members Screen
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Setting Security Access for a Trend
The Trend editor’s Classes screen allows you to define the security class 
setup for this trend. You also set up trend snapshots on this screen.

To set security access:

1. From the Trend editor, click the Classes tab to display the Classes 
screen (see Figure 393).

Figure 393. Trend Editor Classes Screen

2. If you wish to use the Snapshot Trends feature, click Enable Snap-
shot. When a snapshot is taken, sampling is disabled until the snap-
shot is reset. This allows you to analyze the data leading up to the 
point in time when the snapshot occurred.

3. If you selected Enable Snapshot, the Trigger On referencer edit con-
trol becomes active. In this field, specify the binary input referencer 
or event state of an analog input object that serves as a trigger for a 
snapshot to be taken. If you reference a binary property, that property 
is monitored every minute, and if the state transitions from 0 to 1 for 
more than two minutes, a snapshot is triggered.

If you reference the event state of an analog input object, that prop-
erty is monitored every minute. If the analog input object goes into a 
Low Alarm or High Alarm for more than two minutes, a snapshot is 
triggered (make sure the analog input object is not in an alarm state 
when you initially assign the referencer). If you don’t make a selection 
here, no snapshot is taken. 

4. If you selected Enable Snapshot, the Snapshot Notification Class field 
becomes active. In this field, specify which Event Class will receive a 
message of the snapshot occurrence when a snapshot actually hap-
pens.

5. Click Security Classes to display the Change Security Classes dialog 
box (see Figure 394 on page 459).
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Figure 394. Change Security Classes Dialog Box

6. For each security class, click to insert a check mark if you want users 
of this class to have security access to this trend object.

7. Click OK to return to the Classes screen.

Viewing the Status Screen
The Trend editor’s Status screen displays information about past and 
present data sampling, and provides some controls for managing this 
data. This screen displays when you first access the Trend editor.

To view the status screen:

1. From the Trend editor, click the Status tab to display the Status 
screen (see Figure 386 on page 450). 

2. View the Sampling Enabled field. Yes indicates that the system col-
lects samples regularly for this trend. (Click Report to view the sam-
ples.)

3. Click Clear Samples if you want to erase all accumulated data for this 
trend.

4. View the Snapshot Taken field. Yes indicates that a change in state of 
the referenced property triggered a snapshot, and that sampling has 
been suspended.

5. Click Reset Snapshot to resume sampling and to prepare the system 
for the next snapshot event. This button is available only if the Snap-
shot Taken field contains a Yes.

6. View the remaining fields on this screen. These fields display:

• How frequently this trend is currently set up to take samples, the 
number of samples stored in BCU memory
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• The current number of members
• The percentage of BCU memory allocated to this trend object that 

sample storage currently occupies

You can also identify the BCU name and the status of communica-
tions.

7. Click Report to generate a standard trend report automatically.

Saving a Trend Object to a BCU
To access trends with the Trend editor or to save trends, Tracer Summit 
must be communicating with a BCU.

New or existing trend objects cannot be saved to a BCU unless that BCU 
is currently communicating with the PC Workstation. You can access an 
existing trend to edit it only when your PC Workstation is online with the 
BCU where the trend is saved. For new trends, you can access the editor 
if there is at least one BCU online.

Archiving Trend Data

The BCU that is running the trend will not automatically archive trend 
data to a PC Workstation’s hard drive. To accomplish this, you must use 
Tracer Summit software to access the data accumulated in the BCU and 
archive it to the workstation’s hard drive.

To manually archive trend data to the PC Workstation:

1. Access the Trend editor Status screen for the trend object whose data 
you want to archive.

2. Click Report to access the Tracer Summit Report Viewer and auto-
matically run the standard trend report.

3. After the report has been run, you can save it to the workstation’s 
hard drive.

To automatically archive trend data to the PC Workstation:

◆ See the section about scheduling reports in Chapter 32, “Designing 
Reports.”
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Chapter 30

Using the Graphics Editor

One of the most powerful tools available in Tracer Summit for Windows is 
the Graphics editor, which allows you to create and customize graphics 
(also called graphic objects) for your system with specialized tools and 
menus. Graphics in Tracer Summit are the primary way in which daily 
operators check system status and perform operator overrides.

Operators rely on the graphics you create to display information quickly 
and clearly. You can create graphics to:

• Provide real-time status information about a particular object, or 
about the system

• Give users the ability to change an object’s state or setpoint
• Display an animated image
As an advanced user, you can build and adapt graphics to be displayed 
when an item is clicked on the navigation tree, when a target is clicked 
within a graphic, and when the Graphic button is clicked in a UCM editor. 
Using Tracer Summit’s Graphics editor, you can:

• Edit the standard graphics provided with Tracer Summit to use on 
one or more sites as custom graphics

• Create new graphics
• Customize the background, font, size and appearance of fields on a 

graphic, as well as the background of the graphic itself
• Create expanded messages
• Create runtime graphs for either live properties or trended objects
• Create links to external sources

For descriptions and information about specific fields, toolbar buttons, 
dialog boxes, and palette buttons in the Graphics editor, see Tracer Sum-
mit online help.
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About Graphics
In Tracer Summit, you can create a graphic by adding graphic elements, 
such as text (static or dynamic), images, target links to other graphics, 
and controls, to a background image. A background image might be a 
solid color or a floor plan of a site. You place layers of these graphic ele-
ments (also called fields) on the background to create a composite graphic. 
You can also layer an animated image on top of another image, or place a 
static text label on top of a control. Target fields layer over other images 
to create links to other graphic objects. You can move intersecting layers 
of images and other fields behind or in front of other layers. Figure 395 
shows an example graphic.

Figure 395. Example of a Graphic in the Graphics Editor

Note:

• A graphic is linked to an object by its name. If you change 
the name of an object that is referenced by a field on a 
graphic, the graphic will be unable to display data for the 
object. Instead, “Object Unavailable” will be displayed. 

• All references to Windows folder names in this chapter 
refer to subdirectories of the location where Tracer Sum-
mit is installed on your PC Workstation, which is typically  
C:\Program Files\Tracer Summit. Subdirectories within 
this folder include Graphics\Standard, Graphics\Custom 
and Graphics\site name (where site name is the name of 
the current site).

Target 
Image

Target 
Buttons

Fields Layered 
Over an Image

Background 
With Grid On

Static 
Text 
Field
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Accessing the Graphics Editor
1. Display the graphic you want to edit.

2. From the Setup menu, select Graphics editor. The displayed graphic 
view is transformed.

Using the Graphics Editor Tools
When the Graphics editor is open, two groups of tools display: a graphics 
toolbar and a floating tool palette that you can move around the screen 
using the mouse. Figure 396 shows these tools.

Figure 396. Graphics Editor Toolbar and Tool Palette

The Graphics editor palette allows you to select from among 17 types of 
fields to insert. Table 25 on page 464 shows the types of fields that are 
available for insertion and configuration. When you click a palette button 
or select a field for editing, an editor displays that provides configuration 
options for the corresponding field type. More information about these 
editors is available in Tracer Summit online help.  

Use the graphical status control to create geometric shapes or designs 
(such as a thermometer) and display them on an analog property.
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Table 25. Graphic Field Types and Palette Buttons  

Field Type Field Name
Palette 
Button

Description

Status 
Fields

Status text Inserts text drawn from the property you specify.

Analog in 5 color Inserts a field that shows the viewer a color-coded update of 
the alarm state of an analog property you specify.

Binary Inserts text drawn from the binary property you specify.

Animation Inserts images to create animation from multiple image files 
that run when a binary or an analog property is in a state 
you specify.

Graphical Status Inserts geometric shapes or designs (such as a thermome-
ter) on an analog property. In runtime view, users can add 
the maximum and minimum values and a caption.

Control 
Fields

Override control Inserts a button with a text label you provide. In the runtime 
view, clicking the resulting button displays the Override dia-
log box, allowing users to alter the system via the graphic.

Setpoint control Inserts a numeric text field. In the runtime view, the field 
allows users to change settings of numerical data.

Binary Check Box control Inserts an unchecked check box. In the runtime view, users 
can check the check box to change the state of the property 
you specify.

Selection List control Inserts a drop-down list that contains entries linked to a 
property. In the runtime view, users can select from this list 
to change the state of the associated property.

Text or 
Image 
Fields

Static text Inserts text that you specify.

Image Inserts a graphic image (any BMP, GIF, or JPG file).

AVI movie Inserts an AVI movie that runs for as long as the graphic is 
displayed or until the movie ends.
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Target 
Fields Target text Inserts a line of text that links to another graphic.

Target image Inserts a graphic image that links to another graphic.

Target button Inserts a button that links to another graphic.

Target External Inserts a button that links to a Web site, a file, or an applica-
tion outside of Tracer Summit.

Graph field
Graphing Inserts a graph on the graphic.

Cursor
Default cursor Changes the cursor from an insertion point back to a selec-

tion cursor.

Table 25. Graphic Field Types and Palette Buttons  (Continued)

Field Type Field Name
Palette 
Button

Description
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Using the Graphics Pop-Up Menu

In the Graphics editor, you can select options from the menu bar or select 
options from a pop-up menu. To display a pop-up menu, right-click on a 
graphic field or on the graphic background. You can then click a selection.

If the mouse button is positioned over a field, the pop-up menu items are 
specific to the field. Otherwise, the pop-up menu is specific to the entire 
graphic.

Using the Grid to Organize Fields

When you edit a graphic in the Graphics editor, you can display a default 
grid pattern of colored dots to assist in aligning graphic elements. You can 
change the default settings of grid color (black) and spacing in pixels (15). 
When the grid is on, an optional Snap to Grid feature automatically 
aligns fields to the grid when you insert or move them.

Displaying the Grid on a Graphic

1. With the graphic displayed in the Graphics editor, from the Layout 
menu, select Grid Options. The Grid Options sub-menu displays.

2. Click the On option to display the grid, which appears as a matrix of 
dots (see Figure 397). To hide the grid, click the On option again.

When you save the graphic, the grid settings are saved with it.

Figure 397. Graphic with Grid On
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Changing the Grid Color on a Graphic

The Graphics editor automatically chooses a contrasting grid color where 
the grid overlaps any image. 

To select a different color:

1. With the graphic displayed in the Graphics editor, make sure the grid 
is turned on (see “Displaying the Grid on a Graphic” on page 466).

2. From the Layout menu, click Grid Options. The Grid Options sub-
menu displays.

3. Select Color and from the Color sub-menu, select Red, Blue, Green or 
Black.

The grid options are saved with each graphic. The next time this graphic 
is edited with the grid on, selections default to the same grid options.

Using the Snap To Grid Feature on a Graphic

The Graphics editor automatically enables the Snap To Grid feature 
when the grid is turned on. This feature causes the upper left-hand cor-
ner of any field that is added to or moved on the graphic to be aligned 
with the nearest upper left-hand grid intersection. 

To disable the feature:

1. With the graphic displayed in the Graphics editor, make sure the grid 
is turned on (see “Displaying the Grid on a Graphic” on page 466).

2. From the Layout menu, select Grid Options to display the Grid 
Options sub-menu.

3. Click Snap To Grid.

To enable the feature:

◆ Repeat the steps above. When you click Snap To Grid and it has no 
check mark, Tracer Summit inserts a check mark and re-enables the 
feature.

The grid options are saved with each graphic. The next time this graphic 
is edited with the grid on, the Snap To Grid selection defaults to the set-
ting you chose.

Configuring Grid Spacing

1. With the graphic displayed in the Graphics editor, make sure the grid 
is turned on (see “Displaying the Grid on a Graphic” on page 466.)

2. From the Layout menu, select Grid Options to display the Grid 
Options sub-menu. 

3. Click Grid Spacing. The Grid Spacing dialog box displays (see 
Figure 398 on page 468).
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Figure 398. Grid Spacing Dialog Box

4. Enter a number between 2 and 100. This is the number of pixels 
between intersection points on the grid.

5. Click OK to display the Graphics editor and the grid with the spacing 
you specified.

The grid configuration is saved with each graphic. The next time this 
graphic is edited with the grid on, it defaults to the configuration you set 
up.

Editing Graphic Properties
While you are in the Graphics editor, you can edit the following graphic 
properties: the background image of the graphic, the security access to 
the graphic, and the graphic’s context object (filters that set the site 
name, object type and context of the object when it is launched). All these 
properties are edited at the Graphic Properties dialog box. You can also 
view the location and HTML file name of the graphic.

Changing the Background of a Graphic

1. Display the graphic whose background you want to change in the 
Graphics editor. Do not select any fields.

2. From the Edit menu, select Properties. The Graphic Properties dialog 
box displays (see Figure 399 on page 469).

Note:

While you are in the Graphics editor, you can also access the 
Graphic Properties dialog box from the graphics pop-up menu. 
Move the mouse cursor so that it is not positioned over any 
fields, then right-click to display the pop-up menu and select 
Edit Properties.
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Figure 399. Graphic Properties Dialog Box—Background Image Screen

3. Click Browse to display the Locate Image dialog box (see Figure 400).

Figure 400. Locate Image Dialog Box

4. Select an image (see “Using the Locate Image Dialog Box” below).

5. Click OK to return to the Graphic Properties dialog box.

6. Click OK to return to the Graphics editor window.
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Using the Locate Image Dialog Box

1. Click Browse in the Graphic Properties dialog box or in the Setup 
screen of the Insert Image dialog box. The Locate Image dialog box 
displays (see Figure 400).

2. Select either Global Images or Current Site Images. If you select Glo-
bal Images, you can select an image available for the system. If you 
select Current Site images, you can select only an image associated 
with this particular site where you are logged in. The Image Files 
field lists graphics according to the current check box selections.

3. If you selected Global Images, select either Standard or Custom to 
specify the type of images you want this dialog box to list. Standard 
images are included with Tracer Summit. Custom images are created 
by editing a standard image or by starting with a blank image. 
Images specified as Global Images are available to all sites on the sys-
tem.

4. Click the GIF, JPG, or BMP check box to display a particular graphic 
file type in the Image Files field.

5. Select the image file name you want. The Sample field displays a pre-
view of the image. The Path text line identifies its location.

6. Click OK to insert the selected image in the current graphic.

Viewing a Graphic’s File Name and Location

Sometimes you need to know the file name and location of a graphic, if, 
for example, you want to copy or delete the graphic using Windows 
Explorer.

To view a graphic’s file name and location:

1. Display the graphic in the Graphics editor. Make sure no fields are 
selected.

2. From the Edit menu, select Properties. The Graphic Properties dialog 
box displays.

3. Click the Graphic Information tab (see Figure 401). The graphic’s file 
name and location displays in the HTML Path field.

Note:

If images are not displaying properly in the Graphics editor, 
your workstation’s Display settings in Windows might need cor-
rection. Your workstation must be set up for a minimum of 16-
bit colors. To check display settings, click the Windows Start 
button. Click Settings, then Control Panel. From the Control 
Panel, select Display.
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Figure 401. Graphic Properties Dialog Box—Graphic Information Screen

Setting Up Security for a Graphic

You can specify whether users have access to a graphic.

To set up security for a graphic:

1. Display the graphic in the Graphics editor. Make sure no fields are 
selected.

2. From the Edit menu, select Properties. The Graphic Properties dialog 
box displays.

3. Click the Graphic Information tab (see Figure 402).

Figure 402. Graphic Properties Dialog Box—Graphic Information Screen
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4. Click the Security Classes button. The Change Security Classes dia-
log box displays (see Figure 403). 

Figure 403. Change Security Classes Dialog Box

5. Click the Access field next to each class to grant or deny access. A 
check in the field grants access. No check denies access.

6. Click OK to display the Classes screen.

7. Click Save.

Selecting the Context Object for a Graphic

When you create a new graphic object, you may give the graphic a con-
text. For example, if you have created a graphic of a floor plan, you might 
specify its site and the area object that controls the floor displayed by the 
graphic. When the floor plan graphic is displayed, the context allows the 
user to display the appropriate schedule or report for the area entered as 
the current object of the floor plan.

To select the context object:

1. Display the graphic in the Graphics editor. Make sure no fields are 
selected.

2. From the Edit menu, select Properties. The Graphic Properties dialog 
box displays.

3. Click the Context Object tab (see Figure 404).

Note:

The context object also will be used to fill in template fields on a 
graphic when it is displayed. For more information on template 
graphics, see “Creating and Modifying Graphics with Template 
Fields” on page 510.
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Figure 404. Graphic Properties Dialog Box—Context Object Screen

4. In the Site Name field, select the site. To select the active site, select 
<default>.

• If you select <default> for the site name, the Object Type and 
Object Name fields display <default> also.

• If you choose a specific site name, the Object Type and Object 
Name fields display the first type and name defined on the site.

5. In the Object Type field, select from the list of object types defined for 
the site you specified.

6. In the Object Name field, select from the list of objects defined for the 
site and object type you specified.

7. Click OK.
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Creating and Editing Graphic Fields
You may want to customize graphic objects for specific sites by adding 
fields, changing the name displayed for fields, or by moving fields to dif-
ferent locations on the graphic background. (The changes are not saved to 
the standard graphic; instead, your edited graphic is saved in the Graph-
ics/ Custom folder.)

Inserting a Graphic Field

1. In the Graphics editor, display the graphic in which you want to 
insert the field.

2. Click the palette button associated with the type of field you want to 
insert (see Table 25 on page 464). The cursor turns into an insert 
prompt (see Figure 405).

Figure 405. Insert Prompt

3. Position the insert prompt at the location on the graphic where you 
want to insert the field. Drag the prompt to define the shape and size 
you want the field to be. The field is inserted and an editor appropri-
ate for the field type you selected displays.

4. Complete the fields on the editor screens.

5. Click OK to return to the Graphics editor. (For field types that refer-
ence a specific property, the OK button is not available until you spec-
ify a property in the Property field.)

Note:

For images and AVI movies, you can let Tracer Summit deter-
mine the field size based on the image size and proportion. Sim-
ply click once on the graphic to insert the field (rather than 
dragging to define the field size). The field’s editor displays.
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Accessing the Graphic Field Editor

1. Click the field you want to edit. A cross-hatched border displays 
around the field to show that it is being edited (see Figure 406).

Figure 406. Field with Cross-Hatched Border

2. Click the right mouse button to display a pop-up menu, then select 
Edit Properties. An editor displays that corresponds to this field type.

3. Make changes to the information as necessary. Your edits take effect 
when you click OK.

Selecting a Property Reference for Graphic Fields

On the Property screen, you can specify the site name, object type, object 
name, and property for the graphic.

To select a property reference for a graphic field:

1. Display the graphic field editor for the field:

• When you insert a new field, the editor automatically displays.
• For existing fields, position the mouse pointer over the field, then 

click the right mouse button and select Edit Properties from the 
pop-up menu.

2. In the Site Name field, select the name of the site.

3. In the Object Type field, select an object type from the list of those 
defined for the specified site. The selection will filter the Object Name 
field to display only those property types and instances defined in the 
site.

4. In the Object Name field, select the name of the object from the list of 
those available.

5. In the Property Name field, select the property from the list of those 
available. (You must complete this field to exit the screen.)
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Editing Setup Information for a Graphic Field

The setup information for a graphic field gives a name to the field for ref-
erence while you are in the Graphics editor. The name displays on the 
graphic field for Static Text, Target Text, Target button fields, and Target 
External button fields, but does not display on the graphic for other fields. 
The Setup screen for other fields requires additional information (see 
“Setup Information for Graphic Fields” on page 477 and “Creating 
Graphic Links to External Sources” on page 488).

To edit a field’s setup information:

1. Click the field you want to edit. A cross-hatched border displays 
around the field.

2. Click the right mouse button to display a pop-up menu, then select 
Edit Properties. The graphic field editor for this field displays.

3. Click the Setup tab. Figure 407 shows the Setup screen for a status 
text field.

Figure 407. Status Text Editor—Setup Screen

4. Edit the information as necessary. Refer to “Setup Information for 
Graphic Fields” on page 477.

5. Click OK.
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Setup Information for Graphic Fields

The Setup screen of the graphic field editor changes based on the field 
type selected. The following sections give detailed information on the 
setup information for specific field types.

Setup Information for Status Text, Setpoint Control, Static Text, 

and Target Text Fields, and Target Buttons

Setup information for Status text, Setpoint control, Static text, and Tar-
get text fields, as well as for target button fields, is similar. When you dis-
play the field’s editor and select the Setup tab, you can edit the Editor 
Text field. This field indicates the text that displays on the graphic for 
static text, target text, and target buttons. (For Target External setup 
information, see “Creating Graphic Links to External Sources” on 
page 488. When you display the Target External editor, select the Desti-
nation tab to edit the Display Text field.)

Figure 408 shows the Setup screen for a status text field.

Figure 408. Status Text Editor—Setup Screen
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Setup Information for Analog in 5 Color Fields

Figure 409 shows the Setup screen of the Analog in 5 Color editor.

Figure 409. Analog in 5 Color Editor—Setup Screen

Setup options include the following:

• For an analog input object, the alarm limit default settings are dis-
played. For other analog values, edit the alarm and warning settings 
as desired. 

• Click with the right mouse button on the field labels to change the col-
ors that display for each warning, if desired.
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Setup Information for Binary Text Fields

Figure 410 shows the Setup screen of the Binary Text editor.

Figure 410. Binary Text Editor—Setup Screen
:

Setup options include the following:

• Type a label for the graphic field in the Editor Text field. (This label 
will not display on the graphic.)

• Edit the text displayed when the property is active in the Active Text 
field, if desired.

• Edit the text displayed when the property is inactive in the Inactive 
Text field, if desired.

• Click the Change button to select a different color displayed for the 
Active Text and Inactive Text, if desired.

• Click the Change button to select a different background color behind 
the text, if desired.
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Setup Information for Graphical Status Fields

The Graphical Status editor lets you create geometric shapes or designs 
(such as a thermometer) and display them for an analog property. 
Figure 411 shows the Setup screen of the Graphical Status editor.

Figure 411. Graphica Status Editor—Setup Screen

To create a graphical status field:

1. Select a template from the list. (You can use the templates that ship 
with Tracer Summit or create your own.)

2. Type a minimum and maximum value.

3. Type a caption (text displays on graphic).

4. Click the Digital Value field to display the current value of the prop-
erty. (If the template is not set up for a digital value this field will not 
be available.)
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Setup Information for Animation Fields

Figure 412 shows the Setup screen of the Animation editor for a binary 
property. Figure 413 shows the Setup screen for the analog property.

Figure 412. Animation Editor—Binary Setup Screen

Figure 413. Animation Editor—Anlog Setup Screen
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Setup options include the following:

• Change to analog or binary (defaults to the type of property that is 
selected)

• Select whether you want to display the images for Active State or 
Inactive State (binary property).

• Click the Add button for each state to select the image(s) needed to 
create the animation from the Locate Image dialog box (see Figure 
400 on page 469).

• Click the up or down arrow button to change the order the frames are 
displayed, as desired.

• In the In the Frame Delay field, specify the number of milliseconds 
you want the frames to display. (This number applies to all of the 
images for a binary animation. A lower number makes the animation 
appear faster.) (binary property)

• In the Analog Range fields, select the Low and High limits to start 
and stop the animation (analog property).

• To test the effect of the animation, click the Test Animation button 
(binaryproperty).

Note:

You can not change the state an image represents after it has 
been added. If you add an image in one state and want to 
change it to the other state, delete the image. Select the state 
you want it added to, then add the image.
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Setup Information for Images, Target Images, and AVI Movies

Setup information for image fields and AVI movie fields is similar. 
Figure 414 shows the editor Setup screen for an image field.

Figure 414. Image Editor—Setup Screen

To select an image, click the Browse button and select one from the 
Locate Image dialog box (see Figure 400 on page 469). 

After you have selected an image, a sample displays on the Setup screen.

Editing Text Styles and Borders for Graphic Fields

For any graphic fields with text, including status text, setpoint, static 
text, and target text fields, you can modify the text styles or borders of the 
fields.

To edit text styles or borders:

1. Display the graphic field editor for the field:

• When you insert a new field, the editor automatically displays.
• For existing fields, position the mouse pointer over the field, then 

click the right mouse button and select Edit Properties from the 
pop-up menu.

2. Click the Style tab. Figure 415 on page 484 shows the Style screen for 
a status text field. A preview of the font displays in the Font area.
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Figure 415. Status Text Editor—Style Screen

3. In the Font field, select a font for the text.

4. In the Size field, select a font size.

5. Check the appropriate boxes (if any) for bold or italic text.

6. To change the color of the text, in the Foreground Color field, click the 
Change button and select a color.

7. To change the color of the text background, in the Background Color 
field, click the Change button and select a color.

8. To change the number of decimal places for numbers, select a value in 
the Digits Right of Decimal field.

9. Click the Border tab. Figure 416 on page 485 shows the Border screen 
for a status text field.

Note:

Font styles and sizes vary by PC. You must ensure that the PC 
Workstation that the graphic will be displayed on has the corre-
sponding font.

Note:

The number you enter here will take effect only if the graphic 
field will display numeric information.
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Figure 416. Status Text Editor—Border Screen

10. In the Width field, select the width of the border (in pixels).

11. In the Style field, select the border’s style (such as solid, dotted or 
dashed).

12. To change the color of the border from black, in the Color field, click 
the Change button and select a color.

13. Click OK when you are finished.

Selecting the Destination for Target Fields

One navigation method you can provide to daily operators is a target 
field, which can be Target text, a Target image, a Target button, or a Tar-
get External button. When the user passes the mouse pointer over a tar-
get field, the pointer changes into a pointing finger. When the user clicks 
on the target field, the view links to another graphic (called the target 
field’s destination). By inserting target fields, you can provide access to 
other graphics in the site—you can even insert target fields that link to 
graphics at other sites. Target External buttons allow you to link to exter-
nal file sources (see “Creating Graphic Links to External Sources” on 
page 488).

When you create the target field, you can choose whether you want the 
destination graphic to replace the launching graphic or to appear in a sep-
arate window. The user is able to return to the launching graphic by click-
ing the Back button, or by closing the window containing the second 
graphic (if displayed in a separate window).

If the user does not have access to the destination graphic, the cursor does 
not change into a pointing finger.

To select the destination:

1. In the Graphics editor, display the graphic that has the target field 
you want to edit.

2. Click on the target field to select it.
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3. Click the right mouse button, then select Edit Properties from the 
pop-up menu. The graphic field editor displays for that target field. 
Figure 417 shows the Target Text editor.

Figure 417. Target Text Editor—Destination Screen

4. At the Destination screen, click UCM/Application Objects or Graphic 
Objects, depending on which graphic you want users to see after they 
click this target field. The UCM or application destination displays a 
graphic that is associated with the object.

5. In the Site Name field, select the site that contains the UCM/Applica-
tion object or graphic you want users to see after they click this target 
field in the current graphic. 

6. In the Object Name field, select the name of the UCM or graphic you 
want users to see after they click this target in the current graphic.

7. In the Editor Text field, select whether you want the target field to 
display the destination object name or custom text.

8. If you want the second graphic to display in a separate window that 
appears over the current graphic after the target field is clicked, click 

Note:

If you select UCM/Application Objects, the context is supplied, 
so the fields of the Context Object screen are not available. If 
you select Graphic Objects, you need to select the context. See 
“Selecting the Context Object for a Graphic” on page 472. On 
the Context Object screen, make selections for the Site Name 
and Object Name fields.

Note:

If you selected Graphic Objects in step 4, the Object Name field 
changes to the Graphic Name field.
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Open New Window. (Some users may not be able to make the selec-
tion to open a second graphic window due to their security level.)

9. Click OK when you are finished completing all the editor screens.

Selecting the Context Object for Target Fields

When you link to another graphic using a target field, the context infor-
mation is passed on to the Report and Scheduling editors, and to the new 
graphic for use in template fields. See “Creating and Modifying Graphics 
with Template Fields” on page 510. 

To select the context object for a target field:

1. Display the graphic field editor for the field:

• When you insert a new field, the editor automatically displays.
• For existing fields, position the mouse pointer over the field, then 

click the right mouse button and select Edit Properties from the 
pop-up menu.

2. Click the Context Object tab. Figure 418 shows the Context Object 
screen for a target text field.

Figure 418. Target Text Editor—Context Object Screen

3. In Site Name field, select <default>. 

4. In the Site Name field, select the site. To select the active site, select 
<default>.

• If you select <default> for the site name, the Object Type and 
Object Name fields display <default> also.

• If you choose a specific site name, the Object Type and Object 
Name fields display the first type and name defined on the site.

5. In the Object Type field, select from the list of object types defined for 
the site you specified.
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6. In the Object Name field, select from the list of objects defined for the 
site and object type you specified.

7. Click OK.

Creating Graphic Links to External Sources

You can create graphic links to external sources using the Target Exter-
nal button. The Target External button behaves similarly to a shortcut 
icon on a workstation desktop. It links the graphic to a source outside of 
Tracer Summit, such as a Microsoft Word document, an Adobe Acrobat 
file, or a Web site through Internet Explorer. The external application 
opens in a separate window and runs independently of the Tracer Sum-
mit application.

The Target External button allows you to:

• Launch an application outside of Tracer Summit
• Open a file using an application outside of Tracer Summit, provided 

the file is associated with an application
• Opens to a Web site using Internet Explorer

To create a graphic link to an external file:

1. In the Graphics editor, click the Target External button on the tool 
palette. The cursor turns into an insert prompt.

2. Position the insert prompt at the location on the graphic where you 
want the button to appear. Click to display the Target External editor. 
Figure 419 shows the destination screen of the Target External editor.

3. In the Display Text field, enter the label you want the button to dis-
play.

4. In the Target field, create a link to an external application or file by 
either typing the target path or clicking the Browse button to select 
the application or file. 

To create a link to a Web site, either type in the Web address or open 
Internet Explorer and browse to select the site. Copy the Web site 
address and paste it into the Display Text field.

The selected path or address will display in the Target field, as shown 
in Figure 419 on page 489. 
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Figure 419. Target External Editor—Destination Screen

5. Use the Style tab if you want to change the appearance of the button 
(see “Editing Text Styles and Borders for Graphic Fields” on 
page 483).

6. Click OK when you are finished completing the editor screens. The 
Target External button will appear at the point where you positioned 
the insert prompt (see step 2).

7. To edit the button, right-click on the button and select Edit Properties 
from the pop-up menu.
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Organizing Graphic Fields
When you are creating new graphic fields or modifying existing fields, you 
may want to:

• Move one or more fields to a different location on the graphic
• Resize one or more fields to be the same size
• Copy (or cut) fields and paste them on another graphic
• Align several fields along their top, bottom, left, or right edges

Selecting a Graphic Field

◆ Click once over the field. A cross-hatched border displays around the 
field.

Selecting Multiple Fields at Once

1. Click the first field you want to edit. A cross-hatched border displays 
around the field to show that it is the primary field.

When you perform actions requiring fields to match position, or size, 
or alignment, this primary field is used as a model for the other fields. 
(If you do not want this field to be the primary field, click Default Cur-
sor on the palette, then make a different selection.)

2. Holding down the Ctrl key, click one or more additional fields on the 
same graphic. Fields do not need to be of the same type to be selected 
at the same time. 

A striped border displays around these subsequent items you select to 
show that they are secondary fields (see Figure 420). When you per-
form actions requiring fields to match position, or size, or alignment, 
these fields change to match the primary field.

Figure 420. Primary and Secondary Fields

Primary field with 
cross-hatched border

Secondary fields with 
striped borders
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Moving a Graphic Field

1. Click the field you want to move. (You can also move multiple selected 
fields at once. See “Selecting Multiple Fields at Once” on page 490.) 

After you select the field, the cursor turns into a movement cursor 
(see Figure 421).

Figure 421. Movement Cursor

2. Drag the field to a new location within the graphic. All fields selected 
with this field also move.

To move the field just one pixel at a time, press the left, right, up or 
down arrow keys on your keyboard while the movement cursor is dis-
played.

When you release the mouse button, the default cursor returns.

Resizing a Graphic Field

1. Click the field you want to edit. A cross-hatched border displays 
around the field.

2. Use the mouse to grab one of the edges or corners of the field. The cur-
sor changes to directional arrows showing the direction in which the 
field dimension can be changed. 

3. Drag the field in the direction of the arrows to increase or decrease its 
size. When you release the mouse button, the default cursor returns.

Cutting and Pasting a Graphic Field

1. Click the field you want to cut. A cross-hatched border displays 
around the field. (You can also select multiple fields to cut simulta-
neously. See “Selecting Multiple Fields at Once” on page 490.)

2. Click Cut Selected Field(s) on the Graphics editor toolbar to remove 
the field from the graphic (see Figure 422). 

Figure 422. Cut Selected Field(s) Button

3. Place the cursor at the location where you want to paste the field you 
removed. This can be a location on the same graphic or on a different 
graphic.

4. Click Paste Selected Field(s) on the Graphics editor toolbar to insert 
the field in the new location (see Figure 423). The field is inserted at 
the new location.
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Figure 423. Paste Selected Field(s) Button

Copying a Graphic Field

1. Use the default cursor to click the field you want to edit. A cross-
hatched border displays around the field. (You can also select multiple 
fields to copy simultaneously. See “Selecting Multiple Fields at Once” 
on page 490.)

2. Click Copy Selected Field(s) on the Graphics editor toolbar (see 
Figure 424). 

Figure 424. Copy Selected Field(s) Button

3. Place the cursor at the location within the graphic where you want to 
paste the field you copied. This can be a location on the same graphic 
or on a different graphic.

4. Click Paste Selected Field(s) on the Graphics editor toolbar to insert 
the field in the additional location (see Figure 423).

5. If additional configuration is required to distinguish the copied field 
from the original field, complete this configuration.

Aligning Graphic Fields

You can use the Align buttons on the Graphics editor toolbar to align sec-
ondary graphic fields with the primary field you select.

To align graphic fields:

1. Click the field to which you want to align the other fields. A cross-
hatched border displays around this primary field.

2. Hold down the Ctrl key and click the other fields that you want to 
align to the primary field. A striped border displays around these sec-
ondary fields.

3. On the Graphics editor toolbar, click one of the following:

• Align Left, to align all of the secondary fields along the left of the 
primary field

• Align Right, to align all of the secondary fields along the right of 
the primary field

• Align Top, to align all of the secondary fields along the top of the 
primary field

• Align Bottom, to align all of the secondary fields along the bottom 
of the primary field

See Figure 425 on page 493.
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Figure 425. Align Buttons

Making Graphic Fields the Same Size

You can use the Make Same buttons of the Graphic editor toolbar to make 
several fields the same size as a primary field that you select.

To make graphic fields the same size:

1. Click the field which you want to use for the size of all selected fields. 
A cross-hatched border displays around this primary field.

2. Hold down the Ctrl key and click the other fields that you want to 
make the same size as the primary field. A striped border displays 
around these secondary fields.

3. On the Graphics editor toolbar, click one of the following:

• Make Same Height, to make all of the secondary fields the same 
height as the primary field

• Make Same Width to make all of the secondary fields the same 
width as the primary field

• Make Same Size to make all of the secondary fields the same size 
as the primary field

See Figure 426.

Figure 426. Make Same Buttons

Align 
Left, Right, Top, Bottom

Make Same 
Height, Width, Size
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Moving Graphic Field Layers Forward or Back

When you add graphic fields, they are layered on the background in the 
order created. For example, if you create a Static Text label first, then add 
a Target Image field, the Target Image will be a layer on (or in front of) 
the label. You may want to move the label on top of the image.

For an example of fields layered over an image, see Figure 395 on page 
462.

To move graphic field layers forward or back:

1. Select any field(s) you want to move forward or back (see “Selecting 
Multiple Fields at Once” on page 490).

2. Click the right mouse button. From the pop-up menu, make a selec-
tion:

• Select Move Back by 1 to move the currently selected field(s) 
behind one field.

• Select Move Forward by 1 to move the currently selected field(s) 
forward one field.

• Select Move to Back to move the currently selected field(s) all the 
way to the back. (You can also select the Move to Back button on 
the Graphics editor toolbar.)

• Select Move to Front to move the currently selected field(s) in 
front of other fields. (You can also select the Move to Front button 
on the Graphics editor toolbar.)

Deleting a Graphic Field

1. Select all the fields you want to delete (see “Selecting Multiple Fields 
at Once” on page 490). 

2. From the Edit menu, select Delete. The selected fields are deleted.
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Saving Graphics
You can save a graphic using the Save Graphic button on the Graphics 
editor toolbar or using the Save Graphic command from the File menu. 
When saving a graphic, keep in mind the following:

• For custom graphics, your changes overwrite the current graphic file.
• For standard graphics, your changes do not overwrite the original 

standard graphic. Instead, they are saved into a graphic file of the 
same name in the Graphics\Custom folder, which will override the 
standard graphic.

• To save a graphic file to a new name or a different location, you can 
use the Save Graphic As command. For custom graphics, refer to 
“Saving a Custom Graphic to a New Location or File Name” below. 
For standard graphics, refer to “Saving Edited Standard Graphics” on 
page 496.

• The first time you save a custom graphic you created from a blank 
graphic, you must specify the name and location of the graphic file. 
Refer to “Saving a Custom Graphic to a New Location or File Name” 
below.

To save a graphic:

◆ On the Graphics editor toolbar, click Save (see Figure 427). The 
graphic file is updated with your changes.

Figure 427. Save Button

Saving a Custom Graphic to a New Location or File 

Name

To save a custom graphic to a new name or location, you can use the Save 
Graphic As command. The steps are the same for the first time you save a 
custom graphic created from a blank graphic, because you need to specify 
the name and location of the graphic file.

To save a custom graphic to a new location or file name:

1. From the File menu, select Save Graphic As. If this is your first time 
saving a graphic, select Save Graphic. The Save As Graphic dialog 
box displays (see Figure 428 on page 497).

2. In the Graphic Object Name field, enter a name for this graphic. The 
name appears in the list of custom graphic objects and, possibly, on 
the navigation tree. Do not use an object name that is already in the 
system.

3. In the HTML File Name field, enter an HTML name for the graphic 
file. Tracer Summit uses this file name to locate the graphic. Do not 
use an HTM file name that is already in use. (If you do not type the 
.HTM extension, Tracer Summit automatically adds it.)
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4. Select either Global Graphics or Site Graphics. If you select Global 
Graphics, this graphic is saved to the Graphics\Custom folder and is 
available for assignment to any site. If you select Site Graphics, you 
must also identify the particular site to which you want to assign this 
graphic. This graphic is saved in the Graphics\site name folder and 
cannot be used for any other site. If you are saving an existing site 
graphic, you cannot change it to a global graphic or change to another 
site.

5. To change the security access for this graphic, click the Security 
Classes button to display the Change Security Classes dialog box.

6. At the Save As Graphic dialog box, click OK to create the graphic 
object in the location you specified.

If the graphic has no template fields, it is added as a node on the 
Tracer Summit root node (if you selected Global Graphics in step 4) or 
below the site you identified (if you selected Site Graphics in step 4).

Saving Edited Standard Graphics

When you edit a standard graphic and use the Save Graphic command to 
save it, the edited standard graphic is stored in the Graphics\Custom 
folder (which makes the graphic a global graphic available to all sites). 
Tracer Summit automatically displays this edited standard graphic when 
you select its associated object. The next section “How Tracer Summit 
Searches for and Displays Standard Graphics” explains how this works.

If you want to make the edited standard graphic a site graphic that is 
available only to the current site, you need to use the Save Graphic As 
command to save the edited graphic to the Graphics\site name folder. 
Refer to “Saving an Edited Standard Graphic as a Site Graphic” on 
page 497.

For information on saving an edited standard graphic to a new name (as a 
custom graphic), refer to “Saving an Edited Standard Graphic as a Cus-
tom Graphic” on page 498.

How Tracer Summit Searches for and Displays Standard Graphics

When you click on an object in the navigation tree, Tracer Summit follows 
a search sequence to locate the object’s graphic file. To have Tracer Sum-
mit use an edited version of a standard graphic, it is helpful to know how 
Tracer Summit searches for standard graphics. The program looks for the 
HTML file that matches the name of the original standard graphic and 
searches in this order:

1. The Graphics\site name folder for the current site.

2. The Graphics\Custom folder.

3. The Graphics\Standard folder where graphics originally included 
with Tracer Summit are stored.

Knowing this search sequence allows you to store graphics in locations 
and with names so that Tracer Summit first finds the one you want to 
display.
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For example, the original standard graphic for an area is called area.htm 
and is stored in the Graphics\Standard folder. Let’s say you open this 
graphic and modify it, then use the Save Graphic command to save it. 
Tracer Summit automatically saves the modified graphic to a file called 
area.htm (the same name) in the Graphics\Custom folder. Now, when you 
display the standard graphic for an area on any site, Tracer Summit dis-
plays the modified version of the graphic because it looks in the Graph-
ics\Custom folder before it looks in the Graphics\Standard folder.

To save a modified standard graphic in the Graphics\site name folder, 
you need to use the Save Graphic As command (as described in the next 
section).

Saving an Edited Standard Graphic as a Site Graphic

1. Display the standard graphic in the Graphics editor and make the 
necessary edits.

2. From the File menu, select Save Graphic As. The Save As Graphic 
dialog box displays (see Figure 428).

The Graphic Object Name and HTML File Name fields already con-
tain the appropriate names for the standard graphic. Do not change 
the names or Tracer Summit will not locate the modified graphic’s file 
at runtime.

Figure 428. Save As Graphic Dialog Box

3. Select either Global Graphics or Site Graphics:

• If you select Global Graphics, this graphic is saved to the Graph-
ics\Custom folder and is available for assignment to any site. 
(Selecting Global Graphics at the Save Graphic As dialog box has 
the same effect as using the Save Graphic command.)
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• If you select Site Graphics, you must also identify the particular 
site to which you want to assign this graphic. This graphic then 
cannot be used for any other site.

4. To change the security access for this graphic, click the Security 
Classes button to display the Change Security Classes dialog box.

5. At the Save As Graphic dialog box, click OK to save the graphic object 
in the location you specified. (Do not check the Fill in Template Fields 
check box.)

Saving an Edited Standard Graphic as a Custom Graphic

To create a custom graphic, you can edit a standard graphic (rather than 
starting with a blank graphic). To save an edited standard graphic as a 
custom graphic, you simply use the Save Graphic As command to change 
its object and HTML file name. When you change the name of the edited 
standard graphic, the graphic is no longer the standard graphic for the 
specified object. The graphic can be used as a modified standard graphic 
(it won’t appear in the navigation tree) or saved with no template fields (it 
will appear as a node on the tree).

To save an edited standard graphic as a custom graphic:

1. In the Graphics editor, display the standard graphic for the UCM, 
application, or site object and make the necessary edits.

2. From the File menu, select Save Graphic As. The Save As Graphic 
dialog box displays (see Figure 428 on page 497).

3. In the Graphic Object Name field, specify the name of the object. This 
name may appear on the navigation tree.

4. In the HTML File name field, enter a new name for the custom 
graphic. 

5. Select either Global Graphics or Site Graphics:

• If you select Global Graphics, this graphic is saved to the Graph-
ics\Custom folder and is available for assignment in any site.

• If you select Site Graphics, you must also identify the particular 
site to which you want to assign this graphic. This graphic will be 
saved to the Graphics\site name folder for the selected site and 
cannot be used for any other site.

6. To change the security access for this graphic, click the Security 
Classes button to display the Change Security Classes dialog box.

7. At the Save As Graphic dialog box, click OK to save the custom 
graphic in the location you specified. 

• If the graphic is to be used as a modified standard graphic, do not 
check the Fill in Template Fields check box.
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• If the graphic is to be used with no template fields, then check the 
Fill in Template Fields check box.

If the graphic has no template fields, it is added as a node on the 
Tracer Summit root node (if you selected Global Graphics in step 5) or 
below the site you identified (if you selected Site Graphics in step 5).

Restoring an Original Standard Graphic
A set of standard graphics are shipped with Tracer Summit. These origi-
nal standard graphics are stored in the Graphics\Standard folder. By 
default, these standard graphics display when you click an item on the 
navigation tree or click the Graphic button in a UCM editor. 

When you edit a standard graphic, the edited version is automatically 
saved as a global graphic in the Graphics\Custom folder, unless you use 
the Save Graphic As command to save it as a site graphic in the 
Graphics\site name folder specific to the current site. The file name is the 
same as the original standard graphic.

As described in “How Tracer Summit Searches for and Displays Standard 
Graphics” on page 496, Tracer Summit first looks for an object’s graphic 
in the Graphics\site name folder, then in the Graphics\Custom folder, 
and finally in the Graphics\Standard folder.

If you want to return to using an original standard graphic rather than 
your edited version, you simply have to delete the edited versions in the 
Graphics\site name and Graphics\Custom folders.

To restore an original standard graphic, you first identify the location of 
the custom HTML file and then delete it.

To restore an original standard graphic:

1. In the Graphics editor, display the edited standard graphic that you 
no longer want to use the object’s standard graphic.

2. From the Edit menu, select Properties. The Graphic Properties dialog 
box displays.

3. Click the Graphic Information tab of the Graphic Properties dialog 
box (see Figure 429 on page 500).

Note:

When you save a graphic that contains template fields, the 
graphic is not included on the navigation tree. See “Creating 
and Modifying Graphics with Template Fields” on page 510 for 
more information about template fields.
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Figure 429. Graphic Properties Dialog Box—Graphic Information Screen

4. Note the file name and path to the file.

5. Using Windows Explorer, locate and delete the file.

6. In Tracer Summit, display the graphic for the object. 

You may need to repeat these steps again if there was a copy of the 
graphic file in both the Graphics\Custom and the 
Graphics\site name folders. When the Graphics Information screen of 
the Graphics Properties dialog box displays the graphic’s folder as 
\Program Files\Tracer Summit\Graphics\Standard, then you have 
restored the original standard graphic.

Note:

You can also rename the HTML file, which has the same effect 
as deleting the file because Tracer Summit will not be able to 
locate it. You should rename a graphic file when you are not 
sure whether you may need the custom graphic again in the 
future.
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About Site and Global Graphics
Tracer Summit classifies most graphics into two categories:

• Site graphics are specific to a site and are not available to be assigned 
to other sites. These graphics are objects that reside in the site data-
base and initially have their corresponding HTML file stored in the 
Graphics\site name folder.

• Global graphics are available to all sites. These graphics are objects 
stored in the system site database and initially have their correspond-
ing HTML files stored in the Graphics\Custom folder.

Many customers have only one site on their Tracer Summit system and so 
will usually save their custom graphics as site graphics. 

Global graphics are most useful when you have multiple sites within your 
Tracer Summit system and want to set up your own standard graphics or 
have graphics appear above sites as group of sites nodes on the naviga-
tion tree. Group of sites nodes help you navigate when you have multiple 
sites.

All graphics in a system are set up as either global graphics or site-spe-
cific graphics. If a graphic is set up to be a global graphic, it is stored at 
the system site and is available for use at one or more additional sites. All 
global graphics can be selected from the Open Graphic or Edit Graphic 
dialog box with any active site. If a graphic is associated with a specific 
site, then it may be accessed and edited only when you are logged onto the 
appropriate site.

Within global graphics, there are two categories of existing graphics that 
you may access using the Graphics editor: standard graphics and custom 
graphics. All graphic objects have corresponding HTML files. Whenever 
you save a graphic or save it under a new name, you create or update the 
associated HTML file as well.

A standard graphic is a graphic that is shipped with Tracer Summit. 
Tracer Summit provides these ready-made graphics stored in the system 
site for many UCMs and applications. These standard graphics are for 
your convenience, if you do not have the time or resources to invest in cre-
ating all new graphics for your system. Standard graphic HTML files are 
always stored in the Graphics\Standard folder for the system. If a stan-
dard graphic is modified, the modified HTML file is stored in the Graph-
ics\Custom or Graphics\site name folder, depending upon the location 
you choose in the Save As Graphic dialog box.

A custom graphic is a graphic that you have previously created in the 
Graphics editor, or which you have created based on a standard graphic. 
Custom graphic objects can be stored in either the global site or a specific 
site. The corresponding HTML file is saved in the Graphics\Custom 
folder (for the global location) or the Graphics\site name folder for the 
site-specific location.
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Creating Images for Use in Graphics
Using the Graphics editor, you can import images you create in other soft-
ware applications into graphics used in Tracer Summit. The file types 
that Tracer Summit can import include the following:

• Graphics Interchange format (GIF)—version 89a is recommended 
because version 87a does not support transparent colors

• JPEG File Interchange (JPG)—Hoffman compressed and progression 
encoding

• Bitmap (BMP)—RGB encoded, RLE encoded
• Audio-Video Interleave (AVI)

To create these image files, you can use a variety of graphics packages, 
including Paintshop Pro versions 5 and 6, AutoCAD, CorelDRAW, or Win-
dows Paint.

Saving Image Files

For optimal performance, save each image file in the same directory as 
the HTML file that use the image. For site-specific images (used by only 
one site), store the image files in the Graphics\site name folder. For 
images used by more than one site, store the image files in the Graph-
ics\Custom folder.

Name image files using up to 32 characters. Choose a name that is as spe-
cific and informative as possible, especially if you may use this image sev-
eral times within a site or for other sites.
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Window and Image Sizes

Table 26 lists window sizes for different window options within Tracer 
Summit. This information is helpful if you are designing images that you 
want to cover the entire screen (such as background images). If you have 
a background image set to the indicated height and width for the given 
window display options, then no information will be hidden and require 
scrolling to see.

Table 26. Image Sizes for Different Window Options 
(Based on 800 x 600 display settings)

Window or 
Image Size 

(Width x Height 
in Pixels)

Window Display Options

Navigation 
Tree 

Displayed?

Status Bar 
Displayed?

Summit 
Task Bar 

Displayed?

Windows 
Task Bar 

Auto Hide 
Enabled?

594 x 452 Yes Yes Yes No

594 x 480 Yes Yes Yes Yes

594 x 512 Yes Yes No No

594 x 540 Yes Yes No Yes

594 x 470 Yes No Yes No

594 x 498 Yes No Yes Yes

594 x 530 Yes No No No

594 x 558 Yes No No Yes

780 x 452 No Yes Yes No

780 x 480 No Yes Yes Yes

780 x 512 No Yes No No

780 x 540 No Yes No Yes

780 x 470 No No Yes No

780 x 498 No No Yes Yes

780 x 530 No No No No

780 x 558 No No No Yes
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Creating a Custom Graphic from a 

Blank Graphic
One way to create a custom graphic is to edit an existing graphic, then 
use the Save Graphic As command to save it under a new name (see “Sav-
ing Graphics” on page 495).

Another way to create a custom graphic is to start with a blank graphic. 
You may wish to do this if there is no standard graphic for the object you 
want to illustrate, or if the standard graphic is so different from what you 
need that it is more efficient to start with a blank graphic.

To create a custom graphic from a blank graphic, you must open the 
blank graphic, build the custom graphic, then save it.

Opening a Blank Graphic

You can open a blank graphic from the Tracer Summit main menu or 
from the Graphics editor.

Opening a Blank Graphic from the Main Menu

1. If your system includes multiple sites, make sure you are logged onto 
the correct Tracer Summit site (so that graphics are saved to the 
appropriate site).

2. From the Setup menu, select Graphics editor. The Edit Graphic dialog 
box displays (see Figure 430).

Figure 430. Edit Graphic Dialog Box

3. Click New to display a blank graphic in the Graphics editor (see Fig-
ure 431 on page 505).
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Figure 431. Graphics Editor—New Graphic Window

4. Insert fields, images and background as described in “Building a Cus-
tom Graphic” on page 505.

Opening a Blank Graphic from the Graphics Editor

◆ On the Graphics editor toolbar, click New Graphic (see Figure 432) to 
display a blank graphic (see Figure 431).

Figure 432. New Graphic Button

Building a Custom Graphic

The first step in creating a new graphic is to add the main image(s) over 
which you will add fields. There can be more than one image per graphic 
object. For example, this image could be a floor plan or a drawing of a 
chiller, or both.

Selecting the Background Image

The background image is an image that fills the entire graphic window. 
Often, you may want to select the same background image for all custom 
graphics you create to provide a standard look for all graphics. Typically, 
this background image is simply a solid color screen.
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To select a background image, refer to “Changing the Background of a 
Graphic” on page 468.

Inserting Other Images

1. Use a third-party graphics creation tool to generate a graphic in GIF, 
JPG, or BMP format.

2. Save the image in the Graphics\Custom or Graphics\site name 
folder.

3. With your custom graphic displayed in the Graphics editor, on the 
Graphics editor palette, click Image (see Figure 433). The cursor 
becomes an insert prompt.

Figure 433. Image Button

4. Make a selection:

• To create an image that keeps its proportion (or aspect ratio) the 
same as you created it, click once on the graphic at the approxi-
mate place you want to insert the image.

• To create an image of a specific size, drag the insert cursor to cre-
ate a box where you will insert the image. Choosing this option 
may distort the image’s aspect ratio (the image, for example, may 
be stretched wider than it was when you created it). This may 
adversely affect the quality of the image.

When you release the mouse button, the Image dialog box displays 
(see Figure 434).

Figure 434. Image Dialog Box

Note:

This is the only image a grid displays over.
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5. Click Browse to select a file name and path of the image from the 
Locate Image dialog box (see “Using the Locate Image Dialog Box” on 
page 470).

6. At the Image dialog box, click OK. The graphic displays with the new 
image inserted.

7. Change the size or position of the image as necessary. Follow the 
directions for moving or sizing fields (see “Moving a Graphic Field” on 
page 491 or “Resizing a Graphic Field” on page 491). 

Inserting Fields

The task of inserting and configuring fields on a new custom graphic is 
the same as on an existing standard graphic (see “Inserting a Graphic 
Field” on page 474).

Saving Custom Graphics

Graphic objects in Tracer Summit are stored with corresponding HTML 
files. You can save custom graphics as either global graphics or site 
graphics:

• To make a graphic a site graphic that is available only to the current 
site, choose the site as the location to save the graphic.

• To make a graphic a global graphic that you can assign to any site, 
choose the global location to save the graphic.

Use the Save Graphic command or the Save Graphic As command to save 
the graphic. For more information, refer to “Saving Graphics” on 
page 495. 
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Creating Expanded Messages
An expanded message is a graphic object that you can assign an analog or 
binary input. When the input goes into alarm, the alarm is displayed in 
the event log with a small envelope to indicate it has an expanded mes-
sage. Users can click on the envelope to view the expanded message. You 
can use an expanded message to give operators detailed information 
about an alarm and show (in text or images) an action they should take.

To create an expanded message, you create a graphic with text and 
images, just as you would for any graphic. When you save it, you save it 
as an expanded message (an option at the Save Graphic As dialog box).

When you save the graphic with the expanded message option, Tracer 
Summit saves both the HTML file for the graphic and an expanded mes-
sage object that links back to the graphic object. This graphic then dis-
plays when the expanded message object is viewed.

After you have created an expanded message, the expanded message 
object is available to be assigned in the analog or binary input editors for 
alarming and viewing in the event log.

You can use the same steps for creating an expanded message whether 
you are working with a new graphic or an existing graphic.

To create an expanded message:

1. Display the Graphics editor and make a selection:

• Open an existing graphic that you want to use as an expanded 
message.

• Create a graphic to use as the expanded message. Include text 
fields and images as appropriate. You can create a custom graphic 
from a blank graphic or edit a standard graphic.

2. From the File menu, select Save Graphic As. If you are saving the 
graphic for the first time, select Save Graphic. The Save As Graphic 
dialog box displays (see Figure 435 on page 509).

Note:

A graphic that has template fields cannot be an expanded message.
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Figure 435. Save As Graphic Dialog Box—Expanded Message

3. Click the Create Expanded Message dialog box.

4. Complete the other fields as appropriate (for more information, see 
“Saving Graphics” on page 495).

5. Click OK. The graphic file is saved and the expanded message object 
is created.
BMTX-SVP01B-EN 509



Using the Graphics Editor
Creating and Modifying Graphics with 

Template Fields
Template fields allow you to create your own standard graphics. They 
look at the context of the graphic for the necessary information to display 
data in the field. Because graphics containing template fields do not have 
a fixed context object, they do not automatically appear on the navigation 
tree. From within the Graphics editor, you can recognize a template field 
because the Site Name and Object Name properties to which it refers are 
listed as <default>.

Because template fields do not have a fixed context object, you can use 
graphics with template fields in several places on the same site or on 
other sites. The standard graphics included with Tracer Summit use tem-
plate fields.

Fields that can be used as template fields are:

• Graphical status
• Status text
• Analog in 5 color
• Binary text
• Animation
• Target text
• Target image
• Target button
• Setpoint control
• Override control
• Binary check box control
• Selection list control

A target field set up as a template field will pass the context object of the 
current graphic to the graphic being opened. Graphics with template 
fields being launched from a target on another graphic must have the 
appropriate context object passed via the target. For example, the system 
will display “no such property” for all template fields on a graphic if those 
templates were for VAV II/III/IV and the target context object was for an 
IntelliPak Rooftop.    

To assign a graphic with template fields to a UCM or an application, use 
the Navigation Tree editor (see Chapter 26, “Using the Navigation Tree”).

Note:

Graphics that were on the tree and were modified to include 
template fields will no longer appear on the navigation tree.
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Inserting a Template Field on a Graphic

1. Display the graphic to which you want to add a template field.

2. Make a selection:

• To insert a new field, click the appropriate button on the Graphics 
editor palette and then click on the graphic (see “Inserting a 
Graphic Field” on page 474). The editor for that field displays.

• To change an existing field into a template field, click on the field 
and then click the right mouse button. Select Edit Properties from 
the pop-up menu. The editor for that field displays.

3. Display the Property screen or the Context Object screen as appropri-
ate. Figure 436 shows the Property screen for the Status Text editor 
and Figure 437 shows the Context Object screen for the Target Text 
editor.

Figure 436. Status Text Editor—Property Screen

Figure 437. Target Text Editor—Context Object Screen
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4. In the Site Name field, select <default>. 

5. Edit the information on the other screens as desired.

6. Click OK. The specified graphic field is created.

Saving a Graphic with Template Fields

Saving a graphic with template fields is the same as saving any graphic. 
Use the Save Graphic or Save Graphic As command on the File menu. At 
the Save Graphic As dialog box, make sure you do not select the Fill In 
Templates check box, which hard codes the information and changes the 
template fields back to regular fields. For detailed information on saving 
graphics, refer to “Saving Graphics” on page 495.

When you save a graphic with template fields, the graphic object does not 
appear on the navigation tree or in the Open Graphic dialog box. You can 
assign the graphic to a UCM, application or site node on the navigation 
tree using the Navigation Tree editor.

To edit a graphic with template fields, you must follow the steps in “Edit-
ing a Graphic With Template Fields” on page 513.

Note:

For the Property screen, the Object Name field is automatically 
assigned a value of <default>. For the Context Object screen, 
the Object Type and Object Name fields are assigned a value of 
<default>.
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Editing a Graphic With Template Fields

If you have assigned a graphic with template fields to a UCM or applica-
tion using the navigation tree, then you can open the graphic for editing 
as you would other graphics. See “Accessing the Graphics Editor” on 
page 463.

If you have not assigned the graphic to the navigation tree, you must open 
it from the Edit Graphic dialog box, as described in the following steps.

To edit a graphic with template fields:

1. From the Setup menu, select Graphics editor.

• If you have a graphic currently displayed, then that graphic is 
opened for editing. From the File menu, select Open Graphic. The 
Edit Graphic dialog box displays.

• If no graphic was displayed, then the Edit Graphic dialog box dis-
plays.

See Figure 438.

Figure 438. Edit Graphic Dialog Box

2. Click the Template Graphics check box. The list updates to include all 
template graphics.

3. Click the name of the graphic, then click Edit. The selected graphic 
displays in the Graphics editor.

4. Edit and save the graphic.
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Putting Permanent Information into Template Fields on 

a Graphic

You may decide you no longer want a graphic to have template fields. 
Instead, you want it to contain permanent information. You can have 
Tracer Summit fill in the information based on the context from which 
you launch the graphic.

To put permanent information into a graphic’s template fields:

1. Open the graphic that has template fields in the Graphics editor. 
Make sure you choose the appropriate context from which to launch 
the graphic:

• To launch from an object on the navigation tree, click on the object 
in the navigation tree to display the graphic, then on the Setup 
menu select Graphics editor.

• To launch from a UCM editor, display the editor for the associated 
UCM (on the Setup menu, select Unit Controllers, then the UCM 
type). At the UCM editor Status screen, click Graphic to display 
the graphic. Then on the Setup menu, select Graphics editor.

• To launch from a target field on other graphic, click on the target 
field to display the associated graphic with template fields. Then 
on the Setup menu, select Graphics editor.

2. From the File menu, select Save Graphic As. The Save As Graphic 
dialog box displays (see Figure 439).

Figure 439. Save As Graphic Dialog Box—Fill In Template Fields

3. Complete the Object Name and HTML File Name fields with different 
names for standard graphic objects. (Overriding a standard graphic 
object with permanent information for template fields will do so for 
all objects that use the same standard graphic object.)
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4. Click the Fill In Template check box.

5. Click OK. The graphic is saved with the object name and HTML file 
name provided. All of the template fields are hard-coded to the con-
text object of the graphic you launched in step 1. Because the graphic 
no longer has template fields, Tracer Summit assigns it to the naviga-
tion tree. The graphic is also available at the Open Graphic dialog 
box.

If the name of the graphic object was changed, you must use the Nav-
igation Tree editor to assign the new graphic to a UCM, application or 
site node on the tree.

Deleting a Graphic
There are two steps to deleting a graphic:

• Deleting the graphic object
• Deleting the HTML file associated with it

To delete a graphic object:

Use the Delete Object utility on the Tools menu. See Chapter 39, “Delet-
ing Objects and Sites.”

To delete an HTML file associated with a file:

In Windows Explorer, use standard procedures to delete the associated 
HTML file from the Graphics\site name folder or from Graphics\Custom 
folder. When displaying the object, Tracer Summit will revert to the 
graphic stored in the Graphics\Standard folder, if there is one. (If there is 
no standard graphic file, the user will see an error message indicating 
that the file does not exist or cannot be found.)

Note:

Renaming a graphic file to a name that is not called by Tracer 
Summit has the same effect as deleting the HTML file. Tracer 
Summit cannot find this file. Rename a graphic file only when 
you are not sure whether you may need a custom graphic again 
in the future.
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Using the Graphing Control Editor
From the Graphing Control editor, you can create graphs for either live 
properties or historical data trends from Tracer Summit. You can have as 
many graphs on a graphic that you want and plot up to four properties 
per graph.

Live Property Graphs

A live property graph shows the value of any property in Tracer Summit 
in real time. The sampling of data starts when the graphic is opened and 
stops when the graphic is closed. Using a right-mouse-click, you can 
choose to start and stop sampling, as well as, change the style of the 
graph or print it out. Live graphs are valuable for monitoring building 
conditions in real time.

Historical Graphs

A historical graph shows values that have been stored by the BCU in a 
trend object. Graphs that display trend objects are static since the data is 
historical. Using a right-mouse-click, you can refresh the data, change the 
style of the graph, or print it out.

 Accessing the Graphing Control Editor

With the Graphics Control editor open, click the graphing symbol button 
on the tool palette, then click anywhere in the Graphics editor. The 
Graphing Control editor displays (see Figure 440).

Note:

The Trend viewer provides an easier method for creating and 
viewing graphs for live or historical trend data (see Chapter 28, 
“Using the Trend Viewer”).
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BM
Figure 440. Graphing Control Editor—Members Tab
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Selecting Graph Members

From the Graphing Control Members tab, you can add items to the Graph 
Members tree to create a live property or single trend object graph (see 
Figure 441). 

Figure 441. Graphing Control—Selecting Live Property members 

To set the graph members for live properties:

1. With the Graphics Control editor open, click the graphing symbol but-
ton on the tool palette, then click anywhere in the Graphics editor. 
The Graphing Control editor displays with the Members tab active. 

2. In the Site box, select the site name. Once the name is selected, the 
Type, Name, and Property fields are filtered to only display those 
objects defined in the site. 

3. In the Type list box, select the object type for the graph.

4. In the Name list box, select the name of the object.

5. In the Property list box, select the property to be sampled. 

6. Click Add to add the selected property to the Graph Members tree. 

Note:

You are only allowed to add up to four properties to the tree. 
Then the Add button is not available. Clicking on the plus (+) 
sign, expands the list to show the selected graph properties.
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7. Repeat steps 2-6 above to add other properties to the list of members, 
as necessary. 

8. To remove properties from the Graph Members tree, highlight the 
selection and click Remove.

9. To add a Trend member and select graph plot properties, see the fol-
lowing sections.

10. Click OK to create the graph and return to the Graphics editor’s main 
screen, where the Graph field is displayed (see Figure 443 on 
page 520).

To set the graph members for a single Trend object: 

1. In the Site box, select the site name.

2. In the Type list box, select a Trend (see Figure 442).

Figure 442. Graphing Control—Selecting Trend Object Members

3. In the Name list box, select the name of the object.

4. In the Property list box, select the property to be sampled. Only mem-
bers of the selected trend can be added to the graph.

5. Click Add to add the selected property to the Graph Members tree.

6. Repeat steps 2-5 above to add other properties to the list of members, 
as necessary.

7. To remove properties from the Graph Members tree, highlight the 
selection and click Remove.
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8. To select graph plot properties, see “To select graph plot properties:” 
on page 520

9. Click OK to create the graph and return to the Graphics editor’s main 
screen, where the Graph field is displayed (see Figure 443). 

Figure 443. Graph Field

To select graph plot properties:

1. In the Graph Members tree, highlight the graph member property 
name to assign color, Y1/Y2, and legend text.

2. In the Color list box, select a color for the graph and legend text. You 
should select different colors for each item graphed. For pie and bar 
charts, an automatic color generation is used to color each of the sam-
ples on the plot. 

3. The Y1-axis is the default selection. Use Y1 for single trend items and 
similarly grouped items. Use Y2 for dissimilar items that you need to 
show resolution on.

4. Click OK to save the information and return to the Graphics editor, 
where the Graph field is displayed (see Figure 443).

Selecting the Graph Type

Select the graph type on the Graph Settings tab. There are six graph 
types to choose from (line, pie, area, scatter, and bar). 

Note:

Y2 items will always be a line drawn on the graph, except for 
Area (3D). In Area (3D), Y2 selections are graphed against the 
Y1-axis.

Note:

All except the line graph can be viewed in two or three dimen-
sions.
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To choose a graph type:

1. Open the Graphing Control editor.

2. Click the Graph Settings tab to display the graph types (see 
Figure 444).

3. In the Graph Title field, type the title you want to appear above the 
graph.

Figure 444. Graphing Control—Graph Settings Screen

4. In the Background Color field, select the background color that the 
graph title, plot, and time stamps will appear on.

5. In the Refresh Rate field, select the sampling rate for the graphed 
properties. The selected and plotted properties are all sampled at this 
rate. The time stamp appears in military time.

6. Click OK to save the information and return to the Graphics editor, 
where the Graph field is displayed (see Figure 443 on page 520).

Note:

This tab can be accessed at any time in the runtime mode from 
a pop-up menu item by right-clicking on the graph. This allows 
you to quickly change graph types, while keeping the graphic 
field open.
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Setting up Graph Samples

When setting up a graph, you can also set the axis labels of the object. 
The default is to place ticks and time stamps on the graph once per sam-
ple. At this screen you can also assign a title to the X/Y-axis.

To assign titles and set up graph samples:

1. Open the Graphing Control editor.

2. Click the Axis tab to display the Axis screen (see Figure 445)

Figure 445. Graphing Control—Axis Screen

3. In the Y1 Title field type a title. The title is automatically centered to 
the left of this axis. If you are also using the Y2-axis, type a title. The 
title is automatically centered to the right of this axis.

4. In the X-axis Title field, type a title. The title is automatically cen-
tered below the X-axis. 

5. In the Ticks Every field, type the number of samples to be counted 
before a tick is placed on the graph.

6. In the Labels Every field, type the number of samples to be counted 
before a label is placed on the graph. Labels are the sampled time 
stamps in HH.MM.SS format.

7. Click OK to save the information and return to the Graphics editor, 
where the Graphic field is displayed (see Figure 443 on page 520).
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Chapter 31

Using the Calculations Editor

You can create calculation objects that perform calculations based on 
selected system data, such as the information provided in property refer-
encer edit controls. Calculations can be performed and saved for a time 
period that you define. The resulting calculated data can then be used in 
trends, graphic displays, and alarms.

You create and edit calculations using the Calculations editor. The follow-
ing section describes the calculation types and their formulas.
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About Calculation Types
Tracer Summit includes the following calculation types:

• Average
• Cool Flow Rate
• Heat Flow Rate
• Maximum
• Minimum
• Meter Totalization
• Peak for X Minute Intervals (X = 5, 15, 30, or 60)
• Total Cooling Degree Days
• Total Heating Degree Days
• Total Run Hours/Starts

These calculation types and their respective calculation formulas are 
defined as in the sections that follow.

Average

The Average calculation returns the average value for the current day 
and the current billing period.

Today’s Avg = A / N

A = Running total
N = Counter for number of samples
Today’s Avg = New Average

Processing: Once per minute. If the enable referencer is on, the refer-
enced analog value is added to the running total (A), and the counter (N) 
is incremented. The running total (A) is divided by the counter (N) to 
obtain the average. Calculated values are saved for the current and previ-
ous day, and for the current and previous billing period.

Cool Flow Rate

The Cool Flow Rate calculation typically measures the total energy 
required to provide cooling to a building or area. This calculation looks at 
two factors: the flow rate of the fluid (air or water) and the temperature 
differential across the process.

Total = Total + (Flow Rate x Conv x (Temp 2 - Temp 1))

Flow Rate = Measured Flow Rate
Conv = Edited Conversion Factor
Temp 2 = Entering Temperature
Temp 1 = Leaving Temperature
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Processing: If the enable referencer is on and temperature 2 (Temp 2) is 
greater than temperature 1 (Temp 1), the cool flow value (Flow Rate x 
Conv x [Temp 2 - Temp 1]) is added to the total cool flow value (Total). The 
calculation is evaluated each minute, provided the temperature differen-
tial (Temp 2 - Temp 1) remains positive. Calculated values are saved for 
the current and previous day, and for the current and previous billing 
period.

Typical Application: You can use Cool Flow Rate calculations to accu-
mulate the BTU output of chillers, VAV boxes, fan coils, air handling 
units, and so on. You can use the calculated results for energy reports or 
tenant billing. The following illustrations demonstrate some typical appli-
cations.

For air flowing through a 

coil: 

Temp 2 = 

Temp 1 = 

For coil water:

Temp 2 = 

Temp 1 = 

For condenser water:

Temp 2 = 

Temp 1 = 

For chilled water:

Temp 2 = 

Temp 1 = 

Note:

The Cool Flow Rate calculation requires a conversion factor to 
scale the flow measurement device and account for the heat 
content of the fluid. If the calculation is for a constant volume 
process, you must assign an analog output with a default value 
of the volume for the Flow Rate referencer.

Air Flow
1 4

2 3

Water
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Coil
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3
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Load

To
Load
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4 33
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1
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Heat Flow Rate

The Heat Flow Rate calculation typically measures the total energy 
required to provide heating to a building or area. This calculation looks at 
two factors: the flow rate of the fluid (air, water, or steam) and the tem-
perature differential across the process.

Total = Total + (Flow Rate x Conv x (Temp 1 - Temp 2)

Flow Rate = Measured Flow Rate
Conv = Edited Conversion Factor
Temp 2 = Entering Temperature
Temp 1 = Leaving Temperature

Processing: If the enable referencer is on and temperature 1 (Temp 1) is 
greater than temperature 2 (Temp 2), the heat flow value (Flow Rate x 
Conv x [Temp 1 - Temp 2) is added to the total heat flow value (Total). The 
calculation is evaluated each minute, provided the temperature differen-
tial (Temp 1 - Temp 2) remains positive. Calculated values are saved for 
the current and previous day, and for the current and previous billing 
period.

Typical Application: You can use Heat Flow Rate calculations to accu-
mulate the BTU output of boilers, fan coils, or air handling units. You can 
use the calculated results can be used for energy reports or tenant billing. 
The following illustrations demonstrate some typical applications.

For air flowing through a 

coil: 

Temp 2 = 

Temp 1 = 

For coil water:

Temp 2 =  

Temp 1 = 

For a boiler:

Temp 2 = 

Temp 1 = 

Note:

The Heat Flow Rate calculation requires a conversion factor to 
scale the flow measurement device and account for the heat 
content of the fluid. If the calculation is for a constant volume 
process, you should assign an analog output with a default 
value of the volume for the Flow Rate referencer.

Air Flow
1 4

2 3

Water
Flow

Coil

1

4

3
2

Boiler Supply
Hot Water

Return
Hot Water 1 2

1

2
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Maximum

The Maximum calculation returns the highest value for the current day 
and current billing period.

Processing: If the enable referencer is on, the current analog value is 
compared to the present maximum value. If the current analog value is 
greater than the present maximum value, then the current analog value 
is saved as the new maximum value. Calculated values are saved for the 
current and previous day, and for the current and previous billing period.

Typical Application: The Maximum calculation typically determines 
the highest space temperature that has occurred in a tenant space.

Minimum

The Minimum calculation returns the lowest values that have occurred 
during the current day and current billing period.

Processing: If the enable referencer is on, the current analog value is 
compared to the present minimum value. If the current analog value is 
less than the present minimum value, the current analog value is saved 
as the new minimum value. Calculated values are saved for the current 
and previous day, and for the current and previous billing period.

Typical Application: The Minimum calculation typically determines 
the lowest temperature that has occurred in a space overnight.

Meter Totalization

The Meter Totalization calculation totals metered flow rates, such as gas, 
electric, and water.

Total = Total + (Meter Value x Conv)

Total = Meter Total 
Meter Value = Referenced Value 
Conv = Edited Conversion Factor 

Processing: If the enable referencer is on, the meter value conversion 
factor (Meter Value x Conv) is added to the meter total (Total). The refer-
enced value (Meter Value) is added to the total (Total) each minute. Calcu-

Note:

If the current analog value is equal to the present maximum 
value, the current value is not saved as the new maximum 
value.

Note:

If the current analog value is equal to the present minimum 
value, the current value is not saved as the new minimum 
value.
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lated values are saved for the current and previous day and the current 
and previous billing period.

Typical Application: The Meter Totalization calculation typically totals 
quantities that are metered by utilities, such as gas, electric, or water.

Peak for X Minute Interval

The Peak for X Minute Interval calculations combine a maximum and an 
average to determine the highest value that has occurred over a specified 
interval. An average value is collected over the specified time interval and 
compared to an existing maximum. If the sampled average is greater 
than the existing maximum, it becomes the new peak value. Peaks are 
calculated for the current day and current billing period.

Temp Peak = Sum X - Sum X + New Value
                                           X                                                                                                     
                                              X

X = Number of Minutes in the Selected Interval 
Sum X = Sum of Last X Values 
New Value = New Value To Be Averaged 
Temp Peak = Temporary Peak Value 

Processing: If the enable referencer is on, the temporary peak (Temp 
Peak) calculation is performed. If the calculated temporary peak value 
(Temp Peak) is greater than the present peak value, the peak value is set 
equal to the temporary peak value (Temp Peak). If the temporary peak 
value (Temp Peak) is less than or equal to the peak value, the peak value 
retains its current value and is not reset. Calculated values are saved for 
the current and previous day, and for the current and previous billing 
period.

Typical Application: Peak calculations typically record the maximum 
electrical usage in kilowatts. The logic used in the Peak calculation mim-
ics the logic that electrical utilities use to bill customers for electrical 
usage over a shifting time frame.

Note:

To set up this calculation, you must connect a metered input 
(pulse or analog) to a BCU I/O Module, PCM, UPCM, or MP580/
581. You need to know the operating specifics, such as type or 
scaling for the selected meter, to determine the appropriate con-
version factor (Conv). A typical pulse meter input, for example, 
is attached to a PCM binary input and configured to measure 
electrical usage in KW. This rate (in KW) is stored in the PCM 
object as a Pulse Accumulator property and is referenced by the 
Meter Totalization calculation object. To total this in KW, the 
conversion factor is 0.01667, or KW/60 samples per hour.

Note:

Electrical meters are typically pulse meters. If brought into a 
PCM, UPCM, or MP580/581, the controller can calculate a 
KWH rate that the calculation object can reference.
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Total Cooling Degree Days (CDD)

Cooling degree days indicate the external environmental conditions and 
measure the amount of time in a day that the outside air temperature 
was warmer than the base temperature. The Total Cooling Degree Days 
calculation compares the outside air temperature to a base temperature 
each minute and increments the cooling degree days value when the out-
side air temperature is above that base temperature. Typically, 65°F is 
the base temperature, but the break-even temperature of the building 
may be a better value for calculating cooling degree days.

                                  OAT - Base Temp                                                      
CDD = Deg Total + 24 Hours x 60 Min

Deg Total = Total Degrees Cool Today 
Base Temp = Edited Base Temperature 
OAT = Outside Air Temperature

Processing: If the enable referencer is on and the base temperature 
(Base Temp) is less than the outdoor air temperature (OAT), the differ-
ence of the outdoor air temperature and base temperature (OAT - Base 
Temp) is divided by the total cooling minutes (24 Hours x 60 Min). The 
resulting value is then added to the degree total (Deg Total) for that day 
and the degree total for the billing period. Calculated values are saved for 
the current and previous day, and for the current and previous billing 
period.

Typical Applications: Cooling Degree Day calculations compare 
weather conditions. They are valuable as a means of accounting for 
changes in the cooling load from one year to the next.
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Total Heating Degree Days (HDD)

Heating degree days indicate the external environmental conditions and 
measure the amount of time that the outside air temperature was cooler 
than the base temperature. The Total Heating Degree Days calculation 
compares the outside air temperature to a base temperature each minute 
and increments the heating degree day value when the outside air tem-
perature is below that base temperature. Typically, 65°F is the base tem-
perature, but the break-even temperature of the building may be a better 
value for calculating heating degree days.

                                  Base Temp - OAT                                                      
HDD = Deg Total + 24 Hours x 60 Min

Deg Total = Total Degrees Heat Today 
Base Temp = Edited Base Temperature 
OAT = Outside Air Temperature

Processing: If the enable referencer is on and the value of the outdoor 
air temperature (OAT) is less than the base temperature (Base Temp), the 
difference of the base temperature and outdoor air temperature (Base 
Temp - OAT) is divided by the total heating minutes (24 Hours x 60 Min). 
The resulting value is then added to the degree total (Deg Total) for that 
day. Calculated values are saved for the current and previous day, and for 
the current and previous billing period.

Typical Applications: Heating Degree Day calculations compare 
weather conditions. They are valuable in energy reporting to account for 
changes in the heating load from one year to the next.
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Total Run Hours/Starts

The Total Run Hours/Starts calculation monitors the value of a binary 
referencer and accumulates Run time when the referenced input is on. 
Whenever the referenced input changes from off to on, a Start is accumu-
lated.

N = N + 1

T = T + 1/60

N = Number of Starts
T = Total Number of Run Hours

Processing for Starts: If the enable referencer is on and the binary ref-
erencer transitions from Off to On, the number of starts (N) is incre-
mented. Calculated values are saved for the current and previous day, 
and for the current and previous billing period.

Processing for Run Hours: If the enable referencer is on and the prop-
erty referencer is on, the total number of run hours (T) is incremented. 
Calculated values are saved for the current and previous day, and for the 
current and previous billing period.

Typical Application 1: Run hours and starts typically determine equip-
ment maintenance schedule.

Typical Application 2: Use the Run hours calculation to determine how 
many hours an area has been in timed override. For this application the 
property reference should be “Timed Override In Control” for an area.

Note:

For typical application 1, you should not clear run hour and 
start calculations at the end of the billing period. These calcula-
tions typically reference an analog input, which generates an 
alarm when a defined run hour limit or starts limit has been 
exceeded. For example, a chiller might be set to generate an 
alarm when it has run for 100 hours, or when it has more than 
200 starts.
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Accessing the Calculations Editor
1. From the Setup menu, click Calculations. The Select Calculation dia-

log box displays (see Figure 446).

Figure 446. Select Calculation Dialog Box

2. Click the desired calculation object.

3. Click OK. The Calculations editor Status screen displays. Figure 447 
shows the editor for the Heat Flow Rate calculation.

Figure 447. Calculations Editor for Heat Flow Rate
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Creating a New Calculation Object
To create a new calculation object, you must:

• Open and name a new calculation object and choose a calculation type 
(as described in this section)

• Set up the calculation object, including choosing whether the calcula-
tion will be controlled by a referencer and choosing whether to reset 
the calculation at the end of the billing period (see “Setting Up a Cal-
culation Object” on page 535)

• Define security access (see “Setting Security Access for a Calculation 
Object” on page 538)

• Save the calculation object

To create a new calculation object:

1. From the Setup menu, select Calculations. The Select Calculation 
dialog box displays.

2. Click New. The New Calculation Name dialog box displays (see 
Figure 448).

Figure 448: New Calculation Name Dialog Box

3. In the Calculation Name field, enter a name. Use a maximum of 32 
characters. 

4. Click OK. The Select Calculation Type dialog box displays (see 
Figure 449 on page 534).

Note:

You must enter a name before you can save the new calculation 
object. You can modify the name from the Setup screen of the 
Calculations editor.
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Figure 449. Select Calculation Type Dialog Box

5. Select the type of calculation you want to create. 

6. Click OK. The Calculations editor displays.

7. To set up the calculation, follow the steps in “Setting Up a Calculation 
Object” on page 535.
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Setting Up a Calculation Object
When you set up a calculation object, you must select a property for each 
referencer field. (For detailed information on using referencers, see Chap-
ter 3, Using Referencer Edit Controls).

To set up a calculation object:

1. From the Calculation editor, click the Setup tab to display the Setup 
screen. Figure 450 shows the Calculation editor Setup screen for the 
Heat Flow Rate calculation.

Figure 450. Calculation Editor Setup Screen

2. For each referencer field, click the referencer button (...) to the right of 
the field. The Select Property Reference dialog box displays (see Fig-
ure 451 on page 536).
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Figure 451. Select Property Reference Dialog Box

3. In the Type field, select the type of object.

4. In the Name field, select the object’s name.

5. In the Property field, select an analog property.

6. Click OK to return to the Setup screen. The referencer field now dis-
plays the name and property of the chosen referencer. The status of 
the referenced property is now displayed.

7. In the Conversion Factor field, keep the default value or enter a new 
conversion factor value for the calculation. 

8. In the Enable field, choose whether the calculation will be enabled, 
disabled, or controlled by a referencer.

To enable the calculation process:

• Select Enabled to allow the calculation process to continue.

To discontinue the calculation process:

• Select Disabled to stop the calculation process.

To control the calculation process by a referencer:

• Click the Mode button to the left of the Enabled/Disabled field. 
The referencer field changes to “???.”

• To select a property referencer, click the referencer button (...). 
The Select Property Reference dialog box displays. Select a binary 
property and click OK.

• In the On Delay for Referencer field, specify the amount of time 
the referencer must be on before analog property referencer data 
is included in the calculation.

9. To reset the calculation object at the end of the billing period, select 
the Reset at End of Billing Period check box.

10. In the Units field, select the units to display for the calculation.

11. Click Save.
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Clearing Calculation Data
You should clear the historical information stored in a calculation object 
after any property on the Setup screen is changed. The historical informa-
tion displays in the History group of the Status screen. The Status 
screen’s Clear button is available whenever non-zero data is displayed.

To clear calculation data:

1. From the Calculations editor, click the Status tab to display the Sta-
tus screen.

2. Click Clear. The Clear Calculation Data dialog box displays (see 
Figure 452).

Figure 452. Clear Calculation Data Dialog Box

3. Click the check box next to the quantities you want to clear.

4. Click OK to save and reset the quantities to 0.000.

Note:

Clearing of data occurs the next time the calculation is run. 
This may occur as much as one minute following the clearing of 
data.
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Setting Security Access for a 

Calculation Object
1. From the Calculations editor, click the Classes tab to display the 

Classes screen (see Figure 453).

Figure 453. Calculations Editor Classes Screen

2. Click Security Classes. The Change Security Classes dialog box dis-
plays (see Figure 454).

Figure 454. Change Security Classes Dialog Box

3. Click the Access field next to each class to grant or deny access. A 
check in the field grants access. No check denies access.

4. Click OK to display the Classes screen.

5. Click Save.

Deleting a Calculation Object
You cannot delete a calculation object from the Calculations editor. Use 
the Delete Object function from the Tools menu to delete a calculation 
object (see Chapter 39, “Deleting Objects and Sites”).
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Chapter 32

Designing Reports

The ability to create reports that are tailored to your facility is a key ben-
efit of the Tracer Summit system. Reports provide the information you 
need to make decisions about building operations. Reports help you man-
age utility costs, equipment efficiency, and tenant billings. 

The Report editor allows you to design easy-to-run, easy-to-read reports. 
You can use any information available in Tracer Summit to create a 
report. You can define report elements such as titles, footers, fonts, and 
page orientation. You can also instruct the system to automatically gener-
ate custom reports at regular intervals. Automatically generated reports 
can be printed and stored to disk for data archiving. 

Use reports for:

• Record keeping and documentation
• Energy monitoring
• Troubleshooting

You run reports using the Reports Viewer, which is accessed from the Sta-
tus menu or from the Reports button on the toolbar. For instructions on 
running reports, refer to the Tracer Summit Daily Operations guide.

Note:

For Tracer 100 sites, you can only use the Reports Viewer to see 
the Diagnostic Report for the site. You cannot use the Reports 
editor to create a report. Tracker sites do not have reports to 
view or edit.
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Report Types
Tracer Summit supports two types of reports—live and trend. 

• Live Reports. Live reports display selected values at a particular 
point in time (see Figure 455 on page 541).

• Trend Reports. Trend reports use trend objects to display historical 
data obtained over a period of time (see Figure 456 on page 542).

Live Reports
Live reports display values of selected properties at the time the report is 
run. Each line in a live report contains a row heading, followed by the cur-
rent value(s) for the property. A live report can display three types of 
members:

• Any single displayable property in the system
• A calculation object with predefined properties
• A blank row

When a calculation object is used in a live report, the report displays data 
based on the calculation type it is performing. The current value, today’s 
value, yesterday’s value, current billing period’s value, and last billing 
period’s value are displayed on the same row. See Figure 455 on page 541.
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Figure 455. Sample Live Report
BMTX-SVP01B-EN 541



Designing Reports
Trend Reports

Trend reports allow you to view, print, and save the historical data col-
lected in trend objects (see Figure 456). For information about setting up 
a trend object, see Chapter 29, “Trending Data”.

Figure 456. Sample Trend Report

A trend report can display data collected over multiple time periods, such 
as a trend of space temperatures and relative humidity. It can also dis-
play multiple properties over the same time period, such as a 12-month 
chiller summary report. A custom trend report may contain information 
from multiple trend objects, even at different intervals.

A trend report displays the date and time in the left column, and values 
from the selected trends in subsequent columns. You can use as many 
trend members as you would like in a report. If a sample does not exist for 
an object and property for a given time, the data cell is blank. For exam-
ple, a custom report contains a trend object with a five-minute interval, 
and a trend object with a 30-minute interval. The trend object with the 
five-minute interval displays data for each five-minute interval. The 
trend object with the 30-minute interval displays data only at half-hour 
intervals. The rows that contain five-minute intervals contain blank 
areas. If a trend sample was unable to be collected, the report will display 
“???”.
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Standard Reports

Tracer Summit includes a set of predefined standard live and standard 
trend reports.

Standard live reports provide status information for a single object. Most 
objects in the system have at least one associated standard live report. 
You can create your own standard live reports. You can also edit pre-
defined standard live reports.

Standard trend reports (known as quick trend reports in previous ver-
sions of Tracer Summit) display a pre-formatted trend report containing 
all the trend members in a trend object. Standard trend objects cannot be 
edited. You can, however, create your own custom trend reports.

Running a Report
You run a report using the Report Viewer, which you can access by click-
ing the Reports button on the toolbar or selecting Reports from the Status 
menu. You can also run a standard report from a UCM or application edi-
tor by clicking the Report button on the editor’s Status screen.

After you run the report, you can print it, saved it to a Report (.rpt) file, or 
export it to a tab delimited text file (.TXT). For more information about 
running a report, see the Tracer Summit Daily Operations guide.

Accessing the Report Editor
When you design a new report or edit an existing report, Tracer Summit 
allows you to select from three report types—standard live, custom live, 
or custom trend. When you select a report type, you have access to all 
existing reports of that type. You can open an existing report to edit it. 
You can also use an existing report as a template for a new report or open 
a blank report.

The procedures for selecting a standard live report and for selecting a cus-
tom live or custom trend report are slightly different. After you select the 
report, the Report editor displays.

Note:

For Tracer 100 sites, you can only use the Reports Viewer to see 
the Diagnostic Report for the site. You cannot use the Reports 
editor to create a report. Tracker sites do not have reports to 
view or edit.

Note:

For Tracer 100 sites, you can only use the Reports Viewer to see 
the Diagnostic Report for the site. You cannot use the Reports 
editor to create a report. Tracker sites do not have reports to 
view or edit.
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Selecting a Standard Live Report

1. From the Setup menu, select Report editor. The Select Report to View 
dialog box displays (see Figure 457).

Figure 457. Select Report to View Dialog Box

2. Click the Standard Live option.

3. Click OK to display the Select Standard Live Report dialog box (see 
Figure 458). 

Figure 458. Select Standard Live Report Dialog Box

4. Click the arrow to the right of the Standard Report Type field to 
select a report type. The available reports that match the selected 
type appear in the Report Name list.

5. In the Units field, select the units of measure (either Inch-Pound or 
International System) for the report. The default selection is the units 
of measure defined for the site in site configuration. 

Note:

If you need help with reports, click the Tutorial button to open 
the Tracer Summit Daily Operations Tutorial.
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6. If you wish to open a blank report containing default selections, click 
New to display the Report editor.

7. If you wish to edit an existing report or use an existing report as a 
template for a new report, click the name of the report you wish use in 
the Report Name list.

8. Click OK to display the Report editor for the selected report.

To edit the report, follow the instructions in “Designing or Editing a 
Report” on page 548.

Selecting a Standard Trend or Custom Report

1. From the Setup menu, select Report editor. The Select Report to View 
dialog box displays (see Figure 459).

Figure 459. Select Report Type Dialog Box

2. Click the Standard trend or Standard Trend option.

3. Click OK to display the Select Report dialog box (see Figure 460).

Figure 460. Select Report Dialog Box
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4. If you want to create a new report containing default selections, click 
New to display the Report editor.

5. If you wish to edit an existing report or use an existing report as a 
template for a new report, click the name of the report you wish to 
use.

6. Click OK to display the Report editor for the selected report. To edit 
the report, follow the instructions in “Designing or Editing a Report” 
on page 548.

Opening a Saved Report

1. From the Setup menu, select Report editor. The Select Report to View 
dialog box displays (see Figure 461).

Figure 461. Select Report to View Dialog Box

2. Click the Open a Saved Report option. 

3. Click OK to open the Reports folder (see Figure 462 on page 547). 
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Figure 462. Reports folder

4. Highlight the report you want, and then click the Open button to dis-
play the report in the Reports editor.

Opening a Previously Viewed Report

1. From the Setup menu, select Report editor. The Select Report to View 
dialog box displays (see Figure 463).

Figure 463. Select Report to View Dialog Box

2. Click the Recent Reports option. 

3. Click the arrow to the right of the field to select a report. 

4. OK to display the Report Editor for the selected report. 
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Designing or Editing a Report
When designing or editing a report, you can:

• Edit the report’s name or page orientation (see “Editing the Name or 
Orientation of the Report” below.)

• Define the members to be included in the report (see “Defining Report 
Members” on page 548)

• Format the layout of the report (see “Entering Titles and Formatting 
the Report” on page 552)

• Specify when the report will run (see “Scheduling a Report” on 
page 554)

Editing the Name or Orientation of the 

Report
1. From the Report editor, click the Setup tab (see Figure 464).

Figure 464. Report Editor Setup Screen

2. Enter a name for the report in the Report Name field. Make the name 
as informative as possible. Use a maximum of 32 alphanumeric char-
acters.

3. Choose the report’s page orientation (portrait or landscape).

Defining Report Members
The information presented in the body of the report is defined in the 
Members screen of the Report editor. You select the type of data and the 
specific properties of the data that you want to include in the report. Your 
selections become the report members. You define the row (for a live 
report) or column headings (for a trend object), and the order in which the 
data is displayed. You can also add blank rows between report members. 
Blank rows add space between the data rows and make the report more 
readable. Blank rows may also contain row headings, which are generally 
used for section titles.
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The procedures for defining the body of the report vary for a standard live 
report, a custom live report, and a custom trend report.

Defining the Members of a Standard Live Report

1. From the Report editor, click the Members tab (see Figure 465).

Figure 465. Report Editor Members Screen

2. To insert a property to the Report Member list, click the member 
immediately above where you want to add the new member.

3. Click the name of the property you wish to add in the Property list.

4. Click Add to add your selection to the Report Members list.

5. With the member you just added highlighted in the Report Members 
list, enter the label you want the report to display for that member in 
the Row Heading field. You can enter one or two row headings. 

6. Continue to define the report members, repeating steps 2 through 5 
for each member you wish to add.

Note:

There are a few membership rules unique to the standard live 
report type. When you run a standard live report, you should 
understand these rules:

• Standard live reports may contain properties from a single 
object type.

• If a new report is created, the Type field will be available 
until the first report member is defined.

• Subsequent report members must be the same object type.
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Defining the Members of a Custom Live Report

1. From the Report editor, click the Members tab (see Figure 466).

Figure 466. Report Editor Members Screen

2. Click the object type in the Type list. Available objects of the selected 
type are displayed in the Name list.

3. Click the object name in the Name list. Available properties of the 
selected object are displayed in the Property list.

4. Click the name of the property in the Property list. 

5. Click Add to add your selection to the Report Members list.

6. With the member you just added highlighted in the Report Members 
list, enter the label you want the report to display for that member in 
the Row Heading field. You can enter one or two row headings. 

7. Continue to define the report members, repeating steps 2 through 6 
for each member.

8. To add a calculation object to the Report Members, click Add Calcula-
tion.
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Defining the Members of a Custom Trend Report

1. From the Report editor, click the Members tab (see Figure 467).

Figure 467. Report Editor Members Screen

2. Click the name of the trend in the Trend list. Available Trend mem-
bers for the selected trend are displayed in the Trend Members list.

3. Click the name of the member in the Trend Members list. 

4. Click Add to add your selection to the Report Members list.

5. With the member you just added highlighted in the Report Members 
list, enter the label you want the report to display for that member in 
the Column Heading field. You can enter one or two column headings. 

6. Continue to define the report members, repeating steps 2 through 5 
for each member.
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Changing the Report Member Order

When you run a report, the body of the report will display the member 
data in the order that they appear in the Report Members list. You can 
change the order using the Order arrow keys.

To change the report member order:

1. From the Report editor’s Members screen, click the member name you 
wish to move in the Report Members list.

2. Click the up arrow in the Order field to move the member up one row. 
Click the down arrow to move the member down one row. 

Adding a Blank Row in the Report

1. From the Report editor’s Member screen, click the member name in 
the Report Members list immediately before where you wish to add a 
blank row.

2. Click Add Blank Row.

3. Provide a row heading for the blank row, if you wish.

Entering Titles and Formatting the 

Report
Use the Layout screen of the Report editor to format the report, and to 
prepare the report for display and printing. The Layout screen allows you 
to enter titles, headings, and footers and format the fonts used in the 
report. You can use special functions to insert the date, page number, 
time, and security information in the report (see Table 27). You can enter 
these functions in any cell in the Header, Column Headings, and Footer 
fields of the Layout screen.

Table 27. Entering Date, Page, Time, and Security Functions in a Report

If you are editing an existing report or using an existing report as a tem-
plate, the current titles will appear in the Layout screen when you open 
it. If you are creating a new report, the Tracer Summit default layout 

To Do This: Enter This:

Insert the current Date $D

Insert current report page $P

Insert total number of pages in 
the report

$N

Inserts the current time $T

Inserts the Security Information 
(Site Name, User Name, and Job 
Title

$S
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selections will appear in the Layout screen. To change the existing set-
tings, select the cell contents and enter a new entry. 

To set the page orientation (portrait or landscape) of the report, refer to 
“Editing the Name or Orientation of the Report” on page 548.

Entering and Formatting the Report Titles

1. From the Report editor, click the Layout tab (see Figure 468).

Figure 468. Report Editor Layout Screen

2. Click the desired cells in the Header section and enter the titles you 
want to display in the report. 

3. To change the font for a cell, select the cell and click the Font button 
to the right of the Header section. The Font dialog box displays. 

4. Select the font, font styles, and size.

5. Click OK to close the Font dialog box and display the Layout screen.

Entering and Formatting the Column Headings

1. Display the Report editor’s Layout screen.

2. Click the desired cells in the Column Headings section and enter the 
column headings you want to display in the report. 

Note:

Column headings 2 through 5—which are Today, Yesterday, 
Last billing period, and Current billing period—only appear in 
a custom live report that contains calculation report members.
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3. To change the font for a cell, select the cell and click the Font button 
to the right of the Column Headings section. The Font dialog box dis-
plays. 

4. Select the font, font style, and size. 

5. Click OK to close the Font dialog box and display the Layout screen.

Formatting the Body Text

1. Display the Report editor’s Layout screen.

2. To change the font for the body text in the report, click the Font but-
ton to the right of the Body section. The Font dialog box displays. 

3. Select the font, font style, and size. 

4. Click OK to close the Font dialog box and display the Layout screen.

Entering and Formatting the Report Footer

1. Display the Report editor’s Layout screen.

2. Click the desired cells in the Footer section and enter the footer text 
you want to display in the report.

3. To change the font for a cell, select the cell and click the Font button 
to the right of the Footer section. The Font dialog box displays. 

4. Select the font, font style, and size. 

5. Click OK to close the Font dialog box and display the Layout screen.

Scheduling a Report 
Tracer Summit allows you to instruct the system to run custom live and 
custom trend reports automatically at specific times. You can schedule a 
report to run daily, weekly, monthly, or annually. You schedule a report in 
the Schedule screen of the Report editor.

Selecting a Reporting Interval

1. From the Report editor, click the Schedule tab. The Schedule screen 
displays.

2. Click the Enable Auto Reporting check box. The rest of the fields on 
the screen become active.
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Setting Up Daily Reports

1. Click Daily in the Auto Schedule Interval field. The field to the right 
of the Auto Schedule Interval displays options for setting the time for 
daily reports (see Figure 469).

Figure 469. Report Editor Daily Schedule Options

2. Click the arrows to the right of the Time 1 field to set a time for the 
first daily report.

3. If you want to schedule times for more than one daily report, check 
the associated check box and set a time in the Time 2, Time 3, and/or 
Time 4 fields.

Setting Up Weekly Reports

1. Click Weekly in the Auto Schedule Interval field. The field to the 
right of the Auto Schedule Interval displays options for setting the 
time for weekly reports (see Figure 470).

Figure 470. Report Editor Weekly Schedule Options

2. Click the arrows to the right of the Time field to set a time for the 
weekly report.
BMTX-SVP01B-EN 555



Designing Reports
3. Click the arrow to the right of the Day field to set a day for the weekly 
report.

Setting Up Monthly Reports

1. Click Monthly in the Auto Schedule Interval field. The field to the 
right of the Auto Schedule Interval displays options for setting the 
time for monthly reports (see Figure 471).

Figure 471. Report Editor Monthly Schedule Options

2. Click Use Last Day of Month or Define Day of Month. 

3. If you select Define Day of Month, click the arrow to the right of the 
day field to set a day for the monthly report.

4. Click the arrow to the right of the Time field to set a time for the 
monthly report.
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Setting Up Annual Reports

1. Click Annually in the Auto Schedule Interval field. The field to the 
right of the Auto Schedule Interval displays options for setting the 
time for annual reports (see Figure 472).

Figure 472. Report Editor Annual Schedule Options

2. Click the arrows to the right of the Month field to set a month for the 
annual report.

3. Click the arrow to the right of the Day of Month field to set a day for 
the annual report.

4. Click the arrow to the right of the Time field to set a time for the 
annual report.
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Setting Output Options for a Report
1. From the Report editor’s Schedule screen, click the Output To button. 

The Output To dialog box displays (see Figure 473).

Figure 473. Output To Dialog Box

2. To direct the system to print the report automatically when it is run, 
check Printer. The Printer Name field becomes active. The report will 
be printed to the default Windows printer shown below the Printer 
Name box.

3. Click the arrow to the right of the Printer Name to select a different 
printer.

4. To direct the system to save the report automatically when it is run, 
check Output to File. The remaining Output to File fields become 
active.

5. To change the default save directory, click Browse to display the 
Browse for Folder dialog box.

6. Select the folder where you want the file saved and click OK. The 
Output To dialog box displays again.

7. In the File Name field, select Auto Generated or Specified. Auto Gen-
erated report files are stored in the format YYMMDD0X, where YY is 
the year, MM is the month, DD is the day, and 0X is the counter for 
the report. For example, the first report generated on March 23, 1999, 
is saved to the file name 99032301.

8. If you select Specified, enter the file name you want the system to 
assign to the report in the field to the right of the Specified field. This 
file is overwritten each time the scheduled report is generated.
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9. To add a report to the end of a previous report, select Append to File.

10. To change the file type, select a new type in the Save as Type field.

11. Click OK to close the Output To dialog box and display the Schedule 
screen.

Saving the Report

To save a report:

◆ To save your report, click Save at the bottom of the Report editor, or 
select Save Report from the File menu.

To copy a report to a new report name:

◆ With the new report open in the Report editor, select Save Report As 
from the File menu.

Deleting Reports
Occasionally, you may want to delete reports from the Tracer Summit sys-
tem. For example, you may want to delete specific reports you created for 
site setup and troubleshooting.

To delete reports:

1. Display the Report editor (see “Accessing the Report Editor” on 
page 543).

2. From the File menu, select Delete Reports. The Delete Reports - 
Select Site dialog box displays.

3. Select the site that contains the report you want to delete and click 
OK. The Delete Reports dialog box displays.

4. In the Type field, select the type of the report you want to delete. You 
can delete custom reports or user-defined standard reports. (Pre-
defined standard reports included with Tracer Summit may be edited, 
but cannot be deleted.)

5. In the Existing Reports list, select the report names you want to 
delete.

Note:

After you delete reports from the system, you cannot recover 
them unless you have a report backup file. Before deleting 
reports, we recommend backing up all reports that you may 
want to use again. See the Tracer Summit Daily Operations 
Guide for information on backing up reports, or see Chapter 38, 
“Restoring into the Tracer Summit Workstation”, of this guide 
for information on restoring reports.
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6. Click the Add button. The reports display in the Selected Reports to 
Delete list. You can also click Add All to add all reports of the selected 
type to the list of reports to delete.

7. To remove any reports from the Selected Reports to Delete list, select 
the report name and click Remove. You can also click Remove All to 
clear the list.

8. Click the Delete button. You are prompted to confirm the deletion.

9. Click Yes. The selected reports are deleted.
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Setting System Options

The System Options editor allows you to customize or change screen, file, 
and print options to fit your preferences. The selected options affect only 
the PC Workstation you are working on. Event log capacity settings, how-
ever, might affect the performance of multiple workstations in a shared 
database. 

The System Options editor allows you to

• Select the home graphic, (screen that displays when you click Home)
• Display override status from an override button on a graphic
• Display category alarms icons in the toolbar
• Display Alarm pop-up dialogs for event category alarms
• Select the event log printer and alarm options
• Change the default file directories
• Change the workstation device ID for event routing
• Select whether object and property IDs are displayed throughout the 

Tracer Summit system
• Set up basic e-mail message forwarding services
• Configure connection options for the navigation tree
• Change e-mail profile

• Configure how long to store harvested trend data on the workstation
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Changing the Home Graphic
The home graphic displays when you click Home in the Tracer Summit 
toolbar.

To change the home graphic:

1. From the Tools menu, select Options to display the System Options 
editor General screen (see Figure 474).

Figure 474. System Options Editor—General Screen
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2. Click Change button to the right of the Home Graphic field to display 
the Select Home Graphic dialog box (see Figure 475).

Figure 475. Select Home Graphic Dialog Box

3. In the Graphic Object Name list, click the name of the graphic you 
wish to select.

4. Click OK to select the graphic and display the General screen.

Note:

The Select Home Graphic dialog box lists all available system 
graphics stored in the C:\Program Files\Tracer  
Summit\Graphics\Custom directory.
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Displaying Override Status

You can enable a “hand” icon to display on an override button when the 
object has been manually overriden (see Figure 476). 

Figure 476. Hand icon—displaying override status

To display override status:

1. Click on Tools from the menu bar, then select Options. The Systems 
Options screen displays. with the General tab open (see Figure 477).

2. Check the Display Override Status dialog box.

3. Click Save. 

Figure 477. Override Status Checkbox

Object in manual 
override

Display override 
status checkbox
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Configuring Category Alarm Buttons 

and Pop-up Dialog Boxes
Use the Events table to configure the category alarm buttons on the tool 
bar and alarm pop-up dialogs for event categories (see Figure 478). 

Figure 478. Events table

To configure category alarms:

1. From the Tools menu, select Options to display the System Options 
editor General screen (see Figure 474 on page 562).

2. To display alarm categories on the toolbar, check the toolbar checkbox 
next to the category. Figure 479 shows an example of category icons 
displayed on the toolbar.

Figure 479. Category Alarms Displayed on Toolbar

Note:

Alarm categories are set up in Site Configuration. For more 
information, refer to Chapter 6, Systems Programming guide, 
“Setting up Event Classes.”
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To configure alarm pop-up dialog boxes:

1. To set up the workstation to display a pop-up dialog box when an 
alarm comes into the system, edit the Max Popup field. (see 
Figure 478 on page 565). Figure 480 shows an example of a category 
alarm popup.

2. In the Events table, type the number of alarm pop-up dialog boxes 
you want to display for incoming alarms.

Figure 480. Category Alarm Pop-up Dialog Box

Using the Category Alarms on the Toolbar

Use the category alarms to quickly filter and view problem alarms.

1. From the first drop-down list, click the down arrow to select whether 
to show all alarms in a site, only unacknowledge alarms, or no alarm 
count. Figure 481 shows no alarm count for category alarms.

Figure 481. Category alarms by alarm count

Note:

If the Max Popups field is zero (0), no popups will display. 
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2. From the second drop-down list, select to show category alarms for all 
sites, current site, or a particular site (see Figure 482).

Figure 482. Category alarms by site or group

3. To quickly view all alarms in an alarm category, click an alarm cate-
gory button.The alarm category (1–5) appears when you move the 
cursor over the button (see Figure 483). The Event log displays show-
ing only alarms for that alarm category (see Figure 484).

Figure 483. Category Alarm number

Figure 484. Event Log Displaying Category Alarms

Category 1 
alarm
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Viewing Alarm Pop-up Dialog Boxes from the Event 

Log

Incoming alarms can be configured to display in a pop-up dialog box (see 
configuring pop-up alarms on page 566). An alternate way to access 
alarm pop-up dialogs is from the event log (see Figure 484 on page 567).

1. From the event log, righ-click anywhere in the event row, a pop-up 
menu displays (see Figure 485).

2. Click View Popup. The alarm pop-up dialog box displays.

Figure 485. Popup Menu

Figure 486. Category Alarm Pop-up Dialog Box

Note:

You can also view the alarm pop-up dialog box by double-click-
ing anywhere in the event row.
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Setting Up the Events Printer, Message 

Forwarding, and Event Log Settings
When Tracer Summit BCUs or Tracer 100 and Tracker panels generate 
alarms and events, you can have those alarms and events sent to a 
printer as well as updated in the alarm and event log. Tracer Summit 
uses printers installed in the Windows operating system to print events.

The System Options editor allows you to select a default printer and 
change settings related to event printing. The editor also allows you to 
specify who should receive an alarm or event by means of e-mail or e-mail 
enabled cell phone/pager. Through the editor, you can also modify the size 
of the event log.

For more information about alarms and events, refer to the Tracer Sum-
mit Daily Operations guide.

Setting Up the Events Printer

1. From the Tools menu, select Options. The System Options editor dis-
plays (see Figure 487).

Figure 487. System Options Editor—General Screen
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2. To change the events printer, in the Events group click the Change 
button (see Figure 488). The Print Setup dialog box displays (see 
Figure 489).

Figure 488. System Options Editor

Figure 489. Print Setup Dialog Box

3. In the Name field, select the printer that Tracer Summit will use to 
print events and alarms.

4. Select additional printer setup options as necessary. For more infor-
mation on setting printer options, see the instructions provided with 
Microsoft Windows or with your printer.

5. Click OK. The System Options editor General tab displays.

Note:

The Print Setup dialog box varies depending upon the printer 
selected.

Note:

• Tracer Summit sends alarm and event information to the 
printer one line at a time. A tractor-feed (or line-feed) 
printer works best as the events printer so that you can 
view the events as they are generated and printed. If you 
select a sheet-feed printer (such as a laser printer), you do 
not see the events until a complete page is printed.

• Typically, the events printer is connected directly to the PC 
Workstation (on the LPT1: port). 
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6. To have events print to the printer, make sure Enable Event Printing 
is selected.

7. If you want to be able to connect to a remote site when an incoming 
alarm is received, select Show Connection Dialog on Incoming 
Alarms.

8. If you want to have incoming alarms be silent (rather than sounding a 
beep), select Disable Workstation Alarm.

IMPORTANT
Selecting Disable Workstation Alarm keeps the workstation from beep-

ing when an alarm comes in, regardless of how Alarm and Message 

Routing is setup.

Setting up Message Forwarding

1. From the Tools menu, select Options. The System Options editor dis-
plays (see Figure 488 on page 570).

2. Select the alarm class from the list, and type an e-mail address in the 
To email address field (see Figure 490).

When you select and save the Forward Alarm Class and To e-mail 
address fields, alarms that match the selected alarm class from all 
sites in the database are e-mailed. Also, all Tracer 100 critical (prior-
ity 2) and Tracker alarms are automatically e-mailed if your worksta-
tion receives such alarms from Tracer 100 and Tracker sites.

Figure 490. Forward Alarms Fields

IMPORTANT
Your workstation must be set up as an event receiver in BCU sites, with 

a telephone number defined in Tracer 100 and Tracker sites, and other 

requirements for alarms must be satisfied, as described in Chapter 6, 

“Configuring Tracer Summit BCU Sites.”

Setting Up Automatic Refresh

1. From the Tools menu, select Options. The System Options editor dis-
plays (see Figure 488 on page 570).

2. Click the Enable Auto Refresh check box (see Figure 491). Select the 
refresh rate from the list.

For performance tuning, you can select a custom auto refresh inter-
val. This interval can range from 30 seconds to 5 minutes (see 
Figure 491). If you are expecting a lot of alarms, set the refresh rate 
to a higher value. If you are troubleshooting one piece of hardware, 
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and these are the only alarms you expect to see, set the refresh rate to 
a lower value.

Figure 491. Enable Auto Refresh Rate Fields

3. Select the event log capacity from the Event Log Capacity list.

For system performance and manageability, you can modify the stor-
age capacity of the event log with your selection of the Event Log 
Capacity. The Tracer Summit software will not allow the number of 
events saved in the database to exceed this limit.

If you do insert a new event in the database that exceeds this limit, 
the Tracer Summit software deletes the oldest events in the database 
until the number of events in the database comes within the limit. 

Note:

If you set the refresh rate value too low, the user may experi-
ence what appear to be screen lockups.

Note:

• The BCU event log and the error log viewers cannot be 
automatically refreshed. Selecting Enable Auto Refresh has 
no effect on these viewers.

• In a shared SQL database, workstations do not share this 
setting. Each workstation has its own setting.

• If you change the database source from SQL to an existing 
Microsoft Access Tracer Summit database, the refresh rate 
is restored to its previous value. However, when you change 
the database source from SQL to a blank Microsoft Access 
Tracer Summit database, the refresh rate is reset to its 
default Microsoft Access value when Tracer Summit starts 
up.
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The type of database that you are using determines the maximum 
limits 

4. From the BCU Event Log Capacity list, select the record size and 
change it to the appropriate value.

When the new value is less than the number of existing records in the 
log, a warning appears, as described in the note for step 3.

5. From the Error Log Capacity list, select the record size and change it 
to the appropriate value.

When the new value is less than the number of existing records in the 
log, a warning appears, as described in the note for step 3.

6. Click Save.

Harvested Trend Data Field

This field determines how long Tracer Summit should keep the data in 
the Trend Viewer database (see Figure 492). Any data that is older than 
the selected number of years will be purged from the Trend Viewer data-
base. This applies for both Access database users and SQL database 
users. The purge process occurs once a month. (So, technically, the data-
base retains no more than x years + one month.) For example, if this field 
is set to keep harvested trend data for 1 year starting January 1st, 2007, 
then the first purge of data will occur Feburary 1st, 2008.

Note:

• If the new event log capacity value is less than the number 
of existing events in the log, the following warning message 
appears: You will lose events from your Event Log! It is rec-
ommended that you cancel and first back up the Event Log. 
Continue with save and lose events? <Yes> <No>.
• If you click Yes, the new capacity value is saved, and the 

log is truncated to the new value when a new event is 
inserted in the log.

• If you click No, changes are not saved, and the capacity 
is restored to the original value.

• In a shared SQL database, workstations share this setting. 
Each workstation cannot have its own setting because the 
database is shared. 

• If you change the database source from SQL to an existing 
Microsoft Access Tracer Summit database, the event log 
capacity value is restored to its previous value. However, 
when you change the database source from SQL to a blank 
Microsoft Access Tracer Summit database, the event log 
capacity value is reset to its default Microsoft Access value 
when Tracer Summit starts up.
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Figure 492. Harvested Trend Field

To set the purge date:

◆ Click the down arrow and select the number of years to keep the data 
before it is automatically purged.

Changing Default File Directories
Tracer Summit uses many directories or folders to store files. Typically, 
you will want to accept the system defaults. You can modify the default 
locations to store graphic files on a common file server, for example.

IMPORTANT
When you are using a shared SQL database, you might have to store 

these files in a shared folder on your LAN. This is to ensure that all 

Tracer Summit users can access these files.

To change default directories:

1. From the Tools menu, select Options. The System Options editor dis-
plays.

2. Click the File Locations tab. The File Locations screen displays (see 
Figure 493).

Figure 493. System Options Editor File Locations Screen

3. Click the file type whose location you wish to modify in the File Types 
list. 
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4. Click Modify to display the Browse for Folder dialog box (see Figure 
494 on page 575).

Figure 494. Browse for Folder Dialog Box

5. Select a new location in which to save files. 

6. Click OK to select the location and display the File Locations screen.

Changing Advanced Settings
The System Options editor allows you to change the workstation device 
ID and to set options for how objects and properties are displayed. These 
options are most often used when doing advanced troubleshooting. Use 
these options only if you are an advanced user.

Changing the Workstation Device ID

The workstation device ID identifies the workstation to the rest of the 
Tracer Summit system, primarily for the purposes of alarm and message 
routing, notification, and acknowledgment. Take care when you change 
the device ID. Changing the ID can result in intercepting messages 
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meant for another workstation or not receiving messages intended for the 
workstation.

To change the workstation device ID:

1. From the Tools menu, select Options. The System Options editor dis-
plays.

2. Click the Advanced tab to display the Advanced screen (see 
Figure 495).

Figure 495. System Options Editor Advanced Screen

3. In the Workstation Device ID field, click the Change button. The 
Change Workstation Device ID dialog box displays (see Figure 496).

Note:

Tracer Summit provides a default workstation device ID that is 
based on the number assigned during the software installation. 
Generally, the first workstation created is ID 80. Each addi-
tional workstation number is increased in increments of one.

Typical workstation addressing is as follows:

• 80 – 100 for on-site workstations
• 101 – 120 for remote workstations
• 121 – 140 Trane-reserved addressing
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Figure 496. Change Workstation Device ID Dialog Box

4. In the New Device ID field, select a new ID number.

5. Click OK.
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Selecting Whether Object and Device IDs Display

The Advanced screen of the System Options editor allows you to select 
whether object and device identification numbers (IDs) are displayed 
throughout the Tracer Summit system. If you select to display the IDs, 
then whenever you select or view a UCM, area, device, object or property, 
the item’s object and device IDs, as well as its name, are displayed.

This information is valuable for troubleshooting BACnet interface 
projects. Most of the time, however, you do not need to display the object 
and device IDs. For more information on BACnet interfaces, refer to 
Chapter 37, “Using BACnet for Non-Trane Devices”.

An example of where the object and device IDs display within Tracer 
Summit is at the Object and Properties Selection dialog box (accessed 
through the Status menu’s Object and Properties item). See Figure 497.

Figure 497. Objects and Properties Selection Dialog Box

To display device and object IDs:

1. From the Tools menu, select Options. The System Options editor dis-
plays.

2. Click the Advanced tab to display the Advanced screen (see Figure 
495 on page 576).

3. Check the Show Object and Device IDs check box to enable this 
option. To disable the option, uncheck the check box.
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Selecting an E-mail Profile for Message Forwarding

The e-mail profile is the one associated with the From e-mail address of 
users which appears in the From field of e-mails that they send.

To select an e-mail profile:

1. From the Advanced tab in the System Option editor, click the Change 
button in Message Forwarding E-Mail Profile (see Figure 498). The 
Profile Select dialog box appears (see Figure 499). Existing e-mail 
profiles display in the Profile list.

Figure 498. Change Profile Button

2. Select a profile. The Username and Password fields of the mailbox are 
blank.

3. If required, type the correct username and password to access the 
mailbox of the profile on the server. The password displays as a series 
of asterisks (see Figure 499).

IMPORTANT
If no profiles display, contact your IS or system administrator for help in 

creating a new e-mail profile for your PC.

Figure 499. Profile Select Dialog Box

4. Click OK to select the profile.
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Setting Connection Features of the Navigation Tree

When you double-click a site node in the navigation tree, the Tracer Sum-
mit software can do one of three things:

• Connect immediately
• Prompt you whether you want to connect
• No immediate connection

The response to the double-click on a site node is determined by what you 
set in system options. For more information about the navigation tree and 
connecting to sites, see “Connecting to a Site from the Tree” on page 401.

To set connection features for the navigation tree:

◆ From the Advanced tab in the System Options editor (see Figure 495 
on page 576), in the Double Clicks on Navigation Tree Nodes group:

• Click Connect Immediately if you want Tracer Summit to connect 
immediately to a site after a double-click on a site node

• Click Prompt for Connection if you want Tracer Summit to 
prompt the user with a dialog box that asks whether they want to 
connect to the site after a double-click on a site node

• Click No Connection if you want Tracer Summit not to connect 
immediately to a site after a double-click on a site node
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The BCU Operator Display

The BCU operator display is a liquid crystal display (LCD) touch screen 
that is installed in Tracer Summit BMTX or BMTW BCU as an option. 
The operator display makes it possible for the occasional daily user to 
perform most of the Tracer Summit daily activities at the BCU. 

Initially, the Tracer Summit software and PC Workstation are needed to 
set up the operator display for operations. After setup is complete, the 
operator display can serve as a stand-alone operator interface between 
the user and the building automation system (BAS) equipment. 

At the PC Workstation, the following site objects are set up for monitoring 
at the BCU operator display:

• Equipment and applications
• Time of day schedules
• Alarms and events

For information on using the operator display, see the Tracer Summit 
BCU Operator Display Operations guide.
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Accessing the BCU Operator Display 

Editor
1. From the Setup menu, select Operator Display. A list of all the opera-

tor displays that have been set up in site configuration displays (see 
Figure 500).

2. Select the name of the operator display that you want to edit. 

Figure 500. Select Dialog Box

3. Click OK to display the Operator Display editor (see Figure 501). The 
editor opens up to the Status tab. View this screen to see the number 
of objects that has been selected for monitoring at the operator dis-
play.

Figure 501. Operator Display Editor—Status Screen
582 BMTX-SVP01B-EN



Creating a New BCU Operator Display
Creating a New BCU Operator Display
To create a new BCU operator display object, you perform the following 
tasks:

• Add an operator display object to the selected device (as described in 
this section).

• Add a BCU event log object to the device (optional). Adding a BCU 
event log object enables users to view and acknowledge system 
alarms and events at the operator display (see “Adding a BCU Event 
Log object” on page 60).

• Select objects for viewing and editing at the operator display (see 
“Setting Up the BCU Operator Display” on page 586).

The following steps show you how to create a BCU operator display object 
from the Site Configuration editor. You can create an operator display 
object while configuring a site (see Chapter 6, “Configuring Tracer Sum-
mit BCU Sites”), or you can add it to a specified BCU (as described in this 
section).

To create a new operator display object: 

1. From the Setup menu, select Site Configuration.

2. From the Site Configuration editor, click the Devices tab to display 
the Devices screen (see Figure 502).

Figure 502. Site Configuration — Devices Screen

Note:

The operator display buttons are only available for BMTX and 
BMTW BCUs.
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• If the appropriate BCU is listed, select it. Then click the Edit 
Device button. The Edit Device dialog box displays (see 
Figure 503). 

• If the appropriate BCU is not listed, click the Create Device but-
ton to display the Create Device screen.

Figure 503. Site Configuration—Edit Device

3. Click the Operator Display Add button. The Create New Operator 
Display dialog box displays (see Figure 504).

Figure 504. Create New Operator Display Dialog Box
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4. Type a name in the Operator Display Name field. Make the name as 
informative as possible. Use a maximum of 32 characters.

5. To change the default security access for the operator display, click 
Security Classes (see “Setting Up Security—Tracer Summit System” 
on page 135). 

6. Click OK to close the Create New Operator Display dialog box.

7. From the Edit Device screen, click OK. 

8. From the Devices screen, click Save. The operator display object is not 
created until you save.

9. Click OK to return to the main screen.

Note:

You must enter a name before you can save the new operator 
display object. You can modify the name at any time from the 
Edit Operator Display dialog box. You can access the dialog box 
from the Operator Display Edit button. 
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Setting Up the BCU Operator Display
Setting up the operator display is as easy as selecting a device and cus-
tomizing the operator display home screen. To set up the operator display 
for daily operations, perform the following tasks:

• Select a device from the Devices tab or select individual object types 
and their members from the Object Types tab and Members tab.

• Use the Main Screen tab to customize the operator display home 
screen.

Operator Display Options

To set up security for the operator display, or to enable custom screens, 
see “Setup Options for the Operator Display” on page 593.

Selecting a Device

From the Devices screen, you can quickly select all of the objects residing 
in a device. The objects will then be available at the operator display for 
monitoring. 

1. From the Operator Display editor, click the Devices tab. The Devices 
Screen displays (see Figure 505).

Figure 505. Operator Display Editor—Devices Screen
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2. From the Available Devices list, select the name of the device.

3. Click the Add button to add the device to the Selected Devices list. 

4. Click Save to save your changes.

Removing a Device

1. From the Selected Devices list, select the name of the device.

2. Click the Remove button to move the device back to the Available 
Devices window.

3. Click Save to save your changes.

Note:

The Tracer Summit software automatically moves all the object 
types in that device to the Selected Objects list on the Object 
Types screen (see Figure 506 on page 588). Also, the members 
associated with those object types are automatically moved to 
the Selected Objects list on the Members screen (see Figure 507 
on page 589).

Note:

The Tracer Summit software automatically moves all the object 
types in that device back to the Available Objects list on the 
Object Types tab. Also, the members associated with those 
object types are automatically moved back to the Available 
Objects list on the Members tab. All of the objects for that 
device will no longer be available at the operator display for 
monitoring.
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Selecting Individual Object Types

Use this screen to quickly select all of the members of an object type.

To select individual object types:

1. From the Operator Display editor, click the Object Types tab. The 
Object Types screen displays (see Figure 506).

Figure 506. Operator Display Editor—Object Types Screen

2. From the Available Object Types list, select the name of the object.

3. Click the Add button to add the object to the Selected Object Types 
list.

4. Click Save to save your changes.

Note:

When you select objects from the Available Object Types list, 
the Tracer Summit software automatically moves all of the 
members belonging to that object type from the Available 
Object list to the Selected Objects list on the Members screen 
(see Figure 507 on page 589). Also, the software automatically 
moves the associated device from the Available Devices list to 
the Selected Devices list on the Devices screen (see Figure 505 
on page 586).
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Removing Individual Object Types

1. In the Selected Object Types list, select the name of the object you 
want to remove.

2. Click the Remove button to move the object type back to the Available 
Object Types list.

3. Click Save to save your changes.

Selecting Members

Use this screen to quickly select and remove members of an object type 
from the object lists.

To select members of an object type:

1. From the Operator Display editor, click the Members tab. The Mem-
bers screen displays (see Figure 507).

Figure 507. Operator Display Editor—Members Screen

2. From the Available Objects list, select the name of the member.

Note:

The Tracer Summit software automatically moves all of the 
members belonging to that object type from the Selected 
Objects list to the Available Objects list on the Members tab. 
The members of the object type will no longer be available for 
monitoring at the operator display.
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3. Click the Add button to add the member to the Selected Objects list.

4. Click Save to save your changes.

Removing Members

1. In the Selected Objects list, select the name of the member you want 
to remove.

2. Click the Remove button to move the member back to the Available 
Objects list. That member will no longer be available for monitoring 
at the operator display.

3. Click Save to save changes.

Note:

When you select objects from the Available Objects list, the 
Tracer Summit software automatically moves the object type 
associated with that member from the Available Object Types 
list to the Selected Object Types list on the Object Types screen 
(see Figure 506 on page 588). Also, the software automatically 
moves the associated device from the Available Devices list to 
the Selected Devices list on the Devices screen (Figure 505 on 
page 586).

Note:

If you remove all of the members belonging to an object type, 
the Tracer Summit software will automatically move the object 
type back to the Available Object Types list on the Object Types 
tab. The members of that object type will no longer be available 
for monitoring at the operator display. 
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Customizing the Operator Display 

Home Screen
From the Main Screen you can customize the information on the operator 
display home screen. Use this screen to add a title and custom data points 
to the operator display (see Figure 508). Figure 509 on page 592 shows an 
example of a customized home screen.

Figure 508. Operator Display Editor Screen
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Figure 509. Example of Customized Operator Display Home Screen

To customize the operator display home screen:

All fields on the Main Screen editor are optional and can be left blank 
(refer to Figure 508 on page 591).

1. In the title field, type text that will display as the title of the home 
screen. If this field is left blank, the title will default to the site name.

2. In the Line One Description field, type text that describes the custom 
data point. If this field is left blank, no information will be displayed. 

3. In the Object Type field, use the selection arrow to select the object 
type from the list.

4. In the Object Name field, use the selection arrow to select the object 
name from the list.

5. In the Property Name field, use the selection arrow to select the prop-
erty whose value will appear on line one as the first custom data 
point.

6. Repeat steps 1-5 for adding the second custom data point to the oper-
ator display.

7. Click Save to save your changes.

Title

Description of Custom 
data point #2

Description of Custom 
data point #1

Custom data 
points
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Setup Options for the Operator Display
The following tasks are optional when setting up the operator display:

• Setting up BCU operator display security access (see “Setting Up 
Security for the Operator Display” on page 147)

• Enabling security for the BCU operator display (as described in this 
section)

• Choosing operator display options (as described in this chapter)
• Creating custom screens (see Chapter 35, “Using the Custom Screen 

Editor”)
• Setting up a custom screen (as described in this chapter)

Enabling Security at the Operator Display

Use the following procedure to set security at the operator display. When 
security is enabled, users need a password and edit access to edit system 
information. Passwords and edit access are set up in the Site Security edi-
tor (see “Setting Up Security for the Operator Display” on page 147). 

To enable security at the operator display:

1. From the Setup menu, select Operator Display. The Select Operator 
Display dialog box displays.

2. Select the operator display you want to set up security for and click 
OK. The Operator Display editor displays.

3. Click the Setup tab. The Setup screen displays (see Figure 510).

Figure 510. Operator Display Editor—Setup Screen
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4. Click the Enable Security checkbox to place a check in the box (see 
Figure 511). 

Figure 511. Setup Screen—Enable Security

5. Click Save to save your changes.

Disabling Security at the Operator Display

1. From the Operator Display editor, click the Setup tab (see Figure 510 
on page 593).

2. With the Enable Security checkbox checked, click the checkbox to 
remove the check and disable security. With security disabled, users 
have edit access to all functions at the operator display.

3. Click Save to save your changes.

Operator Display Options

From the Setup tab, you can enable or disable certain items on the opera-
tor display touch screen. These items are shown in Figure 512. A descrip-
tion and procedures for how to enable or disable each item follows.

Figure 512. Setup Screen—Operator Display Options

Note:

The software will automatically place a check in this box when 
an operator display password is assigned in the Site Security 
editor (see “Setting Up Security for the Operator Display” on 
page 147).
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Disabling Non-Critical Confirmation Screens

Confirmation screens display to confirm that you want to proceed with an 
operation, for example, making a change to a schedule or set point.

To disable non-critical confirmation screens:

1. From the Operator Display editor, click the Setup tab (see Figure 510 
on page 593).

2. Click the Disable Confirmation Screen checkbox to place a check in 
the box. Only non-critical confirmation screens are disabled.

3. Click Save to save your changes.

Disable Audible Alarm

An audible alarm will beep when certain types of events and alarms are 
received at the operator display. If the user exits the event log with an 
unacknowledged alarm or event that has been set up to beep, the system 
will reset the beep-timer to beep again in 60 minutes. If an unacknowl-
edged alarm or event exists, but that type of event does not beep, the 
beep-timer will not reset. Alarms and events are set up to beep in Site 
Configuration event routing (see “Setting Up Event Classes” on page 81).

To disable the audible alarm:

1. From the Operator Display editor, click the Setup tab (see Figure 510 
on page 593).

2. Click the Disable Audible Alarm checkbox to place a check in the box. 

3. Click Save to save your changes.

Enabling Custom Screens

This option is available when custom screens have been saved to the site 
database. You must first create custom screens before they are available, 
(see Chapter 35, “Using the Custom Screen Editor”).

To enable custom screens:

1. Click the Enable Custom Screens checkbox (see Figure 512 on page 
594).

2. Click the selection arrow. The list expands to display all custom 
screens saved to the site database.

3. Select a custom screen from the list. This screen will be the first cus-
tom main screen to display after the View button is pressed on the 
operator display home screen (see Figure 509 on page 592).

4. Click Save to save your changes.
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Enabling the Quick-Select Function

The quick-select function automatically adds members of a selected appli-
cation to the operator display object list. Figure 513 shows applications 
that use the quick-select function.

Figure 513. Setup Screen—Applications that Use the Quick-select 

Function

To enable the quick-select function:

1. Click the application for which you want to automatically add mem-
bers. A dialog box displays asking you to confirm your selection.

2. Click OK.

3. Click Save. From this point forward, when the application is selected 
to be included in the operator display object list, the members of that 
application will automatically be included in the object list.

Note:

When the quick-select function is disabled (checkbox not 
checked), only the application will be moved in the operator dis-
play object list.
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Selecting Custom Screens

Use the following procedure to select custom screens for use at the opera-
tor display. Custom screens are created in the Custom Screens editor (see 
Chapter 35, “Using the Custom Screen Editor”).

To add a custom screen:

1. From the Operator Display editor, click the Custom Screens tab. The 
Custom Screens screen displays (see Figure 514).

Figure 514. Operator Display—Custom Screens Screen

2. In the Available Screens list, select one or more custom screens.

3. Click Add to add the custom screen. An asterisk appears behind the 
name of the screen, indicating that it has been added but not saved to 
the site database. You will need to save the custom screen in order for 
it to be available at the operator display.

4. Click Save to save your changes.

To remove a custom screen:

1. In the operator display list, select the custom screen you want to 
remove.

2. Click Save to save your changes.

To add all available custom screens:

1. Click the Add All button to add custom screens to the operator display 
list.

Note:

Only custom screens that have not been saved (an asterisk 
appears after the name) are moved back to the Available 
Screens list.
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2. Click Save to save all custom screens to the site database.

To remove all unsaved custom screens:

1. Click the Remove All button. Only custom screens that have not been 
saved (asterisk appears after the name) are moved back to the Avail-
able Screens list.

2. Click Save to save your changes.

Deleting Saved Custom Screens
◆ To delete saved custom screens from the operator display list, go to 

the Tools menu and select Delete Objects.
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Chapter 35

Using the Custom Screen 

Editor

The BCU Custom Screen editor enables you to create custom screens that 
you can download to a BCU operator display. Using the Custom Screen 
editor, you can develop screens that meet the unique needs of users and 
sites.

Situations when you might create custom screens include those where 
different levels of users access the operator display during daily opera-
tions. For example, at a site where the users are not advanced, you can 
create a screen that fits their needs and uses. For sites where more 
advanced users access the operator display, you can create more sophisti-
cated screens than the standard screens.

Custom screens often provide quick access to frequently used informa-
tion, as well as to information that is not available on standard operator 
display screens. With custom screens, for example, you can insert a 
graphic of your equipment and then apply graphic and text fields that 
report the status of the equipment and let you perform overrides.

With custom screens, you can:

• Create a library of custom screens and navigation schemes that can 
be used at multiple job sites

• Use a combination of custom and standard screens in the BCU opera-
tor display

• Navigate from a custom screen to a standard screen
• Create a monochrome bitmap unique to your site and import it and 

display it
• Define custom reports to display
• Define which object/properties that you can view on text and graphic 

screens

Creating custom screens for the operator display uses procedures similar 
to those for creating other Tracer Summit graphics. For more information 
about creating Tracer Summit graphics in general, see “Using the Graph-
ics Editor Tools” on page 463.
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About Custom Screen Graphics
Custom screen graphics are similar to graphics created with the Tracer 
Summit Graphics editor. With the Custom Screen editor, you can create a 
site or equipment graphic that includes text, images, target links to other 
graphics, and fields that display control values.

Each time you create a custom screen, you will see a custom graphic tem-
plate (see Figure 520 on page 604). Starting with this template you add 
graphics or fields that display the information you need.

A custom screen graphic template always displays two icons: the Home 
target and the Back target. The Home target takes you to the main screen 
of the operator display (see Figure 509 on page 592). On the Home screen 
you can access the View, Alarms, and Schedules buttons. The Back target 
takes you to the last screen you viewed.

You add and delete custom screens to the operator display module using 
the Operator Display editor (see “Enabling Custom Screens” on 
page 595). In that editor, you can assign a custom screen as the first 
screen that appears when the View button is pressed (see “Selecting Cus-
tom Screens” on page 597).

Access the custom screen graphic tools using the tool bar (see “The Cus-
tom Screen Toolbar and Palette” on page 605). The tool bar provides for-
matting buttons that delete, paste, align, snap items to the grid, etc. The 
tool palette contains the buttons that you click to insert fields and other 
graphics, including text fields, control value fields, or bitmaps.

If you are connected to the operator display while you are creating a cus-
tom screen, you can view what values will appear in the graphic fields. 
Switch to run-time screen view (see “Switching to Run-Time (Live) Screen 
View” on page 617) to see these real-time values.

The graphics in Figure 515 and Figure 516 on page 601 display the exam-
ple types of graphics and fields you can insert on custom screens. 
Figure 515 shows an example of an equipment status custom screen, 
while Figure 516 shows an example of a custom screen that was linked to 
from the first custom screen (Figure 515).
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Figure 515. Example Custom Screen

Figure 516. Example Linked Custom Screen

Background with grid on

Static text field

Bitmap image

Home Target

Custom screen name

Back Target

Target Button

View equip-
ment Button

Status text

Imported custom bitmaps

Binary text

Override 
button
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Accessing the Operator Display Custom 

Screen Editor
1. From the setup menu, select Operator Display Custom Screen. The 

Select Custom Screen dialog box appears (see Figure 517).

Figure 517. Select Custom Screen Dialog Box

2. Select the screen you want to access.

3. Click OK to access the Custom Screen editor. The selected screen dis-
plays in the editor.
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Creating Custom Screens
1. From the Setup menu, select Operator Display Custom Screen. The 

Select Custom Screen dialog box appears (see Figure 517 on page 
602).

2. Click New. The New Operator Display Custom Screen Name dialog 
box appears (see Figure 518).

Figure 518. New Operator Display Custom Screen Name Dialog Box

3. Type the name of the new custom screen.

4. Click OK. The Save Operator Display Custom Screen dialog box dis-
plays (see Figure 519).

Figure 519. Save Operator Display Custom Screen Dialog Box

5. From the BCU Name list, select the BCU operator display that you 
are creating the custom screen for.

6. Click OK to display the custom screen template (see Figure 520 on 
page 604).

Note:

Tracer Summit only allows you to assign the screen to a BCU 
that already has an operator display created for it.
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Figure 520. Operator Display Custom Screen Editor Template

Creating a Custom Screen from Another Custom 

Screen

You can create a custom screen based on one that you have already cre-
ated.

To create a custom screen from an existing custom screen:

1. From the File menu, select Save Custom Screen As. The New Opera-
tor display Custom Name dialog box appears (see Figure 518 on page 
603).

2. Perform steps 3-6 of “Creating Custom Screens” on page 603.
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Using the Custom Screen Editor Tools
When the Custom Screen editor is open, two groups of tools display (see 
Figure 521): a graphics toolbar and a floating tool palette that you can 
move around the screen using the mouse.

Table 28 lists the toolbar buttons and what they do. Table 29 on page 607 
lists palette buttons and their functions.

Figure 521. Custom Screen Editor Toolbar and Tool Palette

The Custom Screen Toolbar and Palette

The toolbar and palette contain text and graphic design buttons that help 
you create custom screens. 

Cut, Copy, Paste, Delete Undo, Redo Align: 
Top, Right, Top  
or Bottom

Make Same: 
Height, Width,  
or Size

Center: 
Horizontally,  
Vertically

Move Field 
to Front or 
Back

Tools: 
Snap to Grid, 
Set X/Y Snap. 
Screen Name

Switch to Runtime View

Status text

Override control

Static text

Target button

Setpoint control

Binary text

Bitmap

Default cursor

Table 28. Toolbar Buttons and Descriptions 

Toolbar Button Description

Cut Selected Field(s)
Click to place the selected fields on the clipboard for use in this custom screen or 
another custom screen.

Copy Selected Field(s)
Click to place the selected fields on the clipboard for use in this custom screen or 
another custom screen without removing them from their current location.

Paste Selected Field(s)
Click to insert in the custom screen any fields that are currently held on the clip-
board.

Delete Selected Field(s)
Click to remove the field from the custom screen. The item is not placed on the cus-
tom screen clipboard.

Undo Click to undo the last modification to the custom screen.
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Redo Click to redo the last modification to the custom screen.

Align Left
Click to align all selected fields along the left side of the primary field. The primary 
field is the last field you selected when pressing CTRL and clicking one or more 
additional fields.

Align Right

Click to align all selected fields along the right side of the primary field. The primary 
field is the last field you selected when pressing CTRL and clicking one or more 
additional fields. This menu selection has no effect on the y-coordinate of the 
selected field.

Align Top
Click to align all selected fields along the top of the primary field. The primary field is 
the last field you selected when pressing CTRL and clicking one or more additional 
fields.

Align Bottom
Click to align all selected fields along the bottom of the primary field. The primary 
field is the last field you selected when pressing CTRL and clicking one or more 
additional fields.

Make Same Height
Click to make all selected fields the same height as the primary field. The primary 
field is the last field you selected when pressing CTRL and clicking one or more 
additional fields. This menu selection has no effect on the width of the selected field.

Make Same Width

Click to make all selected fields the same width as the primary field. The primary 
field is the last field you selected when pressing CTRL and clicking one or more 
additional fields. This menu selection has no effect on the height of the selected 
field.

Make Same Size
Click to make all selected fields the same dimensions as the primary field. The pri-
mary field is the last field you selected when pressing CTRL and clicking one or 
more additional fields. 

Center Horizontally on 
Screen

Click to align the horizontal center of one or more fields with the horizontal center of 
the screen. If you select only one field, its horizontal center coincides exactly with 
the horizontal center of the screen. If you select multiple fields, their average hori-
zontal center coincides exactly with the horizontal center of the screen. This menu 
selection has no effect on the y-coordinate of the selected field.

Center Vertically on Screen

Click to align the vertical center of one or more fields with the vertical center of the 
screen. If you select only one field, its vertical center coincides exactly with the verti-
cal center of the screen. If you select multiple fields, their average vertical center 
coincides exactly with the vertical center of the screen.

Move Field to Front Click to place the selected field on top of any other fields that it overlaps. 

Move Field to Back Click to place the selected field behind any other fields that it overlaps.

Snap to Grid

Click to quickly align fields in the custom screen. When the Snap To function is 
enabled (see “Snapping a Bitmap or Field to the Grid” on page 617), the upper-left 
corner of any field that is new, or has been repositioned, will be aligned with the 
nearest grid intersection.  
The reference point is the upper left-hand corner of the field that is being positioned 
on the screen. The snap-to function is activated when you release the mouse button 
to insert the field onto the custom screen. 

Set X/Y Snap
Click to modify the grid spacing to any value between 4 and 32 pixels. The default 
spacing is 8 pixels. You can select separate horizontal and vertical spacing for the 
grid. They do not have to be the same. 

Table 28. Toolbar Buttons and Descriptions (Continued)

Toolbar Button Description
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Screen Name
Click to change the name of the custom screen object. This will change the name of 
the custom screen in the Tracer Summit database.

View Live Screen

Click to view the run-time version of the custom screen. Run-time view simulates 
what the custom screen will look like when it is viewed at the BCU operator display.  
The system will also validate the objects/properties that have been added to the cus-
tom screen. Warning messages display when items are not available at the site with 
which the custom screen has been associated.

Table 28. Toolbar Buttons and Descriptions (Continued)

Toolbar Button Description

Table 29. Custom Screen Palette Buttons 

Field Type Field Name
Palette 
Button

Description

Status 
Fields

Status text Inserts text drawn from the property you specify.

Binary Inserts text drawn from the binary property you specify.

Control 
Fields

Override control Inserts a button that can override the present value for vari-
ous objects within a Tracer Summit site.

Setpoint control Inserts a numeric text field. The field allows users to change 
settings of numerical data.

Text or 
Image 
Fields

Static text Inserts text that you specify.

Bitmap Inserts a monochrome bitmap image, no larger than 320 x 
240 pixels in size

Target 
Fields

Target button Inserts a button that links to another custom or standard 
screen.

Cursor Default cursor Changes the cursor from an insertion point back to a selec-
tion cursor.
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Using the Custom Screens Pop-Up Menu

In the Custom Screens editor, you can select options from the menu bar or 
select them from a pop-up menu. To display a pop-up menu, right-click on 
a custom screen field or on the custom screen background. You can then 
make a selection from the pop-up menu (see Figure 522).

If the mouse button is positioned over a field, the pop-up menu items are 
specific to the field. Otherwise, the pop-up menu is specific to the custom 
screen.

Figure 522. Custom Screen Pop-Up Menu

Displaying the Custom Screen Palette

Use the following procedure to display the custom screen palette (see Fig-
ure 521 on page 605).

To display the custom screens palette:

1. From the Custom Screen editor, select Palette from the Layout menu. 
A submenu appears.

2. Select the palette mode you desire.

• Click Show to display the palette
• Click Hide to hide the palette
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Configuring and Using the Grid

The Custom Screen editor has a grid that helps you place screen elements 
precisely on the custom screen template. Use the following procedures to 
configure the grid and snap to settings that help you lay out custom 
screens.

Displaying the Grid

1. From the Layout menu, select Grid Options.

2. Select On from the Grid Options submenu. The grid appears on the 
Custom Screen editor and enables the Grid Spacing and Snap To 
menu items. A check mark appears next to the On menu item in the 
Grid Options submenu of the Layout menu.

3. To remove the grid and remove the check mark next to the On menu 
item, repeat steps 1 - 2.

Configure Grid Color

1. With the grid displayed on the Custom Screen editor, from the Layout 
menu, select Grid Options.

2. Select Color from the Grid Options submenu.

3. Click the color that you want the grid to display.

Configuring Grid Spacing

1. With the grid actively displayed on the Custom Screen editor, from 
the Layout menu, select Grid Options. The Tracer Summit software 
displays the Grid Options submenu.

2. Click Spacing. The Snap Settings dialog box appears (see Figure 523).

Figure 523. Snapping Dialog Box

3. Scroll through the values in the Snap X Value list and/or click a new 
value from the Snap Y Value list. The newly selected snap X value 
and/or snap Y value displays in the corresponding fields of the dialog 
box.

4. Click OK to redisplay the grid with the modified grid settings.
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Adding Status Text, Binary Text, and Setpoint Control 

Field(s)

Use the following procedure to add fields that can display information 
from sensors or equipment installed at your site.

To add control value fields:

1. From a custom screen, click the palette button associated with the 
type of field you want to insert (see Table 29 on page 607). The cursor 
turns into an insert prompt (see Figure 524).

Figure 524. Insert Prompt

2. Position the cursor at the location on the graphic where you want to 
insert the field and click. The field is inserted and an editor that is 
appropriate for that field displays.

From the dialog box, select the appropriate values as described in 
“Selecting Property Reference and Setup Information for Status Text, 
Binary Text, and Setpoint Control Fields” below.

Selecting Property Reference and Setup Information for Status 

Text, Binary Text, and Setpoint Control Fields

On the Property screen, you can specify the site name, object type, object 
name, and property for the field.

• Status text displays information about a single selected property for a 
specific UCM or for all UCMs of a specific object type that are 
installed at a single site.

• Binary text displays a text view of the binary property of an object 
that you specify. You can define which of the two logical states (0 and 
1) will display.

• Setpoint control text is information that comes from a sensor or 
HVAC unit. Inserting this field allows you to change the values in this 
field at the operator display.

To select a property reference for these fields:

1. In the Object Type list, select an object type. The list displays only 
those property types and instances that are defined for the site.

2. In the Object Name field, select the name of the object from the list.

3. In the Property Name list, select the property name. (You must com-
plete this field to exit the screen.)

4. Type or select the setup information for the field. After you enter this 
information, the Editor Text field displays the values you enter.

• If you are entering Status text, use the arrow to select the right of 
decimal value.
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• If you are entering binary text, type the text that will appear 
when the apparatus is in an inactive and/or active state.

• If you are entering setpoint information, type the minimum and 
maximum value.

5. Click OK to insert the information on the custom screen.

Inserting an Override Control Field

Use the following procedure to select one of the six preselected control 
class names from the expanded selection list. The override field lets you 
override the present value for various objects within a Tracer Summit 
site.

To add an override control field:

1. From a custom screen, select the Override Control Field button (see 
Table 29 on page 607). The cursor turns into an insert prompt (see 
Figure 524 on page 610).

2. Position the cursor at the location on the graphic where you want to 
insert the field and click. The field is inserted and the Override Con-
trol Field dialog box displays (see Figure 525 on page 612).

From the dialog box, select the appropriate values as described in 
“Defining the Properties of an Override Control Field” on page 612.

Note:

Using this field you can restrict the acceptable range of values. 
For instance, a valid zone temperature setpoint might be 
between 50 and 90°F. However, for either energy-conservation 
or comfort reasons, you might want to restrict the setpoint that 
can be entered from the BCU operator display to a range of  
65–85°F. 
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Figure 525. Override Control Field Dialog Box

Defining the Properties of an Override Control Field

1. In the Object Type list, select the object type.

2. In the Object Name list, select the object name or list of objects. The 
Editor Text displays the current value of the object in edit mode and 
as it exists at the operator display.

• Select a specific object by its name if you want to display a 
present value override control for a single unit control module 
(UCM).

• Select <List Of> if you want to display a present value override 
control for all UCMs of the selected object type. When you select 
this value, an override button displays on the custom screen for 
all UCMs configured at the BCU.

3. In the Current list, select the priority for the override control. The 
BCU operator display uses pre-defined priority controls for overrides.

When you press the override button at the operator display, the prior-
ity of the override is evaluated to see whether it cancels the priority 
that is currently controlling the property.

Use the names in the Available on System list as a reference when 
assigning the current control class for the override control. The list 

Note:

During daily operations, the user can override this value at the 
operator display.

Note:

The default is control class 12.
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displays the 16 control class names that were set up in site configura-
tion (see “Setting Up Control Priorities” on page 630).

4. Click OK to insert the information on the custom screen.

Inserting a Static Text Field

Use the following procedure to add a static text field. Static text is infor-
mation on the custom screen that does not change. Examples of static text 
include a screen title, field title, or other item that adds information to 
the screen and remains unchanged.

To add a static text field:

1. From a custom screen, click the Static Text palette button (see Table 
29 on page 607). The cursor turns into an insert prompt (see Figure 
524 on page 610).

2. Position the cursor at the location on the graphic where you want to 
insert the Static Text field and click. The field is inserted and the 
Static Text dialog box displays (see Figure 526).

Figure 526. Static Text Dialog Box

3. Type the text that you want displayed on the custom screen.

4. Click OK to add the text to the custom screen. The static text string 
displays on the custom screen.

Inserting a Custom or Standard Bitmap

Use the following procedure to add a custom or standard bitmap to the 
custom screen. Custom bitmaps are created using third-party graphics 
packages and imported into Tracer Summit (see “Creating and Importing 
Bitmaps” on page 620). Standard bitmaps are a set of standard equip-
ment images that ship with Tracer Summit.

To insert a bitmap:

1. From a custom screen, click the Bitmap palette button (see Table 29 
on page 607). The cursor turns into an insert prompt (see Figure 524 
on page 610).

2. Position the cursor at the location on the screen where you want to 
insert the field and click. The Bitmap dialog box displays (see 
Figure 527 on page 614).

From the dialog box, select the appropriate values as described in 
“Selecting a Bitmap” described below. The field is inserted and the 
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Override Control Field dialog box displays (see Figure 525 on page 
612).

From the dialog box, select the appropriate values as described in 
“Selecting a Bitmap” described below.

Figure 527. Standard Bitmap Dialog Box

Figure 528. Custom Bitmap Dialog Box

Selecting a Bitmap

1. Select the type of graphic you are entering:

• If you are inserting a custom bitmap that you have created and 
saved in a directory, click the Custom button.

• If you are inserting a standard bitmap, click the Standard button.
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2. Select the desired bitmap.

• If you are inserting a standard bitmap, select it from the bitmap 
list (see Figure 527 on page 614).

• If you are inserting a custom bitmap, click the Browse button and 
select the bitmap in the directory where you saved it (see 
Figure 528 on page 614).

3. Click OK to add the bitmap to the custom screen. The bitmap displays 
on the custom screen.

Linking a Target Button Field to a Custom or Standard 

Screen

Use the following procedure to link a target button with a custom or stan-
dard screen. During run-time mode at the BCU operator display, the user 
can press this target button and the LCD displays the custom screen that 
is the button’s target.

To link a target button with a custom or standard screen:

1. From a custom screen, click the palette button associated with the 
type of field you want to insert (see Table 29 on page 607). The cursor 
turns into an insert prompt (see Figure 524 on page 610).

2. Position the cursor at the location on the screen where you want to 
insert the field and click. The field is inserted and the Target Button 
dialog box appears (see Figure 529).

Figure 529. Target Button Dialog Box

Defining the Properties of a Target Button

1. In the Button Text field, type the text that you want to display in the 
button as it appears on the custom screen.

2. Select the button target custom screen.

• To link the field to a custom screen, click the Custom Screens but-
ton. In the Button Target list, all of the custom screens that are 
available appear. Select the custom screen that you want to dis-
play when the button is pressed at the operator display.
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• To link the field to a standard screen, click the Standard Screens 
button. Selecting this button causes the Button Target selection 
list to display only the standard screens to which the target but-
ton may be linked. At this time, you can only link to the Main 
View standard screen. Selecting this target places the Main View 
bitmap on the target button (see Figure 530).

Figure 530. Main View Bitmap

3. If you are linking to a custom screen, from the Object Name/Type list, 
select the type of object contained on the custom screen. Click None if 
you are linking the target button to another custom screen that has 
been developed for the site.

• Click the Object Name button to sort the Object/Name/Type by 
the name of the object. The list orders the objects by alphanu-
meric name.

• Click the Type button to sort the Object Name/Type list by type of 
object.

4. Click OK to insert the target button on the custom screen.

Note:

Remember that if you want to use the standard screens to view 
all the equipment at your site, include a target button with the 
Main View on one of your custom screens. If you do not include 
this button, you will only be able to access the custom screens 
you set up in the Operator Display editor as the first screen to 
display (“Enabling Custom Screens” on page 595), as well as 
the Home, Alarms, and Schedule screens.
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Saving Custom Screens

◆ From the File menu, select Save Custom Screen to save your changes.

Switching to Run-Time (Live) Screen View

Use the following procedure to see how the custom screen displays real-
time values in the fields you have added. You must be connected to the 
operator display to access real-time values.

To switch to a live-screen view:

◆ Click Run-Time (Live) Screen View on the Custom Screen editor tool-
bar (see Figure 531). The editing mode is deactivated and you cannot 
edit the custom screen while in live-screen mode.

• If the sensors or equipment are working correctly, their values 
display. Otherwise, question marks (???) display, indicating that 
the present value for the field is unknown.

• If the tools palette is active, the Tracer Summit software hides 
the palette. The rest of the screen maintains the same appear-
ance.

Figure 531. Run-Time (Live) Screen View Button

Organizing Custom Screen Fields
Organizing fields includes such procedures as moving, copying and past-
ing, resizing, and related processes. For information on using the Custom 
Screen editor tools, see “Organizing Graphic Fields” on page 490. The fol-
lowing procedures describe how to use tools that are unique to the Cus-
tom Screen editor.

Snapping a Bitmap or Field to the Grid

Use the following procedure when you want to precisely place bitmaps on 
the grid, also called “snapping to grid.”

To snap a bitmap to the grid in the custom screen template:

1. Use the default cursor to click the bitmap or field you want to edit. A 
cross-hatched border displays around the bitmap or field. (You can 
also select multiple fields to copy simultaneously. See “Selecting Mul-
tiple Fields at Once” on page 490.)

Note:

The custom screens are not added to the operator display until 
you add them in the Operator Display editor and save them to 
the database (“Selecting Custom Screens” on page 597).
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2. Click Snap to Grid on the Custom Screen editor toolbar (see 
Figure 532). The upper left hand corner of the item is snapped verti-
cally and horizontally to the closest grid line.

Figure 532. Snap to Grid Button

Centering a Bitmap or Field Horizontally

1. Use the default cursor to click the bitmap or field you want to edit. A 
cross-hatched border displays around the bitmap or field. (You can 
also select multiple fields to copy simultaneously. See “Selecting Mul-
tiple Fields at Once” on page 490.)

2. Click Center Horizontally on the Custom Screen editor toolbar (see 
Figure 533). The bitmap or field aligns horizontally in the template.

Figure 533. Center Horizontally

Centering a Bitmap or Field Vertically

1. Use the default cursor to click the bitmap or field you want to edit. A 
cross-hatched border displays around the bitmap or field. (You can 
also select multiple fields to copy simultaneously. See “Selecting Mul-
tiple Fields at Once” on page 490.)

2. Click Center Vertically on the Custom Screen editor toolbar (see 
Figure 534). The bitmap or field aligns vertically in the template.

Figure 534. Center Vertically

Editing Custom Screens
Use the following procedures to select custom screens to edit and to select 
graphic elements on those screens for editing.

Selecting a Custom Screen to Edit When You Have 

Another Screen Open

1. With a custom screen open, from the File menu, select Open Another 
Custom Screen. The select Custom Screen dialog box displays (see 
“Select Custom Screen Dialog Box” on page 602).

When you have not yet saved the current custom screen, the Save 
Changes dialog box gives you the option to save the screen.
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2. Select an available screen.

3. Click OK to edit the custom screen.

Selecting a Bitmap or Field to Edit

1. Click the bitmap or field you want to edit. A cross-hatched border dis-
plays around the element.

2. Right-click the bitmap or field. The custom screen pop-up menu 
appears (see Figure 535).

Figure 535. Example pop-up Menu with Edit Properties Selected

3. Select Edit Properties from the pop-up menu. The property dialog box 
for the item appears.

• If you are editing a Status Text field, the Status Text property 
dialog box appears.

• If you are editing a Binary Text field, the Binary Text property 
dialog box appears.

• If you are editing an Override Control field, the Override Control 
property dialog box appears (see “Defining the Properties of an 
Override Control Field” on page 612).

• If you are editing a Setpoint Control field, the Setpoint Control 
property dialog box appears.

• If you are editing a Static Text field, the Static Text property dia-
log box appears (see Figure 526 on page 613).

• If you are editing a Bitmap, the Bitmap property dialog box 
appears (Figure 527 on page 614).

• If you are editing a Target Button, the Target Button property 
dialog box appears (Figure 529 on page 615).

4. Change the properties as required.

5. From the File menu, select Save to store your changes in the data-
base.
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Changing the Custom Screen Name

Use the following procedure to change the name of the custom screen. 
This is the name of the custom screen as it appears beneath the custom 
screen template and in the Operator Display editor.

To change the name of the custom screen:

1. Click Screen Name on the Custom Screen editor toolbar (see 
Figure 536). The Screen Name dialog box appears (see Figure 537).

Figure 536. Screen Name Button

Figure 537. Custom Screen Name Change Dialog Box

2. In the Screen name field, type the new name for the custom screen.

3. Click OK to change the name of the screen. The custom screen name 
that appears beneath the custom screen template changes to the new 
name.

Creating and Importing Bitmaps

Using the Custom Screen editor, you can import images you create in 
other software applications into graphics used in the Custom Screen edi-
tor. Tracer Summit can import bitmap (BMP) images that have been 
saved as monochrome and are no larger than 320x240 pixels.

To create these image files, you can use a variety of graphics packages, 
including Paintshop Pro versions 5 and later, AutoCAD, CorelDRAW, or 
Windows Paint.

Once you save the files to the appropriate directory, you can insert them 
into your custom screens in the same way as graphic BMP images are 
inserted (see “Inserting a Custom or Standard Bitmap” on page 613).

Closing a Custom Screen
1. With a custom screen actively displayed in the custom screen editor, 

from the File menu, select Close Custom Screen.

2. When you have not yet saved the custom screen, the Save Changes 
dialog box appears.

3. Click Yes to store your changes.
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Using Rover in Tracer Summit 

You can use the Rover Comm5 service tool within your Tracer Summit 
software to configure unit controllers. There are two ways to do this:

• Start the full version of Rover from the Tracer Summit Tools menu
• Open Rover configuration screens from Tracer Summit UCM editors

You can use Rover to configure all supported Comm5 controllers through 
Tracer Summit. The Rover Comm5 service tool must be purchased and 
installed separately from Tracer Summit. Tracer Summit Version 15.0 or 
higher and Rover Version 5.0 are required.

For more information, see “About Using Rover in Tracer Summit” on 
page 623.

Starting Rover in Tracer Summit
Rover is available in Tracer Summit only when:

• Rover Comm5 Version 5.0 and Tracer Summit Version 15.0 or higher 
are installed on your computer.

• The site security supervisor has granted you access to Rover (full 
access).

To start Rover in Tracer Summit:

1. Connect locally or remotely to a Tracer Summit site.

2. From the Tools menu, select Rover. The BCU Selection dialog box 
appears.

If the Rover menu item is not available, check the requirements 
above.

3. Select the BCU that connects to the Comm5 link with the controllers 
you want to configure.

4. Click Configure with Rover. Rover Comm5 starts.

Note:

Rover Comm4, the Rover Flash Download application, and the 
Air and Water Balancing application are not available through 
Tracer Summit. All other Rover functions are available.
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Accessing Rover Configuration Screens 

from UCM Editors
Rover configuration screens are available in Tracer Summit only when:

• Rover Comm5 Version 5.0 and Tracer Summit Version 15.0 or higher 
are installed on your computer.

• The site security supervisor has granted you access to Rover (configu-
ration only).

• The software plug-in for the unit controller is available in Rover.
• The UCM is communicating with the BCU.

To open Rover configuration screens:

1. Connect locally or remotely to a Tracer Summit site.

2. On the Setup menu, point to Unit Controllers, then select the type of 
Comm5 controller you want to configure. The Select controller dialog 
box appears.

You can use Rover to configure the following types of controllers: Dis-
charge Air Controller (DAC), Generic LonTalk Device (GLD), Tracer 
MP580/581, and Space Comfort Controller (SCC).

3. Select the controller you want to configure, then click OK. The appro-
priate UCM editor appears.

4. On the Setup tab, click the Configure with Rover button. The Rover 
Configuration dialog box appears.

If the Configure with Rover button is not available, check the require-
ments above.

5. Make changes as needed, then click the Download button to save your 
changes to the controller.

6. Click Close.
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Setting up Security for Rover
Because the Rover Comm5 service tool makes available all configuration 
options for Comm5 controllers, you'll want to restrict access to qualified 
technicians and operators. Only site security supervisors can add or 
remove access to Rover.

To set up security for Rover:

1. From the Setup menu, select Site Security.

2. In the Select Security dialog box, select the user for whom you want to 
grant access to Rover.

3. On the Functions tab, select the Rover (Configuration Only) check box 
and/or the Rover (Full Access) check box.

The Configuration Only option grants access to configuration screens 
only (from a UCM editor). The Full Access option grants access to the 
complete Rover service tool so that bindings can be created between 
controllers.

4. Click Save.

5. Click the Open Another button to add access for other users.

6. Click Close when you are finished.

About Using Rover in Tracer Summit

Why should I use Rover in Tracer Summit?

By using Rover in Tracer Summit, you can:

• Configure Comm5 controllers remotely on links with BCUs
• Create and view bindings remotely on links with BCUs
• Use Rover and Tracer Summit on the same computer

Do I need Rover to manage my building automation 

system?

You probably don’t need Rover to manage your building automation sys-
tem on an ongoing basis. Rover is a configuration and troubleshooting tool 
for individual controllers—it doesn’t have the sophisticated system-level 
reporting or scheduling capabilities of Tracer Summit. 

If you’re a Trane technician, using Rover in Tracer Summit makes it 
much easier to work with Comm5 controllers on Tracer Summit sites. You 
can connect your computer to a BCU locally or remotely and then use 
Rover to set up and troubleshoot connected Comm5 controllers.
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Who can access Rover from Tracer Summit?

The site security supervisor must grant access to appropriate technicians 
and operators before they can use Rover through Tracer Summit. There 
are two levels of access:

• Rover (Configuration Only), which offers access only to Rover configu-
ration screens from UCM editors

• Rover (Full Access), which offers access to the full version of Rover, 
including the ability to create bindings between controllers

Note:

An operator with full Rover access can configure all supported 
Comm5 controllers, even if that operator does not have access 
to certain types of Comm5 controllers in Tracer Summit.
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Using BACnet for Non-Trane 

Devices

BACnet (Building Automation Control network) is a standard communi-
cation protocol adopted by ASHRAE for sharing data between various 
manufacturers’ equipment and building automation systems. Tracer 
Summit uses the BACnet protocol for all communications between BCUs 
and PC Workstations. BACnet protocol is also used to:

• Control and monitor non-Trane devices

• Communicate equipment information to a non-Trane control system 
so that it can control and monitor the Trane equipment

Tracer Summit uses and supports many standard BACnet objects. Tracer 
Summit also expands on BACnet by using Trane proprietary UCM 
objects. Trane UCM objects follow the BACnet protocol structure, but are 
not included in the BACnet standard. In order for non-Trane devices to 
interpret UCM object data, you must create standard BACnet input or 
output objects and reference them to UCM objects.

Connect a non-Trane device to a Trane BCU or PC Workstation through 
Ethernet, ARCNET, BACnet/IP, or an EIA-232 (point-to-point) connec-
tion. 
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Interfacing to Non-Trane BACnet 

Devices
Tracer Summit can control and monitor a non-Trane device. To set up a 
communication link with a device, you must create a BACnet object (non-
Trane device) in the Site Configuration editor and assign a device ID.

To set up a non-Trane device:

1. Install Trane device and non-Trane device hardware, communication 
wiring, network cards, and software. (See the Tracer Summit Hard-
ware and Software Installation guide for instructions.)

2. If the site with the non-Trane device is not defined, follow the instruc-
tions in Chapter 6 “Configuring Tracer Summit BCU Sites” to set up 
the new site. After you have set up the site, continue to the next step.

3. From the Setup menu, select Site Configuration. The Select Site dia-
log box displays (see Figure 538). 

Figure 538. Select Site Dialog Box

4. Click the name of the site you want to display. 

5. Click OK to display the Site Configuration editor (see Figure 539 on 
page 627).
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Figure 539. Site Configuration Editor Setup Screen

6. Click the Devices tab to display the Devices screen (see Figure 540).

Figure 540. Site Configuration Editor Devices Screen
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7. Click Create Non-Trane BACnet Device to display the Create New 
Non-Trane BACnet Device dialog box (see Figure 541). 

Figure 541. Create New Non-Trane Device Dialog Box

8. Type the name and the device ID for the BACnet device. 

9. Select the object type from the Object Types field. The default selec-
tion is All Types.

10. Click the Scan button to display a list of all the available objects in 
the non-Trane device. 

11. From the Available Objects list, select the objects that you want to 
view. Then, click the Add button to add the items to the Selected 
Objects list.

12. Click Okay to save the changes and return to the Devices tab.

13. Click the Communications tab and check the Disable Automatic 
Updates box (see Figure 542 on page 629). 

Note:

The device ID is provided by the device manufacturer. Each 
device on a network must have a unique device ID. Contact the 
manufacturer for instructions, if necessary.
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Figure 542. Disable Automatic Update Checkbox

14. To set up control priorities, go to “Setting Up Control Priorities” on 
page 630.

Offline Editing

When editing offline, you can add an object to a non-Trane device using 
the Manually Add New Objects fields.

To manually add new objects:

1. Type the object type, instance, and name of each object.

2. Click the Add button.

Note:

By checking this box, Tracer Summit will no longer scan non-
Trane BACnet devices for updated objects every 30 minutes. 
However, Tracer Summit will get updates from the non-Trane 
devices when objects are viewed in custom graphics or Objects 
and Properties.

Note:

If you manually add an object with the same type and instance 
of a device already in the Selected Objects list, the object will be 
replaced with the new name that you manually gave the object.
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Setting Up Control Priorities
Control priorities identify the levels at which Tracer Summit applications 
control an object. 

Each control priority name is mapped to a control application. You can 
change the default application for any control priority. You can also 
change the control class name for some control classes. 

Selecting Control Priority Defaults

1. From the Site Configuration editor, click the Control Priorities tab 
(see Figure 543).

Figure 543. Site Configuration Editor Control Priorities Screen

2. Click the Tracer Summit Defaults button or BACnet Defaults button 
to select a set of defaults. The default names display in the Control 
Priority Names list.

Note:

Be careful when modifying BACnet default applications. If you 
are using BACnet protocols to communicate with non-Trane 
devices, you must make sure the names align for each control 
class.
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Modifying the Control Application for a Class

1. From the Site Configuration editor, click the Control Priorities tab 
(see Figure 543 on page 630).

2. Click the name of the control class you wish to modify in the Control 
Priority Names list.

3. Click the name of the application you want to assign to the class in 
the Available Control Applications list.

4. Click the right arrow to assign the application. The application name 
displays in the Assigned Control Applications list.

5. To remove an application from the Assigned Control Applications list, 
click the name to highlight it. Then click the left arrow to remove the 
application.

Modifying the Name for a Priority Class

1. From the Site Configuration editor, click the Control Priorities tab 
(see Figure 543 on page 630).

2. Click the Control Class Names button to display the Control Class 
Names dialog box (see Figure 544).

Figure 544. Control Class Names Dialog Box

3. Click the field to the right of the control class number you wish to 
modify. The control class names that cannot be modified are unavail-
able.

4. When you are done making changes to the class names, click OK to 
close the dialog box.
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Providing Information to Other Systems
A non-Trane system can control and monitor Trane equipment. To set up 
communications to another system, create a BCU for the Trane device. If 
you are using an EIA-232 point-to-point) connection with the BMTW you 
must also create a modem object. The BMTX has an on-board EIA-232 
connection. Then create BACnet analog and binary input and output 
objects to reference Trane UCM properties.

After creating the BACnet input and output objects, you can print a list of 
BACnet objects that exist on the site. The non-Trane device manufacturer 
will use the list to configure the controlling device.

Trane provides listings (templates) of typical BACnet input/output points 
for Trane equipment. Please contact Trane for more information.

Communication Flow Between Devices

Figure 545 on page 633 illustrates the communication flow between 
Trane and non-Trane devices.
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Figure 545. BACnet Flow Diagram
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To set up Tracer Summit to provide information to other systems:

1. Install Trane device hardware, communication wiring, network cards, 
and software. (See the Tracer Summit Hardware and Software Instal-
lation guide for instructions).

2. Set up a site. (Follow the instructions in Chapter 6, “Configuring 
Tracer Summit BCU Sites.”)

3. From the Site Configuration editor, click the Devices tab (see 
Figure 546). 

Figure 546. Site Configuration Editor Devices Screen

4. Click Create Device to display the Create New Device dialog box (see 
Figure 547 on page 635).
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Figure 547. Create New BCU Dialog Box

5. Enter a name for the device in the Device Name field. Use up to 32 
characters.

6. Type a number in the Device ID field.

7. Type a number in the Network Number field. The default value is 1. 

Note:

All devices must have a unique device ID provided by the man-
ufacturer. Devices that share the same network must have 
unique device numbers. Contact the device manufacturer for 
instructions, if necessary.

Note:

Devices (BCUs and non-Trane devices) on a network must 
share a network number. When you have multiple networks 
(ARCNET, Ethernet, EIA-232) on a site, each network must 
have a unique network number. For example, if you have a 
BACnet interface using an EIA-232 connection between a BCU 
and another vendor’s gateway, then the BCU must have a dif-
ferent network number than the other vendor’s gateway.
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8. From the Panel Type list box, select the device type: Enhanced BCU 
(BMTX), modular BCU (BMTW) or BCU (BMTS). If the panel type is 
a modular BCU (BMTW), the Capacity Cards field is available. For 
high a capacity BCU, select 2. For a standard capacity BCU, select 1. 

The BMTX has an on-board EIA-232 connection that does not require 

configuration, skip the following steps for the BMTX.

9. To set up an EIA-232 connection, click Add Modem to display the Cre-
ate New Modem dialog box (see Figure 548). 

Figure 548. Create New Modem Dialog Box

10. Enter a name for the modem in the Modem Name field. Use up to 32 
characters. Assign a name that will help you identify the modem, 
such as BACnet Connection or EIA-232 Connection. 

11. Click OK to return to the Edit Devices screen.

12. To add a BCU I/O module to the site, see Chapter 18, “BCU Inputs 
and Outputs” for instructions. 

13. Click OK to display the Devices screen.

14. Click Save.

Note:

The BCU I/O module buttons are only selectable for Modular 
BCUs (BMTW)
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Configuring the Modem for an EIA-232 Connection

1. To configure the modem for an EIA-232 connection, from the Setup 
menu select Communications. Additional menu selections display.

2. Select BCU Modem. The Select BCU Modem dialog box displays (see 
Figure 549).

Figure 549. Select Modem Dialog Box

3. Click the name of the modem you created for the EIA-232 Connection. 

4. Click OK to display the Modem editor (see Figure 550).

Figure 550. BCU Modem Editor Status Screen

5. Click the Setup tab to display the Setup screen (see Figure 551 on 
page 638).

Note:

This section only applies to the BMTS and the BMTW. The 
BMTX is automatically set up.
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Figure 551. BCU Modem Editor Configuration Screen

6. Click the arrow to the right of the Connect By field to display a list of 
modem types.

7. Select Hardwired.

Defining Input/Output Points
1. Define a list of input/output reference points you will need. 

Use the Trane provided list of typical BACnet input/output points for 
Trane equipment to create your point list. 

2. Using the Input/Output editor (accessed through the Setup menu), 
create the analog inputs, analog outputs, binary inputs, or binary out-
puts you have defined. (For instructions, see Chapter 17, “Creating 
Input/Output Objects.”)

Note:

As a BACnet input or output object is created, a BACnet ID is 
automatically assigned to the object. Once you have created a 
BACnet input or output object, do not delete the object. The 
object address is only assigned once, and cannot be recreated 
after it is deleted.
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Running a Report of BACnet Objects 
1. From the Status menu, select Reports. The Select Report to View dia-

log box displays (see Figure 552).

Figure 552. Select Report to View Dialog Box

2. Click Standard Live to select a standard live report.

3. Click OK. The Select Standard Live Report dialog box displays (see 
Figure 553).

Figure 553. Select Standard Live Report Dialog Box

4. Click the arrow to the right of the Standard Report Type field to dis-
play a list of report types.

5. Click Site Reports to display a list of site reports in the Report Name 
field.

6. Click Site BACnet Report.

7. Click OK to display the Sort Report By dialog box (see Figure 554 on 
page 640).
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Figure 554. Sort Report By Dialog Box 

8. Click Device ID to sort the report by the device ID; click Name to sort 
the report by the device name.

9. Click OK to display the Site BACnet Report in the Report Viewer (see 
Figure 555).

Figure 555. Site BACnet Report

10. To save the report in the default reports folder, click Save. For more 
information on saving reports, refer to the Tracer Summit Daily Oper-
ations guide.
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11. To print the report on a printer, click Print to display the Print dialog 
box (see Figure 556).

Figure 556. Print Dialog Box

12. Click OK to print the report. For instructions on changing the default 
Print dialog box settings, see your Microsoft Windows or printer docu-
mentation.

13. To print the report to a file, click the Print button in the Report 
Viewer.

14. Click to select the Print to file check box.

15. Click OK to print to file. The print file will be saved in the default 
report folder and will have a .PS file name extension. 

16. Click Close to exit the Report Viewer.

Note:

Some manufacturers can input BACnet object data directly to 
their system from an electronic file. You can use the Print to file 
field in the Print dialog box to create an electronic file for this 
purpose.
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Chapter 38

Restoring into the Tracer 

Summit Workstation

After you have backed up site database files, Custom Programming Lan-
guage (CPL) files, graphics files and report files, you can restore these 
files into the original PC workstation or a new PC workstation. For more 
information on backing up Tracer Summit files, refer to the Tracer Sum-
mit Daily Operations guide.

Restoring a Site and CPL Files
You can restore backup site files and Custom Programming Language 
(CPL) files to the original PC Workstation or a new PC Workstation.

To restore a site and CPL files:

1. From the Tools menu, select Restore. Additional items display.

2. Select Site. The Restore Location dialog box displays (see Figure 557). 
The Restore File Path field displays the default path and name of the 
backup file to be restored.

Figure 557. Site Restore Dialog Box

Note:

If you need help restoring a site, click Tutorial to access The 
Tracer Summit Operations Tutorial (tutorial button not 
shown).
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3. To change the Restore File Path, click Browse. The Select File to 
Restore From dialog box displays (see Figure 558).

Figure 558. Select File to Restore From Dialog Box

4. Select the directory where the site backup file is saved from the file 
list. The file list displays previously saved backup files.

5. Select the file name to restore from the backup file list.

6. Click Open. The Site Restore dialog box displays again. The new file 
name and path display in the Restore File Path field. 

7. Select the specific site or sites to be restored from the Available 
Site(s) list box. 

8. Use Add or Add All to copy the selected sites to the Selected Sites 
window. Click Remove or Remove All to remove the sites from the 
Selected Sites window.

9. Click Next to display the Restore CPL dialog box (see Figure 559 on 
page 645).
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Figure 559. Restore CPL Dialog Box

10. To change the source path for the CPL backup files, click Browse next 
to the CPL Source Path field. The Browse for Folder dialog box dis-
plays.

11. Select a CPL source path from the selection window.

12. Click OK. The Restore CPL dialog box displays the selected CPL files. 

13. To change the location to restore CPL files to, click Browse next to the 
CPL Destination Path field. The Browse for Folder dialog box dis-
plays.

14. Select a CPL destination path.

15. Click OK. The Restore CPL dialog box displays. 

16. Select the CPL file(s) to be restored from the Available CPL File(s) 
list box.

17. Click Add or Add All to copy the selected CPL files or sites to the 
Selected CPL Files list box. Click Remove or Remove All to remove 
the site from the Selected CPL Files list box. 

18. Click Restore to begin the restoring process. The Site Restore dialog 
box displays. 

The selected site database backup file and selected CPL files are 
restored to the locations you selected.

Note:

To over write all selected locations, check the Overwrite all 
selected sites check box. Any sites that fail are listed at the end 
of the restore process.
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Restoring Global Graphics
You can restore backup global graphic files and expanded message files to 
the original PC Workstation or a new PC Workstation. 

To restore global graphics:

1. From the Tools menu, select Restore. Additional items display.

2. Select Graphics. The Restore Graphic dialog box displays (see 
Figure 560).

Figure 560. Restore Graphic (Global Graphics) Dialog Box

3. To change the source path of the graphics, click Browse. The Browse 
for Folder dialog box displays.

4. Select a file location path.

5. Click OK. The Restore Graphic dialog box displays.

6. Click Global Graphics to restore the graphics that are common to 
multiple sites.

7. Select the graphics to be restored from the Details window. Click 
Select All to select all global graphics.

8. Click OK to restore the selected graphics. 
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Restoring Site Graphics
You can restore backup site graphic files and expanded message files to 
the original PC workstation or a new PC workstation. 

To restore a site graphic:

1. From the Tools menu, select Restore. Additional items display.

2. Select Graphics. The Restore Graphic dialog box displays (see 
Figure 561).

Figure 561. Restore Graphic (Site Graphics) Dialog Box

3. To change the path where backup graphics are located, click Browse. 
The Browse for Folder dialog box displays.

4. Select the directory location.

5. Click OK. The Restore Graphic dialog box displays.

6. Click Site Graphics to restore graphics specific to a site.

7. Select the site to restore from the drop-down list.

8. Select the graphics to be restored from the Details window. Click 
Select All to select all site graphics.

Note:

The restore function for site graphics is required only for cre-
ation of a node on the Navigation Tree. Once this node is cre-
ated, it is no longer necessary (or possible) to restore. The 
updated files (.GIF, .BMP, .JPG, .HTM, .AVI) can be copied via 
Windows Explorer to the correct directory.
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9. Click OK to restore the selected graphics. 

Restoring a Report
You can restore backup report files to the original PC Workstation or a 
new PC Workstation. 

To restore a report:

1. From the Tools menu, select Restore. Additional items display.

2. Select Reports. The Select Report Backup File dialog box displays (see 
Figure 562).

Figure 562. Select Report Backup File Dialog Box

3. Select the file location of the backup report from the Look In field.

4. Select the report file to restore.

5. Click Open to restore the selected report. You are returned to the 
Tracer Summit main window.

6. To view the restored reports, click Reports.
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Restoring Operator Display Custom 

Screens
Use the following procedures to restore a custom screen.

To restore custom screens

1. From the Tools menu, select Restore. A submenu appears.

2. Select Custom Screen from the Restore submenu. The Select File to 
restore From dialog box appears.

3. Select the file that contains the custom screens.

4. Click OK. The Restore Custom Screens dialog box appears (see 
Figure 563).

Figure 563. Restore Custom Screen Dialog Box

5. Click the Available Sites arrow to select the site whose custom 
screens you want to restore.

6. Select the BCU from the Available BCUs list. The selected BCU dis-
plays in the Available BCUs field.

7. In the Custom Screens list, select the custom screens that you want to 
restore.

8. Click Add to add the screens to the Selected Custom Screens list (see 
Figure 563).

9. Click OK. The Tracer Summit software restores the selected custom 
screens to the selected BCU.
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Restoring a Tracer 100 Site
Use the following procedures to restore a Tracer 100 site.

To Restore Into an Empty Tracer Summit Database

When you first configure Tracer Summit workstation, the database is 
empty. 

◆ To restore a Tracer 100 site into an empty database, follow the proce-
dure described in Chapter 6, “Restoring a Site from the Site Creation 
Wizard.”

Restoring Into a Non-empty Database

This procedure assumes that a backup file of the Tracer 100 site was 
already made. For more information about backing up a site, refer to the 
Daily Operations guide. This backup file is a *.BDB backup file, not a 
*.SAV file backup.

◆ Perform the steps described in “Restoring a Site and CPL Files” on 
page 643.
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Chapter 39

Deleting Objects and Sites

From time to time you may need to delete an object or a site from the 
database because:

• An object such as analog or binary input was created for troubleshoot-
ing purposes

• An object was placed in a database by mistake
• The database has grown and you want to reduce the number of 

objects in it
• A site is no longer needed

Although you can delete either an object or a site, the procedure has some 
built-in safeguards:

• If you are trying to delete an object that is referenced by other objects, 
the references to the object you want to delete must be replaced with 
references to other objects. 

• If any user is logged on to the site you want to delete, they must log 
off before you can delete the site. You cannot be logged onto the site 
you want to delete. 

Note:

Object editing should not be done while a deletion is in process 
(other than editing references to a object you want to delete).

Note:

Only users with security access can delete objects or sites. For 
more information, see Chapter 9, “Setting Up Security—Tracer 
Summit System.”
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Deleting Objects
The basic steps in deleting an object are:

1. Select the objects you want to delete (see “Selecting Objects to Delete” 
on page 652).

2. Search to determine if other objects are dependent on (reference) that 
object (see “Searching for Referencers” on page 653). 

3. If other objects are referencing the object you want to delete, you 
must edit those references (see “Opening and Editing the Referencing 
Object Editor” on page 654). If no other objects reference the object 
you want to delete, go to the next step. 

4. Delete the objects (see “Deleting the Objects” on page 657).

Selecting Objects to Delete

1. From the Tools menu, select Delete Object. Tracer Summit displays 
the Delete Objects dialog box (see Figure 564).

Figure 564. Delete Objects Dialog Box

2. Make a selection:

• To delete objects (UCMs, applications, input/output devices, 
graphics, and so on) from the site you are currently logged onto, 
click Current Site Objects.

• To delete graphics that have been saved as global, click Global 
Site Objects.

3. Click OK. The Select Object(s) to Delete dialog box displays with a list 
of the object types and all instances of that object (see Figure 565 on 
page 653).
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Figure 565. Select Object(s) to Delete Dialog Box

4. In the Select Object Type list box, scroll to the type of object you want 
to delete. All of the objects of that type are displayed by name in the 
Available Names list box.

5. Click on the names of the objects you plan to delete in the Available 
Names list.

6. Click Add to add the selected names to the Selected Object Names 
list.

7. Use Add, Add All, Remove, and Remove All to change the Selected 
Object Names list. If you want to delete all objects of the same type, 
use Add All. If you want to delete several—but not all—objects of the 
same type, highlight and add them one at a time.

8. Click Search. (The Search button is available only if you have selected 
at least one item to delete.)

9. Continue to the next section.

Searching for Referencers

After you click Search at the Select Object(s) to Delete dialog box, Tracer 
Summit searches for objects that reference the object you want to delete 
and displays the Search Results screen (see Figure 566 on page 654).

Search results for objects are divided into two types:

• Objects that have no references display in the Objects That Can Be 
Deleted list box.

• Objects that have other objects referencing them display in the 
Objects That Cannot Be Deleted list box.
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Figure 566. Delete Objects Search Results Screen

If there are objects that you want to delete listed in Objects That Cannot 
Be Deleted list box, go to the section “Opening and Editing the Referenc-
ing Object Editor” on page 654. 

Otherwise, finish deleting the objects (proceed to the section “Deleting the 
Objects” on page 657).

Opening and Editing the Referencing Object Editor

To complete the process of deleting the object listed in the Objects That 
Cannot Be Deleted list box, you must edit the other objects that reference 
this object. These other objects are listed in the Object Is Referenced By 
list box. This box displays the object name, the object or objects that have 
references to the one you want to delete, and the property whose refer-
ence must be changed if you are to delete the object (see Figure 567 on 
page 655).
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Figure 567. Delete Objects Search Results Screen

To open and edit the referencing object editor:

1. Double click on the object you want to edit in the Object is Referenced 
By list box. The editor for that object displays. The initial screen is 
the Status screen. The Delete Object Search Results screen remains 
open behind the object’s editor window.

2. Click the tab that contains the referencer edit control fields you want 
to change.
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3. On the new screen, click the referencer button in the appropriate ref-
erencer edit control field (see Figure 568).

Figure 568. Referencer Edit Control Field 

Clicking the referencer button displays the Select Property Reference 
dialog box (see Figure 569). The type, name, and specific property 
defining the object you want to delete are displayed.

Figure 569. Select Property Reference Dialog Box 

4. In the Select Property Reference dialog box, you must choose a differ-
ent object to replace the object you want to delete. Select a new object 
with the Type or Name fields, then select the property you want that 
is associated with that object.

5. Click OK. You return to the referencing object’s editor window.

6. If there are referencer changes in any other editor screen of this 
object, click the tab for that screen.

7. Make the changes by repeating steps 3-6 for each property listed in 
the Objects Is Referenced By list box, until no more fields reference 
the object you wish to delete.

8. Click Save to save the changes in the object editor.

9. Click Close to close the object editor window and return to the Delete 
Objects Search Results screen. The object for which you have changed 
the references will now be able to be deleted and will be displayed in 
the Objects That Can Be Deleted list box.

10. Proceed to the next section.

Referencer 
button
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Deleting the Objects 

If the search results show objects in the Objects That Can Be Deleted list 
box, the Delete Object button on the Delete Objects Search Results screen 
is active (see Figure 566 on page 654).

To delete objects in the Objects That Can Be Deleted list box:

1. Click Delete Object. A message tells you that all editors will be closed 
(see Figure 570).

Figure 570. All Editors Will Be Closed Message

2. Click Yes. For each object listed in the Objects That Can Be Deleted 
box, a confirmation prompt displays (see Figure 571).

Figure 571. Confirm Delete Object Dialog Box

3. Click Yes to All to continue the deletion process. All of the objects 
listed in the Objects That Can Be Deleted list box are removed from 
the database.

4. Click Finish. You are returned to the Tracer Summit main screen.
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Deleting a Site
The procedure for deleting sites is similar to the procedure for deleting 
objects. The main difference is that Tracer Summit searches for security 
rights that allow you to delete a site, not for references to the objects that 
you want to delete.

To delete a site, you must follow these rules:

• You must be logged onto a site in order to delete another site.
• If only one site is available, you cannot delete a site.
• You cannot delete the site you are logged onto (see the next section for 

steps in how to log off of the current site).

IMPORTANT
Deleting a site removes all graphics. If you might want the data again, 

then back up the site before deleting it.

Deleting a Site You Are Currently Logged Onto

If you want to delete a site you are currently logged onto, you must log off 
and log onto another site. The steps for logging onto a different site are:

1. From the Connect menu, select Log On.

2. Select another site to log onto.

3. Proceed with the steps to delete a site.

Deleting a Site You Are Not Logged Onto

1. From the Tools menu, select Delete Object. The Delete Objects dialog 
box displays (see Figure 572).

Figure 572. Delete Objects Dialog Box

2. Click Delete Entire Site.

Note:

Deleting a site removes it from the PC Workstation, but not 
from the BCUs.
658 BMTX-SVP01B-EN



Deleting a Site
3. Click OK. The Select Site(s) to Delete dialog box is displayed. The list 
of sites is shown in the Available Sites list box (see Figure 573).

Figure 573. Select Site(s) to Delete Dialog Box

4. Click the sites you would like to delete.

5. Use Add or Add All to place the sites you want to delete into the 
Selected Sites list box. You can use Remove and Remove All to move 
sites back to the Available Sites list box if you need to.

6. When all the sites you wish to delete are listed in the Selected Sites 
list box, click Search. Tracer Summit displays the results of the 
search for sites to delete process on the Search Results screen (see 
Figure 574 on page 660).
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Figure 574. Site Deletion Search Results Screen

The Search Results screen shows:

• The Site(s) That Can Be Deleted list box listing sites that have no 
users logged on to the system and are available for deleting. 
When there are sites in this list box, the Delete Object button 
becomes active.

• The Site(s) That Cannot Be Deleted list box, which contains sites 
that currently have users logged on and cannot be deleted.

7. Click Delete Object. A message tells you that all editors will be closed 
(see Figure 575 on page 661).

Note:

Sites that have users logged on cannot be deleted. If you are 
currently logged on to the site you want to delete, it is unavail-
able for deleting. See “Deleting a Site You Are Currently 
Logged Onto” on page 658.
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Figure 575. All Editors Will Be Closed Message

8. Click Yes. For each site listed in the Site(s) That Can Be Deleted box, 
a confirmation prompt displays (see Figure 576).

Figure 576. Confirm Delete Site Dialog Box

9. Click Yes if you want to continue with the deletion. The site and all 
associated objects, including graphics, are removed from the data-
base.
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Chapter 40

Resetting a Device

The Tracer Summit System allows you to reset a BCU at four different 
levels. In order of least to greatest impact on the BCU, the reset levels 
are:

1. Reset
2. Clear BCU RAM and Reset
3. Clear Database, RAM, and Reset
4. Clear Code, Database, RAM, and Reset
For detailed information about reset levels, see Table 30 on page 667.

The reset procedures are typically done by selecting BCU Reset/Restore 
from the Tools menu in Tracer Summit. 

Software Method to Reset BCU
1. From the Tools menu, select BCU Reset/Restore.

2. The BCU Reset/Restore dialog box displays (see Figure 577).

Figure 577. BCU Reset/Restore Dialog Box

3. Click the BCUs you wish to reset in the Choose BCUs to Reset box. To 
select all the BCUs, click Select All. To clear the current selections, 
click Select None.

4. Click the desired level of reset in the Choose BCU Reset Level field.
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5. If you select Clear Code, Database, RAM and Reset, click the arrow to 
the right of the Code Version field to select the version of code you 
wish to download into the BCUs.

6. Click Reset to reset the selected BCUs. The Reset/Restore dialog box 
closes, and you return to the previous screen.

Hardware Method for Resetting BCU
All of the “Clear. . . Reset” procedures can also be done at the BCU as 
described in the following subsections.

Reset
To reset, cycle power to the BCU by unplugging and re-plugging the 
24 Vac power connector at the top of the termination board.

Clear BCU RAM and Reset
The BCU normally preserves the content of RAM through power failure. 
RAM contains the current status of all BCU object trend data, events, and 
alarms. In most cases, this is desirable. However, there are circumstances 
in which you may need to clear RAM. This is normally done from the PC 
Workstation, as described in this guide. RAM can also be cleared at the 
BCU as follows:

1. Turn off power to the BCU.

2. Set all DIP switches to on.

3. Turn on power.

4. The LED display should show 8, then 7, and then E with the decimal 
point flashing.

CAUTION
If you wait longer than 10 seconds, the BCU code and database may be 

cleared as well as its RAM.

5. As soon as the LED display shows E with the decimal point flashing, 
turn off power.

6. Set the DIP switch to its proper position.

7. Turn on power. The LED display should show the following sequence:

8, 7, 6, 4, 3, 2, H, –, “dancing dash”
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Clear Database, RAM, and Reset
Database contains the user programmed data, which consists of all BCU 
objects, such as areas, VAVs, I/O, UCMs, trends, CPL, etc. 

In most cases, you will perform this operation from the PC Workstation, 
as described in this guide. However, this can also be done at the BCU as 
follows:

1. Change the DIP switch S1 position 8 to Off.

2. The LED display will show the following sequence: 
J, 8, 7, 6, 4, 3, 2, H, –, –P

3. Change DIP switch S1 position 8 back to on.

4. The LED display will show the following sequence: 
J, 8, 7, 6, 4, 3, 2, H, –, –P, Pd, “dancing dash”

When the BCU has code and detects a change in DIP switches at S1, the 
BCU clears the current database and looks for a PC Workstation from 
which to download a database that matches the new device ID (corre-
sponding to the settings at DIP switch S1).

Clear Code, Database, RAM, and Reset
Code consists of the BCU image software, which is similar to the operat-
ing system in a PC. 

In most cases, you will force a BCU to accept new code from the PC Work-
station, as described in this chapter. However, this can also be done at the 
BCU as follows: 

1. Turn off power to the BCU.

2. Set all DIP switches to on.

3. Turn on power. The LED should display the following sequence:

8, 7, E (with decimal point flashing for about 10 seconds), 5, 4, 3, 2, –, 
EC, Cd, –H, “dancing dash”

4. Turn off power and set the DIP switch to its proper position.

5. Turn on power and observe the following sequence: 8, 7, 6, 5, 4, 3, 2, 1, 
-P,Pd, “dancing dash.”

Note:

You must have a PC Workstation connected, and that worksta-
tion must contain the appropriate version of BCU code. If the 
PC Workstation is not connected, the procedure will have no 
effect on the BCU.
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Clear Comm5 database
In a BMTX BCU (or a high-capacity BMTW BCU), a Comm5 database 
will be cleared if a BACnet database site name is loaded that does not 
match the Comm5 database site name. To force the BCU to clear its 
Comm5 database, perform the following actions:

1. Create dummy site with a different name than the existing Comm5 
database in the BCU.

2. If the BCU is connected, you can clear the BACnet database from the 
BCU by using the Tools menu and BCU Reset/Restore. Or you can 
clear the database by using the DIP switches.

3. Immediately disconnect (either unplug Ethernet or use the Discon-
nect icon) so BACnet database does not automatically reload.

4. Select dummy site.

5. Reconnect to the BCU.

6. Download the dummy site to the BCU.

7. Once the BCU begins normal operation, you can clear the BACnet 
database again from the BCU (using either the Tools menu and BCU 
Reset/Restore, or the DIP switches).

8. Disconnect the BCU from the PC Workstation so the dummy data-
base is not automatically sent again.

9. Select the real site.

10. Establish connection again to the BCU to download the real BACnet 
database.

11. The Comm5 database will be cleared and will need to be recon-
structed. 

If the BACnet database already has assigned Neuron IDs, from the 
main menu select Setup, and then Site Configuration. Choose the 
Device tab and click the Assign Neuron ID button. Install the Comm5 
link as described in “Comm5 Links” on page 93.  
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Table 30. Reset level descriptions for the BMTX BCU 

BCU reset/restore command Reasons to reset Notes

Reset (same as power cycle)

• Resets the processor on the selected 
BCU

• Initialize modem

• Initialize communication links

• Temporary loss of communication with 
the BCU

Clear RAM and reset

• Clears the RAM from the BCU and resets 
the BCU processor

• If the BCU has a database intact, it auto-
matically reconstructs the RAM as 
needed and resumed processing

• Update members in VAS (not applicable 
for Comm5 VAS)

Same as reset plus:

• Loss of operator overrides. Values 
return to Tracer Summit defaults

• Loss of pending alarms

• No loss of Comm5 database

Clear database, RAM, and reset

• Clears both the database and RAM from 
the selected BCU and resets the BCU 
processor. 
Note: To prevent download of database 
from secondary workstations, discon-
nect them from LAN before proceeding.

• Clear the BCU database using the BCU 
reset/restore command or using DIP 
switch method.

• Then disconnect BCU from the LAN 
either by removing the LAN cable or 
using the Disconnect button on the Tool-
bar.

• Restore the new database to the PC 
workstation.

• Reconnect the BCU.

• Database will be automatically sent to 
the BCU.

• Restore a backup database from the PC 
workstation to the BCU.

• Replace a database in the BCU.

Same as Clear RAM and Reset plus:

• Takes longer to regain communication 
with the BCU and UCMs than a clear 
RAM or reset does.

• If database is restoring from a backup of
the site, current trend and calculation 
information is lost and reverts to infor-
mation stored in backup.

Clear code, database, RAM, and reset

• Clears all memory—code (image), data-
base, and RAM—from the BCU and 
resets the BCU processor.

• If the PC workstation is online, it auto-
matically downloads the code.

• Once the code is successfully down-
loaded, the PC workstation automati-
cally downloads a new database.

• Required when upgrading Tracer Sum-
mit BCU image

Same as Clear Database, RAM, and Reset 
plus:

• Code will load to a BCU that does not 
have an address.

• If a database with a different address or 
site name is loaded to the BCU, the BCU
Comm5 database will be cleared.

Clear Comm5 database

• Happens automatically when site name 
in BCU changes or BCU address 
changes.

• If the PC workstation is online, it auto-
matically downloads the code.

• Once the code is successfully down-
loaded, the PC workstation automati-
cally downloads a new database.

• Used for troubleshooting problem links • Cannot be done from a PC Workstation 
BCU Reset/Restore menu.

Note: For detailed instructions for the DIP switch method, refer to “Hardware Method for Resetting BCU” on page 664.
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Restoring a Tracer 100 Panel
Use the following procedure to restore a Tracer 100 site. There are sev-
eral things you should remember before performing this procedure:

• The procedure only applies to Tracer 100 sites.
• You must be logged on with a username that has level 1 or level 2 

security access.
• You must have created a .SAV file. You can create a .SAV file using 

other Trane products such as Tracer Access, BMN, or PCL Edit. You 
can also use Tracer Summit’s Task Manager (see “Specifying Where 
to Save a Backup File” on page 229) or the Backup a Remote applica-
tion (see “Creating .SAV files for Tracer 100 Panels” on page 412).

• You can only restore .SAV files into panels for which they were 
intended. In other words, you cannot restore a .SAV file from a Tracer 
100i into a Tracer 100L, nor can you restore a .SAV file from Tracer 
100 panel version 14.x, for example, into a Tracer 100 panel version 
15.x.

• After you restore a Tracer 100 panel, the building control for the 
panel is turned off. After the restore, you must turn it back on 
through terminal emulation.

To restore a Tracer 100 panel:

1. From the Tools menu, select Restore. A submenu appears.

2. Select Remote. The Restore a Remote dialog box appears (see 
Figure 578).

Figure 578. Restore a Remote Dialog Box

When you restore a Tracer 100 site with several panels, the Remote 
Unit to Restore list displays all of the site panels. The list is sorted by 
ascending unit numbers, with unit 1 as the Tracer 100 COP.

3. Click the Browse button to find the .SAV file in the workstation data-
base.

4. From the Remote Unit to Restore list, select the panel that you want 
to restore.

5. Click OK.

• If you are not currently connected to the site, Tracer Summit 
automatically connects to the panel. The Restore in Progress dia-
log box appears. (The restore process can last as long as 15 min-
utes.)
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• If Tracer Summit automatically connects and restores the panel, 
at the end of the process a dialog box appears. This dialog box 
asks you whether you want to start a terminal emulation session 
with the panel you just restored. Click OK.

6. Turn the building control back on.
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A Alarm
An audible or visual signal from a Building Management System that 
warns of an abnormal and critical operating condition.

Analog
Data represented as a variable value, such as temperature control or flow.

Analog input (AIP)
A varying voltage, current, or resistive signal that can be converted to 
engineering units of temperature, pressure, humidity, wattage, etc.

Analog output (AOP)
An analog output is a varying voltage or current signal used to change the 
position of an external device such as an electric valve. 

Application
A specific program or task to which a computer solution can be applied.

Application program
A computer program designed to meet specific user needs, such as a pro-
gram that controls or monitors a process. Examples: Time of Day Sched-
uling, Chiller Plant Control.

Array
A list of elements. In the case of Chiller Plant Control, a list of identical 
properties used for each chiller identified as a member of the chiller 
plant.

Auto refresh
Ability to view events in the Event Log viewer without manual interven-
tion. Any events normally seen by pushing the manual refresh button in 
Tracer Summit version 12 can be seen automatically if auto refreshing is 
enabled.

Auto Save
Process of saving the event log using the workstation Task Manager.
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B Backup copy
One or more files that are copied onto a storage medium for safekeeping 
in case the original gets damaged or lost.

BACnet
A standard communication protocol developed by the American Society of 
Heating, Refrigeration, and Air Conditioning Engineers. It defines how 
information will be packaged for transportation between building auto-
mation system (BAS) vendors.

BCU-ELO
Building Control Unit-Event Log Object.

BCU
Building control unit.

BCU Operator Display Object List
List of objects/properties existing at a single site that have been selected 
for view at a BCU operator display. The Operator Display Setup editor is 
used to define this list.

BCU Operator Display Override List
List of objects/properties existing at a single site that have been selected 
to be allowed to be overridden at a BCU operator display. The Operator 
Display Setup editor is used to define this list.

BCU sizing tool
A Microsoft Excel spreadsheet available in the TraneNet information sys-
tem that allows the BAS engineer to determine the number of building 
control units (BCUs) that are required at a site.

Billing period
The period of time between consecutive readings of the utility company 
meters for billing purposes.

Binary
• A number system with only two digits, 0 and 1, in which each symbol 

represents a decimal power of two; or
• Any system that has only two possible states or levels, such as a 

switch that is either on or off. (On is represented as 1 and off is repre-
sented as 0.); or

• The presence of voltage (equivalent to 1) or absence of voltage (equiv-
alent of 0) in a computer circuit.

Binary input (BIP)
An ON/OFF input to the processor to indicate status. Some typical exam-
ples are flow switches, limit switches, or other contacts.
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Binary output (BOP)
An ON/OFF control output from the processor.

Building control unit (BCU)
An intelligent field panel that communicates with multiple Trane unit 
control modules (UCMs). 

Building automation system (BAS) or 
Building management system (BMS)
A combination of controllers and other software products that communi-
cate with and control various mechanical systems to enable building 
management. These include the heating, ventilation, and air conditioning 
systems as well as lighting systems access control, and miscellaneous 
other devices within a building.

Building Management Network (BMN)
A DOS-based product for managing multiple Tracer and Tracker sites.

C Calculated analog
A term synonymous with point type 11. Calculated analogs are logical or 
software analog points that are similar to analog output and analog 
inputs, except they are not associated with hardware. Calculated analogs 
can be used in most Tracer 100 programs as analog inputs or outputs. 
Calculated analogs are most frequently used as setpoints for direct digital 
control (DDC) loops, and various types of ICS equipment such as SCP, 
AHU, and TCM, etc. These calculated analog setpoints can be set by the 
operator or calculated using the process control language (PCL) program.

Calculated binary
A term synonymous with point type 08. Calculated binaries are logical or 
software binary points that are similar to binary outputs, except they are 
not associated with hardware. Calculated binaries can be controlled by 
any Tracer Building Control program, just like binary outputs (point type 
05). You can use the on/off status of calculated binaries in other Tracer 
Summit programs in place of binary inputs or binary outputs.

Capacity
The maximum output of the equipment. For example, “The chiller has a 
capacity of 800 tons.”

CenTraVac
Trane’s registered name for the line of hermetic centrifugal refrigeration 
machines that provide chilled water for comfort or industrial water cool-
ing installations. The CenTraVac chiller name has also been applied to 
include certain models of Trane’s helical rotary chiller.
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Chiller plant control
Tracer Summit application that allows the operator to optimally coordi-
nate multiple chillers and their related equipment to supply cold water to 
the system.

Chiller sequencing
An integral part of the chiller plant control that sequences and automati-
cally rotates up to six chillers and their associated pumps to optimize 
individual chiller runtime and system performance.

Code
A software program, running in the BCU, equivalent to the operating sys-
tem of a personal computer. It controls the physical operation of the BCU. It 
is different from the CPL code that a technician would write.

Communication link
A set of wires connected from one device to another that is used to trans-
mit information between the devices. This link is typically a twisted pair 
of wires for Trane building management systems.

Configuration
The functional arrangement of a system. Usually set by computer inter-
face or DIP switch settings.

Constant volume system
Air-distribution system that keeps the volume of air supplied to a system 
constant to maintain acceptable conditions. 

Context object
A UCM or an application object defined when a user launches a graphic 
from the navigation tree, a graphic target, or from the UCM or applica-
tion editor.

COP Tracer
Communications Processor. A term applied to the lead Tracer 100 Series 
panel in a unit-to-unit configuration. The COP panel uses address 1. 
Communicating with unit-to-unit Tracer 100 panels can only occur as a 
pass-through of the COP Tracer. The communications baud rate is limited 
to 1200 baud.

Custom Programming Language (CPL)
Language used in Tracer Summit to write routines to accommodate con-
trol strategies. Routines are used to sequence equipment, calculate set-
points and values, and perform shutdown sequences. 

Custom graphic
• A hard-coded graphic created by a user in Tracer Summit; or
674 BMTX-SVP01B-EN



Glossary
• A standard graphic (template) that has been modified; or
• A site graphic available only to a specific site.

Custom screen 
An operator display screen created by an installer/programmer. It always 
has a Home button and might include a monochrome bitmap, data items, 
and custom navigation buttons.

D DAC
Discharge Air Controller profile.

Database
A computer file that contains all site-specific information used by a BCU to 
control site operation. This file is stored in the PC Workstation and in indi-
vidual BCUs on the network. In the PC Workstation, the file is named sum-
mit.mdb and is located in C:\Program Files\Tracer Summit\Database 
directory.

Demand limiting
A function that reduces electrical demand by measuring incoming electri-
cal power and either turning off specified loads or adjusting temperature 
setpoints to keep energy usage below a prescribed level during the 
demand interval.

Device
Computer hardware that performs some specific function. Input devices 
such as a keyboard are used to get information into the CPU. Output 
devices, such as a printer, are used to take information out of a computer 
in some usable form. Input/output devices are able to perform both input 
and output of information.

Diagnostic
A program that checks the operation of a device board or other component 
for malfunctions and errors and reports its findings. 

Diagnostic report
A form of standard live report for displaying diagnostics from the active 
UCM status data location within Tracer 100 and Tracker panels. For 
BCU sites, the upload is from UCMs and analog input and binary input 
objects.

DIP switches
Configuration switches of various components of the building manage-
ment system. Placing each individual DIP switch either on or off config-
ures the address and the function of the miscellaneous control 
components of the building management system.
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Direct digital control (DDC)
A higher level of programming used by building management systems to 
control variable outputs, such as valves or actuators. In industry, DDC 
means direct control by a microprocessor controller, with no intermediate 
devices.

Discovery
The process of finding all online controllers on a Comm5 link and display-
ing their Neuron IDs and Location Labels.

Display
In this document, the term display is used to refer to the touchscreen dis-
play device. 

E Economizer control
The opening or closing of various HVAC dampers to cool a building with 
outside air, usually when the outside air is 40ºF to 65ºF.

EEPROM
Electrically erasable programmable read-only memory. An electronic chip 
that can store information such as control set points, be reprogrammed in 
the field, and maintain its memory during a power loss.

EIA-232
Interface standard used for communications between peripheral devices 
and energy management systems.

E-mail profile
A group of settings that define how the mail server is set up for a particu-
lar user. For example, a profile may include access to a mailbox on 
Microsoft Exchange Server and specify that the Outlook Address Book 
appears in the Address Book dialog box.

E-mail recipient
In message forwarding, just an e-mail address. A forwarded alarm mes-
sage can be retrieved by a person using a client-side e-mail program such 
as Microsoft Outlook or an e-mail-supported pager service provider, or 
both.

Ethernet
Networking standards that transmit data at 10 Mbps using a specified 
protocol. Ethernet is a popular LAN technology.

Event log
A listing of events such as alarms and control actions that can be viewed 
by the building management system operator.
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Event
Generated by an alarm, a diagnostic, a user operation such as controlling 
a point or object, logging on/off, or acknowledging alarms. Typically, an 
event turns into an alarm if it has been set up to beep and/or require 
acknowledgement.From the point of view of the user, several types of 
inputs to the control system generate an event.

Extranet
Proprietary Internet site for Trane personnel to access when not able to 
get to TraneNet.

F Filtering
Filtering is used to display only the rows of events that meet user-speci-
fied criteria. In other words, rows that do not match the criteria are elim-
inated from the displayed list.

G Global change
A mechanism through which a user can change the setup of many objects 
of the same type in one action, rather than having to open every object to 
make the change.

Global graphic
A graphic that can be used to display information for any site. A graphic 
object is created in the system site and is available for use by all sites con-
nected to the PC Workstation.

Global objects
Includes the workstation modem, global graphic, keyboard macros, group 
security, group configuration, and message forwarding.

Graphic
A compilation of Summit-supplied information and images that form a 
display of information on the PC. A graphic requires a graphic object in 
the database, an HTML file, and one or more image files to be in a specific 
file structure under the \Graphics subdirectory in Tracer Summit.

Graphics can be displayed from the navigation tree, from a UCM editor, 
from a graphic target field, or from the main menu. 

Group
• An organization of one or more devices under a single name; or
• A collection of sites or groups in the Tracer Summit database that 

exist as an object in the system. The user can perform an action on a 
group, which in turn will propagate that action to every site or group 
of sites that belongs to the group
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H Hard-coded graphic
A graphic that contains no template fields. All the information that is 
needed to display the data in the fields on the graphic is stored in the 
HTML file for the graphic. This graphic does not require a context to dis-
play its information in the graphic fields. It can appear on the navigation 
tree without having to be assigned by the navigation tree editor.

HTML file
A file that is written in Hypertext Markup Language, a standard coding 
language used to create HyperText documents for use on the World Wide 
Web or an intranet network. A file of this type is required for a graphic 
object to be displayed. The file must be in the \Graphics directory under 
the standard, custom, or site name subdirectories. The Tracer Summit 
Graphics Editor creates the file along with the graphic object.

Information maintained in the file includes all graphic fields (types, prop-
erties, positions, size, and order of display) and image references (names, 
type, position, size, and order of display). The file also keeps the necessary 
information from the graphic object to take the object from one PC Work-
station to another. This file cannot be used in a Web Browser to display 
Tracer Summit information.

HVAC
Heating, ventilating, and air conditioning. Building mechanical system 
equipment.

I Image
File used by a graphic to display a photo or picture.

Internet service provider (ISP)
Services such as Microsoft Network, AOL, Compuserve, etc.

L LAN
Local Area Network

LCD
Liquid crystal display. The display screen that is an integral part of the 
operator display.

Level 0
Security level at which the user can view the grouping structure from the 
Group Setup dialog box but cannot access grouping functionality in Glo-
bal Changes, Task Manager, or Message Forwarding. User cannot access 
Group Security.

Level 1
Security level at which the user can view the grouping structure from the 
Group Setup dialog box but cannot edit group setup. User can access 
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grouping functionality in Global Changes, Task Manager and Message 
Forwarding. User cannot access Group Security.

Level 2
Users have full group access. They can access and edit group security and 
group setup. They can access grouping functionality in Global Changes, 
Task Manager, and Message Forwarding.
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M Macro 
A key that is set up by the user to execute often-used keystroke sequences 
on the PC.

MAPI
Messaging Application Programming Interface. A messaging architecture 
and a client interface component for applications such as electronic mail, 
scheduling, calendaring, and document management. As a messaging 
architecture, MAPI provides a consistent interface for multiple applica-
tion programs to interact with multiple messaging systems across a vari-
ety of hardware platforms.

Source: The Free On-line Dictionary of Computing, © 1993-2001 Denis 
Howe

N Navigation scheme
The way in which screens and graphics are linked together. It defines 
what will happen next when the user touches a target on the BCU opera-
tor display.

Navigation tree
The panel on the left-hand side of the main Tracer Summit window that 
displays all sites, buildings, areas, and HVAC equipment set up for the 
system.

Night economize
Setting that uses cool, dry outside air during unoccupied periods to pre-
cool a building, thus minimizing the use of mechanical cooling.

Night heat/cool
Setting that provides mechanical heating/cooling during unoccupied peri-
ods to bring space temperature back to within a predefined range.

O Object
An element recognized by the Tracer Summit database. Objects may be 
input and output points, UCMs or applications.

Object instance
At a site there may be many units of a particular object type installed: 
Centrifugal Chillers, VAV II/IIIs, and Voyagers, etc. An object instance 
refers to a unit installed on the link Chiller 1 or Voyager 12. Each object 
instance will have a unique address used to identify it to the building 
automation system.

Offline
The operational state of a device when not communicating on the net-
work.
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Online
The operational state of a device when communicating on the network or 
with a control device.

Operator display
A liquid crystal display (LCD) mounted on a modular BCU for basic oper-
ator functions including viewing a local BCU event log. The operator dis-
play consists of an LCD with a printed circuit to control the display. 
Additional components include a time clock and external memory. The 
operator display is equipped with a touch screen as a user input device.

Operator display object list
The list of objects/properties existing at a single site that have been 
selected for viewing an operator display. The Operator Display editor is 
used to define this list.

Optimal start
The process of efficiently starting HVAC equipment so that the occupied 
setpoints will be achieved at the appropriate time. The Tracer Summit 
system, for instance, may be programmed for occupied temperature at 
6:00 a.m., but with optimal start, may start at 5:15 a.m. to enable temper-
ature control to be achieved by 6:00 a.m.

P Panel
A term generally used for Tracer 100 Series or Trackers units that are 
monitored from a central location.

PC (Personal Computer) Workstation
The primary operator interface for the Tracer Summit system. The work-
station and the Tracer Summit software serve as a communication link 
between the operator and the BCUs and other equipment. The worksta-
tion provides a graphical interface to system information.

Priority control
The ability to define custom control sequences that respond to alarm con-
ditions. Priority control sequences receive the highest priority; they over-
ride all other control sequences.

Programmable control module (PCM)
A Trane-based controller (DDC) that is fully programmable. It controls 
and monitors a wide range of HVAC and other applications, including air-
handling equipment, pumps, cooling towers, boilers, and water chilling 
units.

Property
One element of an object’s characteristic information. This information 
element can be viewed, referenced, and applied throughout the Tracer 
Summit system.
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R RAM
A type of computer memory located on the BCU logic board that is used to 
store temporary data such as operator overrides, UCM scan data, and CPL 
saved values.

Referencer
An edit control in Tracer Summit editors that allows the value of one 
property to be set equal to the value of another property. 

Rover Comm5 service tool
Trane’s service tool for Comm5 unit controllers. The Rover software is 
used to set up and troubleshoot controllers on Comm5 links. Rover is not 
designed for daily management of building automation systems. With 
Rover Version 5.0 and Tracer Summit Version 15.0, you can use Rover 
within Tracer Summit to configure Comm5 controllers locally and 
remotely.

Rover device plug-in
A software module that Rover uses to interact with a device, such as a 
Tracer ZN510 zone controller. Each type of controller requires its own 
software plug-in for Rover. You can download new and revised plug-ins 
from TraneNet.

RS-232
(see EIA-232)

Runtime view
The presentation of a graphic in Tracer Summit with live, updated data. 

S Scan
A connection to designated Tracer 100 panels that retrieves status infor-
mation, and downloads changes to schedules, holidays, and trends, etc. 
Like BMN, Tracer Summit can scan Tracer 100 panels as well as BCU 
sites.

SCC
Space Comfort Controller profile.

Structured Query Language (SQL)
Pronounced either see-kwell or as separate letters. SQL is a standardized 
query language for requesting information from a database. SQL sup-
ports distributed databases (databases that are spread out over several 
computer systems). This enables several users on a network to access the 
same database simultaneously. 
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Setpoint
Typically a zone sensor or thermostat (STAT) heat/cool value to be main-
tained by the system.

Shared event log
An event log database, in SQL format, stored in a SQL server and 
accessed by multiple Tracer Summit workstations.

Site
A logical grouping of equipment serving a single facility.   The customer 
defines the site as a logical grouping.

Site graphic
A graphic that is available only to a specific site (a custom site graphic).

SMTP
Simple Mail Transfer Protocol. A protocol defined in STD 10, RFC 821, 
used to transfer electronic mail between computers, usually over Ether-
net. It is a server to server protocol, so other protocols are used to access 
the messages. The SMTP dialog usually happens in the background 
under the control of the message transport system, e.g. sendmail but it is 
possible to interact with an SMTP server using telnet to connect to the 
normal SMTP port, 25.

Source: The Free On-line Dictionary of Computing, © 1993-2001 Denis 
Howe

Sorting
To arrange the information alphanumerically in a given column of a 
table.

Standard screen
The menu-driven screens that allow the user to navigate within the BCU 
operator display. Depending on the context, a standard screen will have 
any combination of static text, live text, and/or icons.

Static text
Text that does not come from the Tracer Summit database. The only way 
to change static text is by using the display setup editor. The title for a 
custom graphic screen is an example of static text.

Status
An indication of a condition which may or may not be normal. An alarm 
may be a response to an abnormal status, and may be recorded in an 
event log.

Syntax
A set of rules for a programming language.
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System security
A method of maintaining or restricting access to the building manage-
ment system. Typically, a four-digit code enables access to override or con-
trol the system.

T Target field
A graphic field that launches another graphic from within Tracer Summit 
(either a Target field, a Target image, or a Target button) or a graphic 
field that links to a source outside of Tracer Summit (a Target External 
button).

Target link
A graphic field (a target field, target image, or target button) that is 
linked to another graphic screen. When the user touches this target link, 
the screen to which the target is linked displays.

Task
In the Task Manager application, an operation or series of operations that 
are performed by a workstation. Examples of tasks include automatically 
initiating communications to a site or performing a backup of a site data-
base.

Template graphic
A graphic that contains at least one field for which the information 
required to display Tracer Summit data depends on the object for which 
the graphic is being displayed. All standard graphics are template 
graphics.

Terminal emulation session
A personal computer with a central processing unit disabled so that the 
keyboard and the display screen can be used to communicate with and 
program another device either directly or through a modem connection.

Time of day scheduling (TOD)
The process of assigning the times during the day for defined actions to 
occur for various components of the building management system. These 
include typical on or off commands.

Timed override (TOV)
An operator function to override equipment operation from unoccupied 
control to occupied control.

Touch
The user/operator touches a target on the BCU Operator Display. This is 
the touch screen equivalent to a keyboard or mouse input at the worksta-
tion.
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Touch screen
A transparent overlay on an LCD or computer screen that is sensitive to 
touch by a finger or stylus.

Tracer Graphical Programming (TGP) language 
The language that technicians will use to write programs to control the 
Tracer MP580/581 programmable controller.

Tracer MP580/581 Controller
A multi-purpose programmable controller that offers direct digital control 
and monitoring of applications through the use of generic inputs and out-
puts. Often used on air-handlers, pumps, cooling towers, boilers, water 
chilling units, and non-HVAC applications.

Tracer 100 series panel
The Tracer product line of building management systems. Tracers pro-
vide building automation and energy management by monitoring and 
controlling HVAC equipment, providing the user with management infor-
mation, and networking with Tracer systems. Panels in this series 
include the Tracer 100, Tracer 100i, and Tracer chiller plant manager.

Tracer remote
A term generally used for Tracer 100 Series panels (also referred to sim-
ply as panel, remote, remote unit, and remote panel, etc.) that are moni-
tored from a central location.

Tracer Summit
Trane’s premier building management system that allows facility manag-
ers to operate a building in an optimized and efficient manner. Tracer 
Summit gives the facility operator control of temperature, humidity, 
scheduling, lighting, energy, and much more. All of these building control 
capabilities can be programmed and managed as a single system through 
Tracer Summit. 

Tracer VV550 VAV Controller
The Tracer VV550 (factory-installed) and Tracer 551 (field-installed) con-
trollers provide digital control for variable air volume (VAV) boxes and 
communicate with a Tracer Summit BAS by using Comm5, Trane’s 
implementation of LonTalk® communications protocol.

Tracker
The Tracker building automation system is Trane’s building management 
system for small, light commercial buildings. It consists of an operator 
display on the Tracker controller and a menu-driven interface program in 
the embedded software.
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Trane Data Link (TDL)
A file type used in place of the UDL (Universal Data Link) file type so the 
user is limited to setting up only the information necessary to run Tracer 
Summit.

TraneNet
Proprietary internal intranet site for Trane offices.

Trend log
Retains a historical record of values for specified points.

U Unit control module (UCM) 
A factory-mounted microelectronic circuit board that is typically used for 
control of HVAC equipment and linking to an integrated comfort system.

Unit control panel (UCP)
The factory mounted, microprocessor-based unit controller of the Trane 
CenTraVac chiller for unit process control, load control and equipment 
safety protection.

Unit-to-unit
The Tracer 100 Series system that has models capable of being configured 
with a COP Tracer with up to seven slave Tracers connected to it over an 
18 AWG twisted, shielded-pair wire LAN. The Tracer Summit system 
communicates to the slave Tracer 100 through the modem on the COP 
Tracer.

Universal Data Link (UDL)
A Microsoft database management tool for configuring database connec-
tions and security.

Universal programmable control module (UPCM)
Programmable ICS controller that provides direct digital control and 
monitoring for a wide range of HVAC and other applications.

W Wizard
An application utility that helps you step through a particular task 
related to the application. For example, the Site Connection Wizard in 
Tracer Summit leads you through the steps of connecting to various sites 
using different communication media.

Workstation
Refers to a personal computer, either a laptop or a desktop, that is loaded 
with the Tracer Summit software and the Setup editor software.
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Glossary
V Variable air volume (VAV)
Air distribution system that varies the volume of air supplied to a system 
to maintain acceptable space comfort conditions.
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Glossary
Z Zone
The smallest area of control in an HVAC system. It is characterized by 
having a single thermostat or zone temperature sensor. A room served by 
a single VAV box is an example of a zone. Several rooms served by the 
same VAV box also constitute a zone.

Zone control system
System that provides individual temperature control to each area in a 
building using the same single zone heating/cooling unit.
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Symbols

Advanced override
Overriding an Area, 316

* in password field, 139
. . . button, 21

Archiving event log, Task manager, 
228

/// or // in CPL comment lines, 374
??? value, 13, 20, 22, 542

A

Accessing, 174
Accessing alarm popups from event 

log, 568
Accessing the Simplified Override 

Dialog Box, 174
Accessing the trend viewer through a 

graphic, 432
Acknowledgment of alarms

Requiring operators to provide, 82
Advanced override, 314

Overriding a UCM, 195–197
Overriding an area, 314–317
Overriding the present value, 273, 

314, 316
Advanced overrides

Changing for analog output
Present value, 273

Changing for binary values, 273
Advanced settings, changing, 575
Advanced Systems Override, 187
Advanced systems override, 187
Air handler

Selecting for a Comm3/Comm4 
VAS, 336

Selecting for a Comm5 VAS, 322
Air temperature sensors, setting, 308
Airflow drive max, 339
Airflow valve

Balancing, 330
Alarm buttons on toolbar, configuring, 

565
Alarm popups, accessing from event 

log, 568
Alarm popups, configuring, 566
Alarms and events

Alarm, definition, 671
Analog input, setting up, 252
Binary input, setting up, 257
Enabling and disabling for analog 

input, 252

Enabling and disabling for binary 
input, 258

Forwarding alarms from groups of 
sites, 245

Message forwarding and call 
center, 237

Message forwarding and call 
center, and, 231, 245

Overriding at workstation, 571
Printing, 150
Routing for UCM, 197
Routing of a binary input, 258
Routing of an analog input, 253
Setting options, 569
Showing and hiding connection 

dialog, 571
Telephone notification, 163
Trend snapshots, 458

Ambient temperature lockout, 
selecting, 293

Analog in 5 color field, setup 
information for, 478

Analog input
Alarm scenarios, 252
Analog input editor, 251, 282
Analog, definition, 671
Assigning expanded message, 508
Creating, 250, 280
Defining referencer for, 250
Definition, 250, 671
Expanded message for, 253
Naming, 250
Present value of, 252
Routing of alarm, 253

Analog output
Analog output editor, 260
Analog, definition, 671
Calculated, 212
Class, entering, 263
Creating, 259
Defining referencer for, 259
Definition, 259, 671
Global references, setting up, 268
Globally change, 211
Modifying the present value, 209
Naming, 259

Annual report, setting up, 557
Application

Application program, definition, 
671

Assigning access to, 140, 141
Definition, 671
Denying access to, 140
689



 Index
Non-Trane device, See Non-
Trane device

Setting up for Tracer Summit, 8
Unavailability of offline testing 

for, 13
View only access to application, 

140, 141
View/edit access to application, 

140, 141
Viewing properties of, 27

Area
Adding members, 306
Advanced overrides

Overriding present value, 
314

Overriding the present value, 
316

Creating, 305
Definition, 301
Making a timed override 

request, 314
Security access to, 312
See also Area control

Area control
Air temperature sensors, 308
Area control editor, 304
Cancel timed override (TOV) 

request, 316
Capabilities, 301
Definition, 301
Enabling and disabling night 

economizing, 311
Enabling and disabling timed 

override, 310
Membership rules, 307
Operating modes, standard 

behavior, 302
Security access to an area, 313
Start timed override (TOV) 

request, 316
Area node, 399
Array

Definition, 671
Using in CPL text file, 382

Audit Trail databases
Harvesting trend objects, 457

Audit trail databases
Setting up historical trend 

objects, 457
Auto log off

Minutes for, 140
Security option, 140

AutoCAD, 502, 620
Autocommissioning VAVs in VAS 

Comm5, 332
Automatic connection of sites, from 

navigation tree, 580
Automatic remote connection 

security option, 140
Autoselecting image size, 474
Average calculation, 524

AVI movie, 502
Autoselecting size, 474
Inserting, 464
Setup information for, 483

B

Back button, 485
Background

Changing for a graphic, 468
Locating image for, 470

Backing up, 643
Backing up function

and groups of sites, 219
Backup function, 643

Backup copy, definition, 672
Backup during site setup, 7
Restoring from a backup, 643
Task manager, and

Backing up BCU sites, 218
Tracer 100 backups, 219

See also Task manager
BACnet

BACnet ID, 638
Communications flow, 633
Control priorities, 630
Creating input/output object for, 

638
Definition, 625, 672
Electronic file, 641
Input/output objects for, 632, 

638
Input/output points, 638
Protocol, uses in Tracer Summit, 

625
Providing information to other 

systems, 632
Running report of objects, 639
Troubleshooting, 578
Using for non-Trane devices, 

625
BACnet device(s)

Creating in a site, 70
Default device ID, 70
Deleting from a site, 72
Editing in a site, 71
Name, dependent on device ID, 

70
BACnet protocols

See BACnet device(s)
BACnet/IP

Site connection for, 37, 38
Balancing, system, 330
BAS (building automation system), 

definition, 673
Base chiller, 296
BBMD IP address, 39
BCU

Adding modem for, 60

clear code, database, RAM, and 
reset procedure, 665

clear Comm5 database, 666
clear database, RAM, and reset 

procedure, 665
clear RAM and reset procedure, 

664
Connection, programming 

without, See Offline 
programming

Creating for a site, 57
Definition, 673
Deleting from a site, 65
Deleting modem from, 64
Deleting when contains objects, 

65, 68, 72
Device ID, assigning, 58
Device ID, default, 58
Editing in a site, 61
Modem, See BCU modem
Operator display, and, 581
Pagers and, See Pager
Required for site creation, 57
Resetting, See Reset function
Role in BACnet setup, 633
Role in online programming, 11
Selecting for CPL program, 388
Version, selecting, 78
Viewing memory for trend 

sampling, 460
BCU I/O Module Object

Analog inputs, setting up, 284
Binary inputs, setting up, 285
Calculating the pulse multiplier, 

284
Creating, 280, 583
Pulse metered inputs, setting 

up, 284
BCU modem

Configuring, 162
Creating new, 161
Editor, accessing, 160
Phone book, managing, 163
Redialing, 161
Security access to, 166
Setting up, 161

BCU object
Viewing and modifying, 207

BCU objects
Present value, modifying, 207
Uploading and downloading, 

207
BDB files, 219, 412, 650

Task manager site backups, 218
Beep

Causing when event message 
received, 82

Preventing at workstation, 571
Billing period

Defining, 79
Definition, 672
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Scheduling calculations around, 
531

Used as a sampling interval, 456
Binary animation field, setup 

information for, 481
Binary input

Alarm scenarios, 257
Alarm state, cause of, 257
Assigning expanded message, 

508
Binary input editor, 256
Binary, definition, 672
BMTX, 277
Class, entering, 258
Creating, 255
Defining referencer for, 255
Definition, 255, 672
Expanded message for, 258
In CPL routine, 270
Naming, 255
Routing of alarm, 258

Binary output
Binary output editor, 266
Binary, definition, 672
Calculated, 212
Class, entering, 267
Creating, 265
Defining referencer for, 265
Definition, 265, 673
Global references, setting up, 

268
Globally change, 211
Modifying the present value, 

209
Naming, 265
Saving, 267
Standard behavior in an area, 

302
Binary text field, setup information 

for, 479
Custom screen editor, and, 610

Blank row
Adding to a report, 552
Purpose in a report, 548

BMP file format, 470, 502, 506
Custom screen editor, and, 613

BMS (building management 
system), definition, 673

Body text
Formatting for reports, 554
Report members displayed in, 

552
Boolean, 380, 381
Border, editing for graphic fields, 

483
Break in CPL program, 392
Building automation control 

network, See BACnet

C

Calculated analog and binary 
objects, 212

Accessing the editor, 213
Terminal emulation, and, 212
Uploading and downloading, 

207, 212
Calculation

Adding to a report, 550
Average, 524
Billing periods, scheduling 

around, 531
Cool Flow Rate, 524
Defining billing period for, 79
Editor, accessing, 531
Enabling, 536
Heat Flow Rate, 526
Maximum, 527
Meter Totalization, 527
Minimum, 527
Object, See Calculation object
Peak for X Minute Interval, 528
Pulse meter input, 278
Total Cooling Degree Days, 529
Total Heating Degree Days, 530
Total Run Hours/Starts, 531
Types, list of, 524
Using in live reports, 540

Calculation object
Clearing data from, 537
Creating, 533
Deleting, 538
Security access to, 538
Setting up, 535
See also Calculation

Calling card, 164
Capacity, definition, 673
Category alarms

assigning, 83
CCD, See Total Cooling Degree 

Days
CenTraVac, definition, 673
Changeover voting, 342
Changing for output objects

Present value, 273
Chiller

CenTraVac, definition, 673
Failure, 289
Setting up UCM for, 298
Units, 298
See also Chiller plant

Chiller plant
Adding members, 295
Base sequence, 296
Chiller object settings, 295, 297
Control capabilities, 289, 345
Creating new, 291, 347
Creating new objects for, 291
Definition, 674
Duplicate chiller types, 296

Normal sequence, 296
Peak sequence, 296
Security access to, 298
Sequence types, 296
Sequencing, definition, 674
Startup settings, 293
Subtract settings, 294
Swing sequence, 296
System setup, 292
See also Chiller

Chiller plant editor, 289
Accessing, 290, 346

Code
Writing in CPL, 369

Column heading, entering for 
reports, 553

Comment, adding, 374
Common space

VAVs, 324
Communication link

Changing once created, 63
Definition, 674
In non-Trane setup, 632

Communications port
PC workstation modem, 158
Tracer 100 or Tracker panels, 410

Compile function, 386
Compile report, 386
Failure, 387
Viewing errors in source files, 

387
Configuration, definition, 674
Configuring alarm popups, 566
Configuring category alarm buttons 

and popups, 565–567
Configuring category alarm 

buttonsAlarm buttons, 
configuring, 565

Configuring communication 
settings, 77

BCU sites, 155
Tracer 100 or Tracker panels, 124
Tracer 100 or Tracker sites, 156

Connecting to a site from the 
navigation tree, 401

Connection
Non-Trane devices, types of 

connections for, 625
Connection status

ARCNET status, 31
BACnet/IP, 31
Determining, 30
EIA-232, 31
Ethernet, 31
Not Connected status, 31

Constant mode in referencers, 20
Constant volume system, 

definition, 674
Context for a graphic, 472

Target fields, 487
See also Template field
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Control application
Assigning, 631
Modifying, 631

Control class, 631
In VAS Comm3/Comm4, 343

Control mode in referencers, 20
Control priorities

BACnet and, 630
Defaults, selecting, 630
Definition, 86, 272, 315, 630
Setting up, 86
Setting up for BACnet Devices, 

630
Conversion factor

For a Cool Flow Rate 
calculation, 525

For a Heat Flow Rate 
calculation, 526

For a Peak X Minute Interval 
calculation, 528

Cool Flow Rate calculation, 524
COP panel, 128

Creating, 128
Definition, 128
See also Tracer 100 or Tracker 

sites
Copy a site

BCU, 54
Objects not copied

Tracer 100 or Tracker sites, 
122

Objects not copied, BCU sites, 
54

Tracer 100 or Tracker site, 122
CorelDRAW, 502, 620
CPL, 369

Definition, 674
Error codes, 394
How area control affects, 302
Library of sample programs, 

369, 371
Syntax, 373, 376
Syntax, definition, 683
Templates, 371
Using CPL editor to reference 

objects and properties, 376
See also Programming

CPL editor
Closing, 370
Opening, 370

CPL files
Backing up, 643
Restoring from a backup, 644

CPL object
Compiling from a CPL text file, 

386
Creating new, 388
Downloading to BCU offline, 

389
Downloading to BCU online, 

389

Need for same name as text file, 
388

Outputs, inhibiting, 392
Replacing existing, 389
Running manually to debug, 

392
Testing, 391

CPL program, See CPL text file or 
CPL object

CPL text file, 369
Adding an object and property 

reference, 378
Adding an object reference, 376
Adding comments, 374
Adding functions, 375
Adding statements, 374
Array, 382
Assigning an object, 376
Assigning enumerations, 379
Compiling into a CPL object, 386
Creating, 371
Creating as a database object, 

387
Creating from existing file, 371
Creating from template, 371
Creating new from blank text 

window, 374
Example of array, 382
Example of saved value, 385
Example, after enumeration 

assigned, 381
Example, before enumeration 

assigned, 380
Locating errors in, 386
Naming objects and properties, 

376
Naming restrictions, 373
Referencing an object and 

property indirectly, 378
Referencing an object indirectly, 

376
Saving, 373
Structure, 371

Cross-hatched border on graphic 
field, 475, 476, 490

Custom global graphic node, 399
Custom graphic

Creating from blank graphic, 
504

Definition, 501, 674
Inserting main image, 505
Location, 501
Opening blank graphic, 504
Saving, 495, 507

Custom live report
Members, adding, 550
See also Report

Custom profile, 138–142
Custom programming language, 

See CPL

Custom programming routines,  
See Routines

Custom screen editor, 599
About custom screen graphics, 

600
Accessing the operator display 

custom screen editor, 602
Creating and importing 

bitmaps, 620
Creating custom screens, 603
Custom screen template, 600, 

604
Editing custom screens, 618
Organizing custom screen 

fields, 617
Restoring operator display 

custom screens, 649
Using the custom screen editor 

tools, 605
Adding fields, 610
Displaying the custom 

screen palette, 608
Using the custom screens 

pop-up menu, 608
See also Operator Display

Enabling custom screens, 
595

Operator display options, 
594

Custom screen editor palette, 605
Custom site graphic node, 399
Custom trend report

Members, adding, 551
See also Report

D

Daily report, setting up, 555
Database

Characteristics of Tracer 
Summit’s, 11

Importance of updating before 
programming offline, 14

Setup using offline 
programming, 13

Database Sync status field, 30
Date

Inserting into report, 552
See also Time and date

Daylight savings, 88
Debugging, See CPL program, 

testing
Decimal point in graphics, 484
Default file directories, changing, 

574
Default site, 55
DEFDBL statement, 378
DEFFLT statement, 378
DEFINT statement, 378, 380
DEFLNG statement, 378
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DEFOBJ statement, 377
Delete event option, using, 360
Deleting Tracer Summit items, 651

Object, deleting, 652
Report, deleting, 559
Restrictions, 651, 658, 660
Site, deleting, 658

Demand limiting, definition, 675
Destination, 485
Device

Creating for use with non-Trane 
server, 634

Definition, 675
Device ID for PC workstation, 67, 

576
Options, advanced, 578
Viewing for a site, 61

Device ID
Assigning for non-Trane device, 

626
For BCU, 58
Need for unique, 635
Obtaining for non-Trane device, 

628
Showing, 578
Workstation, changing, 575

Device, operator display, adding 
and deleting, 586–587

See also Operator display
Device, Tracer 100 or Tracker panel, 

125
Diagnostic, definition, 675
Dialing prefix, 164
Differential

Definition, 309
For MWU, 340
Setting, 309

DIP switch, definition, 675
Direct digital control, definition, 676
Directory

Changing default for files, 574
For storing graphics, 496

Disconnect remote connection 
security option, 140

Displaying manual override status
Hand icon, 564

Displaying Override Status, 172
Drive max airflow, 343
Duct pressure optimization in VAS 

Comm5, 327
Duty cycle, Tracer 100, 358
Dynamic values, appearance of 

when offline, 13

E

Economizer control, definition, 676
Edit level of security, definition, 135
EEPROM, definition, 676
Effective period of a schedule, 363

EIA-232 connection
Configuring modem object for, 

637
Creating modem object for, 636
Definition, 682
Modem object setup required, 

632
Electronic file, using to input 

BACnet data, 641
Electronic library, 25
Ellipsis button, 21

Archiving event log, Task 
manager, 228

See also ... button, 21
Ellipsis,  See Referencer button
END statement, 373
Energy conservation

Accomplishing with chiller plant 
control, 289

Monitoring pulse meter input, 
278

Enumeration
Assigning in CPL text file, 379
Defining for priority shutdown, 

380
Definition, 379
Example, after assignment, 381
Example, before assignment, 

380
Error codes in CPL, interpreting, 

394
Error-30 through Error-307, 394
Ethernet, definition, 676
Event

Adding, 358
Changing event time, 359
Removing, 360

Event class
Example user-defined classes, 

82
Labels for, 82
Predefined classes, 81
Recommended notifications, 81
Trend snapshots and, 458

Event Classes
Assigning for present value, 312
Assigning for timed override 

(TOV), 312
Category alarms, 83
Setting up, 81–83

Event log
Adding a BCU event log object, 

60
Archiving, 218, 221
Creating expanded message for 

a graphic, 508
Definition, 676
New features, 2
Printer selection, 569
Printing, 150

Saving archive as text or Excel 
file, 228

Settings, changing, 569
Viewing alarm popups, 568
See also Task manager

Events in a schedule, See 
Scheduling, 351

Events printer
Definition, 150
Setting up and selecting, 150

Exception in a schedule, 351
Exceptions

Adding to time of day reports, 
368

Expanded message
Backing up, 643
Creating, 508
Definition, 508
Restoring from a backup, 646, 

647
Selecting for analog input 

alarm, 253
Selecting for binary input alarm, 

258

F

Feedback reference
Definition, 257
Selecting, 258

Field in a graphic, See Graphic field
File directories, changing default, 

574
File format

Event log archive, 228
as .SAV, 228
as .TXT, 228
as Excel file, 228

File name
Auto generating for reports, 558
Specifying for a report, 558

Fill in template option, 515
Folder, see Directory
Fonts in a graphic, 484
Footer, entering for reports, 554
For more information about Tracer 

Summit, 5
Frequency of running CPL program, 

setting, 388
Frequency of trend sampling, See 

Interval
Function

Adding in CPL text file, 375
Assigning access to, 140

G

GIF file format, 470, 502, 506
Global changes, 203
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Calculated analog and binary 
objects, 212

Globally changing sites
Applying changes to a single 

site, 204
Applying changes to 

multiple sites, 205
Groups, and, 201
Modifying BCU objects, 207
Object types you can change, 

203
Offline programming, and, 18
Task manager, and, 217

Global graphic
Backing up, 643
Definition, 501, 677
Effect of selecting save option, 

497, 498
Navigation tree, and, 405
Restoring from a backup, 646

Global references
Setting up for analog or binary 

outputs, 268
Setting up for VAS Comm5 

members, 328
Graphic

Background, changing, 468
Basics, 462
Blank, 504
Context for, 472, 487
Custom, See Custom graphic
Definition, 677
Deleting, 515
Deleting, renaming as 

alternative to, 500, 515
Displaying for UCM when 

offline, 13
Editing, 463
Editor,See Graphics editor
Expanded message, See 

Expanded message
Field,See Graphic field
File formats for images, 470
File name, 470
Folders, 462
Global, definition, 501
Grid, See Grid
Hard-coded graphic, definition, 

678
Home, changing, 562
Inserting images, 506
Jumping to, See Target field
Location, 470
Location search order, 496
Options, 461
Palette, See Graphics editor 

palette
Properties, editing, 468
Renaming, 500, 515
Restoring, 499, 646, 647
Saving, 495–496

Security access to, 471
Setup, allocating workstations 

for, 13
Site-specific, definition, 501
Standard, definition, 501
Template field, See Template 

field
Uses of, 461
See also Custom screen editor

Graphic field
Aligning multiple, 492
Analog in 5 color field, 464
AVI movie field, 464
Binary animation field, 464
Binary check box field, 464
Border, editing, 483
Border, significance of cross-

hatching, 475, 476, 490
Border, significance of stripes, 

490
Copying, 492
Cutting and pasting, 491
Deleting, 494
Editing, 474, 475
External file sources, 488
Identifying type of, 475
Image field, 464
Inserting, 474
Making the same size, 493
Moving, 491
Moving by one pixel, 491
Moving forward or back, 494
Organizing with the grid, 466
Override control field, 464, 607
Primary field, 490
Property references for, 475
Resizing, 491
Secondary field, 490
Selecting multiple, 490
Selection list control field, 464
Setpoint control field, 464, 607
Setup information, 476, 477
Static text field, 464, 607
Status text field, 464, 607
Target button field, 465, 607
Target External button field, 476, 

488
Target fields, 485
Target image field, 465
Target text field, 465
Template field, See Template 

field
Text style, editing, 483
Types of, 464
See also Custom screen editor

Adding control value fields, 
610

Graphic object, see Graphic
Graphical status field, setup 

information for, 480
Graphics editor

Accessing, 463
Capabilities, 461
Using, 461

Graphics editor palette, 464
Graphing control editor

Creating a single trend object 
graph, 519

Creating live property graphs, 
518

Using historical graphs, 516
Using live property graphs, 516

Graphs, See  Graphing control 
editor

Grid
Color, changing, 467
Displaying on a graphic, 466
Snap to grid, disabling, 467
Snap to grid, enabling, 467
Spacing, configuring, 467
Using to organize fields, 466
See also Custom screen editor

Group of sites node, 399
Group security, 144
Group, definition, 677
Grouping sites, 199

Creating a group, 200
Creating call centers for groups 

of sites, 202
Creating scan tasks for groups, 

202
Forwarding alarms from groups 

of sites through e-mail, 245
Task manager, and, 226
Using groups to make global 

changes, 201

H

Hand icon
displaying for manual override, 

564
Harvesting trend objects, setting 

up, 457
HDD, See Total Heating Degree 

Days
Header .cpl file, 371
Heat Flow Rate calculation, 526
Heat Pump Loop Control (HPLC)

Loop controller member, 
assigning, 349

Need-to-run threshold, 345, 348
Need-to-run votes, 347
Night Heat/Cool operation, 345
WSHP compressor referencer, 

349
WSHP member, assigning, 349

Heat/cool
Night heat/cool, See Night 

heat/cool
VAV air system control, 339
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Historical trend objects, setting up, 
457

Holiday, 351
Adding to time of day schedule 

reports, 368
Holiday schedules, setting

Message forwarding and call 
centers, 242

Home graphic, changing, 562
HTML file

Definition, 678
Name, 495
Role in deleting graphic, 515
Search sequence, 496

HVAC equipment
Controlling with a schedule, 351
Definition, 678
During site setup, 8

I

I/O, See Input/output object
Image

Autoselecting size, 474
Changing state assignment, 482
Creating for a graphic, 502
Definition, 678
File formats, 470, 502
Inserting in a graphic, 506
Locating, 470
Saving, 502
Setup information for, 483
Sizes available, 503

Inch-pound units, 56
Input

Metering for use in calculations, 
528

See also Input object
Input object

Analog input, 250, 280
Binary input, 255
Definition, 249
Naming, 270
See also Input/output object

Input/output object
Creating, 249, 277
Creating for BACnet, 638
Modifying, 270
Naming, 270
Role in BACnet setup, 633
Security classes, 274
Types of, 249, 280
Using during site setup, 8
Using in BACnet, 632
Viewing properties for, 27
See also Input object or Output 

object
Input/output points for BACnet, 638
Input/output, See Input/output 

object

Insert prompt, 474
Interval

Sampling interval for trend, 456
Selecting for reporting, 554

IP subnet, 37, 45
I-P units, 56

J

JPG file format, 470, 502, 506

K

Keyboard macros
Accessing the macro editor, 414
Creating a macro, 415
Editing from the navigation tree, 

407
Macro node icon, 400
Selecting predefined macros, 

416
Tracer 100 predefined macros, 

418
Tracker predefined macros, 423
See also Navigation tree, 407

L

Labels, for event classes, 82
LAN

Connection, programming 
without, See Offline 
programming

Layout
Changing in reports, 552
Codes for reports, 552

LEDs
clear code, database, RAM, and 

reset procedure, 665
clear Comm5 database, 666
clear database, RAM, and reset 

procedure, 665
clear RAM and reset procedure, 

664
Library

CPL examples, 369
Electronic reference, 25

Lighting, how area control affects, 
302

Line-feed printer, 150
Live report

Calculation, using in report, 540
Custom, selecting, 545
Defining row for, 548
Definition, 540
Member types, 540
Sample, 541
Standard, 543

Standard, membership rules 
for, 549

See also Report
Local area network,  See LAN
Logging onto multiple sites, 139

M

Macro
See  Keyboard macros

Macro node, 400
Main control buttons, Trend Viewer, 

446
Main image of a custom graphic, 

505
Manual override status, displaying, 

564
Manually adding objects

Non-Trane device, 629
Master workstation, 12
Maximum calculation, 527
Member of a report

Changing order of, 552
Defining, 548

Member of a schedule, 361
Member of a trend

Adding, 453
Definition, 453
Editing, 453
Including in a report, 542
Limited number allowed, 454

Member of an area, adding, 306
Member of an object type, operator 

display, adding and deleting, 
589–590

See also Operator display
Message forwarding and call 

centers, 231
Accessing the editor, 236
Alarms, forwarding, 244
Background considerations, 232
Call center, definition, 232
Creating a message forwarding 

schedule, 241
Issues to consider before 

creating a call center, 234
Selecting a site/group from 

which alarms are sent, 245
Selecting alarm event classes, 

246
Setting holiday schedules, 242
Setting up call centers and 

message forwarding, 237
Creating a call center, 238
Registering e-mail profiles, 

237
Scheduling when recipients 

receive e-mails, 239
Test e-mail forwarding, 240

Meter Totalization calculation, 527
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Microsoft Windows
Modem for PC workstation, 

adding, 152
Printer setup, 150

Microsoft Windows Paint, 502, 620
Minimum calculation, 527
Mode button, 19

Options, 20
Modem

Adding a Tracer 100 or Tracker 
modem, 156

Adding for a site BCU, 60, 161
Adding for a workstation, 152
Adding object for EIA-232 

connection, 636
BCU modem setup, 160
Configuring object for EIA-232 

connection, 637
Deleting from BCU, 64
PC workstation modem setup, 

151
Security access to, 166
Setting up, 151

Monthly report, setting up, 556
Morning warm up, See MWU 

settings
Movement cursor, 491
MWU settings, 338

MWU differential, 340
MWU setpoint, 340
Selecting, 340

N

Name
Site, inability to modify, 35

Navigation tree
Connecting to a site from the 

tree, 401
Creating nodes, 402

Assigning graphics to, 405
Basic considerations, 402
Creating nodes inside site 

nodes, 403
Cutting and pasting, 403
Finding a node, 404
Grouping nodes, 404

Definition, 397, 680
Different types of nodes, 399
Editing macros from, 407
Navigation tree, capabilities, 

397
Using the navigation tree, 400

The tree menu and pop-up 
menus, 400

See also System options
Setting connection features, 

580
Network adapter, See Adapter

Network number, need for unique 
in BACnet, 635

New
Site, 34
UCM, 191
User, setting up, 136

NIC, See Adapter
Night economize

Area mode settings, 303
Definition, 680
How area control affects, 301
Setting up, 311, 356
Tracer 100 schedules, and, 358

Night heat/cool
Area mode settings, 303
Definition, 680
How area control affects, 301

No access level of security, 
definition, 135

No Such Property message, 510
Nobody Logged On

Need for user name, 143
Setting up user profile, 143

Node
Definition, 397
Types of, 399
See also Individual node types

Non-Trane device
Communication flow between 

devices, 632
Connection types, 625
Interfacing to, 626
Network, need for unique 

number, 635
Offline Editing, 629
Providing information to other 

systems, 632
Role in BACnet setup, 633
Using BACnet for, 625
See also BACnet device(s)

Normal chiller, 296
Normal day, 351
Not used mode, 22
Numeric Only paging protocol, 169

O

Object
And property reference, 378, 

578
Assigning in CPL text file, 376
Definition, 680
Deleting, 651, 652, 657
Grouping into security classes, 

274
Name in template field, 510
Options, advanced, 578
Properties, viewing, 27
References to an object, 

locating, 653

Referencing a property of, 22
Referencing indirectly in CPL 

text file, 376, 378
Security access for, 90, 286
Security, assigning access, 142
Showing object ID, 578

Object types, operator display, 
adding and deleting, 588–589

See also Operator display
Occupied mode, in VAS 

Comm3/Comm4, 340
Occupy, area mode settings, 303
Off Alarm Limits field 

requirements, 253
Offline Editing

Non-Trane device, 629
Offline programming

Database requirement, 14
Global changes, and, 18
Information flow in Tracer 

Summit, 11
Of existing site, 14
Of new site, 12
Offline, definition, 680
Task manager, and, 217
Tracer 100 sites, 17
UCM type required, 13
Ways to use, 12

Offset, setting for schedule 
members, 362

On Alarm Limits field requirements, 
253

Online programming, 12
Information flow in Tracer 

Summit, 11
Online, definition, 681
Terminal emulation, and, 411
Tracer 100 sites, 17

Opening, 434
Operator display, 581

Accessing the editor, 582
Adding event log, 60
Creating a new BCU operator 

display, 583
Enabling custom screens, 595
Home screen, 591
Selecting custom screens, 597
Setting up security, 147
Setting up the BCU operator 

display, 586
Selecting a device, 586
Selecting members, 589

Setup options for the operator 
display, 593

Enabling security at the 
operator display, 593

Operator levels, See Security, 135
Optimal start/stop, 351, 356

Area mode settings, 303
How area control affects, 301
Optimal start, definition, 681
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Optimization features for VAS 
Comm5, 327

Options, system, See System 
options

Output object
Analog output, 259
Binary output, 265
Definition, 249
Naming, 270
See also Input/output object

Output of reports, controlling, 558
Output, See Output object
Over-pressurization of ducts, VAVs, 

324
Override

Button names associated with, 
171

VAVs in VAS Comm3/Comm4, 
342

VAVs in VAS Comm5, 330
Override status, displaying hand 

icon, 564
Overrides

Overriding analog and binary 
values, 271–273

Overrides, advanced, 187
Overriding a Binary Output, 182

Non-Trane, 183
Overriding a Multi-State Analog 

Output, 180
Overriding a Multi-State Output

Non-Trane, 181
Overriding a UCM or Application, 

185
Overriding an Analog Output, 177

Non-Trane, 179
Overriding an Area, 314
Overriding other values

Using the advanced override, 
197

Overriding the present value
Using the advanced override, 

314
Overwriting settings, prevention of 

when offline, 14

P

Page count, inserting into report, 
552

Page number, inserting into report, 
552

Page printing, 150
Pager

Editor, accessing, 167
Message forwarding, call 

centers, and, 231, 233, 234
Object, creating, 168
Protocol, selecting, 169
Security access to, 169

Setting up, 167, 169
Paintshop Pro, 502, 620
Palette, See Graphics editor palette
Panel node, 399
Password

Assigning, 139
Before security established, 135
Showing and hiding, 139

Pause in dialing, code for, 164
PC modem, See Modem, 33
PC workstation

Creating in a site, 66
Default device ID, 67, 576
Definition, 681
Deleting from a site, 68
Deleting last from site, 68
Destination for restore function, 

646, 647
Device ID, assigning, 67, 576
Device ID, changing, 575
Editing in a site, 67
Enabling and disabling alarm, 

571
Master workstation, 12
Modem, See PC workstation 

modem
Need for additional, 13
Offline, 11
Online, 11
Required for site creation, 57, 66
Requirements for remote 

communication, 7
Role in archiving trends, 460
Setting up, 7
Synchronization among 

multiple, 90
Time and zone, setting up, 86

PC workstation modem
Adding in Windows, 152
Configuring for BCU sites, 155
Configuring for Tracer 100 or 

Tracker sites, 156
Creating new, 153
Editor, accessing, 151
Name, assigning, 154
Object, creating, 154
Phone book, managing, 163
Security access to, 166
Setting up, 157

PCX files, 13
Peak chiller, 296
Peak for X Minute Interval 

calculation, 528
Phone book

Adding for Tracer 100 or Tracker 
panels, 124

Adding phone numbers, 164
Editing phone numbers, 163
Removing phone numbers, 165
Setting up, 163

PIN for pager, 169

Point-to-point connection, See EIA-
232 connection

Pre-defined profile, 138
Pre-selected access for, 136

Pre-defined user, deleting after 
setup, 135

Prefix for phone numbers, 164
Present value

Advanced overrides, 273
Role in changeover voting, 342
Using advanced overrides, 195, 

316
Votes in VAS, 344

Previously viewed report
Opening, 547

Primary field, 490
Printer

Adding in Windows, 150
Events, 150
Line-feed, 150
Operating system, 8
Page, 150
Recommended for event log, 

150, 570
Selecting, 150
Selecting for event log, 569
Setting up for reports, 558
Setup sequence, 8
Tracer Summit, 8
Tractor-feed, 150

Printing
Alarms and events, 150
Electronic file, creating for 

BACnet, 641
Priority class, modifying name of, 

631
Priority control, definition, 681
Priority shutdown

Area mode settings, 303
Defining an enumeration for, 

380
Profile

Assigning pre-defined to a user, 
138

Copying for a user, 138
Nobody Logged On, modifying, 

143
Of user, 136
Setting up, 136

Programmable control module, 
definition, 681

Programming
Definition, 11
In CPL, See CPL
Offline, See Offline 

programming
Online,  See Online 

programming
Order checklist, 7
Setup sequence, 7

Property
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And object reference, 378
Definition, 681
Editing graphic properties, 468
Printing out an object’s 

properties, 28
Reference for analog input, 253
Reference for analog output, 

261
Reference for binary input, 257, 

258
Reference for binary output, 266
Referencing when offline, 22
Selecting for reference, 22
Selecting references for graphic 

fields, 475
Viewing an object’s properties, 

27
Pulse meter input, 278

Q

Quick trend report, See Trend 
report, Standard

R

RAM
Definition, 682

Random access memory, See RAM
Redialing, 161
Reference information in library, 25
Referencer edit control fields, see 

Referencers
Referencers

Definition, 19, 682
Failure of, 22
Locating for an object to be 

deleted, 653
Mode button, 19
Not used mode, 22
Referencer button, 21
Referencer mode, 21

Releasing control back to the 
system, 186

Remote unit
Tracer 100 sites, 125

Report
Auto generating file name, 558
Backing up, 643
Blank row, adding, 552
Body text, formatting, 554
Calculation, using in report, 540
Column headings, entering, 553
Date, inserting, 552
Deleting, 559
Designing, 548
Editing, 543, 548
File format, 543
File name, 558

Footer, entering, 554
Formatting, 552
Layout codes, 552
Member order, changing, 552
Members, defining, 548
Naming, 548
Opening a previously viewed 

report, 547
Opening a saved report, 546
Orientation, 548
Output options, 558
Page count, inserting into 

report, 552
Page number, inserting into 

report, 552
Printer, setting up for reports, 

558
Purpose of reporting, 539
Report editor, 539
Restoring from a backup, 648
Running, 543
Running for BACnet objects, 639
Saving, 559
Scheduling, 554–557
Selecting, 543
Standard reports, 543
Title, entering, 553
Trend, 460, 542
Types of reports, 540

Report viewer, 543
Reports

For time of day schedules, 366
Time of day schedules, 368

Reset function
Resetting a BCU, 663

Restore function
Global graphics, restoring, 646
Reports, restoring, 648
Site graphics, restoring, 647
Sites, restoring, 643

Restoring a Tracer 100 panel, 668
Restoring an original graphic, 499
Restoring custom screens, 649
Right of decimal, 484
Right-click capabilities, 466
Routines

Editing text files of, 13
Testing, 13

Routing
Alarm for a binary output, 267
Alarm for an analog input, 253
Alarm for an analog output, 263
Alarm for an binary input, 258
Alarm for analog input, 253
For chiller plant event class, 298
For UCMs, 197
Overriding, 571

Rover service tool, 621–623
RPT file format, 543
Runtime version

Runtime view, definition, 682

S

Sampling
Clearing samples, 459
Controlling by reference, 454
Delaying, 455
Determining whether 

suspended, 459
Disabled after snapshot, 458
In trend reports, 542
Interval, 456
Limits on, 454
Members of a trend, 453
Number of samples, 455
Resuming, 459
Setup for trend, 454
Viewing samples, 459

SAV files
Creating with Backup a remote 

function, 412
Restoring a Tracer 100 panel 

with, 668
Task manager panel backup, 219
Task manager, group of sites 

task, 226
Task manager, immediate scan, 

221
Task manager, single site task, 

224
Saved Report

Opening, 546
Saved value in CPL text file, 383

Definition, 383
Example, 385
Reading, 384
Writing, 384

Scanning sites, 218
Immediate scan, 221

Schedules
Creating time of day reports, 

366
Scheduling

Creating a daily schedule, 353
Interval for reporting, 554
Reports, 554–557
Save events as a normal 

schedule to weekdays, 
weekends, and holidays, 364

Schedule, definition, 351
Screen, accessing, 352
Using Tracer 100 schedules, 364

Second dial tone, code for, 164
Second window for graphic, 487
Secondary field, 490
Security

Classes, assigning for a site, 142
Group security, 144
Message forwarding and call 

centers, and, 235
Operator display, 147
Profiles, managing, 138
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Security editor, 135
Supervisor, 135
System security, definition, 684

Security access
Auto log off option, 140
Auto remote connection option, 

140
Changing, 90
Choosing options, 140
Disconnect remote option, 140
Edit level, 135
For a chiller plant, 298
For an area, 312
For analog inputs, 253
For analog outputs, 263
For binary inputs, 258
For binary outputs, 267
For calculation objects, 538
For graphics, 471
For modems, 166
For objects, 90, 286
For pagers, 169
For trends, 458
For UCMs, 197
For VAS Comm3/Comm4, 343
For VAS Comm5, 329
Levels of, 136
Match upper and lower case 

option, 140
No access level, 135
Nobody logged on, 143
Operator display, 147
Operator levels, 136
Required for uploading site, 42
Security supervisor option, 140
Setting for a UCM, 198
Setting for an area, 313
Setting for input/output object, 

274
To a class, 142
To a function, 140
To an application, 141
To an object, 142
View only level, 135

Security class
Assigning access to, 142
Definition, 274
For input/output objects, 274
Naming, 80
Read only access, 142
Read/write access, 142

Security supervisor
Security option, 140

Select, 496
Selecting a data range, 446
Setpoint

Definition, 683
Modifying for VAS 

Comm3/Comm4, 341
Modifying for VAS Comm5, 

326–327

Occupied, purpose for, 309
Setting, 309
Unoccupied, purpose for, 309

Setpoint field, setup information 
for, 477

Setting up the Trend Viewer, ??–430
Setup

Graphics, allocating 
workstations for, 13

Testing, 13
See also Programming

Show connection dialog, 571
SI units, 56
Simplified override dialog box

Accessing, 174
Overriding system objects, 

177–186
Setting up, 172
Using, 177

Site
Backing up, 643

Task manager, BCU, 218
Task manager, Tracer 100, 

219
BACnet device, 69
BCUs, managing, 57
Billing periods, defining, 79
Configuration editor,  See Site 

configuration editor
Configuring, 56

Tracer 100 or Tracker, 124
Configuring by Modem or 

Hardwired, 40
Configuring via offline 

programming, 13
Connecting from navigation 

tree, 401
Control priorities, 7
Copying a site

BCU site, 54
Tracer 100 or Tracker, 122

Creating, 34
Tracer 100 or Tracker, 120

Default site, 55
Definition, 33, 683
Deleting when currently logged 

on, 658
Deleting when not logged on, 

658
Devices, listing, 61
Devices, synchronization of, 89
Devices, Tracer 100 or Tracker, 

125
Logging onto multiple, 139
Multiple sites, managing, 33

Grouping sites, and, 199
Task manager, and, 217

Name, inability to modify, 35
Naming, 35
PC workstation(s), managing, 66
Programming offline, 12, 14

Restoring a Tracer 100 or 
Tracker site, 650

Restoring from a backup, 643, 
644

Security access, setting up, 90, 
286

Segmenting by security class, 
274

Selecting to configure, 55
Setting up, 7
Single site setup, 33
Time and date, setting, 86
Tracer 100 or Tracker, 120
UCM(s), managing, 74

Site configuration editor
Accessing, 55
Accessing, Tracer 100 or Tracker 

panels, 124
Capabilities, 33

Tracer 100 or Tracker panels, 
119

Site Connection
configuring a site by Modem or 

Hardwired, 40
Site connection wizard

Site connection process, 35, 45
Site connection process, Tracer 

100 or Tracker sites, 121
Site creation wizard

Restoring a site from, 53
Site creation process, 34
Site creation process, Tracer 100 

or Tracker sites, 120
Site graphic

Backing up, 643
Definition, 683
Effect of selecting save option, 

498
Restoring from a backup, 647

Site modem editor, See Modem 
editor

Site Name status field, 30
Snap to grid feature, 467

Custom screen editor, 617
Snapshot

Effect on sampling, 458
Enabling and disabling, 458
Referencing a trigger, 458
Resetting, 459

Space comfort controller (SCC), 
345, 349

Spacing on grid, configuring, 467
Custom screen editor, 609

Standard graphic
Definition, 499, 501
Location, 501
Replacing, 496
Restoring original, 499
Saving, 495
Saving as custom graphic, 498
Saving as site graphic, 497
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Saving edits to, 496
Standard international units, 56
Standard live report

Definition, 543
Members, adding, 549
Membership rules, 549
Selecting, 544
Using to report on BACnet 

objects, 639
See also Report

Standard time, 88
Standard trend report

Definition, 543
Role in extracting Trends, 449
Running automatically, 460

Start debug option, 391
Statement, adding to CPL text files, 

374
Static text field, set up information 

for
Custom screen editor, 613

Static text field, setup information 
for, 477

Status icon, locating on main 
window, 29

Status text field, setup information 
for, 477

Custom screen editor, 610
Status, definition, 683
Striped border on graphic field, 490
Supervisor of security, setting up, 

135
Swing chiller, 296
Switch for billing period, 79
Switching to run-time view, Custom 

screen editor, 617
Synchronization

Automatic, 90
Of device time in site, 89

Syntax of CPL, See CPL
System node, 399
System options

Advanced, 578
Advanced settings, 575
Alarm settings, 569
Changing event log settings, 

569
Changing home graphic, 562
Changing workstation device ID, 

575
Editing, 561
Selecting an e-mail profile for 

message forwarding, 579
Selecting event log printer, 569
Setting, 561
Setting connection features of 

the navigation tree, 580
Viewing system status, 29

System values
Overriding, 171

System, see Tracer Summit

T

Target field, 485
Context object for, 487
Definition, 485, 684
Destination, 485
Displaying graphic in second 

window, 487
Inserting, 485
Setup information for, 477
Target External button, 476, 488
Target image setup information, 

483
Using with template field, 510
See also Custom screen editor

Task manager, 217
Accessing the Task manager 

schedule screen, 220
Archiving event log, 218
Backing up a BCU site, 218
Backup file location, 229
Creating a task for groups of 

sites, 226
Creating a task for single site, 

222
Four task types, 218
Run immediate scan on single 

site, 221
Saving the event log as a text or 

Excel file, 228
scanning sites, 218
Tracer 100 panel backup, 219

Telephone numbers, See Phone 
book

Template field
Context for, 472, 487, 514
Context object, definition, 674
Definition, 510
Effect on display of navigation 

tree, 499
Eligible field types, 510
Filling in with permanent 

information, 514
Inserting, 511
Object name in, 510
Opening a graphic containing, 

513
Removing from a graphic, 514
Site name in, 510
Template graphic, definition, 

684
Using with target field, 510

Template, custom screen, 603
Tend Viewer

Adding a property, 439
Terminal emulation, Tracer 100 or 

Tracker, 411
Test message

e-mail forwarding, 240
Text file

For CPL, See CPL text file

Saving report as, 543
Text style, editing for graphic fields, 

483
Time

Automatic synchronization of, 
90

Changing, 88
Synchronization for devices, 89
See also Time and zone

Time and date, setting for a site, 86
Time and zone, setting up, 86
Time of day schedule reports, 366

Adding event information, 368
Time of day scheduling, 351

Adding a member to a schedule, 
361

Adding event, 358
Changing a schedule’s name, 

360
Changing effective period, 363
Creating a daily schedule, 353
Creating a time of day report, 

351
Creating a time of day schedule 

report, 366
Definition, 684
During site setup, 8
Offsets, setting for members, 

362
Removing a member from a 

schedule, 362
Removing event, 360
Setting up day of the week, 357
Tracer 100 schedules, 364

Timed override
Assign to event classes, 312
Binary trigger, BMTX, 277
Cancel timed override request, 

316
Definition, 684
How area control affects, 302
Initiating TOV functionality for 

area members, 307
Setting up, 310
Start timed override request, 

316
Title, entering for reports, 553
to, 268
Tool bar, Trend Viewer, 441
Toolbar alarms, configuring, 565
Total Cooling Degree Days 

calculation, 529
Total Heating Degree Days 

calculation, 530
Total Run Hours/Starts calculation, 

531
Tracer 100 or Tracker panels, 409

Altering panel memory, 411
Background, 410
Configuring a Tracer 100 panel, 

124
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Configuring a Tracker panel, 127
Configuring ports, 410
Creating keyboard macros, 413

Predefined macros, 418
Creating Tracer 100 .SAV files, 

412
Interfacing with the navigation 

tree, 411
Terminal emulation, 411
See also Keyboard macros

Tracer 100 or Tracker sites
Configuring Tracer 100 or 

Tracker panels, 124
Copying, 122
Creating, 120
Defining, 119
Editing a Tracer 100 keyboard 

macro from the navigation 
tree, 407

Restoring, 650
Setting up a modem for, 156
Tracer 100 sites with multiple 

panels, 128
Adding panels, 130
See also COP panel

Using Tracer 100 schedules, 364
See also Tracer 100 or Tracker 

panels
Tracer 100 site node, 399
Tracer loop controller, 345, 347, 348, 

349
Tracer Summit

Backing up, 643
CD, 7
Database, 11
Definition, 685
Deleting items, 651
Optional packages, 1
Restoring, See Restore function
Window sizes available, 503

Tracer Summit BCU site node, 399
Tracker site node, 399
Tractor-feed printer, 150
Trend

Archiving, 460
Communication requirements, 

460
Creating, 451
Definition, 449
Interval of sampling, 456
Member, See Member of a trend
Naming, 454
Renaming, 454
Report, See Trend report
Samples, See Sampling
Saving, 460
Security access to, 458
Snapshot, See Snapshot
Trend editor, capabilities, 449
Trend log, definition, 686
Using in a report, 542

Trend object, See Trend
Trend objects

Harvesting for Audit Trail 
databases, 457

Harvesting for Trend Viewer, 
457

Trend report, 460
Custom, selecting, 545
Defining column heading for, 

548
Definition, 540
Sample of, 542
Sampling in, 542
Standard, 543
See also Report

Trend Viewer
adding to, 433
Chart elements, 442–444

data markers, 444
grid, 444
icons, 444
legend, 443

Creating, 431–433
Creating from a graphic, 433
Different ways to open, 434–437
Displaying from popup menu 

on a graphic, 430
Graphic, opening from, 435
Harvesting trend objects, 457
Historical trending, 447
Main control buttons, 445, 446
Saving, 434
Setting up, 426–430
Setting up harvesting trend 

objects, 457
Setup menu, opening from, 434
Toolbar, 441
toolbar, opeining from, 437
Working with, 440–448

Troubleshooting
BACnet, 578
Chiller marked as failed, 298
CPL routines affected when 

input/output renamed, 270
Failure of compile function, 387
Images not displaying properly 

in graphics editor, 470
Incomplete database, 30
Interpreting CPL error codes, 

394
Limited BCU memory for trend 

samples, 454
Messages sent to wrong 

workstation, 575
Referencer failure, 22
Runtime errors halt CPL 

program, 391
System cannot locate graphic, 

497
System cannot locate object, 

462

Variables have wrong values, 
391

TXT file format, 543

U

UCM
Accessing information offline, 

13
Advanced override, 195–197
Advanced overrides

Overriding the present value, 
195

Releasing control of, 196
Chiller, setting up, 298
Configuring, 194
Creating in a site, 74
Creating new, 191
Definition, 686
Deleting from a site, 76
Editor, accessing, 189
Graphic display when offline, 13
Members, standard behavior, 

302
Naming multiple UCMs in a site, 

75
Overriding other values, 197
Role of in a site, 74
Security access to, 197
Setting up, 193
Viewing properties of, 27

UCM node, 400
UCP (unit control panel), definition, 

686
UCP1,See Chiller
UCP2,See Chiller
UDP port number, 38, 46, 48
Unacknowledged Alarms status 

field, 30
Unit control module, See UCM, 33
Unit Controllers menu option, 189
Units of measure

Need for consistency in chillers, 
298

Selecting for a new site, 56
Unoccupied mode

Area mode settings, 303
In VAS Comm3/Comm4, 340

UPCM (universal programmable 
control module), definition, 686

Uploading
Calculated analog and binary 

objects, 212
Uploading and downloading

BCU objects, 207
Upper and lower case

Security option, 140
User

Entering information for, 137
Modifying information for, 143
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Nobody Logged On, 143
Operator levels, 136
Setting up, 136

User name
Before security established, 135
Deleting pre-defined user, 135
Nobody Logged On, need for, 

143

V

Variable, 380, 383, 391
Using to reference an object, 

377
Using to reference an object 

and property, 378
Viewing, 392

Variable air volume (VAV) boxes, 
333

Variable air volume air system, see 
VAS Comm3/Comm4, VAS 
Comm5

VAS Comm3/Comm4, 333–344
Accessing the VAS 

Comm3/Comm4 editor, 334
Air handler, selecting, 336
Airflow drive max, 339
Alarms, 343
Assigning members, 336
Capabilities, 333
Components, 333
Creating object, 335
Drive VAVs to max flow, 343
Heat/cool decisions, 339
Minimum flow value, 338
Modifying, 338
MWU settings, See MWU 

settings
Naming, 335
Security access to, 343
Setpoints, modifying, 341
Setting up, 338
Voting for present value, 344
Voting setpoints, 342

VAS Comm5, 319–332
Accessing the VAS Comm5 

editor, 320
Assigning members, 322–325
Autocommissioning VAVs, 332
Balancing air and water flow, 

330
Common space VAVs, 324–325
Creating the object, 321–322
Duct pressure optimization, 327
Global references, 328
Security access to, 329
Setting up, 326–327
Supported controllers, 319
VAV auxiliary heat at night, 327
VAV calibration, 327

Ventilation optimization, 327
VAV air system

Variable air volume, definition, 
687

VAV air system, see VAS 
Comm3/Comm4, VAS Comm5

VAV I, 337, 339, 341
VAV II, 337, 339
VAV III, 337, 339
VAV IV, 337, 339
Ventilation optimization in VAS 

Comm5, 327
Ventilation, how area control 

affects, 301
See also HVAC equipment

Version of BCU, selecting to 
download, 78

View only level of security, 
definition, 135

W

WAIT statement, 391
Waterflow valve

Balancing, 330
Weekly report, setting up, 555
Window sizes in Tracer Summit, 

503
Windows 98, 7
Windows NT, 7
Workstation alarm, enabling and 

disabling, 571
Workstation, See PC workstation

Z

Zone
Definition, 688
Setting up, 86
Zone control system, definition, 

688
See also Time and zone
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Reader 

Response 

Form

1. In a word, how would you describe this guide?

________________________

2. Using the following scale, rate the overall quality of this guide:  
(Use the following scale.)

1 2 3 4 5

Dreadful Terrific

3. How do you use this guide? (Choose one.)

a. I read it from beginning to end.

b. I read only the sections that pertain to my immediate needs.

c. I read only the sections that pertain to my job.

4. How easily can you find information in this guide? 

1 2 3 4 5

Not easy at all Moderately Very easy 
 —very difficult easy

5. When you actually try the instructions described in this guide, how 
easily can you follow them?

1 2 3 4 5

I can’t Occasionally With 
follow the the content great 

instructions is confusing ease 
at all.

6. How well did you understand the product before reading this guide? 

1 2 3 4 5

Not at all Somewhat Thoroughly

7. How well did you understand the product after reading the guide?

1 2 3 4 5

Not at all Somewhat Thoroughly

8. The best aspect of this guide is __________________________________  

_______________________________________________________________

9. If we were to change one aspect of this guide, it should be _________  

_______________________________________________________________

10. Name, e-mail address: (optional)_________________________________  

_______________________________________________________________

Our goal is to provide accurate 
and efficient information 

to our customers. Please use 
this form to help us improve 

the quality and usability 
of this guide. Make copies of 

this form if needed.

Please send this form 
by fax or mail to: 

Trane GCC 
Product Communications 

4833 White Bear Parkway 
St. Paul, MN 55110 

(fax) 651-407-4198
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